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TTUUTTOORRIIEELL
Écrit par Elmer Perry LLiibbrreeOOffffiiccee -- PPaarrttiiee 22

D ans mon dernier article, je
vous ai présenté les dif-
férents modules du pro-
gramme LibreOffice. Aujour-

d'hui, je voudrais vous montrer les
méthodes de configuration de base
et du formatage manuel pour le mo-
dule Writer. Le module Writer vous
permet de créer des documents texte
formatés. Vous pouvez vous servir de
Writer (ci-dessous) pour quelque chose
d'aussi simple qu'une lettre ou un jour-
nal ou d'aussi complexe qu'un manus-
crit ou une thèse.

Nous regarderons d'abord la fenê-
tre de Writer. Tout en haut, il y a la
barre des menus qui vous permet d'ac-
céder à tous les outils du module et à
toutes les actions possibles sur un
document. En dessous de la barre des
menus, il y a la barre d'outils stan-
dard. Celle-ci vous donne un accès ra-
pide aux commandes usuelles comme
Ouvrir, Enregistrer et Impression rapide.

À côté de la barre d'outils standard se
trouve une fenêtre «  Rechercher  »,
une barre de recherche. Sous la barre
d'outils standard, il y a la barre d'ou-
tils de formatage - où vous trouverez
des icônes correspondant à des outils
habituels de formatage. Cette barre
d'outils est contextuelle et changera
quand vous travaillerez avec des élé-
ments tels que le dessin d'objets. Si
vous avez activé les infobulles, une
description de ce que fait chaque icône
s'affichera lorsque vous passerez la
souris dessus.

Sous la barre d'outils de forma-

tage, à gauche, vous avez des règles,
l'une horizontale et l'autre verticale.
Les règles sont des guides pour vous
aider à faire la mise en page d'un
document. Par défaut, pour l'anglais,
les règles s'affichent en pouces. Il y a
deux façons de modifier les unités de
mesure des règles. Faites un clic-droit
n'importe où sur une règle (à gauche)
et Writer affichera un menu des diffé-
rentes unités. Cette méthode fonc-
tionne mieux quand vous n'avez besoin
de la modification que pour le docu-
ment en cours. Si, toutefois, vous avez
besoin d'une autre unité de mesure
par défaut, vous devrez la changer
dans les options. Allez à Outils >
Options > LibreOffice Writer > Affi-
chage. C'est ici que vous pourrez
paramétrer les unités par défaut des
règles (verticale et horizontale) ou
choisir de travailler sans les règles.

Bien, nous allons maintenant créer
une lettre simple et je vous montrerai
comment formater manuellement les
différents paragraphes de celle-ci. Lan-
cez LibreOffice et démarrez un nou-
veau Document texte. Nous mettrons
la date actuelle en haut du document
et l'alignerons à droite. Allez à Inser-
tion > Champs > Date. Ceci affichera
la date dans le format par défaut
(jj/mm/aa). Vous remarquerez que la

date est surlignée en gris, ce qui vous
signale que c'est un champ que vous
avez inséré dans le document.

Changeons le formatage de la
date. Double-cliquez dessus et une
fenêtre de dialogue (ci-dessus) s'affi-
chera avec les diverses options pour
la date. Sélectionnez celle que vous
voulez et cliquez OK.

Il faut maintenant aligner la date à
droite, alors trouvez les icônes d'ali-
gnement sur la barre d'outils du for-
matage et cliquez sur celle qui cor-
respond à «  Aligner à droite  ». La date
se mettra contre la marge de droite.
Utilisez la touche Fin de votre clavier
pour aller jusqu'au bout de la ligne
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actuelle et appuyez sur Entrée. Nous
ne voulons pas que le texte du nou-
veau paragraphe soit aligné à droite,
il faut donc cliquer sur l'icône «  Ali-
gner à gauche  » pour que le début du
paragraphe soit contre la marge de
gauche. Saisissez votre formule de
politesse et appuyez sur Entrée.

Pour les paragraphes du corps de
notre lettre, nous voulons faire un
alinéa de chaque première ligne.
Quand la précision ne vous tracasse
pas, vous pouvez faire cet alinéa en
vous servant de la règle horizontale.
Vous y remarquerez deux triangles
sur la marge de gauche (ci-dessus à
gauche et à droite), l'un dont la
pointe va vers le haut, et l'autre dont
la pointe va vers le bas. Le triangle du
bas - celui dont la pointe va vers le
haut - vous permet d'ajuster l'alinéa à
gauche pour tout le paragraphe. Vous

en remarquerez un tout à fait sem-
blable à droite, qui sert à ajuster
l'alinéa à droite pour le paragraphe.
Le triangle du haut à gauche - celui
dont la pointe est dirigé vers le bas -
ajuste l'alinéa de la première ligne du
paragraphe. Cliquez sur le triangle du
haut et déplacez-le d'environ 1 ,27 cm
(0,5”).

Si vous avez besoin d'alinéas plus
précis, vous pouvez atteindre la boîte
de dialogue concernant le style du
paragraphe (ci-dessous à gauche) en
double-cliquant sur la partie grise de
la règle horizontale. Vous l'atteindrez
également en allant à Format > Para-
graphe. Ici, vous trouverez beaucoup
d'options de formatage du para-
graphe. Aujourd'hui, ce qui nous inté-
resse c'est seulement l'alinéa de la
première ligne, alors changez Pre-
mière ligne en 1 ,27 cm (0,5”). Cliquez

OK. Vous remarquerez que le triangle
du haut (l'alinéa de la première ligne,
voir ci-dessous) a bougé jusqu'à la
position indiquée par vos soins dans
le dialogue.

Vous pouvez maintenant taper votre
paragraphe. Tapez-le et appuyez sur
Entrée. Vous remarquerez que l'alinéa
de la première ligne du paragraphe
suivant est exactement pareil à celui
du paragraphe précédent. Writer utili-
sera ce style de paragraphe jusqu'à ce
qu'on lui dise de faire autre chose.

Une fois le corps de notre lettre
tapé, nous aurons besoin d'ajouter
une signature, mais nous ne voulons
pas que notre signature soit pareille
aux paragraphes du corps. Avec soit
la méthode de déplacement, soit celle
de la boîte de dialogue style du para-
graphe, mettez l'alinéa à 7,62 cm (3”).
Maintenant, tapez votre formule de
politesse et appuyez sur Entrée. Au
lieu de taper votre nom, utilisons le
champ Auteur pour insérer votre nom :
Insertion > Champs > Auteur. Cela ne
fonctionnera que si vous avez rempli
les données d'identité dans les options.
Votre lettre est maintenant terminée,
et vous pouvez l'imprimer et l'envoyer.

Le formatage manuel fonctionne
bien pour des petits documents, mais
de plus grands documents nécessitent
davantage de contrôle. Si vous déci-
diez de changer le formatage de quel-
ques paragraphes dans un plus grand
document, le faire paragraphe par para-
graphe deviendrait vite lassant. Dans
un plus grand document nous aurons
besoin de pouvoir changer tous les
paragraphes similaires en une seule fois.
La prochaine fois, je montrerai com-
ment utiliser « Styles et formatage »
pour ce faire.

LIBRE OFFICE - PARTIE 2
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La dernière fois, le sujet était la
modification de la mise en page
des paragraphes pour forma-
ter votre document. Tandis que

cette méthode est bonne pour de
courts documents, elle crée beaucoup
de travail si vous décidez de changer
quelque chose dans un document plus
long. Et c'est là que l'utilisation de
styles rendra les choses plus faciles.

Writer de LibreOffice possède cinq
types de styles différents : paragraphe,
caractère, cadre, page et liste. Vous ac-
cédez à tous les styles en cliquant sur le
bouton Styles et Formatage dans la barre
d'outils de formatage. La fenêtre des
styles et formatage apparaîtra. Vous
pouvez alors ancrer la fenêtre sur la
gauche de la barre d'outils de formatage
en appuyant sur la touche Ctrl tout en
double-cliquant sur l'espace vide dans la
barre d'outils de la fenêtre des Styles et
Formatage.

Sur la barre d'outils de styles (ci-
dessus à droite), il y a sept icônes. Les cinq
premières vous donnent accès aux dif-
férents types de styles. Dans l'ordre, à
partir de la gauche, ils sont paragraphe,
caractère, cadre, page et liste. Dans cet
article, nous allons parler surtout des

stylesparagrapheetcaractère.

Ouvrez un nouveau document texte
et tapez un titre. Ouvrez la fenêtre Styles
et Formatage. L'icône paragraphe devrait
être sélectionnée par défaut. En bas de la
fenêtre Styles et Formatage, il y a une
liste déroulante. Sélectionnez Styles de
chapitre. Double-cliquez sur « Titre princi-
pal ». Votre titre sera maintenant centré,
en gras, et deviendra plus grand. Nous al-
lons maintenant modifier le style par dé-

faut pour les titres. Dans la fenêtre Styles
et Formatage, faites un clic droit sur
«  Titre principal  » et choisissez Modifier…
La boîte de dialogue qui s'affichera alors
ressemble beaucoup à celle du dernier
article, mais il y a quelques onglets nou-
veauxqui ne figurent pas dans la boîte de
dialogue « paragraphe » standard. Le pre-
mier s'intitule Gérer. L'onglet Gérer (ci-
dessous) affiche le nom du style, le « Style
de suite » et « Lié à », le style auquel il est
lié. Vous verrez que le Style de suite est
actuellement « Sous-titre », mais, puisque
nous ne voulons pas utiliser un sous-titre,
on changera pour le style «  Corps de
texte  ». Ainsi, quand on appuiera sur En-
trée pour démarrer un nouveau para-
graphe, celui-ci utilisera le style «  Corps de
texte  ». Le style «  Titre principal  » est lié au
style «  Titre  » . Quand des styles sont liés,
toute modification au style parent aura

un effet sur les styles qui y sont liés. Par
exemple, si vous mettez le texte dans le
«  Titre  » en bleu, le texte de tous les styles
qui ysont liésdeviendra bleu également.

Nous allons maintenant changer le
format de notre titre. Cliquez sur l'onglet
Effets de caractère. Les Effets de carac-
tère (en haut à gauche de la page
suivante) vous permettent de modifier
l'apparence de la police, couleur, barré,
soulignage, ombre et relief. La boîte de
dialogue vous montre l'apparence du
texte de votre titre lorsque vous y appli-
quez des effets. Changez-en la couleur à
bleu, le soulignage à Ondulation double
et la couleurdu soulignage à bleu. Cliquez
surOK.

Appuyez sur Entrée pour démarrer
un nouveau paragraphe. Vous remarque-
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rez que le style est devenu « Corps de
texte », exactement tel que nous l'avons
configuré dans l'onglet Gérer. Tapez
maintenant trois paragraphes de texte
que vous utiliserez comme document
d'exemple.

Ensuite, nous modifierons le style
«  Corps de texte  » et en créerons deux
nouveaux basés sur celui-ci. De retour
dans la fenêtre Styles et Formatage, cli-
quez sur la liste déroulante et sélection-
nez la catégorie Styles de texte. Faites un
clic droit sur«  Corps de texte  », puis sélec-
tionnezModifier. Dans l'ongletRetraits et
Espacement, changez l'interligne à 1 ,5

lignes et la première ligne à 0,50. Vous
constaterez que ces modifications ont
été appliquéesauxtroisparagraphes.

Nous allons maintenant créer un
paragraphe pour les longues citations.
Mettez votre pointeur n'importe où dans
le deuxième paragraphe. Dans la fenêtre
Styles, faites un clic droit sur Corps de
texte et choisissez Nouveau. Dans l'on-
glet Gérer, appelez-le «  Citation longue  ».
Changez Style de suite à «  Corps de
texte  », puisqu'on n'a pas souvent deux
longues citations à la file. Vous remar-
querez que, puisque nous avons créé le
nouveau style en faisant un clic droit sur

Corps de texte, il est lié à «  Corps de
texte  » automatiquement. Si vous voulez
créerun nouveau style qui ne soitpas lié à
un autre, changez le lien à «  Aucun(e)  ».

Maintenant, changeons le formatage
de notre nouveau style. Dans l'onglet Re-
traits et Espacement, changez le «  Avant
le texte  » et «  Après le texte » à 0,50.
Changez le retrait de la «  Première ligne  »
pourqu'il soit à nouveau à 0,00. Dans l'on-
glet Police, changez le style à Italique. Cli-
quez sur OK et vous verrez qu'un
nouveau paragraphe appelé «  Citation
longue  » a été ajouté à votre liste. À nou-
veau, mettez le pointeur n'importe où
dans le deuxième paragraphe et double-
cliquez sur « Citation longue ». Vous ver-
rez alors que le retrait de la première
ligne n'existe plus, que le paragraphe a un
alinéa des deux côtés et que le texte est
en italique. Nous voulons maintenant

changer le premier paragraphe pour qu'il
ait quelques lettrines. Puisque nous vou-
lons que le premier paragraphe de
chaque chapitre ait cette apparence,
nous allons créer un autre style. À nou-
veau, faites un clic droit sur «  Corps de
texte  » et choisissez Nouveau. Appelez le
nouveau style «  Premier paragraphe  » et
réglez le Style de suite à «  Corps de
texte  ». Dans l'onglet Retraits et Espace-
ment, mettez le retrait de la première
ligne à nouveau à 0,00. Dans l'onglet Let-
trines (voir ci-dessous), cochez «  Afficher
des lettrines  », réglez le «  Nombre de ca-
ractères  » à 1 et la « Hauteur (en lignes) »
à 2. Cliquez sur OK. Comme auparavant,
aucune modification n'est encore visible.
Mettez votre pointeur dans le premier
paragraphe et double-cliquez sur votre
nouveau style.

Ce nouveau style de paragraphe de-

LIBRE OFFICE - PARTIE 3
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vra suivre le titre de chaque nouveau cha-
pitre. Modifiez le style du « Titre » pour
que le Style de suite devienne « Premier
paragraphe».

Les styles de caractère ne s'ap-
pliquent qu'au texte sélectionné et non
pas à des paragraphes entiers. Sélection-
nez une partie du texte du troisième
paragraphe. Dans la fenêtre Styles et For-
matage, cliquez sur l'icône Styles de ca-
ractère et double-cliquez sur «  Accen-

tuation ». Ainsi, le texte sélectionné
passera en italique. En règle générale,
il est possible de modifier les styles
de caractère de la même façon que
les styles de paragraphe.

L'avantage principal des styles est
que le formatage d'un même type de
texte reste identique tout au long du do-
cument. Dans le prochain article, nous
parlerons de l'ajout de cadres au docu-
ment.

ElmerPerry, dont les passe-temps incluent
le Web design, la programmation et l'écri-
ture, est pasteur pour les enfants à Ashe-
ville en Caroline du Nord
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D ans le dernier article, nous
avons utilisé les styles de
paragraphe pour formater
notre document en créant

des styles réutilisables qui rendent le
document homogène. Dans cet article-
ci, nous allons créer une mise en page
plus avancée en se servant de cadres.
Alors qu'il existe d'autres programmes,
tel Scribus, créés plus particulière-
ment pour faire de la mise en pages
avancée, LibreOffice nous propose
plusieurs outils qui nous permettent
de produire des documents avec une
mise en pages plus complexe que
celle d'une simple lettre. Un de ces
outils le plus utile est le cadre.

Vous pouvez imaginer les cadres
comme des boîtes qui servent à contrô-
ler le flot du texte, des graphiques et
d'autres éléments du document. Une
des fonctions clés des cadres est leur
capacité de se lier l'un à l'autre. Quand
deux cadres sont liés, le texte dans
l'un coule automatiquement dans l'autre,
même si les deux cadres se trouvent
sur des pages différentes. Cette fonc-
tion rend les cadres idéaux pour les
bulletins d'information et d'autres docu-
ments à base d'articles.

Nous allons créer la mise en pages
du premier article (voir ci-dessous) en
se servant de cadres pour contrôler le

flux du texte de l'article. Commencez
par créer un nouveau document. Main-
tenant, dans les menus allez à Inser-
tion > Cadre. Le dialogue Cadre s'affi-
chera. Sous l'onglet « Type », cochez
Relatif pour la largeur et pour la
hauteur. Régler la largeur à 1 00 % et
la hauteur à 25 %. Dans la section
Position, réglez l'horizontale à gauche
à 0.00 cm pour Zone de paragraphe.
Réglez la position verticale en haut à
0.00 cm pourMarge.

Sous l'onglet Options, nommez le
cadre « En-tête d'article ». Les cadres
sont nommés automatiquement sous
format « Cadre# », où # est le nombre
de cadres dans le document. Il est
toutefois souhaitable de donner un
nom significatif à vos cadres pour que
vous puissiez vous souvenir de leur
fonction.

Par défaut, les cadres ont une
bordure sur les quatre côtés, mais
nous voulons une bordure unique-
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ment en bas de notre cadre. Sous
l'onglet Bordures, sélectionnez le
premier carré sous « Disposition des
lignes » par défaut. Cela annulera
toutes les bordures. Cliquez en bas de
la boîte « Défini par l'utilisateur »
pour créer une bordure en bas de
votre cadre.

Nous avons maintenant terminé
avec le paramétrage de ce cadre-ci.
Nous y reviendrons lorsque nous
serons prêts à lier nos cadres. Pour le
moment, cliquez sur OK. Vous verrez
le nouveau cadre dans le document.

Nous allons maintenant créer un
cadre pour le bas de l'article. Cliquez
en dessous du cadre d'En-tête. À

nouveau, dans les menus, choisissez
Insertion > Cadre. Nous voulons à
nouveau une largeur et une hauteur
«  Relatif ». Réglez la largeur à 1 00 %
et la hauteur à 75 %. Réglez la posi-
tion horizontale à gauche à 0,00  cm
pour Zone de paragraphe. Sous l'on-
glet Options, nommez le cadre «  Corps
d'article ». Sous l'onglet Bordures,
cliquez sur « Ne définir aucune bor-
dure ».

Nous voulons que le corps de
l'article ait deux colonnes. Cela se fait
sous l'onglet Colonnes. Modifiez le
nombre de colonnes en 2 et réglez
l'espacement à 6 %. Cliquez sur OK et
le nouveau cadre s'affiche. Vous
aurez peut-être besoin d'ajuster la
position des cadres pour qu'ils s'ali-
gnent correctement. Vous ajustez la
position des cadres en cliquant sur la
bordure des cadres. Vous verrez alors
des poignées vertes sur la bordure.
Celles-ci servent à ajuster la taille du
cadre. En principe, nous n'aurons pas
besoin d'en changer la taille - uni-
quement d'en ajuster la position.
Pour ajuster la position des cadres,
cliquez et tirez sur la bordure là où il

n'y a pas de poignées vertes. Pour des
ajustements plus précis de la position
du cadre, utilisez les touches
Alt+Flèches.

Les cadres sont maintenant là où
nous les voulons. Avant de com-
mencer à écrire l'article, nous devons
lier les deux cadres. Double-cliquez
sur la bordure du cadre En-tête (le
premier cadre que nous avons créé).
Le dialogue Cadre s'affichera. Sous
l'onglet Options, cliquez sur la flèche
à côté de Lien suivant et choisissez
«  Corps d'Article ». Les deux cadres
sont maintenant liés. Cliquez sur OK
pour accepter cette modification et
retournez au document.

Dans le document, cliquez à l'in-
térieur du cadre En-tête. Formatez un
titre et le nom du journaliste en uti-
lisant n'importe laquelle des méthodes
présentées dans les articles précé-
dents. Maintenant, commencez à taper
les paragraphes du document. Vous
remarquerez que, quand vous arrive-
rez en bas du premier cadre, Writer
vous mettra automatiquement dans
le cadre du bas et, quand vous
atteindrez le bas de la première

LIBRE OFFICE - PARTIE 4
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colonne, Writer vous amènera auto-
matiquement en haut de la deuxième.
Si votre article fait plus d'une page,
vous pouvez lier le cadre « Corps
d'Article » à un cadre sur une autre
page. Créer ces liens est une façon
puissante de maîtriser la mise en
pages et la continuité d'un article
pour créer un document dont l’appa-
rence est très professionnelle.

Ajoutons une image à notre cadre
En-tête : Insertion > Image > À partir
d'un fichier. Choisissez l'image que
vous voudriez insérer et cliquez sur
Ouvrir. Si l'image est trop grande pour
votre document, il faudra la redimen-
sionner. Pour éviter de la déformer,
appuyez sur la touche MAJ pendant
que vous tirez les poignées. Pour
mettre l'image dans le cadre, tirez-la
jusqu'au coin en bas et à droite du

cadre, faites un clic droit et choisissez
Ancrer > Au cadre. Double-cliquez sur
l'image pour que le dialogue de ses
propriétés s'affiche. Sous l'onglet
Adaptation du texte, augmentez l'espa-
cement à gauche pour créer une zone
blanche autour de l'image.

Dans LibreOffice, les images sont
en fait des cadres. Quand vous double-
cliquez sur une image dans un docu-
ment, un dialogue de cadre s'affi-
chera avec deux nouveaux onglets :
Image et Rogner. Sous l'onglet Image,
vous pouvez refléter l'image vertica-
lement ou horizontalement. Vous pou-
vez préciser si l'image est reflétée sur
certaines pages ou sur toutes les pages.
Sous l'onglet Rogner, vous pouvez
ajuster à gauche, à droite, en haut et
en bas pour découper certaines par-
ties de l'image. Ceci est utile quand

vous n'avez besoin que d'une partie
de l'image ou que vous voulez forcer
l'image à avoir une taille précise sans
déformer le rapport de l'aspect de
l'image. En outre, vous pouvez mettre
l'image à l'échelle d'une certaine taille
basée sur un pourcentage de sa taille
d'origine. Vous pouvez également vi-
sionner ou changer la taille de l'image
au moyen d'unités de mesure.

En faisant un clic droit sur l'image,
vous pouvez rajouter une description
ou une légende à l'image. Le fait
d'ajouter une légende crée un cadre
de texte autour de l'image avec le
texte en dessous de celle-ci. Cette
fonction est utile pour le marquage
d'illustrations ou de diagrammes dans
votre document. Une fois la légende
créée, vous pouvez la mettre en sur-
brillance et la formater comme toute
autre partie texte du document.

Vous avez maintenant, je l'espère,
une idée de la puissance des cadres.
Notre exemple, il est vrai, était assez
simple, mais vous pourriez très faci-
lement créer la mise en pages d'un
document plus complexe en vous ser-
vant des cadres. Puisque vous pouvez
lier les cadres, vous pouvez créer la
mise en pages d'un bulletin d'infor-
mation où les articles débutent sur
une page, sautent à une autre et se
terminent sur une autre encore.

La prochaine fois, nous allons exa-
miner une autre fonction puissante
de mise en pages disponible dans
Writer de LibreOffice : les sections.

Elmer Perry est éducateur à Asheville,
en Caroline du Nord. Ses passe-temps
comprennent la conception Web, la
programmation et l'écriture.
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D ans la partie précédente
de cette série, nous avons
parlé de l'usage de cadres
dans la mise en pages d'un

document. Dans cette partie, nous
allons regarder un autre outil utile de
mise en pages dans LibreOffice Wri-
ter : les sections. Les sections se
distinguent des cadres par plusieurs
aspects, mais, à certains égards, elles
peuvent avoir les mêmes résultats.
Alors que les deux vous permettent
de diviser une partie de votre docu-
ment en colonnes, quand vous vous
servez des sections, vous n'en con-
trôlez pas la largeur. Les sections occu-
peront toute la largeur, de la marge
de gauche jusqu'à la marge de droite.
En outre, les sections ne peuvent pas
se terminer en plein milieu d'un para-
graphe. Vous ne pouvez pas lier des
sections comme vous pouvez faire
pour les cadres. S'il est vrai que vous
ne pouvez pas lier des sections entre
elles, elles vous donnent la capacité
d'établir des liens vers d'autres
documents ou vers une section dans
un autre document.

Peut-être que la meilleure façon
de concevoir les sections serait de les
considérer comme un moyen de divi-

ser votre document en différents mor-
ceaux, comme l'introduction, l'argu-
ment 1 , l'argument 2, etc. Les sec-
tions peuvent aussi vous permettre
de séparer une partie d'un document
afin de l'utiliser dans un autre docu-
ment. Les sections peuvent être un
outil puissant qui vous permet de récu-
pérer du contenu d'autres documents.

L'utilisation des sections

Nous allons utiliser comme exem-
ple l'importation de citations depuis
un document de citations. Démarrer
un nouveau document et y ajouter
une liste de citations diverses. En-
suite, pour chacune des citations :

Sélectionner la citation entière.

Dans la barre d'outils, allez à In-
sérer > Section…

Attribuer un nom parlant à la cita-
tion (pour exemple, l'une de mes
citations est de Albert Einstein au
sujet de la science ; je l'ai nommée
citation_science).

Une fois que vous aurez fait de
chaque citation une section, enregis-
trez le fichier sous le nom de
citations.odt.

Puis, créons un nouveau document
et ajoutons un paragraphe ou deux

de texte (astuce : vous pouvez ajouter
du texte factice à votre document en
tapant « TEX » et en appuyant sur la
touche F3). Écrivez une présentation
de votre citation et appuyez sur
Entrée. Pour récupérer la citation du
document des citations, Insérer >
Section… Comme toujours, donnez à
la section un nom parlant. Cochez
Lier, puis cliquez sur le bouton
parcourir (…) à côté de Nom de
fichier. Choisissez le document qui
contient vos citations, puis Ouvrir.
Utilisez le menu déroulant des Sec-
tions pour choisir la citation que vous
voulez insérer dans votre document.
Si vous voulez protéger votre citation,
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cochez Protéger sous Protection
contre les modifications. Vous pouvez
également protéger la section contre
les modifications avec un mot de
passe (N.B. : la protection contre la
modification, même avec un mot de
passe, ne veut pas dire qu'un hacker
mal intentionné ne puisse pas accé-
der à votre document pour en chan-
ger le contenu). Vous pouvez rajouter
les autres citations du document de
citations de la même façon.

Éditer les sections

Maintenant que les citations sont
présentes, rendons-les visibles du
premier coup d'œil avec un alinéa et
une couleur d'arrière-plan. Format >
Sections. Le dialogue Éditer les sec-
tions vous présente une liste des
sections dans votre document. Sélec-
tionnez celle que vous voulez éditer.
Dans la fenêtre principale du dia-
logue, nous pouvons changer le docu-

ment (ou la section de document)
auquel la section est liée. Ici, nous
pouvons également changer la Pro-
tection contre modifications et choisir
de Masquer la section ou non (je ne
vois aucune raison pratique pour
laquelle vous masqueriez une partie
du document, mais vous en avez la
possibilité en cas de besoin).

Cliquez sur le bouton Options…
pour afficher le dialogue des options.
Sous l'onglet Retraits changez Avant
la section et Après la section pour
indiquer 1 ,00 cm. Sous l'onglet Ar-
rière-plan, choisissez une couleur
d'arrière-plan pour cette citation. Cli-
quez sur OK. Éditer les autres
sections de citation et puis cliquer sur
OK dans le dialogue Éditer les sections.
Maintenant, vos citations ont un
alinéa et une couleur d'arrière-plan.

Modifications faites
dans le document lié

Si vous avez besoin de changer
l'information dans une section liée à
un autre document, vous pourriez

vous demander si ce serait mieux de
modifier le document original ou le
nouveau document. Les deux sont
possibles. C'est vraiment à vous de

voir. La seule chose dont il faut vous
souvenir c'est que les modifications
faites à une section liée dans un
document n'apparaîtront pas dans le
document original, mais que les modi-
fications du document original peu-
vent éventuellement paraître dans le
document lié.

Vous pouvez contrôler les
actualisations dans les options de
LibreOffice Writer : Outils > Options >
LibreOffice Writer > Général. Dans la
rubrique Actualiser, vous pouvez
choisir d'Actualiser les liens lors du
chargement Toujours, Sur demande
ou Jamais. Toujours mettra à jour les
liens quand vous ouvrirez un docu-
ment contenant des liens. Sur de-
mande vous demandera si vous vou-
lez mettre les liens à jour. Jamais
n'actualisera jamais les liens quand un

LIBREOFFICE - PARTIE 5
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document contenant des liens est
ouvert.

L'actualisation
manuelle de liens

Si vous modifiez le document ori-
ginal et voulez actualiser le document
lié pour que ces modifications y
apparaissent, vous avez deux façons
de mettre le document lié à jour.
Éditions > Liens… affichera le dia-
logue Éditer les liens. C'est ici que
vous pourrez sélectionner un lien
spécifique et le mettre à jour. Pour
actualiser tous les liens en une seule
fois, utilisez Outils > Actualiser > Liens.

Cadres ou sections ?
Parfois, que vous utilisiez des

cadres ou des sections importe peu. Il
y a des cas où l'un ou l'autre peuvent
faire ce dont vous avez besoin. Cela
dit, prendre le temps de réfléchir à la
fonctionnalité de chacun peut vous
aider à faire le meilleur choix. Par
exemple, si vous écrivez un mémoire
de maîtrise et vous avez créé un
document Writer contenant toutes
vos citations et données, des sections
seraient sans doute le meilleur choix
pour vous permettre d'insérer des
données dans votre mémoire. Si,
cependant, vous avez besoin de

débuter un article sur une page,
sauter une page, puis le terminer sur
une autre page, des cadres liés sont
un meilleur choix. Prendre du temps
pour réfléchir à l'objectif, la mise en
page et les sources du contenu de
votre document, ainsi qu'aux fonc-
tionnalités des cadres et des sections,
vous aidera à décider lequel sera le
meilleur outil pour votre document.

Bien que les cadres et les sections
soient souvent similaires, ils ont des
fonctionnalités différentes et conviennent
donc à des objectifs différents. La
puissante capacité de créer des liens
vers des parties d'un autre document
rend les sections uniques. Souvenez-
vous : il faut planifier votre mise en
page et décider en amont des outils
dont vous vous servirez pour accom-
plir votre tâche.

Dans le prochain article, nous exa-
minerons les styles de page, les en-
têtes et les pieds de page dans les
documentsWriter.

Below Zero est un spécialiste d'hébergem ent de serveurs en im plan-
tat ion de proxim ité au Royaum e-Uni.

Cont rairem ent à d'aut res, nous ne four-
nissons que l'espace rack et la bande
passante. Cela rend not re service plus
fiable, plus flexible, plus concent ré et
plus com pét it if quant au prix. Nous
nous spécialisons uniquem ent dans
l'hébergem ent de serveurs et de leurs
systèm es près de chez nous, au sein des Cent res de données
écossais.

Au cœur de l'infrastructure de nos réseaux
est le routage BGP4, à la pointe de la
technologie, qui fournit une livraison
opt im ale des données et aussi un
procédé autom at ique en cas de panne
faisant appel à nos m ult iples fournis-
seurs remarquables. Les clients peuvent être certains que la bande
passante proposée est de qualité maximale ; notre polit ique est de payer
plus pour les meilleurs fournissseurs et, parce que nous achetons en
gros, nos prix extrêmement compétit ifs ne sont pas impactés.

Chez Below Zero, nous vous aidons à at teindre Zéro tem ps d'arrêt .
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Elmer Perry dont les passe-temps
incluent le Web design, la program-
mation et l'écriture, est pasteur pour les
enfants à Asheville en Caroline du Nord.
Son site Web est :
eeperry.wordpress.com

Zéro temps d ' a rrêt

www. ze ro d own t i m e . c o . u k

http://eeperry.wordpress.com
http://www.zerodowntime.co.uk
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C
e mois-ci, nous allons découvrir
quelques méthodes nouvelles
pour formater nos documents
en utilisant les styles de page,

les entêtes et les pieds de page. Dans
des articles précédents, j'ai expliqué
l'utilisation des styles de paragraphe et
de caractères. Les styles de page sont
similaires, mais traitent de la géométrie
de l'ensemble et du formatage de la
page entière. Quant aux entêtes et aux
pieds de page, il s'agit des zones en haut
et en bas de la page. Ils sont habi-
tuellement identiques sur chaque page
du même style.

Pour commencer, nous allons con-
figurer nos document et styles. Dé-
marrer un nouveau document texte,
Fichier > Nouveau. Pour pouvoir accéder
au titre du document, nous allons chan-
ger certaines des propriétés du docu-
ment, Fichier > Propriétés. Sous l'onglet

Description, mettre comme titre du
document « Ceci est le titre ». Nous allons
nous en servir plus tard quand nous
commencerons à créer nos en-têtes et
nos pieds de page. Cliquez sur OK pour
sauvegarder vos changements.

Maintenant, nous devons configurer
nos styles de page. Nous allons en uti-
liser trois : Première page, Standard et
Paysage. Première page et Paysage
existent déjà, mais nous allons les modi-
fier. D'abord, nous créerons notre style
Standard. Pour ce style Standard, nous
voulons une zone d'en-tête en haut, dont
l'arrière-plan soit en gris clair. Ouvrez le
dialogue Styles et formatage, Outils >
Styles et formatage ou cliquez
sur le bouton Styles et formatage
(à droite). Cliquez sur le bouton
styles de page (à droite), faites un clic
droit dans la fenêtre et
sélectionner Nouveau… Le dia-
logue de Style de page s'affiche.
Sous l'onglet Gérer, nommez le style
«  Standard  ». Changer le Style de suite en
Standard. Cela signifie à Writer que,
quand nous aurons atteint le bas de la
page, il devra créer une nouvelle page
avec le même style. Sous l'onglet En-tête,
cochez Activer l'en-tête, ce qui insérera
une zone d'en-tête dans la page. Tou-

jours sous l'onglet En-tête, cliquez sur le
bouton Plus…. Une nouvelle fenêtre de
dialogue s'affichera ; c'est là que nous
pourrons ajouter une bordure et une
couleur d'arrière-plan à notre en-tête.
Sous l'onglet Arrière-plan, choisissez la
couleur gris clair pour l'arrière-plan. Cli-
quez sur OK dans les deux fenêtres de
dialogue et nous avons terminé avec le
style de notre page Standard.

Pour la Première page, nous allons en
modifier une qui existe déjà. Nous vou-
lons une marge du haut de 3” (7,5 cm) -
pour les graphismes de la première page
rajoutés à un autre moment - et une zone
de pied de page en gris clair en bas.
Faites un clic droit sur le style Première
page dans le dialogue des Styles et
formatage et sélectionnez Modifier…
Sous l'onglet Gérer, choisissez Standard
comme Style de suite. L'onglet page nous
permet de changer les marges pour la
page. Réglez la marge du haut à 3” (7,5
cm). Cette fois-ci nous allons aussi à

l'onglet Pied de page où vous cocherez
Activer le pied de page. Cliquez ensuite

sur le bouton Plus… et choisissez la
couleur gris clair pour l'arrière-plan.

Pour régler le style de notre page
Paysage, nous modifierons celui qui
existe déjà. Pour le style Paysage, nous
ajouterons un En-tête et un Pied de
page. Faites un clic droit sur le style
Paysage, puis cliquez sur modifier… Pre-
nez le temps de regarder sous l'onglet
Page et remarquez que l'orientation de
la page est bien paysage - exactement ce
que nous voulions. Activez l'En-tête et le
Pied de page sous leur onglet respectif
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et sélectionnez gris clair comme couleur
d'arrière-plan pour les deux.

Nous sommes maintenant prêts à
créer notre document. Double-cliquez sur
le style Première page et le formatage
de la page de votre document deviendra
le formatage que nous avons ajouté.
Vous remarquerez la zone gris clair du
pied de page en bas. Cliquez à l'intérieur
de cette zone pour modifier le pied de
page. Mais d'abord nous allons y ajouter
le titre, Insertion > Champs > Titre. Le
titre que nous avons mis dans les
propriétés du document y sera inséré.
Vous pouvez utiliser cette méthode pour
insérer le titre du document partout où
vous en avez besoin. Si, par la suite, vous
changez votre titre dans les propriétés
du document, vous pouvez mettre à jour
toutes les instances du champ inséré
avec Outils > Actualiser > Champs ou en
appuyant sur la touche F9 de votre
clavier. Tapez « Page » en vous assurant
de mettre une espace de chaque côté du
mot Page et insérer le numéro de page,
Insertion > Champs > Numéro de page.
Positionnez le curseur au début du mot

Page et appuyez sur la touche Tab de
votre clavier jusqu'à ce que le numéro de
page se trouve contre le côté droit de la
zone du pied de page. Cliquez en dehors
de la zone du pied de page pour vous
retrouver dans le corps de la page.

Une fois que vous aurez fait tout cela,
vous pourrez commencer à taper votre
texte. Une fois que vous aurez atteint le
bas de la page et qu'une nouvelle page
apparaîtra, vous remarquerez qu'elle est
formatée en style Standard avec une
zone d'en-tête en haut. Renseignez l'en-
tête exactement comme nous avons fait
pour le pied de page de la première
page. Assurez-vous d'utiliser les champs,
surtout pour le numéro de page. Le
champ de numéro de page sera utile
quand nous atteindrons la troisième
page. Vous remarquerez alors que les
informations dans l'en-tête ont été
copiées pour vous et que le numéro de
page a été mis à jour afin de cor-
respondre à la page actuelle.

Ensuite, nous allons insérer une page
Paysage. Avant d'arriver à une nouvelle

page, Insertion > Saut manuel. Sélec-
tionnez Saut de page, et sous Style
sélectionnez Paysage. Cela vous mènera
à une nouvelle page avec le style
Paysage. Comme c'est un style différent
de notre style Standard, nous aurons
besoin de remplir les informations d'en-
tête et de pied de page. Ceci est pratique
si vous voulez un en-tête ou un pied de
page différent sur certaines pages, il
suffit d'insérer une page avec un style de
page différent. Lorsque vous avez ter-
miné votre page Paysage, créez un autre
saut de page (Insertion > Saut manuel)
avec un style Standard. Vous remar-
querez que la numérotation des pages
continue, en comptant la ou les pages

Paysage insérées. Si vous ne voulez pas
que les pages Paysage insérées soient
comptées dans le nombre de pages, vous
pouvez ajuster manuellement le numéro
de page dans la boîte de dialogue Saut
manuel.

Writer rend facile l'ajout de pages
avec un style et une orientation dif-
férents, aussi bien que les en-têtes et les
pieds de page automatiques. Vous pou-
vez faire les en-têtes et les pieds de page
aussi grands que vous voulez et ils
peuvent contenir toute l'information que
vous voulez y mettre. Les champs aident
à assurer la cohérence de certaines infor-
mations dans votre document et vous
permettent d'écrire sans vous soucier
des numéros de page.

Dans le prochain article, je quitterai
Writer pour vous montrer comment faire
la base de données du pauvre en utilisant
un classeur Calc. Après cela, nous utili-
serons le classeur pour créer une lettre-
type.

“
Writer rend facile l'ajout
de pages avec un style et
une orientation différents,
aussi bien que les en-
têtes et les pieds de
page automatiques.

Elmer Perry dont les passe-temps incluent
le Web design, la programmation et
l'écriture, est pasteur pour les enfants à
Asheville en Caroline du Nord. Son site
Web est eeperry.wordpress.com

http://eeperry.wordpress.com
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J usqu'à maintenant, nous tra-
vaillions avec LibreOffice Wri-
ter, mais aujourd'hui nous
allons nous en éloigner pen-

dant une seconde pour faire quelque
chose d'un peu différent. Nous allons
créer une base de données primitive
[Ndt : celle d'un pauvre, un « poorman  »]
dans Calc pour ensuite retourner dans
Writer pour créer un mailing (ou pu-
blipostage). Vous acquerrez ainsi des
notions sur l'utilisation d'un Classeur
comme base de données. Pour faire
un mailing, il faut travailler avec une
base de données quelconque. On pour-
rait créer la nôtre dans Base, mais
pour un carnet d'adresses simple, l'uti-
lisation de Calc est nettement plus
facile.

Pour commencer, nous ouvrons Li-
breOffice et cliquons sur Feuille de
calcul. Ainsi un classeur vierge de Calc
s'affichera. Je ne vais pas vous don-
ner beaucoup de détails sur la mise

en page de Calc ; ce sera pour une
autre fois. Vous devez quand même
savoir qu'un classeur est composé d'une
série de colonnes et de lignes. Les
colonnes sont étiquetées en haut avec
des lettres (A, B, C,…) et, à gauche, les
lignes sont étiquetées avec des
chiffres (1 , 2, 3,…). Quand nous uti-
lisons Calc comme base de données,
la première ligne doit contenir les
titres des champs pour la base de don-
nées. Ce sont les en-têtes de champs
de la base de données. Nous met-
trons les en-têtes de champs suivants
sur la première ligne : Titre, Prénom,
Nom, Adresse (rue et numéro), Ville,
Code postal et Pays. Chaque champ
doit être placé dans une colonne dis-
tincte, en commençant par la colonne
A ; ainsi, mettez le curseur dans la
colonne A de la première ligne et
tapez Titre. Pour aller dans la colonne
suivante, vous pouvez utiliser la tou-
che flèche droite du clavier, puis vous
pouvez remplir les autres champs.
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Sur la deuxième ligne, nous commen-
çons à taper nos données. Chaque ligne
estun dossierqui contient tous les rensei-
gnements concernant une personne - du
moins c'est comme ça que je la conçois.
Pour aujourd'hui, inutile de trop vous
inquiéter si les données sont plus
larges que les colonnes. Si vous voulez
ajuster la largeur des colonnes pendant
que vous entrez les renseignements, il suf-
fit de placer la souris au-dessus d'une
ligne séparant deux colonnes. Le curseur
deviendra une flèche double et vous pour-
rez cliquer sur la ligne et la déplacer pour
augmenterou diminuer la largeurde la co-
lonne. Une fois toutes les données saisies,
il faut enregistrer le classeur. J'ai sauvegar-
dé le mien comme Primitive_db.ods.
Une fois cela fait, fermez-le.

Avant de pouvoir utiliser notre base
de données primitive, nous avons besoin
de la référencer dans LibreOffice. Fichier
> Nouveau > Base de données affichera
l'assistant Bases de données [Ndt : Si vous
n'avez pas encore le module Base de don-
nées de LibreOffice, il est disponible dans
la Logithèque Ubuntu ou par l'inter-
médiaire de votre gestionnaire de pa-
quets habituel.]. Choisissez « Connecter
à une base de données existante » et,
dans le menu déroulant, sélectionnez
Classeur. Cliquez sur Suivant. Utilisez le
bouton Parcourir pour sélectionner
votre feuille de calculs. Cliquez sur le

bouton Suivant. Assurez-vous que vous
avez sélectionné « Oui, je souhaite que
l'assistant référence la base de données »
et décochez « Ouvrir la base de données
pour édition ». Cliquez sur Terminer et
nommez la base de données (J'ai appelé
la mienne Adresses). La base de don-
nées que vous venez de créer est liée au
classeur. Chaque fois que vous mettrez à
jour le classeur, la mise à jour paraîtra
dans la base de données. Le seul hic c'est
que vous ne pouvez pas modifier le
classeur si Writer est ouvert. En fait, une
base de données de type classeur doit
être le seul document de LibreOffice ou-
vert, car, autrement, LibreOffice ouvrira
le classeurenmode lecture seule.

Maintenant que notre base de don-
nées est créée et référencée dans LibreOf-
fice, nous pouvons nous en servir pour
créer un mailing. Un mailing est vraiment
intéressant pour expédier des courriers
types à des clients ou des prospects. Le
truc génial c'est que vous pouvez
mettre toutes sortes de données dans
votre base de données et les utiliser
dans la lettre. Par exemple, si vous avez
un programme de récompenses pour
vos clients, vous pourrez avoir un
champ pour les points ; comme cela,
vous pourriez mettre le nombre de

points gagnés par chaque
client dans la lettre, mais
vous n'auriez besoin de la
taperqu'une seule fois.

Cliquez sur l'icône des Sources de don-
nées, Affichage > Sources de données ou
appuyez sur F4. Ainsi les bases de don-
nées référencées s'afficheront en dessous
de la barre du formatage. À gauche,
vous trouverez Adresses (ou ce que vous
avez nommé votre base de données) >
Tables > Feuille1 . Côté droit vous verrez
maintenant vos données mises en page
comme les entrées dans le classeur.
Nous insérons les champs dans le docu-
ment en cliquant sur l'en-tête du champ
et en le glissant dans le document. Un
caractère générique pour chaque champ

que vous glissez dans le document sera
créé. Assurez-vous de glisser l'en-tête du
champ et non pas des données d'un
dossier.

Vous pouvez maintenant taper votre
lettre. Chaque fois que vous aurez besoin
d'un champ de la base de données, vous
pouvez le glisser dans le document. Les
champs de la base de données peuvent
être utilisés à n'importe quel emplace-
ment. Je me répète : votre base de
données peut contenir toutes sortes de
renseignements dont vous aurez besoin.
Un enseignant pourrait même l'utiliser
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pour inclure les notes d'un élève dans
une lettrepoursesparents.

Une fois la lettre terminée, vous pou-
vez choisir une sortie imprimante ou une
sortie fichier. Vous pourriez vouloir choisir
cette dernière quand vous aurez besoin
d'y revenir pour ajouter des informations
personnelles pour certains individus. Par
exemple, un enseignant voudrait peut-
être demander un entretien avec les
parents d'un élève qui sera vraisembla-
blement recalé. Fichier > Imprimer, comme
pour un document ordinaire. Toutefois,
LibreOffice vous avertira que le document
contient des champs de base de données
d'adresses et vous demandera si vous
voulez imprimer une lettre type. Répon-
dez oui et la boîte de dialogue du mailing
s'affichera. C'est ici que vous pouvez choi-
sir d'imprimer vers une imprimante ou
vers un fichier. Vous avez également la

possibilité de n'imprimer la lettre que pour
des dossiers choisis ou pour une plage de
dossiers. Vous sélectionnez les dossiers
en cliquant sur la boîte grise à son début,
ou utilisez CTRL-clic pour ne sélectionner
que quelques dossiers précis ou MAJ-clic
pour sélectionner une suite de dossiers.
Quand vous imprimez vers un fichier,
vous pouvez choisir d'imprimer vers un
seul fichier et, dans ce cas, chaque lettre
commencera sur une nouvelle page, ou
vous pouvez le sauvegarder comme des
fichiers individuels et, dans ce cas-ci,
chaque lettre devrait avoir son propre
fichier. Vous pouvez choisir de générerun
nom de fichier à partir de la base de
données et le champ qui servira de nom.
Avecma version de LibreOffice (3.3.3), j'ai
eu un seul document quel que soit mon
choix. Apparemment, ils travaillent encore
surcette fonctionnalité.

Vous pouvez aussi utiliser votre base

de données pour générer des étiquettes.
Fichier > Nouveau > Étiquettes affichera
la boîte de dialogue Étiquettes. Choisis-
sez votre base de données et votre table.
Glissez les champs dans la boîte d'Ins-
cription. Sélectionnez le type d'étiquette
et cliquez sur le bouton Nouveau docu-
ment. Comme c'est le cas pour les lettres
types, quand vous serez prêt à imprimer,
vous aurez la possibilité de sélectionner
les dossiers que vous voulez et vous
pourrez imprimer vers une imprimante
ou vers un document. Vous pouvez aussi
créer des enveloppes avec à peu près la
mêmeméthode.

Il y a une autre façon de créer une
lettre type, en se servant de Outils >
AssistantMailing. L'assistant a pas mal de
contraintes et quand j'ai essayé de
l'utiliser, j'ai trouvé que c'étaitmoins facile
d'obtenir de bons résultats. Pour moi, la

méthode manuelle décrite ici a donné de
meilleurs résultats tout en laissant au
créateurplusde contrôle sur les sorties.

Le mailing peut vous faire gagner
beaucoup de temps. Tapez votre lettre,
vite fait bien fait, rajoutez des champs de
base de données et imprimez. C'est bien
mieux que de taper des centaines de
lettres ou de modifier chacune d'entre
elles pour changer quelques rensei-
gnements. Dans le prochain article, nous
commencerons à apprendre davantage
sur Calc en créant un classeur simple de
budget.

Elmer Perry dont les passe-temps incluent
le Web design, la programmation et
l'écriture, est pasteur pour les enfants à
Asheville en Caroline du Nord. Son site
Web est eeperry.wordpress.com

http://eeperry.wordpress.com
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C
alc est le module tableur ou
feuille de calcul de LibreOf-
fice ; il est compatible avec
Excel de Microsoft. Nous avons

déjà vu une façon d'utiliser Calc quand,
dans mon dernier article, nous avons
créé notre base de données primitive,
mais Calc peut faire beaucoup plus
que la collecte de données. Comme
son nom l'indique, Calc peut faire des
calculs avec de très nombreuses
fonctions intégrées au pro-
gramme. Cela veut dire que nous
ne sommes pas obligés de cal-
culer la somme des entrées dans
une colonne à la main ; nous
pouvons insérer une formule qui
fera l'addition à notre place. Calc
vous permet de créer un scé-
nario « Et si… » et jouer avec les
chiffres dans votre classeur.

Avant de commencer la cons-
truction de notre classeur Budget,
vous avez besoin de connaître cer-
taines choses sur comment un fichier,
parfois appelé un classeur dans Calc,
fonctionne. Chaque fichier peut conte-
nir plusieurs feuilles de calcul diffé-
rentes. Dans un nouveau classeur,
vous avez par défaut trois feuilles de
calcul, appelées Feuille1 , Feuille2 et

Feuille3. Leur nom figure sur des
onglets en bas de la fenêtre. Chaque
feuille est composée de cellules indi-
viduelles, identifiées par la lettre de
leur colonne et le numéro de leur
ligne. Par exemple, la première cellule
en haut et à gauche est A1 , la pre-
mière colonne, la première ligne.
Chaque feuille peut avoir jusqu'à
1   024 colonnes et 1   048  576 lignes.

La disposition d'une fenêtre Calc
est quelque peu différente de celle
d'une fenêtre Writer. Il y a toujours
une barre standard et une barre de
formatage, mais en dessous de celle-

ci, vous verrez la barre de formule.
Cette barre est votre amie quand
vous travaillez dans Calc. La case tout
à fait à gauche indique le nom de la
cellule actuelle. Elle vous dit quelle
cellule, ou groupe de cellules, est
sélectionné à un moment donné. Les
trois icônes immédiatement à droite
de cette case sont l'assistant fonc-
tions, le bouton somme et le bouton

fonction. Encore à droite, vous
verrez la ligne de saisie que vous
devez utiliser pour modifier le
contenu d'une cellule.

En haut de la feuille, vous
avez les en-têtes de colonne (A,
B, C…) et, le long du côté
gauche, les en-têtes de ligne (1 ,
2, 3…). Les colonnes et les
lignes sont matérialisées sur la
feuille par des lignes gris clair.
Cette grille sera utile lors de la
conception de votre feuille de
calcul.

Il y a plusieurs façons de saisir des
données dans une cellule. Vous pou-
vez cliquer dessus et commencer à
taper. Quand vous avez terminé, ap-
puyez sur Entrée et vous vous retrou-
verez dans la cellule en dessous. Vous

pouvez aussi cliquer sur une cellule et
entrer les données dans la ligne de
saisie de la barre de formule. Cette
méthode a un inconvénient que j'ex-
pliquerai dans une minute, mais, par-
fois, c'est la meilleure façon de modi-
fier le contenu d'une cellule. Vous
pouvez aussi l'éditer dans la cellule,
en double-cliquant dessus, ce qui vous
met en mode édition. Modifier une
cellule dans ce mode est similaire à
son édition dans la barre de formule.

La navigation à l'intérieur de votre
feuille peut se faire à la souris : il suffit
de cliquer sur la cellule que vous sou-
haitez. Cependant, puisque vos doigts
sont souvent déjà sur le clavier, les
raccourcis clavier fonctionnent mieux.
La touche de tabulation (Tab) vous
met dans la cellule immédiatement à
droite de celle où vous vous trouviez.
Maj+Tab vous met dans la cellule
immédiatement à gauche. Appuyez
sur Entrée et vous serez dans la
cellule en dessous de celle où vous
étiez et, avec Maj+Entrée, vous serez
au-dessus. Si vous n'êtes pas en mode
édition, ni en train d'utiliser la ligne de
saisie, les touches fléchées vous
déplaceront dans la direction de la
flèche. Les touches fléchées sont désac-



24full circle magazine Retour au Som m aireLibreOffice

TUTORIEL - LIBREOFFICE - PARTIE 8
tivées pour la navigation si vous êtes
dans la ligne de saisie, ou en mode
édition, pour vous permettre de bou-
ger à l'intérieur du contenu.

Cela étant, avec ces quelques
outils à votre disposition, nous allons
construire la première section de
notre feuille de calcul Budget. Ouvrez
un nouveau fichier Calc. Cliquez sur
l'endroit vierge et gris à gauche de
l'en-tête de colonne et au-dessus de
l'en-tête de la première ligne. Vous
sélectionnerez ainsi toute la feuille.
Dans la barre de formatage, réglez la
police à une jolie police sans-serif
comme Arial et la taille de la police à
1 2 points. En faisant ceci, nous venons
de régler la police et la taille de police
par défaut pour la feuille entière.

Dans la cellule A1 , entrez le texte
«  Revenu pour cette période  » et ap-
puyez sur Entrée. Pour le moment, ne
vous inquiétez pas si le texte dépasse

les limites de la cellule. On va remé-
dier à cela dans un instant. Sur la
deuxième ligne de la colonne A, tapez
« Sources ». Toujours dans la colonne
A, sur les lignes suivantes, tapez vos
différentes sortes de revenu comme,
par exemple Salaire, Free-lance, Prime.
J'ai l'habitude d'ajouter un «  Divers  »
pour les trucs qui ne correspondent
aux autres catégories, comme gagner
le gros lot ou démissionner.

Maintenant, certaines de vos sour-
ces de revenu dépasseront peut-être
de leurs cellules. Nous pouvons ajus-
ter la largeur de la colonne en cli-
quant entre les en-têtes de cellule
pour A et B et en déplaçant la bor-
dure. La cellule A1 ne nous intéresse
toujours pas. À ce stade, le dépas-

sement du texte dans A1 est OK ; il
s'agit ici de vous assurer que toutes
vos sources de revenu se trouvent bien

à l'intérieur des limites de la colonne.

Placez-vous en cellule B2. Tapez
«  Montant ». Appuyez sur Entrée. En
descendant la colonne B, tapez un
montant pour chacune des sources
de revenu. Vous remarquerez que,
par défaut, les nombres ne sont pas
formatés. Nous allons les faire res-
sembler à des montants en monnaie.
Nous les changerons tous en même
temps. Vous pouvez sélectionner toutes
les cellules contenant des nombres
en cliquant avec le bouton de gauche
de la souris et en glissant vers le bas
jusqu'à ce que tous les nombres soient
mis en surbrillance. Vous pouvez aussi
cliquer sur la première cellule, appuyer
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sur la touche Maj en la tenant en-
foncée et cliquer sur la dernière. En
vous servant du clavier, utilisez Maj
avec les touches fléchées. Format >
Cellules > Nombres. Choisissez la caté-
gorie Monétaire. Dans le menu dé-
roulant au-dessus de la boîte format,
sélectionnez la monnaie de votre pays.
Sélectionnez un format monétaire dans
la boîte des formats. C'est vraiment à
vous de choisir. Étant donné que vous
ne devriez jamais avoir un chiffre
négatif dans les cellules de vos reve-
nus, vous n'avez pas besoin de vous
préoccuper trop des formats pour les
nombres négatifs.

Nous allons maintenant nous oc-
cuper du contenu de la cellule A1 qui
continue dans B1 . Puisque ce texte
est le titre de la section, nous voulons
qu'il couvre la largeur de la section. La
solution est de fusionner les cellules.
Mettez les cellules A1 et B1 en sur-
brillance, puis Format > Fusionner les
cellules > Centrer les cellules. Nous
allons beaucoup nous servir de Fusion-
ner les cellules et il deviendra sans
doute l'une des fonctionnalités de
formatage que vous préférerez. Mal-
heureusement, il n'y a pas de rac-
courci clavier. Vous pouvez en créer
un dans Outils > Personnaliser… >
Clavier, mais assurez-vous de ne pas
choisir un raccourci clavier pour une
fonctionnalité usuelle ou prédéfinie.

Maintenant, donnons-lui l'apparence
d'un en-tête, en réglant la police en
gras, Format > Cellules > onglet
Police. Sous Style, choisissez gras.
Rajoutons une bordure autour pour le
démarquer un peu plus du reste.
Cliquez sur l'onglet Bordures. Sous
Par défaut, cliquez sur la deuxième
case, Définir les quatre bordures. Lais-
sez Style tel quel, mais modifiez la
couleur en gris. Cliquez sur OK.

Pour ce qui concerne nos en-têtes
Sources et Montant, nous voulons les
démarquer aussi, mais d'une façon
différente pour les différentier de
l'en-tête de section. Sélectionnez les
deux cellules qui contiennent Sources
et Montant. Format > Cellules > onglet
Police. Sélectionnez gras à nouveau.
Cliquez sur l'onglet Bordures. Cette
fois-ci, nous ne voulons qu'une bor-
dure entre les deux cellules. Dans la
case Défini par l'utilisateur, cliquez
entre les deux boîtes grises qui con-
tiennent un X blanc. Vous verrez une
ligne entre les deux. Modifiez la cou-
leur en gris. Sous l'onglet Alignement,
réglez l'alignement horizontal en
«  centre  » et le vertical en « milieu  ».
Sous l'onglet Arrière-plan choisissez un
bleu clair (Bleu 8) pour la couleur de
l'arrière-plan. Cliquez sur OK.

On pourrait mettre une bordure
autour des sources de revenu, mais

cela peut parfois devenir difficile à
lire. À la place, nous allons changer la
couleur de l'arrière-plan des lignes
paires. Commencez avec la deuxième
source, sélectionnez et le nom et le
montant. Format > Cellules > onglet
Arrière-plan. Choisissez un gris clair

pour l'arrière-plan. J'ai choisi Gris 1 0
%. Cliquez sur OK et faites la même
chose pour toutes les lignes paires.

Ce serait bien d'avoir un sépa-
rateur entre la source et le montant
et une bordure autour de la liste
complète. Cliquez sur la première
source, en appuyant sur Maj, cliquez
sur le dernier montant. Ainsi toutes
les sources et tous les montants
seront mis en surbrillance. Format >
Cellules > onglet Bordures. Sous Par
défaut, choisissez la deuxième case,
Ne définir que la bordure extérieure.
Vous remarquerez que la case Défini
par l'utilisateur a changé. Il y a main-
tenant quatre carrés gris contenant
des X blancs. Cliquez entre les deux

carrés du dessus. Vous obtiendrez
ainsi une ligne verticale entre les
cellules. Un clic au milieu créerait une
ligne verticale et une ligne hori-
zontale, ce que nous ne voulons pas.
Changez la couleur en gris et cliquez
sur OK.

Et voilà : la section Revenu de
notre Feuille de calcul est terminée.
Dans le prochain article, nous allons
continuer notre feuille de calcul Bud-
get en ajoutant la section Actifs. Et
nous allons examiner la façon de
demander à la Feuille de calcul de
faire des maths pour nous au moyen
de la fonction Somme.

Elmer Perry dont les passe-temps in-
cluent le Web design, la programmation
et l'écriture, est pasteur pour les enfants
à Asheville en Caroline du Nord. Son site
Web est eeperry.wordpress.com

http://eeperry.wordpress.com
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D ans la partie 8, nous avons
étudié le formatage des cel-
lules de notre tableur pour
qu'elles apparaissent d'une

certaine manière. Cependant, la véri-
table puissance de Calc vient de sa ca-
pacité à calculer des formules en utili-
sant des mathématiques de base et de
ses fonctions intégrées. Les formules Calc
sont juste ce à quoi vous pensez : des
expressions mathématiques qui utlisent
les données pour créer un résultat. Les
fonctions Calc nous offrent des calculs
prédéfinis et des prises de décision. Avec
juste un peu de connaissances sur les
fomules et les fonctions, Calc devient
un puissant outil d'analyse de données.
Lorsque vous entrez une formule ou
une fonction dans une cellule, votre for-
mule ou fonction doit commencer par
les signes = (égal), - (moins) ou + (plus).

Opérateursarithmétiques

Calc a cinq opérateurs arithmétiques
debase :
+ (Plus) : pour additionner deux nombres
ou comme signe d'un nombre. Ex. =2+5
ou +5.
- (Moins) : pour soustraire un nombre d'un
autre ou rendre un nombre négatif. Ex.
=5-2 ou -5.

* (Astérisque) : opérateur de la multiplica-
tion. Ex. =2 *3.
/ (Slash) : opérateur de la division. Ex.
=21 /7.
^ (Accent circonflexe) : opérateur de l'ex-
posant. Ex. =5^2.

Tout comme dans les vraies mathé-
matiques, vous pouvez utiliser des paren-
thèses pour regrouper des expressions
afin de créer des formules plus compli-
quées. Par exemple, si vous entrez dans
une cellule l'équation =5-2*3, lorsque
vous appuierez sur la touche Entrée, vous
obtiendrez -1 comme résultat. Toutefois,
si vous entrez dans une cellule l'équation
=(5-2)*3, vous obtiendrez 9 comme résul-
tat lorsque vous appuierez sur la touche
Entrée. Cela arrive parce que Calc obéit
aux règles de priorité. Dans la première
équation, la multiplication se fait d'abord,
selon les règles, ce qui nous donne 5-6, ce
qui équivaut à -1 . Dans la deuxième équa-
tion, nous changeons l'ordre des opéra-
tions en utilisant des parenthèses. Dans
ce cas, 5-2 est d'abord calculé dans les
parenthèses, nous obtenons 3, et 3 x 3
équivautà 9.

Référencesdescellules

Écrire en dur nos nombres n'a pas

beaucoup de sens. Nous pourrions sim-
plement utiliser une calculatrice pour ce-
la. Pour libérer la puissance des capacités
de calcul de Calc, une référence aux don-
nées de notre feuille de calcul est néces-
saire. Les références de cellule nous
permettent d'utiliser les données de
notre feuille de calcul dans nos calculs.
Les cellules sont référencées par la lettre
de la colonne et le numéro de la ligne. La
première cellule de la première colonne
estA1 , la deuxième cellule de la première
colonne est A2, la première cellule de la
deuxième colonne est B1 , la deuxième
cellule de la deuxième colonne est B2,
etc. Si nous entrons 5 dans la cellule A1 et
6 dans la cellule B1 , nous pourrons entrer
l'équation =A1+B1 dans n'importe quelle
autre cellule dans le tableur, et le résultat
affiché sera 1 1 .

Dans certaines fonctions, vous aurez
besoin de faire référence à une plage de
cellules plutôt qu'à des cellules indivi-
duelles. Pour faire référence à une plage
de cellules, commencez par la première
cellule suivi de deux points (:) et enfin la
dernière cellule de la plage. Pour accéder
aux 9 premiers éléments de la colonne B,
utilisez B1 :B9. Pour accéder aux 5 pre-
miers éléments de la ligne 1 , utiliser
A1 :E1 .

Que faire si vous devez faire ré-
férence à plusieurs lignes et colonnes ?
Vous avez juste à commencer par la pre-
mière cellule du bloc et à terminer par la
dernière cellule. Par exemple, pour faire
référence à toutes les cellules des 5 pre-
mières lignes et colonnes, vous devriez
utiliserA1 :E5.

Fonctionsmathématiques

Si vous avez besoin de la somme
d'une colonne de nombres, utiliser des
opérateurs mathématiques de base
pourrait très vite devenir laborieux. Calc
propose de nombreuses fonctions pour
des opérations mathématiques, comme
calculer la somme des cellules données
ou encore les fonctions trigonomé-
triques. Ces fonctions accéléreront votre
usagedes formules.

SOMME() est la base de fonctions
mathématiques. Très souvent utilisée,
elle a son propre bouton sur la barre de
fonctions. SOMME() peut prendre jusqu'à
30 nombres ou références de cellules
entre parenthèses. Vous pouvez égale-
ment utiliser les références d'une plage
avec SOMME(), ce qui vous permet d'ob-
tenir rapidement le total d'une colonne,
d'une ligne ou d'une plage de lignes et de
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colonnes. Plusieurs nombres, références
de cellules ou plages de cellules sont sé-
parésparun point-virgule (;).

ExemplesdeSOMME()

=SOMME(A1 ;C2;D5) : somme des trois
cellules.

=SOMME(2;A1 ;C5) : somme du chiffre 2,
A1 etC5.

=SOMME(A1 :A5) : somme des cinq pre-
mièrescellulesde la colonneA.

=SOMME(A1 :B5) : somme des cinq pre-
mièrescellulesdescolonnesAetB.

=SOMME(A1 :A5;C1 :C5) : somme des cinq
premièrescellulesdescolonnesAetC.

Calc propose de nombreuses autres
fonctions mathématiques. Consultez la
documentation de LibreOffice Calc pour
une liste complète, y compris les fonc-
tions trigonométriques.

Calculs aveccondition

Parfois, vous ne voulez effectuer un
calcul que lorsque certaines conditions
sont remplies. Un bon exemple pour illus-
trer cela est d'éviter une division par zéro.
Si vous essayez de diviser par zéro, vous
obtiendrez une erreur. La fonction condi-

tionnelle SI() nous aide à accomplir cela.
La syntaxe de base du SI() est : SI
(test;alors_valeur;sinon_valeur).

Ainsi, si nous voulons diviser A1 par
B2 et que nous voulons éviter l'opération
si B2 est égal à zéro, nous pourrions utili-
ser la fonction SI() :

=SI(B2>0;A1/B2;”division par zéro im-
possible”).

Cela se traduitpar : Si B2 est supérieur
à 0, alors diviser A1 par B2 ; sinon afficher
le texte «division parzéro impossible ».

Les calculs conditionnels peuvent
vous aider à éviter les erreurs dans vos
feuilles de calcul. Utilisez-les dès que vous
pensez qu'un problème pourrait surgir,
comme la division par zéro ou lorsqu'un
nombren'a pasétéentré.

Opérateursdecomparai-
son

Calc propose six opérateurs de com-
paraison que nous pouvons utiliser dans
notre test.
= (égalà)
> (supérieurà)
< (inférieurà)
>= (supérieurou égalà)
<= (inférieurou égalà)
< > (différentde)

En plus des opérateurs de comparai-

son, nous pouvons utiliser les fonctions
NON() et ET() dans notre test. Le ET()
permet de tester plus d'une condition et
NON() l'inverse de la condition. Cette fois,
faisons en sorte qu'aucun des nombres
ne soitégalà 0 :

=SI(ET(NON(A1=0);NON(B2=0));A1/B
2;”division par zéro impossi-
ble”).

Dans cette formule, nous nous assu-
rons que A1 n'est pas nul et que B2 n'est
pas nul avant d'effectuer notre calcul.
Bien que cette formule utilise à la fois les
fonctions ET() etNON(), une formule plus
pratique auraitété :

=SI(ET(A1>0;B2>0);A1/B2;”divi-
sion par zéro impossible”).

Nous avons seulement commencé à
entrevoir les possibilités de Calc en utili-
sant ses formules et ses fonctions. La
prochaine fois, nous jeterons un coup
d'oeil à quelques utilisations pratiques de
certainesde ces fonctions.

Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a
ajouté de l'Amiga, pas mal de DOS et de
Windows, une pincée d'Unix, et un
grand bol de Linux et Ubuntu.

Le Podcast Ubuntu couvre toutes les
dernières nouvelles et les problèmes
auxquels sont confrontés les utilisa-
teurs de Linux Ubuntu et les fans du lo-
giciel libre en général. La séance
s'adresse aussi bien au nouvel utilisa-
teur qu'au plus ancien codeur. Nos dis-
cussions portent sur le développement
d'Ubuntu, mais ne sont pas trop tech-
niques. Nous avons la chance d'avoir
quelques supers invités, qui viennent
nous parler directement des derniers
développements passionnants sur les-
quels ils travaillent, de telle façon que
nous pouvons tous comprendre ! Nous
parlons aussi de la communauté Ubun-
tu etde son actualité.

Le podcast est présenté par des
membres de la communauté Ubuntu
Linux du Royaume-Uni. Il est couvert
par le Code de Conduite Ubuntu et est
doncadapté à tous.

L'émission est diffusée en direct un
mardi soir sur deux (heure anglaise) et
est disponible au téléchargement le
joursuivant.

podcast.ubuntu-uk.org

http://podcast.ubuntu-uk.org/
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D ans la partie 8 de cette sé-
rie, nous avons débuté no-
tre travail dans Calc et
avons créé et mis en for-

me une section Revenu pour une
feuille de calcul Budget. Le mois dernier,
nous avons commencé notre discus-
sion des fonctions et des formules.
Dans cette partie, nous allons conti-
nuer à travailler sur notre feuille de
calcul Budget et utiliser des formules
et des fonctions pour y faire des calculs.

Configuration de la
section Actifs

Si vous vous souvenez, nous avions
mis en place une section contenant
tous les éléments de nos revenus
dans les colonnes A et B. Nous allons
commencer notre section Actifs dans
la cellule D1 . Déplacez-vous vers cette
cellule et entrez-y « Actifs ». Sélec-
tionnez les cellules D1 -G1 , fusionnez

et centrez les cellules (Format > Fu-
sionner les cellules > Fusionner et
centrer les cellules). Dans la cellule
D2, entrez « Type ». Fusionnez et
centrez cette cellule avec E2. Entrez
«  Début » et « Fin » dans, respec-
tivement, les cellules F2 et G2. Dans la
cellule D3, entrez « Total des recettes
pour la période » et fusionnez-la avec
la cellule E3 (Format > Cellules Fusion-
ner > Fusionner les cellules). Dans les
lignes D4-D9, entrez dans l'ordre le
texte suivant : Solde compte chèques,
Transfert épargne, Total disponible,
Solde épargne, Solde retraite, Actifs
bruts. Après avoir entré le texte dans
les cellules, fusionnez ces cellules avec
la cellule adjacente de la colonne E
(c'est-à-dire fusionnez D4 avec E4, D5
avec E5, etc.).

Calcul initial pour la
section Actifs

Dans la cellule F3, nous placerons
notre premier calcul en utilisant la
fonction SOMME(). Pour cette cellule,
nous devons additionner les nombres
de la colonne B dans notre section
Revenu. Entrez cette formule dans la
cellule F3 :

=SOMME(B3:B6)

Cette formule utilise la fonction
SOMME() pour additionner les nom-
bres entrés dans les cellules B3, B4,
B5 et B6. Si votre section Revenu con-
tient plus ou moins d'éléments de reve-
nus, réglez la référence des cellules
donnée à la fonction SOMME(). Si
vous sortez une calculatrice et entrez
les nombres, vous obtiendrez le même
résultat calculé par LibreOffice Calc.

Dans les cellules F4 et F5, saisissez
les montants pour Solde compte chè-
ques et Transfert épargne. Dans la
cellule F6, nous aurons besoin de faire
la somme des trois montants ci-

dessus pour l'élément Total
disponible, mais cette fois,
nous utiliserons une méthode

différente. Sélectionnez la cellule F6
et cliquez sur le bouton somme (à
gauche) de la barre de formule. Vous
remarquerez que LibreOffice trouve
automatiquement les trois montants
ci-dessus et crée une formule de la

fonction SOMME() avec la plage. Ap-
puyez surEntrée pouraccepter la plage.

Entrez les montants pour Solde
épargne et Solde retraite dans les cel-
lules F7 et F8. Sélectionnez la cellule
F9 et cliquez sur le bouton somme
dans la barre de formule. Notez que,
une fois de plus, Calc a sélectionné les
deux nombres au-dessus, mais pour
un total exact des actifs bruts, nous
avons besoin d'inclure le montant to-
tal disponible. Cliquez à gauche et faites
glisser pour sélectionner les trois cel-

lules. Vous devriez voir maintenant la
plage corrigée dans la fonction SOMME().
Appuyez sur Entrée pour accepter.

Mise en place de la
section Dépenses

Nous reviendrons à la section
Actifs pour faire plus de calculs une
fois que nous aurons mis en place la
section Dépenses. Dans la cellule A1 1 ,
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entrez « Dépenses ». Fusionnez et cen-
trez les cellules A1 1 -G1 1 . Dans les cel-
lules A1 2-E1 2, entrez le texte suivant :
Type, Exigible, À payer, Payé et Notes.
Fusionnez et centrez les cellules E1 2-
G1 2. Cela devient notre en-tête de la
ligne pour cette section.

Dans la cellule A1 3, entrez « Epar-
gne » et dans la cellule A1 4, entrez
«  Retraite ». Ces deuxdépenses représen-
teront les sommes déposées dans ces
deux comptes et nous les utiliserons
dans nos calculs définitifs dans la
section Actifs. En commençant par la
cellule A1 5 et en descendant dans la
colonne A, entrez les autres dépenses
comme la nourriture, le carburant, les
hypothèques, le téléphone, etc. Dans
les colonnes B et C, entrez les dates
d'échéance et les montants dus pour
tous les éléments que vous avez en-
trés dans la section Dépenses. Choi-
sissez quelques éléments et mettez
le montant des paiements dans la co-
lonne D. Fusionnez les colonnes E, F
et G pour chacun des éléments.

Formules dans la section
Dépenses

Dans la cellule située sous le der-
nier élément (colonne A), entrez « Dé-
penses totales : » et fusionnez-la avec
la colonne B sur cette ligne. Sélec-
tionnez la cellule dans la colonne C

pour cette ligne. Cliquez sur le bou-
ton somme dans la barre de formule.
Calc devrait sélectionner tous les
montants dans la colonne Montant dû.
Appuyez sur Entrée. Dans la colonne
D de la même ligne, entrez « Total
des paiements » et fusionnez-la avec
la colonne E sur la même ligne. Sélec-
tionnez la colonne F de la même ligne
et cliquez sur le bouton somme dans
la barre de formule. Cette fois, Calc
saute tout jusqu'au dernier montant
dans notre section Actifs, ce que nous
ne voulons cependant pas. Cela arrive
parce que c'est le premier nombre
trouvé par Calc dans la colonne.
Sélectionnez les nombres dans la
colonne Payés de la section pour modi-
fier la plage. Appuyez sur Entrée.

Calculs définitifs pour
la section Actifs

Pour en revenir à la section des
Actifs, nous utiliserons quelques nom-
bres de la section Dépenses afin de
faire quelques opérations en plus.
Sélectionnez la cellule G6. Il s'agit du
total de nos revenus disponibles après
que tous les paiements ont été
effectués. Entrez la formule :

=F6-F##

où ## représente le numéro de ligne
où le total des paiements a été

calculé.

Pour le solde de clôture de notre
compte d'épargne, nous avons besoin
de prendre le total initial, d'ajouter la
somme déposée et de soustraire le
transfert. Si vous placez Epargne comme
votre premier élément dans la section
Dépenses, la formule devrait ressem-
bler à ceci :

=F7+D13-F5

Pour le solde de Retraite final,
nous avons juste besoin d'ajouter le
montant déposé. Si vous avez ajouté
Retraite comme deuxième élément dans
la section Dépenses, la formule sera :

=F8+D14

Enfin, nous allons procéder à
l'ajustement fi-
naldesActifsbruts
en additionnant
les trois chiffres
dans la colonne
G. Sélectionnez
G9 et cliquez sur
le bouton somme
dans la barre de
formule. Calc de-
vrait sélection-
ner les trois nom-
bres dont nous
avons besoin.
Appuyez sur
Entrée.

Notre feuille de calcul Budget est
maintenant terminée, mais elle n'est
pas très belle. La prochaine fois, nous
mettrons en forme notre feuille de
calcul en utilisant des styles.

Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a ajouté
de l'Amiga, pas mal de DOS et de
Windows, une pincée d'Unix et un grand
bol de Linux etUbuntu.
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D ans la dernière partie de
cette série, nous avons ajou-
té les données et les for-
mules à notre feuille de cal-

cul Budget. Le résultat final, bien que
fonctionnel, n'est ni très joli, ni facile à
lire. Nous allons maintenant ajouter
quelques styles à notre feuille de cal-
cul afin de la rendre non seulement
plus agréable à l'œil, mais aussi plus
facile à lire et à trouver des données
spécifiques. Nous atteindrons cet ob-
jectif en utilisant des styles de cellules.

Nous avons utilisé, dans la partie 3 de
cette série, les styles de paragraphe pour
formater les paragraphes de nos docu-
ments. Les styles de cellule sont les équi-
valents dans Calc des styles de para-
graphe. Les styles de cellule nous per-
mettent de définir la bordure, la police,
l'arrière-plan, les effets de police, le format
numérique, l'alignement et la protection
de cellules. Les styles aident à créerune co-
hérencetoutau longdela feuilledecalcul.

Stylesdestitresde
sectionetdecolonne

Nous commencerons par créer des
styles pour nos titres de section et de co-

lonne. Cliquez sur l'icône Styles (ci-contre).
Maintenant, nous allons créer un style
pour les titres de nos colonnes en fonction
du style Section. Baser un style sur un
autre rend rapide et facile l'ajout et la mo-
dification des différences entre les styles.
Dans la fenêtre Styles et formatage, cli-
quez droit sur le style Section et sélection-
nez Nouveau. Nommez le style « Titre
Colonne ». Vous remarquerez que le style
est lié au style Section. Si vous naviguez à
travers les onglets, vous pourrez voir que
tous les paramètres configurés pour le
style Section sont déjà définis. Pour distin-
guer les titres des colonnes de ceux des
sections, nous leur donnerons une couleur
de fond différente. Sous l'onglet Arrière-
plan, sélectionnez une couleur claire ap-
propriéepourle fond, commebleu 8.

Application des styles aux

titres de section et de co-
lonne

Nous pouvons à présent appliquernos
deux nouveaux styles de cellules à notre
feuille de calcul. Les sections sont«Revenu
pour la période », «Actifs »et«Dépenses ».
Sélectionnez les cellules pour ces
éléments et double-cliquez sur le style
Section dans la fenêtre Styles et forma-
tage. Vous pouvez sélectionner plus d'une
cellule et appliquer le style en une seule
fois. Par exemple, mettez en surbrillance
tous les titres des colonnes sous Revenu
(Sources etMontant) et double-cliquez sur
le style Titre Colonne. Faites de même
pour les titres des colonnes dans les deux
autressections.

Styles Modifiable, Total et
Date

Les éléments modifiables sont les
éléments dans notre feuille de calcul Bud-
get que nous aurons besoin de changer à
chaque utilisation. Ce sont la plupart des
cellules sous le titre des colonnes, sauf
ceux qui contiennent des formules qui
sont nos cellules de total. Nous créerons
d'abord le styleModifiable etnous l'utilise-
rons comme lien pour les styles Total et

Date.

Dans la fenêtre Styles et formatage,
cliquez droit sur le style par défaut et
sélectionnez Nouveau. Nommez le nou-
veau style « Modifiable ». Sous l'onglet
Nombres, sélectionnez Monnaie et votre
format monétaire. Réglez votre police et

sa taille sous l'onglet Police. Je suggère
une taille de police d'au moins 12. Assurez-
vous que le style de police est régulier (ni
gras ni italique). Sous l'onglet Bordures,
créez une ombre de bordures grises pro-
jetée sur la gauche et la droite. Vous pou-
vez réaliserceci en cliquantsur la troisième
zone sous Par défaut. Sous l'onglet Pro-
tection de cellules, assurez-vous que la
caseProtégéestdécochée.

Nous allons, à présent, créer le style
Totalen le liantau styleModifiable. Cliquez
droit sur le styleModifiable dans la fenêtre
Styles et formatage, puis sélectionnez
Nouveau. Encore une fois, nous commen-

TTUUTTOORRIIEELL
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çons avec une copie exacte du style sur le-
quel nous avons fait un clic-droit. Nommez
le style « Total ». Nous apporterons des
modifications pour distinguer nos totaux
des éléments ordinaires. Sous l'onglet Po-
lice, modifiez le style pourmettre en gras.
Sous l'onglet Arrière-plan, sélectionnez
une couleur plus foncée que le gris clair
déjà utilisé pour les bordures, comme le
gris ou le gris 40 %. Enfin, cochez la case
Protégé sous l'onglet Protection de
cellule.

Appliquez les styles comme nous
l'avons fait précédemment. Vous remar-
querezque si vous appliquez le styleModi-
fiable à la colonneDate sous les Frais, vous
obtiendrez un résultat étrange pour vos
dates (probablement ####). En fait, elles
ont été converties au format monétaire.
Cliquez droit sur le style Modifiable et
créez un nouveau style nommé «  Dates  ».
Tout ce que nous avons à faire ici est de
changer la catégorie à Date et sélection-
nez un simple format de date numérique
sous l'ongletNombres.

Formatageconditionnel

Nous avons besoin d'un moyen de
morceler le gros bloc de données dans la
section Dépenses. Nous pourrions simple-
ment mettre des bordures autour d'elles,
si ce n'est que de grands groupes de blocs
avec des bordures paraîtraient ternes.
Nous mettrons plutôt en évidence toutes
les lignes paires avec un gris clair. Nous
voulons aussi le faire rapidement. Pour ce-
la, nous utiliserons le formatage condition-
nel.

EST.PAIR(LIGNE())

Avec cette formule, quel que soit le
style que nous choisissons, il ne sera appli-
qué qu'aux lignes paires. Pour le style de
cellule, cliquez sur le bouton Nouveau
style, nommez le style «Modifiable en Sur-
brillance » et liez-le au style Modifiable.
Sous l'onglet Bordures, changez la couleur
de la borduredu gris clairau gris. Allez sous
l'onglet Arrière-plan et changez la couleur
de fond à gris clair. Cliquez surOKpouren-
registrer les modifications. Vous remar-
querez que le style de cellule est
maintenantModifiable en Surbrillance. Cli-
quez sur OK et vous verrez que les lignes
pairessontmisen surbrillanceengrisclair.

Malheureusement, cela a pour effet
secondaire de modifier nos dates à nou-
veau, mais cela est facilement corrigeable
en faisant la même chose avec le style
Date. Sélectionnez toutes les dates dans la
section Dépenses. Format > Formatage
conditionnel. Une fois de plus, utilisez la
formule EST.PAIR (LIGNE()). Cliquez sur le
bouton Nouveau style, nommez le style
«  Dates en Surbrillance » et liez-le au style
Dates. Changez la couleurde la bordure au
gris et l'arrière-plan au gris clair. CliquezOK
pour enregistrer le style, puis sur OK pour
appliquerle formatageconditionnel.

Touchefinale

Juste quelques petites choses simples
pour que tout soit bien. Si vous avez plus
de deux éléments dans la section Revenu,
vous pouvez ajouter la surbrillance en utili-
sant aussi bien le formatage conditionnel
que le style Modifiable en Surbrillance. En
outre, vous pouvez aligner à droite les la-
bels « Total Dépenses » et « Total Paie-
ments»situésplusbas.

Testez à présent votre feuille de calcul.
Rappelez-vous, nous avons protégé les
cellules que nous ne voulions pasmodifier.
Outils > Protéger le document > Feuille.

Vous pouvez entrerunmot
de passe pour protéger le
document ou cliquez sim-
plement sur OK pour le

protéger sans mot de passe. Si vous es-
sayez de modifier l'une des cellules proté-
gées, vousobtiendrez une fenêtre avecun
message annonçant que la cellule est pro-
tégée. Cependant, les cellules non proté-
gées restent facilement modifiables,
comme avant. Utiliser la protection des
cellules est un bon moyen de préserver
vos formules du changementune fois que
la feuille de calcul est en place et qu'elle
fonctionnecommevoulu.

Dans la prochaine partie de cette série,
nous préparerons notre feuille de calcul
pourl'impression en ajoutantun en-têteet
un pied de page. Nous examinerons éga-
lementlesoptionsd'impression.

Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a
ajouté de l'Amiga, pas mal de DOS et de
Windows, une pincée d'Unix, et un
grand bol de Linux et Ubuntu.
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D ans mon dernier article, j'ai
traité la configuration des
styles dans LibreOffice Calc.
Ce mois-ci, je vous montrerai

comment préparer, vérifier et impri-
mer votre feuille de calcul. Nous ajou-
terons des entêtes et pieds de page à
notre feuille, nous utiliserons l'Aperçu
avant impression pour vérifier à quoi
ressemblera notre feuille une fois im-
primée et nous examinerons la boîte
de dialogue d'impression et comment
elle affecte l'impression finale.

Renommerdes feuilles

Lorsque vous créez une nouvelle feuille
de calcul, le classeur par défaut com-
mence par trois feuilles nommées Feuille1 ,
Feuille2 et Feuille3. Vous pouvez utiliser
ces noms dans d'autres endroits dans
votre feuille et nous les utiliserons lorsque
nous créerons l'en-tête et le pied de page
pour notre feuille de calcul Budget.
Toutefois, les noms par défaut ne sont pas
très parlants et nous allons donc les
renommer. Les noms se trouvent sur les
onglets de la fenêtre du programme, en
bas. Pour renommer une feuille, faites un
clic droit sur l'onglet Feuille et sélectionnez
Renommer la feuille dans le menu dérou-
lant. La boîte de dialogue Renommer la

feuille s'affiche. Écrivez un nom significatif
pour la feuille, comme « 24 février 201 2 »
et cliquez sur OK.

En-têtes et pieds de page

Les en-têtes et les pieds de page nous
permettent de créer de la cohérence
entre les pages. Faire cela directement sur
la feuille provoquerait un mélange des
cellules compte tenu des changements et

de l'évolution de la feuille. En utilisant les
paramètres de page, nous pouvons créer
la même apparence pour de nombreuses
pages.

Ouvrez la boîte de dialogue des para-
mètres de la page sous Format > Page. Cliquez
sur l'onglet En-tête. Ici, vous pouvez ajus-
ter les marges, la largeur et la hauteur de
la zone d'en-tête. Je recommanderais de
cocher la case Adaptation dynamique de
la hauteur, sinon votre en-tête pourrait

être tronqué. Cliquez sur le bouton Éditer
pour ouvrir la boîte de dialogue Zone de
l'en-tête. Vous remarquerez que l'en-tête
est divisé en trois zones : gauche, centre et
droite. En bas, vous remarquerez une barre
d'outils. La barre d'outils vous permet
d'insérer des espaces réservés dans l'en-
tête et de formater le texte. Pour notre
feuille de calcul Budget, nous placerons
quelque chose dans chacune des zones.
Dans la zone de gauche, écrivez « Budget
201 2 ». Dans la zone centrale, nous pla-
cerons le nom de notre feuille. Pour obte-
nir le nom de la feuille, cliquez dans la zone
centre et supprimez tout contenu déjà
présent, puis cliquez sur le troisième bou-
ton sur la barre d'outils. Cela permet
d'insérer le nom que vous avez donné à la
feuille. Pour la zone de droite, nous insé-
rerons la date actuelle. Cliquez dans la zone
de droite et supprimez tout contenu déjà
présent. L'avant-dernier bouton sur la
barre d'outils insère la date actuelle. Pour
modifier la police, la taille, la couleur, etc.

du texte, sélectionnez le texte dans l'une
des zones et cliquez sur le premier bouton
de la barre d'outils. Cela affichera une
boîte de dialogue de police, où vous pour-
rez modifier les attributs du texte. Cliquez
sur le bouton OK lorsque vous avez fini
d'éditer votre en-tête.

Nous voudrions aussi peut-être séparer
notre en-tête du reste de la feuille avec
une bordure ou une couleur de fond. Nous
pouvons le faire en cliquant sur le bouton
Options de l'onglet En-tête dans la boîte
de dialogue Page… Dans mon cas, il s'agit
d'une ligne de 0.50pt en bas.

L'onglet Pied de page est le même
que l'onglet En-tête, mais nous allons
mettre des informations différentes dans
les trois zones. Sous l'onglet Pied de page,
cliquez sur le bouton Éditer. Dans la zone
de gauche, placez le nom de la feuille en
utilisant le troisième bouton sur la barre
d'outils, comme nous l'avons fait dans la
zone centrale de l'en-tête. Dans la zone
centrale, supprimez le contenu déjà pré-
sent et tapez le mot Page et un espace.
Cliquez sur le quatrième bouton de la
barre d'outils. Cela crée un espace réservé
pour le numéro de page. Cet espace ré-
servé sera incrémenté pour chaque page
de la feuille. Dans la zone de droite, cli-
quez sur le dernier bouton de la barre
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d'outils pour insérer un espace réservé à
l'heure actuelle. Ceci affichera l'heure lors-
que vous imprimerez la feuille. Avoir la
date et l'heure sur la feuille peut être
pratique lorsque vous avez à faire des
modifications et que vous avez besoin de
savoir quelle est la plus récente. Comme dans
le cas de l'en-tête, nous pouvons modifier
les attributs du texte en mettant en évidence
le texte que nous voulons changer et en
cliquant sur le premier bouton dans la
barre d'outils. Cliquez sur OK lorsque vous
avez terminé l'édition.

Pour séparer le pied de page du reste
du document, nous pouvons utiliser le
bouton Options pour créer une bordure
ou une couleur de fond. J'ai utilisé une
ligne 0.50 pt en haut.

Dans notre configuration, nous avons
utilisé tous les boutons de la boîte de
dialogue d'édition pour l'en-tête/pied de
page à l'exception de deux. Le deuxième
bouton insère le nom du classeur et le
cinquième insère le nombre totalde pages.

Nous avons terminé l'édition de la
mise en page. Cliquez sur OK pour fermer
la boîte de dialogue de configuration de la
page.

Aperçu de la page

L'Aperçu de la page permet de faire les

derniers ajustements à notre feuille avant
impression. Avec la prévisualisation, nous
pouvons être sûrs que tout tienne sur la
page de la façon dont nous le voulons et
que les données apparaissent comme nous
l'avionsprévu.

Pour ouvrir l'Aperçu de la page, allez
dans Fichier > Aperçu . La fenêtre en cours
est remplacée par la fenêtre de visua-
lisation de la page. Vous pouvez faire plu-
sieurs ajustements en mode Aperçu.

Le curseur dans la barre d'outils est le
facteur d'échelle. Cela vous permet de
rendre les cellules plus ou moins grandes
de sorte qu'elles tiennent sur la page
comme vous le souhaitez. Vous pouvez
augmenter la taille en cliquant sur le signe
plus (+) ou la réduire en cliquant sur le
signe moins (-). Vous pouvez également
cliqueretfaireglisserle curseurde réglage.

Le bouton Formater la page affiche la
boîte de dialogue Style de page. Ici, vous
pouvez changer les marges de l'ensemble
de votre page ainsi que la couleur de fond.

Vous pouvez aussi faire des corrections et
des ajustements à vos en-tête et pied de
page. Deux choses que nous n'avons pas
encore mentionnées sont l'alignement du
tableau et l'ordre d'impression. L'alignement
du tableau se trouve sous l'onglet Page. Il
vous permet de centrer le tableau hori-
zontalement, verticalement, ou les deux.
Sous l'onglet Feuille, l'ordre des pages
détermine comment les cellules seront
imprimées sur la page. Cela vous permet
de faire la mise en page de vos données
dans l'ordre et la manière que vous
voulez. Si vous avez plus de colonnes
qu'une page peut contenir, vous pouvez
changer cela de la valeur par défaut à De
gauche vers la droite, puis vers le bas.
Vous pouvez également définir le début
de la numérotation des pages si vous avez
besoin d'une valeur autre que 1 . Vous
pouvez également spécifier ce qui sera
imprimé et ce qui ne le sera pas. Enfin,
vous pouvez régler manuellement l'échelle
ici aussi.

Avec l'Aperçu de la page, vous avez des
boutons pour passer à la page suivante ou

précédente, et pour sauter à la première
page ou à la dernière. Il y a aussi un
bouton Zoom avant/arrière pour un
examen plus approfondi de la page.

Le bouton Marges vous donne la pos-
sibilité d'ajuster la page, l'en-tête, le pied
de page et les marges des colonnes. Cli-
quez sur le bouton Marges pour activer le
mode des marges. Les lignes pointillées
vous permettent de régler manuellement
les marges de la page, de l'en-tête et du
pied de page. Les marqueurs noirs en haut
vous permettent d'ajuster la largeur des
colonnes. Cliquez sur le bouton Marges
pour quitter le mode des marges.

Le bouton Fermez l'aperçu vous fait
sortir du mode de prévisualisation.

L'impression

Nous avons enfin terminé toute notre
préparation et il est temps d'imprimer
notre feuille. Fichier > Imprimer affiche la
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boîte de dialogue d'impression. Sous l'onglet
Général, vous pouvez sélectionner votre
imprimante. Cliquez sur le bouton Pro-
priétés pour les réglages spécifiques à
votre imprimante. Vous pouvez choisir d'im-
primer seulement les feuilles sélectionnées,
toutes les feuilles, ou uniquement les cel-
lules sélectionnées. Vous pouvez égale-
ment spécifier si vous souhaitez imprimer
toutes les pages ou seulement des pages
sélectionnées. Si vous n'avez pas envie
d'ordonner vos pages après les avoir impri-
mées, vous pouvez également choisir de
les imprimer dans l'ordre inverse. Vous
avez la possibilité d'imprimer des copies

multiples et de les assembler ou non.

Sous l'onglet LibreOffice Calc, vous
pouvez choisir d'imprimer ou non les pages
vierges. L'onglet Mise en page vous four-
nit des options pour l'impression de plus
d'une page sur une feuille de papier, dans
quel ordre les imprimer et s'il convient de
mettre une bordure autour de la page.
Dans l'onglet Options, vous pouvez choisir

d'imprimer vers un fichier postscript et, si
vous imprimez plusieurs copies, s'il y a lieu
de le faire comme une tâche d'impression
simple ou multiple.

Une fois que vous avez tout configuré,
cliquez sur Imprimer.

Cette démarche peut sembler exces-
sive pour un document unique, mais vous
devez toujours tenir compte du nombre
de fois que vous allez utiliser et modifier le
document. Si vous utilisez fréquemment
une feuille, comme un budget, une fois
l'en-tête et pied de page réglés, vous n'au-
rez plus à les modifier à nouveau. En envi-
sageant la possibilité de réutiliser les ré-
glages, vous diminuez le temps que vous
consacrerez la prochaine fois pour l'utiliser.

Le mois prochain, nous nous penche-
rons sur quelques petits trucs et
astuces pour travailler avec des feuilles
de calcul dans Calc.

TUTORIEL - LIBREOFFICE PARTIE 1 2

Opinion rapide

Décrochez, abandonnez tout et faites
avancer les choses
par Allan J Smithie

J 'ai déconnecté l'Internet aujourd'hui. Je ne
veux pas dire tout l'Internet, mais plutôt

mon accès. J'ai débranché le routeur du
courant.

J'ai aussi tué le processus de mon lecteur
de musique et laissé mon téléphone portable
dans une autre pièce.

Quelque chose de mystique s'est ensuite
produit : laconcentration.

J'aime l'Internet et j'en suis probablement dépendant. C'est une
ressource considérable et incomparable pour l'information, la re-
cherche, l'apprentissage et le divertissement. Cependant, de temps en
temps, je dois l'éteindre complètement afin de m'organiser pour
avancer [Ndt : allusion à la méthode de gestion des priorités décrite
dans le livre éponyme].

Éteignez la télévision, la radio, l'iPod, la Xbox, la PSP et la Wii.
Fermez les navigateurs (les deux) et tuez le processus des salons de
discussion, d'IRC, d'AIM, de Facepunch, de Twiddle et de tout ce qui est
en cours d'exécution. Le « fact checking », lui, peut attendre. Et
contrairement aux systèmes de croyance contemporains, votre statut
ne doit pas être mis à jour en temps réel. Il sera toujours là. Après cela,
quelque chose aura AVANCÉ.
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J usqu'à présent, nous avons cou-
vert de nombreux sujets sur l'uti-
lisation de Calc de LibreOffice,
mais Calc possède de nombreuses

petites opérations qui sont bonnes à
connaître. Dans cet article, je vais vous
donner mes 1 0 meilleurs conseils faci-
litant l'utilisation de Calc. La plupart
d'entre eux se rapportent à la manipula-
tion de la feuille en cours. Vous pouvez
utiliser ces conseils dans la plupart des
feuilles avec lesquelles vous travaillez.

1 . Nommer les feuilles

Le nom par défaut pour les feuilles
est FeuilleX, où X est un nombre. Vous
avez 3 façons de nommer une feuille. La
première est lorsque vous créez une
nouvelle feuille, en utilisant Insertion >
Feuille… Dans la boîte de dialogue, vous
pouvez déterminer le nom de la feuille.
Vous pouvez également choisir d'insérer

plusieurs feuilles. Lors de l'insertion de
plusieurs feuilles, vous n'avez aucun con-
trôle sur le nom des feuilles. Vous obtien-
drez la convention de nommage par dé-
faut FeuilleX.

De toute façon, vous devrez peut-être
renommer une feuille après qu'elle a été
créée. C'est là que les deuxième et troisième
méthodes s'appliquent. La deuxième façon
de nommer une feuille est en cliquant
droit sur l'onglet de la feuille et en
sélectionnant « Renommer la feuille » à
partir du menu. La boîte de dialogue «  Re-
nommer la feuille » apparaîtra, et vous
pourrez changer le nom de la feuille. La
troisième méthode est tout simplement
de double-cliquer sur l'onglet des feuilles.
Ceci nous amène à la boîte de dialogue
«  Renommer la feuille », où vous pouvez
changer le nom de la feuille.

NOTE : Le nom de la feuille doit com-
mencer par une lettre ou un chiffre, mais
le reste peut inclure des espaces, des
lettres, des chiffres, des soulignements,
et certains caractères spéciaux, comme -
et &. Lors de l'enregistrement au format
Microsoft Excel, les noms de feuilles ne
peuvent pas contenir les caractères : , \, /,
?, *, [ et ]. Si vous avez un caractère non
valide dans le nom, Calc vous affichera un
message d'erreur.

2. Supprimer des feuilles

Parfois, vous souhaitez supprimer
une ou plusieurs feuilles d'un classeur.
Pour supprimer une feuille, faites un clic
droit sur l'onglet de la feuille et
sélectionnez «  Supprimer la feuille… »
dans le menu, ou sélectionnez « Édition >
Feuille > Supprimer… » de la barre de
menu. Calc vérifiera que vous voulez
réellement supprimer la feuille. Pour
supprimer plusieurs feuilles, maintenez
enfoncée la touche Ctrl tout en cliquant
sur les onglets des feuilles que vous
souhaitez supprimer. Utilisez soit la
méthode par clic droit, soit par le menu
pour supprimer les feuilles. Une fois de
plus, Calc va vérifier que vous souhaitez
supprimer les feuilles.

3. Déplacer/Copier des
feuilles

Parfois, vous avez besoin de réorga-
niser ou copier des feuilles. Par exemple,
lorsque vous souhaitez ranger un classeur
à plusieurs feuilles dans l'ordre d'utili-
sation prédominante, ou par date. Copier
une feuille est très pratique lorsque vous
avez besoin de créer une copie exacte de
la feuille, créant ainsi une feuille histo-
rique. Lorsque vous copiez une feuille,
vous obtenez une copie exacte de la
feuille que vous avez copiée, mais quand
vous apportez des modifications à la
nouvelle feuille, ces changements ne sont
pas reportés dans l'ancienne feuille. Par
exemple, vous pouvez créer une copie
d'une feuille de calcul de budget pour
chaque période de paie de l'année et les
conserver dans un classeur.

Déplacer une feuille peut se faire de
deux manières. La première méthode
consiste à faire glisser l'onglet de la
feuille vers la position que vous voulez.
Les doubles flèches indiquent l'emplace-
ment que la feuille doit occuper une fois
que vous la relâchez. L'autre méthode
consiste à utiliser la boîte de dialogue
«  Déplacer/Copier la feuille… ». Vous pou-
vez accéder à ce dialogue en faisant un
clic droit sur l'onglet que vous souhaitez
copier ou déplacer, puis en sélectionnant
« Déplacer/Copier la feuille… », ou par
l'intermédiaire de la barre de menu,
Édition > Feuille > Déplacer/Copier…
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Sous la section Action, vous pouvez
choisir de copier ou de déplacer la feuille
en cours.

REMARQUE : Si vous n'avez qu'une
seule feuille dans votre classeur, les fonc-
tions déplacer et copier seront grisées, et
la copie sera sélectionnée. Dans la
section Vers le document, vous pouvez
choisir de déplacer/copier la feuille dans
le document actuel, dans un autre docu-
ment ouvert ou dans un nouveau docu-
ment. La section Insérer avant contrôle le
placement de la feuille déplacée/copiée.
La feuille se déplace/copie juste une
position avant la feuille sélectionnée. Un
choix spécial ici est «- placer en dernière
position -» (déplacer vers la position
finale). La sélection de ce dernier choix va
déplacer/copier la feuille à la fin de la
liste des feuilles. La section Nom vous per-
met de donner à la feuille un nouveau
nom. Renommer votre feuille est une
bonne idée lors de la copie. Si vous ne lui
donnez pas de nouveau nom, elle conser-
vera le nom actuel et ajoutera un trait de
soulignement et un nombre, par exemple
MaFeuille_2.

4. Onglets de couleur

Les aides visuelles peuvent souvent
permettre de faire avancer les choses
rapidement, tout en travaillant avec un
classeur de grande taille contenant plu-
sieurs feuilles. La couleur est une aide
visuelle facile à mettre en place. Donner
à chaque onglet de la feuille une couleur
différente peut vous aider à le trouver et
vous y rendre rapidement. L'onglet de la
feuille courante est toujours blanc, mais
vous pouvez toujours lui donner une
couleur s'il n'est pas sélectionné. Pour
définir la couleur de l'onglet d'une feuille,
faites un clic droit sur l'onglet et sélec-
tionnez « Couleur d'onglet » dans le
menu. Une boîte de dialogue de couleur
apparaîtra. Sélectionnez simplement la
couleur que vous voulez pour l'onglet et
cliquez sur OK.

5.Figerles lignes/colonnes

Les feuilles longues et larges ont sou-
vent besoin de défilement pour afficher
une partie du contenu dans la feuille.
Mais, dans de nombreux cas, les premières
lignes et colonnes contiennent les infor-
mations dont vous avez besoin pour

donner un sens à l'information. Heureu-
sement, Calc vous fournit un moyen de
figer les lignes et les colonnes.

Pour figer une ou plusieurs lignes,
sélectionnez la ligne en dessous de celle
que vous voulez geler en cliquant sur le
numéro de la ligne, puis Fenêtre > Fixer.
Pour débloquer les lignes, sélectionnez à
nouveau Fenêtre > Fixer. La même chose
est à faire avec les colonnes en sélection-
nant la lettre de colonne à droite des
colonnes que vous voulez fixer, puis Fe-
nêtre > Fixer.

Pour fixer les deux - lignes et colon-
nes -, sélectionnez la cellule en dessous
des lignes que vous voulez geler et à
droite des colonnes que vous voulez
geler, puis sélectionnez Fenêtre > Fixer.

6. Partage d'écran

Une autre manière de travailler avec
de grandes feuilles est d'utiliser l'écran
partagé. Pour diviser l'écran horizontale-
ment, saisissez la barre épaisse juste au-

dessus de la barre d’ascenseur vertical.
Le curseur de la souris se transforme en
flèche double. Faites glisser la barre épaisse
jusqu'à la position que vous souhaitez. Pour
diviser l'écran verticalement, faites la même
chose avec la barre épaisse à la droite de la
barre de défilement horizontal. Pour
obtenir une scission rapide horizontale et
verticale, il suffit de sélectionner Fenêtre
> Scinder. Les partages sont représentés
par des lignes épaisses lourdes. Chaque
zone de l'écran partagé est manipulable

par de nouvelles barres d’ascenseur diffé-
rentes qui apparaissent.

Pour annuler la division d'un écran,
prenez la ligne épaisse et faites-la glisser
vers le sommet pour une division horizon-
tale ou vers la droite pour une division



37full circle magazine Retour au Som m aireLibreOffice

Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a
ajouté de l'Amiga, pas mal de DOS et de
Windows, une pincée d'Unix, et un
grand bol de Linux et Ubuntu.

verticale. Pour annuler toutes les divisions,
utilisez Fenêtre > Scinder.

7. Imprimer les lignes et les
colonnes surchaque page

L'impression d'une feuille qui se fera
sur plusieurs pages peut exiger des
informations essentielles dans certaines
rangées ou colonnes afin d'aider à donner
du sens aux données. Pour contrôler la
façon dont les pages sont imprimées,
vous pouvez définir si certaines lignes ou
colonnes doivent se répéter sur chaque
page.

Ouvrez Format > Zones d'impression >
Éditer. Dans la section « Lignes à répé-
ter », vous pouvez définir les lignes qui
ont besoin d'être répétées sur chaque
page. Par exemple, pour répéter les deux
premières rangées, il faut entrer $1 :$2.
Sous « Colonnes à répéter », vous pouvez
faire la même chose pour les colonnes,
donc pour répéter la première colonne, il
faudra rentrer $A.

8. Remplissage des
cellules sélectionnées

Dans son utilisation la plus basique,
l'outil de remplissage est une façon de
répéter les informations dans une autre
cellule. Pour répéter l'information dans
cette cellule, sélectionnez les cellules
que vous souhaitez répéter, puis Edition
> Remplir > (la direction que vous voulez
remplir : gauche, droite, haut ou bas).

Mais la véritable puissance de l'outil de
remplissage vient de l'utilisation de la
série de remplissage. Edition > Remplir >
Série. L'outil de remplissage en série vous
permet de créer de nombreux types
d'informations en série, allant des nom-
bres aux dates. Il y a aussi le remplissage
automatique, qui utilise une série de
textes prédéfinie dans le programme.
Des exemples de la saisie automatique
sont les jours de la semaine et les mois.
Vous pouvez définir vos propres listes de
saisie automatique dans Outils > Options
> LibreOffice Calc > Listes de tri.

9. Liste de sélection

La liste de sélection
est une fonction texte. La
liste de sélection ne fonc-
tionne que pour le texte
et ne contiendra que du
texte de la colonne ac-
tuelle où se trouve votre
cellule sélectionnée. Pour
activer la liste, sélec-
tionnez une cellule vide et

appuyez sur Alt + Flèche vers le bas sur
votre clavier.

10. Suppression de
données des cellules

Vous avez peut-être parfois besoin
de supprimer complètement les données
d'une cellule, plutôt que de les modifier.
La suppression des données peut se faire

en un seul coup, et vous pouvez sélection-
ner le type d'information qui sera effacé.
Par exemple, vous pouvez sélectionner
un groupe de cellules et choisir de ne
supprimer que la mise en forme, ou
seulement le texte. Il y a aussi un « Tout
Supprimer » pour supprimer toutes les
informations de la cellule. Vous activez la
boîte de dialogue « Supprimer du con-
tenu » en sélectionnant une ou plusieurs
cellules et en appuyant sur la touche
«  Retour arrière » de votre clavier. Vous
pouvez aussi le faire à travers les menus :
Édition > Supprimer du contenu.

Et voilà ! Vous les avez, mes dix meil-
leures astuces pour LibreOffice Calc.

Dans mon prochain article, nous
allons continuer notre voyage dans Calc
en apprenant à créer des diagrammes
et des graphiques.
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Alors que la collecte de don-
nées est utile et aide à déter-
miner des résultats ou à savoir
si les objectifs ont été atteints,

les tableaux et graphiques simplifient
les données pour que les autres puissent
rapidement comprendre et interpréter
les résultats. Le côté artistique pour
faire des tableaux et des graphiques
échappe à la portée de cet article, mais
je vais vous montrer comment créer un
graphique dans Calc qui pourrait vous
servir dansWriter ou Impress. Il y a beau-
coup de tableaux et graphiques prédé-
finis disponibles dans Calc. [Ndt : le
terme utilisé dans le menu de Libre-
Office en français est«  Diagramme…  »].

Nous allons utiliser un simple ensem-
ble de données pour créer notre tableau.
Les données représentent les locations
de bateaux pour une période de six
mois. Nous allons utiliser un graphique
(diagramme) à barres pour montrer la
relation entre les différents types de
locations de bateaux pour chaque mois.

L'Assistant de diagramme
L'assistant de diagramme nous per-

met d'obtenir les éléments de base de
notre tableau remplis rapidement et
facilement. En effet, parfois l'assistant

graphique rassemble tout ce dont vous
aurez besoin pour compléter votre ta-
bleau. L'assistant est votre point de
départ pour toute création de graphique.
Avant de lancer l'assistant, vous devez
sélectionner les données utilisées pour
le graphique. Assurez-vous que vous
venez de sélectionner les données et
leurs en-têtes. Bien que vous puissiez

modifier les plages de la série de don-
nées plus tard, les prendre le plus pré-
cisément possible aide Calc à mieux rendre
les résultats définitifs.

Vous avez deux façons de
démarrer l'assistant de dia-
gramme. Vous pouvez cliquer
sur l'icône Chart Wizard (Assis-

tant de diagramme) (voir ci-dessus) sur la
barre d'outils principale, ou par le menu
avec Insert>Chart (Insertion >Diagramme…).
L'assistant de diagramme est composé

de quatre étapes. Nous passerons en
revue chacune des étapes, mais il est
possible de cliquer sur le bouton Finish
(Terminer) à tout moment pour mettre
fin au processus de l'assistant.

1 . Type du diagramme
Le type du diagramme (ci-dessus) est

l'endroit où vous sélectionnez le type
de graphique que vous souhaitez créer.
Pour certains types de graphiques, vous
avez la possibilité d'effets 3D et, pour
d'autres, non. Pour notre graphique, nous
allons sélectionner le graphique à barres
de base. Puisque nous avons la possibilité
d'effets 3D pour un graphique à barres,
nous allons également cocher la case
3D. Dans le menu déroulant 3D, vous
disposez des options Réaliste ou Simple.
Cela permet de déterminer l'apparence
et l'ombrage de l'effet 3D. Nous allons

utiliser Réaliste. Enfin, vous pouvez sélec-
tionner des formes différentes pour votre
série de données. Nous allons utiliser les
cylindres. Cliquez sur le bouton «  Suivant  »
pour passer à l'étape suivante.

2. Plage de données
Dans la deuxième étape, nous défi-

nissons la Plage de données et com-
ment Calc l'utilise pour créer le gra-
phique. Si nous avons besoin de chan-
ger la plage de ce que nous avons choisi,
nous pouvons soit entrer, soit sélec-
tionner, la plage dans la feuille de calcul.
Le petit bouton à la fin de la zone de
texte Plage de données va minimiser la
boîte de dialogue de l'assistant ; ainsi,
une plus grande partie de votre feuille
de calcul est visible.

Nous avons besoin de dire à Calc si
nos séries de données sont définies par
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ligne ou colonne. Pour notre exemple,
nous avons utilisé des colonnes. De
plus, puisque nous avons sélectionné
les en-têtes aussi bien que les données,
nous devons cocher à la fois First row as
label (Première ligne comme étiquette)
et First column as label (Première
colonne comme étiquette).

Cliquez sur le bouton «  Suivant  »
pour passer à l'étape suivante.

3. Séries de données
La troisième étape (ci-dessous) nous

permet de redéfinir, ajouter, modifier

l'ordre et supprimer des données de
nos séries de données. Vous verrez les
séries de données pour le graphique
définies par leurs étiquettes dans une
liste. Vous pouvez modifier la portée de
la série de la même façon que vous
pourriez l'avoir fait à l'étape plage de
données ; mais gardez à l'esprit que cela
ne s'applique qu'à un ensemble de
données et non pas à l'ensemble du
graphique. Vous pouvez ajouter une
autre série en cliquant sur le bouton
Add (Ajouter). Vous pouvez supprimer
une série en la sélectionnant et en cliquant
sur le bouton Remove (Supprimer). Mo-

difiez l'ordre des séries en sélectionnant
la série que vous souhaitez déplacer et en
utilisant les boutons fléchés haut etbas.

Nous n'avons pas besoin de chan-
ger quoi que ce soit ici, alors cliquez sur
le bouton Next («  Suivant  ») pour passer
à la dernière étape de l'assistant.

4. Éléments du diagramme
La quatrième étape (en haut à droite)

de l'assistant nous permet de définir
des noms pour les différentes parties
de notre tableau, y compris le titre,
sous-titre et les axes x et y. Nous pou-
vons aussi définir l'emplacement de notre
légende et la grille de la zone graphique.
Pour notre exemple de graphique, lui
donner le titre « Exemple de dia-
gramme à barres ». Nous voulons aussi
étiqueter notre axe Y comme « Nombre
de locations ». Puisque notre axe X est
les mois de l'année, nous n'avons pas
vraiment besoin d'une étiquette pour
l'axe X. Il parle de lui-même. Positionnez

la légende dans la partie inférieure
(bottom), donnant à nos données plus
d'espace pour s'étaler.

Nous avons maintenant terminé
avec l'assistant graphique. Si jamais
vous avez besoin de revoir l'une des
étapes, vous pouvez utiliser le bouton
Back (Précédent) ou sélectionner l'étape
dans la liste sur la gauche. Cliquez sur le
bouton Finish (Terminer) pour terminer
l'assistant et afficher le graphique dans
votre feuille de calcul.

Formatage des éléments
du graphique

Après la création du graphique avec
l'assistant graphique, il est possible d'en
changer les éléments. Après avoir cliqué
sur Finish (Terminer), vous remarquerez
que le graphique nouvellement créé est
sélectionné et que votre barre d'outils a
changé. Vous avez la barre de forma-
tage graphique au lieu de la barre d'outils
d'édition standard. La nouvelle barre
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d'outils possède un menu déroulant qui
permet de sélectionner les différents
éléments que vous pouvez changer.
Après avoir sélectionné un élément
dans la liste déroulante, cliquez sur le
bouton Format Selection (Formater la
sélection) pour afficher la boîte de dia-
logue pour cet élément.

Il existe également des boutons per-
mettant de modifier le type de gra-
phique et d'afficher la grille graphique
et la légende. Le bouton avec la double
flèche à côté de la lettre A majuscule
est utilisé pour agrandir le texte avec le
graphique quand vous le redimension-
nez. Je recommande fortement ceci, car
il garde les choses proportionnelles. En
plus des changements dans la barre
d'outils, vous trouverez aussi des chan-
gements dans les menus Insert (Inser-
tion) et Format. Ces changements per-
mettent d'insérer et formater des élé-
ments de votre graphique.

Vous pouvez déplacer le graphique
en faisant un cliquer-déplacer sur les
bords. Redimensionnez le graphique en
faisant un cliquer-déplacer sur l'une des
huit poignées. Si vous avez sélectionné
le bouton échelle du texte, la taille du
texte sera ajustée en même temps que
le tableau lorsque vous le modifiez.

Maintenant, nous allons apporter
quelques modifications à notre tableau.
Dans la liste déroulante de la barre

d'outils, sélectionnez Chart Title (Titre)
et cliquez sur le bouton Formater la
sélection. Dans l'onglet Font (Police), modi-
fiez la taille à 1 8 et le style à bold (gras).
Cliquez sur OK. Ensuite, sélectionnez
Chart Area (Zone du diagramme), puis
cliquez sur Formater la sélection. La
zone graphique est tout le fond du ta-
bleau. Sous l'onglet Remplissage (Area),
sélectionnez une couleur de fond gris
clair. Vous remarquerez que cela change
la couleur de notre zone de données
aussi, mais nous voulons que la zone de
données se détache. Sélectionnez Dia-

gramme (Chart) à partir de la liste
déroulante et cliquez sur Formater la
sélection. Sous l'onglet Area (Remplis-
sage), sélectionnez Fill with color (Rem-
plir) et choisir blanc. Puisque nous
utilisons un graphique 3D, nous allons
changer un peu le point de vue : Format
> 3D View (Affichage 3D…), cochez la
case Perspective et modifiez le pour-
centage à 50 %. Vous verrez que la pers-
pective du graphique change.

Il y a d'autres choses à faire par
vous-même. Essayez de changer la
couleur de l'une des séries de données

ou de régler l'emplacement de certains
des éléments. Tout peut être fait par la
liste déroulante et les menus Format et
Insertion. Lorsque vous désélectionnez
le graphique, vous revenez à la barre
d'outils normale et les menus normaux.
Pour modifier le graphique plus tard, il
suffit de double-cliquer sur le graphique
et vous obtiendrez à nouveau la barre
d'outils et les menus spécialisés.

Nous n'avons fait qu'effleurer la sur-
face des graphiques dans Calc, mais je
vous encourage à jouer avec les diffé-
rents types et éléments. Le type de gra-
phique que vous utiliserez dépend du
type de données que vous avez et les
informations que vous voulez trans-
mettre.

La prochaine fois, nous allons com-
mencer notre travail dans Impress, le
programme de présentation de Libre-
Office.

TUTORIEL - LIBREOFFICE PARTIE 1 4
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P
résentation (Impress) est, com-
me son nom l'indique, le pro-
gramme de présentation de
LibreOffice ; c'est l'équivalent

de PowerPoint de Microsoft Office.
Avec Présentation, vous pouvez créer
des présentations visuelles incluant des
graphismes, des images, des vidéos, de
l'audio, des tableurs et des graphiques.
Présentation comporte un Assistant
Présentation qui est très utile pour
vous aider à configurer une nouvelle
présentation et vous faire démarrer
du bon pied. Sa fenêtre principale
vous aide à décomposer le processus
tâche par tâche.

L'Assistant présentation

Vous pouvez créer une nouvelle
présentation vierge en allant à Fichier
> Nouveau > Présentation. Cependant,
pour démarrer l'Assistant Présenta-
tion, cliquez sur Fichier > Assistants >
Présentation. Si vous voulez commen-
cer par l'assistant chaque fois que
vous créez une nouvelle présenta-
tion, vous pouvez l'activer. Pendant
que vous êtes dans Présentation, cli-
quez sur Outils > Options > Libre-
Office Impress > Général et cochez
«  Démarrer avec l'Assistant » sous

Nouveau document.

Le premier écran de l'assistant (à
droite) vous permet de choisir entre
une présentation vierge, un modèle
ou l'ouverture d'une présentation exis-
tante. Si vous choisissez « À partir
d'un modèle », il y a deux modèles par
défaut. Les deux viennent avec des
diapositives pré-définies. Je vous sug-
gère de cocher Aperçu, puisque ainsi
vous voyez à quoi ressemblera votre
présentation pendant sa création dans
l'assistant.

ASTUCE :Vous avez la possibilité à tout
moment dans l'assistant de cliquer
sur le bouton Créer pour créer une
nouvelle présentation. Cela vous permet
d'utiliser uniquement les parties de
l'assistant dont vous avez besoin.

Cliquez sur Suivant >> pour aller au
deuxième écran de l'assistant. Ici vous
pouvez choisir parmi beaucoup d'ar-
rière-plans de présentation. Vous pour-
rez changer l'arrière-plan des diapos
individuels plus tard, mais celui-ci
deviendra l'arrière-plan de base pour
votre présentation. Vous devrez aussi
sélectionner un média de sortie - nor-
malement écran - mais il y a d'autres
options disponibles si jamais vous en
avez besoin.

Cliquez sur Suivant >> pour avancer
jusqu'au troisième écran de l'assistant.
Ici, vous pouvez choisir une transition
entre les diapos. Il y a beaucoup d'effets

de transition différents parmi lesquels
choisir. Lorsque vous sélectionnez un
effet, vous en avez un aperçu dans la
fenêtre d'aperçu. Vous avez égale-
ment la possibilité d'ajuster la vitesse
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de la transition. Il vous sera possible
de changer l'effet de transition de
diapos individuelles plus tard, mais,
avec l'arrière-plan, la transition est
l'une des choses qui créent de la
cohérence dans votre présentation.
C'est ici aussi que vous pouvez sélec-
tionner le type de présentation. « Stan-
dard » fait avancer les éléments et
diapos en se servant de la souris ou
du clavier. « Automatique » vous permet
de régler la durée d'affichage et la
durée de pause des diapos. Ce choix
dépend de votre présentation et dé-
passe la portée de cet article.

Cliquez sur Suivant » pour aller au
quatrième écran de l'assistant [Ndt :
si vous utilisez un modèle, sinon, l'as-

sistant est terminé]. Ici, vous pouvez
donner le sujet, le nom de la société
(ou votre nom si la présentation n'est
pas pour une société), et les idées qui

sous-tendent la présentation. Ce que
vous mettrez s'affichera sur la pre-
mière diapo.

Cliquez sur Suivant » pour avancer
au cinquième écran de l'assistant. Si
vous avez sélectionné un modèle sur
le premier écran de l'assistant, vous
pouvez vous servir de cet écran pour
avoir un aperçu de chaque diapo après
vos modifications. Vous pouvez éga-
lement choisir si une diapo précise
sera incluse dans la présentation ou
pas. Cochez « Créer un sommaire »
pour créer un résumé des diapos.

ASTUCE :Vous pouvez toujours vous
servir du bouton << Précédent pour re-
tourner à un autre écran et modifier
des éléments de votre présentation.
Cliquez sur le bouton Créer et Pré-
sentation créera les diapositives pour
votre nouvelle présentation.

La fenêtre principale

La fenêtre principale de Présen-
tation (ci-dessus) est divisée en trois
sections, le volet Diapo, l'espace de
travail et le volet Tâches. Vous pou-
vez masquer les volets Diapo et
Tâches en cliquant sur le X dans le
coin supérieur de chacun. Pour mon-
trer les volets à nouveau, utilisez
Affichage > Volet Tâches ou Affi-
chage > Volet Diapo. Vous pouvez
aussi vous servir des marqueurs Mas-
quer (entourés de rouge dans l'image)
pour cacher et afficher les volets.

Le volet Diapo(rama)

Le volet Diapo affiche des minia-
tures de toutes les diapositives de
votre présentation dans l'ordre dans

laquelle elles apparaîtront. Ici, vous
pouvez ajouter, supprimer, copier, col-
ler, bouger, dupliquer, renommer ou
masquer des diapositives. Si vous cli-
quez sur une diapositive dans le volet
Diapo, elle sera placée dans l'espace
de travail où vous pouvez la modifier.

L'espace de travail

Comme son nom l'indique, l'espace
de travail est le volet où vous pouvez
modifier des diapositives. Il y a cinq
onglets de l'espace de travail.

Normal

Normal est l'espace où vous tra-
vaillez sur les diapositives une à une.
Ici, vous pouvez ajouter des images,
changer et ajouter du texte, des effets
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d'animation et plus encore.

Plan
Plan affiche le plan de tout le texte

dans les boîtes texte par défaut sur
chaque diapositive. Les diapositives sont
numérotées. L'affichage Plan vous per-
met de relire et modifier le texte figu-
rant dans les diapositives ou, encore,
y ajouter du texte. Les noms des diapo-
sitives ne sont pas inclus dans le plan.

Notes
Sous l'onglet Notes, vous pouvez

ajouter des notes à des diapositives
individuelles. Vous pouvez changer la
taille de la boîte de texte sous la dia-
positive en cliquant sur la bordure et
en déplaçant les poignées. Les notes
ne s'afficheront pas pendant votre pré-
sentation, mais vous pouvez les im-
primer afin de les utiliser pendant
celle-ci ou les distribuer au public cible
comme prospectus.

Prospectus
Sous l'onglet Prospectus, vous pou-

vez paramétrer l'impression de votre
prospectus. Si vous sélectionnez Mises
en pages dans le volet tâches, vous
pouvez régler le nombre de diaposi-
tives qui apparaîtront sur chaque page
du prospectus (jusqu'à 9 diapos par
page). Ici, vous avez la possibilité aussi

de choisir l'information qui sera im-
primée dans le prospectus.

Trieuse de diapositives
L'onglet Trieuse de diapositives

fonctionne de la même manière que
le volet Diapo, mais, ici, vous avez plus
d'espace pour travailler. Vous pouvez
ajouter, supprimer, déplacer, copier,
coller, dupliquer, renommer et masquer
les diapos. Vous pouvez également tra-
vailler avec un ensemble de diapositives
en en sélectionnant plusieurs.

Le volet Tâches
Le volet Tâches comporte 5 sections.

Cliquer sur le nom d'une section la
développera. Il n'est possible de déve-
lopper qu'une section à la fois.

Pages maîtresses
C'est ici que vous définissez le style

de la page pour votre présentation.
Présentation contient de nombreuses
pages maîtresses pré-définies que vous
pouvez utiliser. Au moyen de Styles,
vous pouvez changer l'apparence d'une
page maîtresse. Une présentation peut
avoir plus d'une page maîtresse, ce
qui vous permet d'utiliser plus d'un
seul style visuel au cours de la pré-
sentation.

Mises en pages
Les mises en pages proposées par

défaut s'affichent ici. Vous pouvez choi-
sir une mise en pages et l'utiliser telle
quelle ou la modifier. Il n'est malheureu-
sement pas possible de sauvegarder
des mises en pages personnalisées vers
les listes de mises en pages.

Ébauche de tableau
Des styles standards de tableau sont

montrés ici. Vous avez toujours l'option
de changer la mise en page et le ta-
bleau se comportera à peu près comme
un tableau dans Calc.

Animation personnalisée
Avec des animations personnali-

sées, vous pouvez régler quand et
comment des éléments s'affichent sur
les diapositives. Vous avez beaucoup
d'options diverses qui vous aideront à
créer les effets visuels dont vous avez
besoin pendant la présentation. N'exa-
gérez pas ici à moins d'avoir une
bonne raison de le faire. Alors que les
animations peuvent rendre votre
présentation intéressante et agréable
à voir, elles peuvent aussi lui donner
une apparence inappropriée et dérou-
tante. Cela dit, si vous avez besoin de
souligner un point précis, des anima-
tions personnalisées peuvent vous
aider à le faire.

Transition de diapo
La section Transition de diapo vous

permet de changer la façon dont une
diapositive remplace la précédente. Il
y a un grand choix de types de transi-
tions et de rapidité de transition. Si
vous choisissez « Passer à la diapo
suivante > Automatiquement après »,
vous pouvez contrôler la durée d'affi-
chage de la diapositive.

Cet article n'a été qu'un bref aperçu
pour vous permettre de commencer à
travailler avec Présentation. Je vous
suggère vivement de commencer à
jouer avec les affichages divers, les
sections et les mises en page afin de
mieux comprendre comment ils fonc-
tionnent et ce qu'ils vous permettent
de faire. La prochaine fois, nous allons
commencer à modifier des diapositives
et à y ajouter du texte et des gra-
phismes.

TUTORIEL - LIBREOFFICE P. 1 5 : PRÉSENTATION
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U ne belle présentation com-
mence par une conception
des diapos agréable et bien
pensée. Vous avez égale-

ment besoin de cohérence entre vos
diapos, des éléments qui les relient.
Dans LibreOffice, vous pouvez utiliser
les pages maîtresses [Ndt : aussi ap-
pelées Masques et en anglais Master
Pages] pour créer le schéma de base
de votre présentation. Les pages maî-
tresses deviennent le cadre de l'ensem-
ble de la présentation, en en reliant
ensemble les éléments. Une grande
partie de ceci se fait au moyen des
styles et les pages maîtresses sont le
style principal. Ainsi, les pages maî-
tresses sont en quelque sorte équi-
valentes auxstyles de page dansWriter.

Modifier les masques

Pour modifier les masques, vous
devez passer en Mode Masque. Ouvrez
le Mode Masque dans Affichage >
Masque > Masque des diapos. Ou
bien, vous pouvez faire un clic droit
sur la page maîtresse que vous sou-
haitez modifier dans la section Pages
maîtresses du volet Tâches, puis sélec-
tionnez Éditer le masque.

Lorsque vous entrez dans le mode
masque, la barre d'outils principale
s'affiche. Elle vous donne des options
particulières pour modifier les pages
maîtresses. Utilisez Ajouter pour ajou-
ter un nouveau masque. Supprimer
vous permet de supprimer le masque
sélectionné. Supprimer est grisé lorsque
vous n'avez qu'un seul masque, car

vous devez en avoir au moins un.
Renommer vous permet de renom-
mer le masque actuellement sélec-
tionné et « Fermer le mode masque »
termine la modification des pages
maîtresses.

Vous avez cinq zones prédéfinies
modifiables dans une page maitresse :

Zone de titre - La zone de titre
contient le titre de la diapositive. Con-
cevez-le comme le sujet de la diapo-
sitive.

Zone d'objet - La zone d'objet con-
tient les données de la diapositive,
que ce soit du texte, une image, un
graphique ou une table. Comme vous
le verrez, les données de la diapo ne
sont pas limitées à la zone d'objet.
Vous pouvez ajouter des éléments en
dehors de la zone d'objet, mais, en
règle générale c'est une bonne idée
de garder des données dans cette
zone pour la cohérence de votre pré-
sentation.

Date, Pied de page et Zone de
numérotation des diapos. Par défaut,
ces zones ne s'affichent pas sur la
diapositive même. Pour changer cela,
allez dans Affichage > En-tête et pied
de page et vous pouvez décider si oui
ou non ces objets apparaîtront sur les
diapositives.
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Modifier la page
maîtresse

Nous allons commencer par le
style par défaut de votre page maî-
tresse. Tout d'abord, nous allons chan-
ger l'arrière-plan. Format > Page. Sous
l'onglet Arrière-plan, utilisez le menu
déroulant et sélectionnez « Dégradé ».
Dans la liste des dégradés, choisissez
Radial rouge/jaune. Cliquez sur OK.
Cela vous donne un fond brillant et
ensoleillé pour travailler.

Ensuite, nous allons ajouter une
image à votre page maîtresse. L'image
apparaîtra sur toutes les diapositives
qui utilisent cette page maîtresse. J'ai
créé une frise contenant les icônes de
toutes les applications de LibreOffice.
Nous voulons qu'elle se place juste en
dessous de la zone d'objet. Insertion

> Image > À partir d'un fichier. Choisir
votre image et Ouvrir. Placez l'image
à la position que vous voulez, juste en
dessous de la zone d'objet. L'image
doit être centrée en bas. Faites un clic
droit sur l'image et choisissez Aligne-
ment > Centré. Vous voulez aussi que
l'image apparaisse derrière les objets
qui pourraient aller par dessus. Faites
un clic droit sur l'image à nouveau,
puis choisissez Organiser > Envoyer
vers l'arrière.

Maintenant, nous allons ajouter
une ligne sous le titre. Prenez l'outil
«  Ligne » dans la barre d'outils de des-
sin en bas de la fenêtre et tirez un
trait sous la zone de titre. Vous pou-
vez changer le style de la ligne à l'aide
de la barre d'outils ligne. Changer le
style de la ligne, l'épaisseur, la couleur
et les styles des flèches de début et
de fin.

Enfin, nous allons modifier les zones
de date, de pied de page et de nu-
méro de page (ci-dessous). C'est dans
la page maîtresse que vous pouvez
modifier la taille et l'emplacement de
ces objets, mais vous pouvez en fait
les remplir avec un contenu à tout
moment. Affichage > En-tête et pied
de page. Sous l'onglet Diapo, il y a
une case à cocher pour chacune des
trois zones : la date, le pied de page
et le numéro de diapo.

Sous Date et heure, vous pouvez
choisir une date fixe ou une date
variable. Vous pouvez utiliser une date
fixe quand vous ne faites la pré-
sentation qu'une seule fois ou si vous
voulez que la date apparaisse d'une
manière non standard. Placez votre
texte de date dans la zone de texte à
côté de la case variable. Ce que vous
placez dans la zone de texte est ce
qui apparaîtra dans le champ date de
la diapositive. Utilisez la date variable
quand la date de la présentation est
inconnue ou si vous faites cette présen-
tation plus d'une fois. Variable placera
la date actuelle dans la zone de texte
Date. Avec la date variable, vous de-
vez sélectionner un format dans la
liste déroulante. Vous pouvez égale-
ment changer la langue.

Pour la zone de pied de page,
tapez le texte que vous voulez dans la

zone de texte de pied de page. Tout
ce que vous tapez dans la zone de
texte apparaît dans cette zone.

Il n'y a pas beaucoup d'options pour
le numéro de diapositive. Vous coche-
rez la case pour le montrer ou la déco-
cherez pour ne pas le montrer. Quand
il est coché, le numéro de la diapo-
sitive apparaîtra dans la zone numéro
de la diapositive.

REMARQUE : Les zones de date,
pied de page et numéro de diapo
sont désactivées sur la première diapo-
sitive, la page de titre.

Cliquez sur le bouton « Appliquer
partout » pour appliquer les paramètres
à toutes les diapositives à l'exception
de la page de titre. Cliquez sur le
bouton Appliquer pour l'appliquer seu-
lement à la diapositive en cours.

Styles d'Impress

Tout comme dans Writer et Calc,
Impress peut utiliser des styles pour
garder le tout uniforme. Ils sont éga-
lement un gain de temps. Cependant,
ils sont un peu différents dans Impress.
Impress n'a que deux types de styles
différents, présentation et graphique.

Un moyen simple de conceptua-
liser les styles de présentation est

http://eeperry.co.cc/resources/modules.png
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comme pour les styles des pages maî-
tresses. Vous avez des styles pour les
arrière-plans, les objets du fond, la
mise en valeur du texte, les notes, les
titres et sous-titres. Vous pouvez modi-
fier ces styles à souhait. Cependant,
vous ne pouvez pas créer de nouveaux
styles de présentation.

Les styles de graphiques sont des
styles pour les objets et les textes qui
ne sont pas directement liés aux pages
maîtresses. Vous pouvez modifier ces
styles comme vous voulez et vous
pouvez en créer de nouveaux.

La modification des styles se fait à
partir de la boîte de dialogue Styles et
formatage. Vous pouvez ouvrir la
fenêtre Styles et formatage en cli-
quant sur le bouton dans la barre
d'outils « Ligne et remplissage », en
appuyant sur la touche F1 1 du clavier
ou en allant sur Format > Styles et
formatage.

Faisons quelques modifications aux
styles de présentation pour montrer
comment ils fonctionnent. Tout d'abord,
passez en mode vue maîtresse, Affi-
chage > Masque > Masque des diapos,

et ouvrez la fenêtre Styles et forma-
tage, Format > Styles et formatage.
Faites un clic droit sur Titre dans la
boîte de dialogue et choisissez Modi-
fier. Sous l'onglet Police, sélectionnez
une police serif ou slab appropriée.
Mettez-la en gras, peut-être. Passez à
l'onglet Remplissage et changez le
remplissage à Dégradé. Choisissez le
premier dégradé dans la liste (noir
vers blanc). Dans l'onglet transpa-
rence, changez le mode à Transparence
et le pourcentage à 50 %. Cliquez sur
OK et vous verrez que la police pour
le titre a changé et qu'il a un fond
dégradé semi-transparent.

Maintenant, sélectionnez Plan 1
dans le dialogue Styles et formatage.
Faites un clic droit et modifiez-le. Tout
ce que nous voulons faire ici, c'est de
changer la police. Cliquez sur OK. Reve-
nez vers la page maîtresse et vous
remarquerez que la police est modifiée
pour tous les niveaux hiérarchiques.
C'est parce que chacun des niveaux
hiérarchiques est lié au précédent. Vous
ne pouvez pas changer ce lien, mais
vous pouvez modifier chacun des ni-
veaux pour qu'ils soient différents.
Cet effet de cascade peut être utile,
surtout avec la police pour aider à
créer l'uniformité.

Dans ce tutoriel, nous avons appris
à créer et modifier des masques dans

Impress. Les masques sont essentiels
pour aider à créer une cohérence
dans votre présentation. Nous avons
également examiné les styles de pré-
sentation et comment ils aident à
créer le style de vos diapositives. Je vous
encourage à jouer avec les para-
mètres des masques et les styles de
présentation. Les styles de présentation
ont 1 4 onglets différents, ce qui les
rend très souples. Vous pouvez créer
une présentation très professionnelle
et visuellement attrayante avec ces
outils.

La prochaine fois, nous commen-
cerons à travailler avec des diapo-
sitives individuelles.

TUTORIEL - LIBREOFFICE P.1 6 : LA PRÉSENTATION
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J 'ai récemment reçu une demande
de tutoriel sur les macros Libre-

Office ; nous allons donc faire une courte
pause dans notre travail dans Présen-
tation pour expliquer brièvement les
macros. Les macros vous permettent
d'automatiser des actions répétitives
telles que taper un en-tête. Cela vous
évite d'avoir à taper ou faire le même
travail, encore et encore. Dans ce tuto-
riel, nous verrons comment enregistrer
des macros et comment les utiliser.
LibreOffice a un langage de script en
Basic qui dépasse la portée de ce tuto-
riel. Peut-être que nous reviendrons aux
macros à une date ultérieure pour discu-
ter du langage de script Basic.

REMARQUE : Vous pouvez trouver des
informations sur LibreOffice Basic dans
l'aide ou télécharger la documentation
sur :
http://wiki.documentfoundation.org/im
ages/d/dd/BasicGuide_OOo3.2.0.odt.

Activer l'enregistrement
de macros

Par défaut, l'enregistrement de macros
est désactivé. Apparemment, les macros
sont considérées comme une « fonction
expérimentale (instable) ». Pour activer

l'enregistrement de macros, Outils > Op-
tions. Sélectionnez l'option Avancé sous
LibreOffice et cochez la case « Activer
l'enregistreur de macro (limité) ». Cela
active l'option « Enregistrer une macro »
sous Outils > Macros.

Enregistrer une macro

En mode d'enregistrement de macro,
l'enregistreur de macros suit tout ce
que vous faites et tout le texte que
vous tapez et l'enregistre dans la macro.
Vous vous rappelez comment nous avons
eu à activer l'enregistreur de macros
pour obtenir l'option Enregistrer une
macro ? Eh bien, c'est parce que parfois,
l'enregistreur de macros se plante. Je ne

l'ai pas vécu moi-même, mais je pensais
que je devais le souligner.

Comme démonstration d'enregistre-
ment d'une macro, nous allons créer
une macro appelée « Signature ». Cha-
que fois que vous écrivez une lettre,
vous devez mettre une formule de
politesse, alors pourquoi ne pas en faire
une macro ?

Commencez avec un nouveau docu-
ment texte. Outils > Macros > Enregistrer
une macro pour démarrer l'enregistreur
de macro. La barre d'outils enregistreur
de macro va apparaître. Il n'y a qu'un
seul choix sur cette barre d'outils : termi-
ner l'enregistrement. Appuyez sur la tou-

che Tabulation de votre clavier trois ou
quatre fois (ce qui devrait placer le cur-
seur près du centre de la page). Tapez
Amicalement, Baisers, ou votre formule
favorite. Appuyez sur Entrée deux fois
pour laisser place à une signature. Ap-
puyez sur Tabulation autant de fois que
vous l'avez fait avant. Mettez le texte
en gras en cliquant sur le bouton Gras
de la barre d'outils de mise en forme,
puis tapez votre nom. Enfin, nous allons
ajouter un titre sous le nom. Appuyez
sur Entrée, Tabulation le même nombre
de fois qu'avant, cliquez sur le bouton
Gras pour désactiver le gras, puis cliquez
sur le bouton Italique pour passer en
italique. Entrez votre titre. Appuyez sur
Entrée. Cliquez sur Terminer l'enregis-
trement.

La boite de dialogue Macros Libre-
Office Basic va apparaître. Choisissez le
répertoire où vous souhaitez enregistrer
votre macro, habituellement Mes ma-
cros. Entrez un nom dans le champ Nom
de la macro, puis cliquez sur le bouton
Enregistrer.

Test de votre macro

Vous devez tester votre macro pour
vous assurer que tout est enregistré

http://wiki.documentfoundation.org/images/d/dd/BasicGuide_OOo3.2.0.odt
http://wiki.documentfoundation.org/images/d/dd/BasicGuide_OOo3.2.0.odt
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correctement, Outils > Macros > Exé-
cuter la macro. La boîte de dialogue
macro va apparaître. Choisissez le réper-
toire où vous avez enregistré votre
macro, sélectionnez-la, puis cliquez sur
le bouton Exécuter. La macro s'exécute
en répétant tout le texte que vous avez
tapé et le formatage que vous avez fait.

Si quelque chose ne vous convient
pas, vous pouvez supprimer la macro et
en créer une autre. Pour supprimer une
macro, Outils > Macros > Gérer les
macros > LibreOffice Basic. Trouvez
votre macro dans le répertoire, sélec-
tionnez-la et cliquez sur le bouton
Supprimer.

Créer un raccourci vers

votre macro
Si vous utilisez souvent une macro,

vous ne souhaitez sûrement pas aller
dans Outils > Macros > Exécuter la macro,
à chaque fois que vous en avez besoin.
LibreOffice vous permet d'ajouter vos
macros à des menus, barres d'outils,
raccourcis clavier et événements d'ap-
plication. Vous pouvez ajouter vos macros
dans Outils > Personnaliser.

À titre d'exemple, nous allons ajou-
ter un menu nommé Macros dans
Writer et ajouter notre macro Signature
à celui-ci. Outils > Personnaliser. Sélec-
tionnez l'onglet Menus. Cliquez sur le
bouton Nouveau. Nommez le nouveau
menu Macros. Utilisez les flèches pour

le déplacer du bas vers la position avant
Aide. Cliquez sur OK. Votre nouveau
menu est vide pour le moment. Cliquez
sur le bouton Ajouter. Sous catégorie,
cherchez les Macros LibreOffice et navi-
guez dans l'arborescence pour trouver
votre macro. Sélectionnez la macro Signa-
ture et cliquez sur le bouton Ajouter. La
macro est ajoutée au menu. Cliquez sur
le bouton Fermer. Cliquez sur OK dans
la boîte de dialogue Personnaliser. Vous
aurez maintenant un élément de menu
nommé Macros et, sous lui, la macro
Signature. Maintenant, vous pouvez la
choisir dans le menu lorsque vous en
aurez besoin, ce qui est plus rapide que
d'avoir à naviguer jusqu'à Exécuter la
macro.

C'était une très brève introduction
aux macros. Avant de décider d'utiliser
une macro, assurez-vous qu'il n'y a pas
une meilleure façon d'accomplir ce que

vous essayez de faire, mais, pour des
actions répétées souvent, les macros
pourrait bien être la solution que vous
cherchez. Il y a un langage de script
LibreOffice Basic et peut-être nous en
discuterons à l'avenir. Vous pouvez
également télécharger des macros sur
le Web que vous pouvez importer et
utiliser dans LibreOffice.

La prochaine fois, nous reviendrons
à Présentation et au travail sur des
diapositives.

Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a
ajouté de l'Amiga, pas mal de DOS et de
Windows, une pincée d'Unix, et un
grand bol de Linux et Ubuntu.
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L ors de la création d'une pré-
sentation, il est important de

présenter les informations de façon
agréable et instructive. Utiliser les
transitions entre diapositives apporte
un mouvement visuel d'un sujet à
l'autre, et mettre en place des anima-
tions contribue à informer l'auditoire
ou à mettre l'accent sur le sujet
actuel. Une trop grande utilisation des
transitions et des animations peut
donner à votre présentation un aspect
moins professionnel. Mais l'utilisation
appropriée de ces fonctionnalités don-
nera à votre présentation une appa-
rence soignée et professionnelle.

Transitionsentre lesdiapos
Les transitions sont les changements

visuels réalisés lors du passage d'une
diapositive à l'autre. Les transitions
fournissent une indication visuelle à
l'auditoire que vous changez de sujet.
En général, vous utiliserez la même
transition entre toutes les diaposi-
tives, mais, dans certains cas, vous
souhaiterez utiliser une transition dif-
férente pour indiquer un changement
de sujet à l'assistance.

La diapositive que vous souhaitez
modifier étant affichée dans la fenê-

tre principale, choisissez Transition
dans le volet des Tâches. Le menu dé-
roulant vous présente un ensemble
de transitions différentes entre les dia-
positives. Si vous avez coché l'aperçu
automatique au bas du volet Transi-
tion, vous verrez un aperçu de la tran-
sition lorsque vous la choisirez ou mo-
difierez ses paramètres.

Vous pouvez modifier plus profon-
dément la transition dans la section
Modifier la transition du volet. « Vi-
tesse » changera la vitesse à laquelle
la diapositive est affichée. « Son » vous
permettra de jouer un son lors de la
transition. Vous pouvez choisir un son
parmi ceux fournis par défaut ou choi-
sir le vôtre. Une fois que vous aurez
choisi un son, vous pouvez choisir « En
boucle jusqu'au son suivant ». Vous en
aurez rarement besoin, mais il est là le
cas échéant.

Dans la section « Passer à la diapo
suivante », vous définissez comment et
quand vous souhaitez que le diapo-
rama avance. « Au clic » signifie que la
diapositive sera affichée jusqu'à ce
que vous cliquiez avec la souris ou
appuyiez sur la barre d'espace. « Auto-
matiquement après » vous permet de
faire avancer automatiquement le dia-

porama après un nombre défini de
secondes. Lorsqu'il est coché, vous
pouvez régler le nombre de secondes
dans le variateur.

En bas de la fenêtre, vous avez
trois boutons. « Appliquer à toutes les
diapos » fait ce qu'il dit, il joue la
transition entre toutes les diaposi-
tives de la présentation. « Lire » fait
en sorte que la transition se déroule
dans la vue principale. « Diaporama »
démarre la présentation à partir de la
diapositive en cours.

Animations
Les « Animations » sont semblables

à des transitions, mais au lieu d'agir
sur la diapo, elles agissent sur les
objets individuels dans la diapo. Les
animations aident à souligner un point,
créer la fluidité et un intérêt visuel
lorsque vous présenterez les objets
sur une diapo. Elles gardent l'audi-
toire attentif au sujet actuel et agis-
sent comme un repère visuel pour le
présentateur.

Pour créer des animations, choi-
sissez d'abord la diapositive pour la-
quelle vous souhaitez créer des ani-
mations. Choisissez le ou les objets
que vous souhaitez animer, puis ouvrez
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le volet « Animation personnalisée »
dans le volet des Tâches. Cliquez sur
«  Ajouter » et la boîte de dialogue des
animations s'ouvrira. Ici, vous pouvez
choisir l'animation que vous voulez pour
le ou les objets choisis.

Présentation propose quatre types
d'animations différentes :
Entrée : Ces animations sont jouées
pendant l'apparition de l'objet sur la
page.
Accentuation : Ces animations sont
utilisées pour souligner un point par
un changement de couleur, un cligno-
tement, etc.
Quitter : Ces animations paraissent
lorsque l'objet quitte la page.
Trajectoires : Ces animations forcent
l'objet à suivre un chemin défini.

Il y a un cinquième onglet dans la
boîte de dialogue des animations liées
à des objets multimédias. Il vous per-
met de démarrer, arrêter et mettre
en pause des objets multimédias.

Une fois que vous aurez sélec-
tionné votre animation, cliquez surOK.

La section « Effet » du volet ani-
mation vous donne la possibilité d'af-
finer votre animation. « Début » contrôle
l'événement qui va déclencher l'ani-
mation. « Au clic » va déclencher l'ani-
mation lorsque le bouton de la souris
est cliqué ou que vous appuyez sur la

barre d'espace. « Avec le précédent »
déclenche l'animation lorsque l'effet
précédent est joué. «  Après le précé-
dent » joue l'animation après l'effet
précédent. Le second contrôle est di-
rectement liée au type d'animation
que vous choisissez. S'il s'agit d'une

animation Trajectoire, il vous demande
une direction. Si l'animation change
de couleur, il vous demande une cou-
leur. Enfin, la « Vitesse » contrôle la
vitesse à laquelle l'animation se joue.
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Le Podcast Ubuntu couvre toutes
les dernières nouvelles et les pro-
blèmes auxquels sont confrontés
les utilisateurs de Linux Ubuntu et
les fans du logiciel libre en général.
La séance s'adresse aussi bien au
nouvel utilisateur qu'au plus ancien
codeur. Nos discussions portent sur
le développement d'Ubuntu, mais
ne sont pas trop techniques. Nous
avons la chance d'avoir quelques super
invités, qui viennent nous parler
directement des derniers développe-
ments passionnants sur lesquels ils
travaillent, de telle façon que nous
pouvons tous comprendre ! Nous par-
lons aussi de la communauté Ubuntu
et de son actualité.

Le podcast est présenté par des
membres de la communauté Ubuntu
Linux du Royaume-Uni. Il est couvert
par le Code de Conduite Ubuntu et
est donc adapté à tous.

L'émission est diffusée en direct un
mardi soir sur deux (heure anglaise)
et est disponible au téléchargement
le jour suivant.

podcast.ubuntu-uk.org

Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a
ajouté de l'Amiga, pas mal de DOS et de
Windows, une pincée d'Unix, et un
grand bol de Linux et Ubuntu.

Exemple d'animation

La vraie puissance des animations
se voit quand vous les combinez pour
créer des effets intéressants pour vos
objets. Dans notre exemple, l'effet
que nous allons créer va afficher des
éléments dans une liste un par un.
Lorsque l'élément suivant s'affiche, le
précédent va se griser. Enfin, tous les
éléments de la liste disparaîtront avant
la transition de diapo.

Créez une nouvelle diapositive et,
dans la zone de texte, ajoutez quatre
éléments de liste. Sélectionnez-les, puis
cliquez sur Ajouter dans le volet « Ani-

mation personnalisée ». Dans l'onglet
Entrée, sélectionnez « Arrivée » et cli-
quez sur OK. Sélectionnez chacune
des animations dans le volet des ani-
mations et positionnez le démarrage
« Au clic », la direction « À partir du
bas », et la vitesse à une vitesse qui
semble bonne sur votre machine.

Pour l'effet de changement de cou-
leur, choisissez les trois premiers élé-
ments de la zone de texte de la dia-
positive, puis cliquez sur le bouton
Ajouter. Sur l'onglet « Accentuation »,
choisissez « Modifier la couleur de la
police », puis cliquez sur OK. Pour
chacune de ces trois nouvelles ani-
mations, positionnez le début avec
les précédents, la couleur à gris, et la
vitesse à une vitesse qui semble bonne
sur votre machine. Remontez l'anima-
tion de changement de couleur pour
le premier élément à l'aide des flèches
« Modifier l'ordre ». Déplacez-la vers
le haut sous l'animation d'entrée pour
le deuxième point. Remontez la
deuxième animation de changement
de couleur sous la troisième animation
d'entrée et laissez le troisième chan-
gement de couleur sous la quatrième,
l'animation d'entrée.

Enfin, nous allons créer un fondu
pour tous les éléments. Sélectionnez
les quatre éléments de la liste dans la
zone de texte de la diapositive. Cli-

quez sur Ajouter dans le volet Ani-
mation. Dans l'onglet Quitter, choisis-
sez « Dissoudre » et cliquez sur OK.
Réglez la première sortie à démarrer
« Au clic » et les trois autres à « Après
la précédente ». Sélectionnez une vi-
tesse de dissolution qui fonctionne
pour votre machine.

Testez vos animations en cliquant
sur « Diaporama » dans le volet ani-
mation. Si vous avez tout configuré
correctement, chaque élément doit
apparaître en volant depuis le bas et
se griser lorsque vous cliquez avec la
souris. À la fin, les quatre éléments
devraient se dissoudre.

Les transitions et les animations
sont essentielles pour créer une pré-
sentation d'allure professionnelle. Si
vous faites attention et ne vous lais-
sez pas emporter, vous pouvez créer
une présentation soignée et inou-
bliable. Rappelez-vous que l'idée d'une
présentation est de présenter vos
idées à votre public et non pas de les
impressionner avec des transitions et
desanimationsexagéréesetfantaisistes.

http://podcast.ubuntu-uk.org/
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B eaucoup de gens collectionnent
des choses comme les cartes de

sport, les livres, les bandes dessinées
ou les papillons. Parfois, il est utile
d'inventorier ces collections et vous
créez donc un catalogue. Vous décidez
quelles caractéristiques s'appliquent
aux éléments que vous souhaitez sui-
vre, vous constatez que certains élé-
ments ont certaines de ces caracté-
ristiques en commun et vous créez un
système pour identifier chaque élé-
ment de manière unique. Enfin, vous
commencez à construire votre cata-
logue. On peut considérer qu'une base
de données est comme un catalogue
d'articles similaires. Vous avez quelque
chose à suivre ; quelle meilleure façon
de le suivre qu'avec votre ordinateur ?

Base est le module de base de
données pour LibreOffice. Base n'est
pas un moteur de base de données,
mais une interface de présentation
pour interagir avec les bases de don-
nées. Par défaut, Base utilise le mo-
teur de base de données HSQL, qui
est un moteur Open Source, mais vous
pouvez vous connecter à d'autres mo-
teurs comme MySQL ou Oracle. Vous
pouvez même utiliser un tableur com-
me socle de base de données, comme

nous l'avons fait dans la partie 7 de cette
série (voir le numéro 52 du FullCircle).

Lors de la création d'une base de
données, vous obtiendrez de meil-
leurs résultats en vous asseyant et en
prenant le temps de concevoir votre
base de données et son compor-
tement. Vous cartographiez les carac-
téristiques que vous souhaitez suivre,
déterminez les relations en commun
et créez un moyen unique d'identifier
chacun des éléments de la collection.
Prendre le temps de la concevoir vous
permettra d'économiser du temps et
des efforts plus tard, lorsque vous
commencerez à créer des rapports et

des recherches pour votre base de
données.

Ce que fait une base de
données

Avant d'entrer dans la conception
concrète d'une base de données, nous
allons parler de ses parties consti-
tuantes. Le plus petit élément d'une
base de données est le champ. Pensez
à un champ comme une caracté-
ristique unique de l'objet que nous
définissons dans la base de données.
Un ensemble de champs est un enre-
gistrement. Un enregistrement définit

toutes les caractéristiques d'un objet
unique dans notre collection. Nous
créons des tables pour stocker les
enregistrements. Les tables définissent
les champs pour chaque enregistrement
et contiennent la donnée pour cha-
que champ dans les enregistrements.

Pensez à une table de base de
données comme une feuille de calcul
de Calc. En haut, vous avez des co-
lonnes. Les colonnes sont les champs.
Sur le côté, vous avez les lignes. Les
lignes sont les enregistrements. La
feuille de calcul entière, contenant
toutes les données, est la table.

Concevoir notre base
de données exemple

Dans cette série d'articles sur Base,
nous allons utiliser une base de
données que j'ai créée pour le suivi de
ma bibliothèque. J'ai voulu cette base
de données assez simple, mais conte-
nant beaucoup d'éléments pour mon-
trer la nature et les aspects des bases
de données relationnelles, principale-
ment la partie relationnelle. Dans cet
article, nous allons suivre les étapes
de mon travail pour la planification de
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la création de la base de données. Nous
suivrons les étapes que j'ai men-
tionnées.

Quelles caractéristiques
inclure ?

Lorsque j'ai commencé à concevoir
ma base de données Livres, je savais
que je ne voulais pas une grosse chose
compliquée avec des informations que
je n'utiliserais jamais. Je savais que
j'avais besoin des trucs de base comme
titre et auteur. Cependant, j'ai décidé
d'y inclure aussi l'année de publica-
tion. Avec toutes les différentes fa-
çons de « lire » les livres aujourd'hui,
j'ai décidé que j'avais également be-
soin de suivre les différents types de
médias. Ainsi, en fin de compte, j'ai
décidé de retenir ces caractéristiques :

• Titre.
• Auteur.
• Année de publication.
• Type de support.

• Relations.

Ce sont les relations qui mettent
du « relationnel » dans les bases de
données relationnelles. La première
fois que nous examinons notre liste
de caractéristiques, nous pourrions
penser que nous avons besoin tout
simplement d'une table avec quatre
champs. Cependant, nous aurions des
ennuis quand nous avons un livre qui
a plus d'un auteur, ou que nous
possédons un livre dans plus d'un
format. Nous pourrions nous conten-
ter d'auteurs multiples dans un seul
champ, mais ceci rendrait la recher-
che de livres d'un même auteur diffi-
cile. Nous pourrions créer des champs
multiples pour plusieurs auteurs, mais
combien voulez-vous en créer ? S'il
s'agit d'une anthologie, le livre pourrait
avoir de nombreux auteurs. La même
chose est vraie pour les types de
médias.

La réponse est la relation. Les rela-

tions nous aident à relier les données
dans des tables différentes les unes
des autres. Il y a trois relations diffé-
rentes définies pour les bases de don-
nées relationnelles. Un à un : pour cha-
que caractéristique individuelle, vous
avez une seule caractéristique corres-
pondante. À titre d'exemple, pour cha-
que personne, vous pouvez avoir un
seul conjoint. Un à plusieurs : pour
chaque caractéristique individuelle, vous
avez de nombreuses caractéristiques
correspondantes. Dans notre cas, pour
chaque livre, vous pouvez avoir plu-
sieurs auteurs. Plusieurs à plusieurs :
pour de nombreuses caractéristiques,
vous avez de nombreuses caractéris-
tiques correspondantes. À titre d'exem-
ple, dans une école, vous avez beau-
coup d'étudiants qui ont beaucoup de
professeurs différents.

Pour notre base de données, nous
avons deux relations Un à plusieurs.
Pour chaque livre individuel, nous pou-
vons avoir plusieurs auteurs et, pour

chaque livre individuel, nous pouvons
avoir plusieurs types de supports. Nous
allons prendre en considération ces
relations quand nous commencerons
à dessiner notre base de données.

Cartographie de la base
de données

C'est une bonne idée de poser
votre base de données sur papier, ou
en utilisant un logiciel de diagrammes,
avant de commencer à travailler dans
Base. J'ai utilisé le programme Open
Source Dia, car il a un module Unified
Modeling Langage (UML) conçu juste-
ment pour la programmation de dia-
grammes. Dia est disponible dans les
dépôts Ubuntu. Vous n'avez pas be-
soin de savoir beaucoup de choses
sur UML pour dessiner une base de
données. Dans cette section, je vais
vous guider tout au long du processus.

La table principale de notre base
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Le Podcast Ubuntu couvre toutes
les dernières nouvelles et les pro-
blèmes auxquels sont confrontés
les utilisateurs de Linux Ubuntu et
les fans du logiciel libre en général.
La séance s'adresse aussi bien au
nouvel utilisateur qu'au plus ancien
codeur. Nos discussions portent sur
le développement d'Ubuntu, mais
ne sont pas trop techniques. Nous
avons la chance d'avoir quelques
supers invités, qui viennent nous
parler directement des derniers déve-
loppements passionnants sur lesquels
ils travaillent, de telle façon que
nous pouvons tous comprendre !
Nous parlons aussi de la commu-
nauté Ubuntu et de son actualité.

Le podcast est présenté par des
membres de la communauté Ubuntu
Linux du Royaume-Uni. Il est cou-
vert par le Code de Conduite
Ubuntu et est donc adapté à tous.

L'émission est diffusée en direct un
mardi soir sur deux (heure anglaise)
et est disponible au télécharge-
ment le jour suivant.

podcast.ubuntu-uk.org

de données est la table Livres. Nous
savons que nous devons avoir les
champs Titre et Date de publication,
mais nous avons aussi besoin d'un
champ unique pour identifier chaque
enregistrement. Puisque deux livres
pourraient avoir le même titre, nous
allons créer un champ auto-généré
nommé LivreID.

Pour la table des auteurs,
nous avons besoin d'un champ
pour le nom de l'auteur (Nom)
et un champ unique généré
automatiquement (AuteurID).
Deux champs pour la table
médias, aussi : MediaID et
Type.

Maintenant que nous avons nos trois
tables, nous avons besoin de les relier
ensem-ble. La liaison est effectuée
par ce qui est connu sous le nom de
clés étrangères. Une clé étrangère est
un champ utilisé pour créer une
relation avec un enregistrement dans
une autre table. Étant donné que nos
deux relations sont Un à plusieurs,
nous ne pouvons pas simplement
coller un champ dans la table Livres
pour référencer les au-teurs et les
types de médias. Nous allons utiliser
des tables intermé-diaires pour relier
les auteurs et les types de médias
ensemble. Ces tables intermédiaires
contiendront les clés étrangères pour

que les ID puissent créer le lien.
Nous aurons besoin de deux tables

intermédiaires. Nous allons les nom-
mer LivresAuteurs et LivresMedias.
LivresAuteurs aura deux champs nom-
més LivreID et AuteurID, qui relient
en retour les champs ID dans les
tables Livres et Auteurs. Nous faisons
la même chose avec la table Livres-
Medias. Deux champs nommé LivreID

et MediaID, pointant vers
les ID dans Livres etMedias.

J'ai créé un diagramme
UML montrant les relations
entre nos cinq tables. Cha-
que case contient une ta-
ble. Le nom de la table
apparaît dans la partie supé-

rieure de la case. En dessous, nous
énumérons tous les champs de la
table et leurs types. Nous discuterons
des types dans la prochaine partie de
ce tutoriel. Les lignes entre les cases
signalent les relations d'une table à
l'autre. La notation 1 ..1 montre que le
champ a une relation Un pour un avec
le champ de l'autre table. La notation
1 ..n montre que le champ a une
relation Un à plusieurs avec le champ
de l'autre table. Par exemple, LivreID
dans la table Livres est relié à LivreID
dans la table LivresAuteurs. Dans la
table Livres, la notation est 1 ..n pour
LivreID, ce qui signifie qu'un livre peut
faire référence à plus d'un enregis-

trement de la table LivreAuteurs. Pour
LivresAuteurs, LivreID a une notation
de 1 ..1 , ce qui signifie que cela fait réfé-
rence à un enregistrement spécifique
dans Livres.

Grâce à notre travail de concep-
tion, nous pouvons facilement créer
notre base de données sans avoir à
faire beaucoup de changements. Nous
connaissons les tables dont nous
avons besoin et comment elles se
relient les unes aux autres. Même si
vous avez l'impression que cela re-
présente beaucoup de travail, le faire
nous permet, en fin de compte, d'éco-
nomiser beaucoup de temps, parce
que nous avons effectivement pensé
à la façon dont nous construirons
notre base de données et comment
elle va fonctionner.

La prochaine fois, nous construi-
rons nos tables et créerons des
relations dans Base de LibreOffice.
En raison de notre conception, le
processus sera rapide et facile.

Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a
ajouté de l'Amiga, pas mal de DOS et de
Windows, une pincée d'Unix, et un
grand bol de Linux et Ubuntu.

http://podcast.ubuntu-uk.org/
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L es bases de données sont utilisées
pour stocker des informations sur

des objets ou des données. Dans le
tutoriel précédent, nous avons défini la
configuration de notre base de données
de livres. Nous avons conçu nos tables
pour les données et défini les relations
entre ces tables. Maintenant, nous allons
réaliser ce que nous avons prévu et
créer réellement le fichier de base de
données, en ajoutant les tables et en
créant les relations.

Création du fichier de
base de données

Comme je l'ai mentionné précédem-
ment, Base n'est pas un fichier de base
de données, mais une interface pour
accéder à, et manipuler, un fichier de
base de données. Bien qu'il soit possible

de se connecter à de nombreux types
de bases de données différents, nous
allons utiliser la base de données en
HSQL par défaut pour notre base de
données de livres.

Pour lancer l'assistant de base de
données, sélectionnez Base de données
à partir de l'écran d'accueil LibreOffice ou
Fichier > Nouveau > Base de données. Le
premier écran de l'assistant de base de
données nous permet de choisir si nous

voulons ouvrir une base de données exis-
tante ou en créer une nouvelle. Sélec-
tionnez Créer une nouvelle base de
données, puis cliquez sur Suivant.

Le deuxième écran de l'assistant nous
demande si nous voulons enregistrer la
base de données et ce que nous vou-
lons faire une fois que la base de don-
nées aura été créée. L'enregistrement
d'une base de données dans LibreOffice

la rend disponible dans tous nos docu-
ments. Nous n'avons pas besoin de cela
pour notre base de données, vous sé-
lectionnez donc Non - ne pas enregis-
trer la base de données. Cochez Ouvrir
la base de données pour l'édition, puis
cliquez sur Terminer. LibreOffice va ou-
vrir une boîte de dialogue pour définir
un emplacement et un nom pour la
base de données. J'ai simplement nom-
mé le fichier : livres.

Une fois que vous avez un nom et un
emplacement pour le fichier de base de
données, l'écran principal de Base s'ou-
vre. Sur le côté gauche, vous avez les
différents éléments qui peuvent cons-
tituer un fichier de base de données. En
haut à droite, vous avez l'accès aux
différentes actions disponibles pour cha-
que partie et, en bas à droite, il y a les
objets déjà créés.
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Types de champs
Avant de créer notre premier tableau,

nous devons discuter de quelques-uns
des types les plus courants de champs
de base de données. Lorsque vous sélec-
tionnez un type pour un champ, on vous
présente de nombreuses options pour
ce type. Beaucoup de types sont iden-
tiques et sont là pour des raisons de
compatibilité. Les types les plus courants
sont les suivants :

Integer (Entier) : un nombre entier, par
exemple 1 23.
VarChar : une chaîne de caractères de
longueur variable. Vous allez définir
la longueurmaximale de la VarChar.
Date : une valeur de date, bien sûr,
par exemple 1 5/1 0/201 2 (le format
exact spécifique à votre pays).
Temps : une valeur de temps, telle
que 09:1 5:25
Decimal : un nombre réel comprenant
la partie entière et la partie fraction-
naire, par exemple 123,25 (le séparateur
de partie est spécifique à votre pays).

Pour nos besoins, nous allons uti-
liser Integer et VarChar.

Création des tables
Base a trois façons de créer des ta-

bles : grâce à un assistant de table, par
la vue de conception et par des ins-
tructions SQL. L'assistant de table n'est

valable que pour créer des types spé-
cifiques de tables en choisissant parmi
une liste de noms de champs prédéfinis.
La méthode SQL vous oblige à connaître
et à comprendre le langage SQL et dé-
passe le cadre de cet article. La vue de
conception est généralement le meilleur
choix et vous présente une liste que vous
remplirez pour créer votre table. Nous
allons utiliser la vue de conception pour
créer nos tables pour ce projet.

Nous allons commencer avec la table
Livres. Cliquez sur Tables dans le volet
Base de données à gauche. Dans le volet
Tâches, cliquez sur Créer une table en
mode Ebauche… pour ouvrir la boîte de
dialogue Table Design. Dans la partie du
haut vous avez des étiquettes pour cha-
cun des éléments du champ : Nom de
champ, Type de champ et Description.
La description est facultative, mais elle
est utile pour prendre des notes sur la
façon dont un champ est utilisé. En bas,

nous voyons les Propriétés du champ.
Cette section évoluera en fonction du
type de champ que nous choisirons.

Dans le premier champ, entrez le
nom LivreID. Dans la boîte déroulante
du Type de champ, cliquez sur Integer.
À vous de choisir d'ajouter – ou non –
une description. Sous les propriétés du
champ, changer AutoValeur en Oui. Cela
placera une icône de clé dans la case à
côté de l'enregistrement du champ mon-
trant qu'il est l'index primaire (ou clé).
Dans la deuxième ligne, tapez Titre pour
le nom. Donnez lui un type Texte
[VARCHAR]. Là encore, entrez une descrip-
tion si vous voulez. Dans les propriétés
du champ, laissez la longueur à 1 00, la
valeur par défaut pour Texte [VAR-
CHAR]. Le troisième champ est Publié
avec un type mis à Texte [VARCHAR].
Changez la longueur dans les propriétés
du champ à 1 2. J'ai choisi Texte [VAR-
CHAR] plutôt que la date parce que nous

voulons juste l'année et, si la date de
publication d'un livre n'est pas connue,
je peux entrer simplement Inconnue.
Cliquez sur l'icône de sauvegarde et
Base vous invite à entrer un nom de
table. Tapez Livres.

Nos tables pour les auteurs et les
médias sont créées à peu près de la
même manière. Pour Auteurs, créez
deux champs : AuteurID, Integer (Auto-
Valeur Oui); et Nom, Texte [VARCHAR]
(longueur 50). Pour Medias, MediaID,
Integer (AutoValeur Oui) et Pour Type,
Texte [VARCHAR] (longueur 25).

Nos deux tables de clés étrangères
nécessitent un traitement un peu diffé-
rent. Dans LivresAuteurs, créez deux
champs entiers nommés LivreID et Au-
teurID. Cliquez sur la case à côté de
l'icône du premier enregistrement. En
maintenant la touche Maj enfoncée,
cliquez dans la case icône du second.
Ainsi, vous devrez avoir sélectionné les
deux enregistrements. Cliquez droit sur
la case icône, puis choisissez Clé
primaire dans le menu contextuel. Cela
crée une clé combinée. Les deux valeurs
ensemble créent la clé primaire, qui
identifie de façon unique chaque enregis-
trement de la table. Pour la table Li-
vresMedia, créez deux champs entiers
nommés LivreID et MediaID. Sélectionnez
les deux champs, faites un clic droit, et
sélectionnez Clé primaire.
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Créer des relations
Une fois que nous avons défini

toutes nos tables, nous pouvons créer
les relations qui lient tout ensemble.
Nous allons créer des relations entre
nos trois principaux tableaux et nos
tables de clés étrangères. La direction
dans laquelle vous faites glisser les champs
est importante, donc attention à la fa-
çon dont vous le faites.

Pour lancer la boîte de dialogue de
définition de relation (Relation Design),
allez dans Outils > Relations. Une liste
de tables apparaît. Choisissez une table
et cliquez sur Ajouter pour ajouter la
table dans Relation Design. Ajoutez les
tables dans l'ordre suivant pour que ce
soit facile : Auteurs, LivresAuteurs, Livres,
LivresMedia, Media. Une fois que toutes les
tables sont ajoutées, cliquez surFermer.

Faites glisser le champ LivreID de
Livres vers LivreID de LivresAuteurs. Une
boîte de dialogue Relations s'affiche.
Sous les Options de mise à jour, cliquez
sur Mise à jour cascade et OK. Cela for-
cera la mise à jour du champ lors des

mises à jour de la table Livres. Faites
glisser le AuteurID de Auteurs vers Au-
teurID de LivresAuteurs. Sélectionnez
Mise à jour cascade dans la boîte de dia-
logue Relations. Ensuite, faites glisser le
LivreID de Livres vers LivreID de Li-
vresMedias. Sélectionnez Mise à jour
cascade. Enfin, faites glisser MediaID de
Medias vers MediaID de LivresMedias.
Sélectionnez Mise à jour cascade. La
conception de vos relations devrait
ressembler à celle montrée ci-dessous.

Avec nos tables et les relations créées,
nous sommes prêts à commencer notre
travail sur la création de formulaires de
saisie de données. Dans notre prochain
tutoriel, nous allons créer les formu-
laires de saisie de données. L'ensemble
se réunira pour créer un système de saisie
de données utilisable.

Le Podcast Ubuntu couvre toutes les
dernières nouvelles et les problèmes
auxquels sont confrontés les utilisa-
teurs de Linux Ubuntu et les fans du
logiciel libre en général. La séance
s'adresse aussi bien au nouvel utilisa-
teur qu'au plus ancien codeur. Nos
discussions portent sur le dévelop-
pement d'Ubuntu, mais ne sont pas
trop techniques. Nous avons la chance
d'avoir quelques supers invités, qui
viennent nous parler directement des
derniers développements passion-
nants sur lesquels ils travaillent, de
telle façon que nous pouvons tous
comprendre ! Nous parlons aussi de
la communauté Ubuntu et de son
actualité.

Le podcast est présenté par des
membres de la communauté Ubuntu
Linux du Royaume-Uni. Il est couvert
par le Code de Conduite Ubuntu et
est donc adapté à tous.

L'émission est diffusée en direct un
mardi soir sur deux (heure anglaise)
et est disponible au téléchargement
le jour suivant.

podcast.ubuntu-uk.org

http://podcast.ubuntu-uk.org/
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J usqu'à présent, dans notre série
sur Base de LibreOffice, nous avons

conçu la mise en pages de notre base
de données, créé les tables et les rela-
tions entre celles-ci. Maintenant, nous
devons penser à la façon dont nous
allons saisir les données dans les tables
et les relier ensemble. Vous pouvez
modifier les tables manuellement dans
la section des tableaux du programme,
mais la meilleure façon est à travers
des formulaires de saisie. Nous allons
créer trois formulaires : Auteurs, Médias
et Livres. Puisqu'ils sont les plus fa-
ciles, nous traiterons d'abord les for-
mulaires pour les auteurs et les médias.
Le formulaire pour les livres réunira le
tout dans un seul et même endroit.

Créer les formulaires
Auteurs et Médias

Cliquez sur Formulaires dans le volet
Base de données sur la gauche. Vous
pouvez créer des formulaires de deux
manières : par le biais de l'assistant ou
par le mode Création. Nous allons uti-
liser l'assistant pour les auteurs et les
médias. Cliquez sur Créer à partir de
l'assistant… dans le volet des tâches.
Cela démarre l'assistant.

À la première étape de l'assistant,
sélectionnez la table Auteurs dans la
liste déroulante, puis déplacez Nom
vers les Champs à utiliser. Ceci se fait
en sélectionnant le champ et en utili-
sant les touches fléchées. Cliquez sur
Suivant.

La deuxième étape concerne les
sous-formulaires dont nous n'avons pas
besoin dans le formulaire Auteurs. Cli-
quez sur Suivant. Vous remarquerez
que les étapes trois et quatre sont
ignorées. Ces étapes concernent les
sous-formulaires. Nous ne les utilise-
rons pas dans la mise en œuvre de
notre base de données.

La cinquième étape nous demande
une mise en page de nos champs.
Comme nous n'avons qu'un seul champ,
nous allons choisir la disposition en
table. Sélectionnez la forme de table
et cliquez sur Suivant.

La sixième étape concerne l'utili-
sation du formulaire. Nous voulons
que le formulaire affiche toutes les
données, donc sélectionnez toutes les
données et cliquez sur Suivant. L'étape
sept concerne les styles du formu-
laire. Vous pouvez sélectionner diffé-

rentes configurations d'arrière-plan pour
votre formulaire. Vous pouvez égale-
ment choisir si vos boutons sont affi-
chés sans bordure, avec des bordures
en 3D, ou à plat. Cliquez sur Suivant.

À la huitième étape, nous donnons
un nom au formulaire, Auteurs, et choi-
sissons si nous voulons le modifier
encore ou bien l'utiliser. Après avoir
nommé le formulaire, cliquez sur Ter-
miner. Le nouveau formulaire appa-
raîtra sur votre écran. Fermez-le et
enregistrez votre travail.

Le formulaire Médias est créé de la
même manière, en utilisant unique-
ment la table Médias au lieu de la
table Auteurs.

Création du formulaire
Livres

Malgré l'utilisation de l'assistant pour
commencer notre formulaire Livres,
nous aurons besoin de le modifier par
la suite pour ajouter des connexions
aux auteurs et aux médias. Passez à
nouveau par l'assistant avec la table
Livres, en ajoutant les champs Titre et
Publié. Sautez encore les sous-formu-

laires. Nous ajouterons nos sous-for-
mulaires manuellement. Pour la mise
en page, utilisez soit Columnar – Labels
on Top [En colonnes – Étiquettes au-
dessus], soit Columnar – Labels Left
[En colonnes – Étiquettes à gauche].
J'ai utilisé Colonnes – Étiquettes au-
dessus. Après avoir nommé le formu-
laire Livres à l'étape huit, sélectionnez
Modifier la forme, puis cliquez sur
Terminer. Cette fois, le formulaire est
ouvert pour l'édition. Nous allons ajou-
ter deux sous-formulaires pour établir
une connexion avec les auteurs et les
médias.

Dans la barre d'outils au bas du for-
mulaire, sélectionnez le Navigateur de
formulaires. Cela ouvre une petite
fenêtre contenant les éléments de
notre formulaire. Faites un clic droit
sur MainForm, puis Nouveau > Formu-
laire. Un nouveau formulaire est ajouté
à la liste. Comme il est déjà sélec-
tionné, il suffit de commencer à taper
pour le renommer FormAuteurs. Nous
allons utiliser ce sous-formulaire pour
créer le lien vers notre table Auteurs
en passant par la table LivresAuteurs.
Cliquez droit sur FormAuteurs et
sélectionnez Propriétés. Sous l'onglet
Données, choisissez table pour le type
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de contenu, et LivresAuteurs pour le
contenu. Maintenant, cliquez sur le
bouton en ellipse à côté de la liste
Master Field. Une boîte de dialogue
de liaison des champs apparaît. C'est
là que nous créons notre lien entre la
table Livres et la table LivresAuteurs.
Sous LivresAuteurs, sélectionnez LivreID
et sous Livres sélectionnez LivreID.
Cliquez sur OK et vous pouvez fermer
la boîte de dialogue Propriétés du
formulaire.

Créez un autre sous-formulaire sous
MainForm nommé FormMédias. Modi-
fiez les propriétés et définissez comme
table le type de contenu et le con-
tenu à LivresMédias. Cliquez sur l'el-
lipse à côté de la liste Master Field,
puis sélectionnez LivreID sous les deux
LivresMedia et Livres. Cliquez sur OK
et fermez la boîte de dialogue Pro-
priétés du formulaire.

Maintenant, nous devons créer nos
contrôles qui contiennent nos auteurs
et médias. Rappelez-vous, nous avons
besoin de la possibilité d'en sélec-
tionner plus d'un, donc une table est
notre meilleur choix pour le contrôle.
Cliquez sur le bouton Autres con-
trôles dans la barre d'outils sur le côté
gauche. Une barre d'outils Autres Con-
trôles apparaîtra.

Assurez-vous que vous avez le Form-
Auteurs sélectionné dans le Navigateur
de formulaires. Cliquez sur le bouton
Tableau de la barre d'outils Autres
Contrôles. Sous les deux zones de
saisie pour le titre et la date de
publication, dessinez le tableau sur la
page. Faites un clic droit dans la sec-
tion d'en-tête de la nouvelle table et

sélectionnez Insérer une colonne > Zone
de liste. Cliquez droit sur la colonne
nouvellement créée et sélectionnez
la colonne. Cela affiche les propriétés
de zone de liste. Dans l'onglet Gé-
néral, modifiez l'étiquette pour les
Auteurs. Passez à l'onglet Données.
Pour le champ de données, sélec-
tionnez AuteurID. Cette base indique
que nous voulons faire le lien avec le
domaine AuteurID dans le tableau
LivresAuteurs. Pour le type de contenu
de la liste, sélectionnez SQL. Dans la
liste Contenu, nous allons écrire une
courte déclaration SQL pour remplir
notre zone de liste avec les noms de
la table Auteurs. Vous pouvez cliquer
sur la flèche vers le bas afin de vous
donner une petite boîte d'édition
pour travailler. L'instruction SQL est
la suivante :

SELECT “Nom”, “AuteurID” FROM
“Auteurs”

Cette déclaration permet de sélec-
tionner tous les enregistrements de la
table Auteurs. Positionnez à 1 le champ
Liens. Le champ Liens détermine quel
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champ remplira la zone de liste. Comme
nous avons sélectionné le champ
Nom d'abord, la liaison de 1 remplira
la zone de liste avec les données des
champs de Nom. Fermez les proprié-
tés de la zone de liste et enregistrez
votre travail.

Nous allons créer le contrôle des
Médias de la même manière que nous
avons fait pour les auteurs. Sélection-
nez le FormMédias dans le Navigateur
de formulaires. Dessinez le contrôle
de table à la droite de vos contrôles
de titre et de publication. Créez une
colonne dans le contrôle. Ouvrez les
propriétés de la colonne et changez
l'étiquette pour Médias. Définissez le
champ Données à MédiasID et le type
de contenu de liste pour SQL. L'ins-
truction SQL pour le contenu de liste
est la suivante :

SELECT “Type”, “MédiasID” FROM
“Médias”

Définissez la liaison à 1 .

Nous en avons maintenant terminé
avec le formulaire. Enregistrez et fer-
mez-le.

Utiliser les formulaires
Les formulaires Auteurs et Médias

sont simples à utiliser. Il suffit de sé-
lectionner une ligne vide et de taper
le nom ou le type. Vous devrez ajou-

ter vos auteurs et vos types avant
d'utiliser le formulaire Livres. Le for-
mulaire Livres est également facile à
utiliser. Remplissez votre titre et l'année
de publication (ou inconnu si vous ne
connaissez pas l'année). Les tables
Auteurs et Médias vous donnent une
zone de liste à partir de laquelle vous
pouvez sélectionner vos auteurs et
les types de médias. Notez que vous
pouvez sélectionner plus d'un auteur
et type de média. Pour créer un nou-
vel enregistrement, cliquez sur le bou-
ton nouvel enregistrement ou sur sui-
vant dans la barre d'outils de contrôle
de formulaire.

Nous avons maintenant une mé-
thode qui fonctionne pour entrer des
données dans notre base de données.
Mais même si elle fonctionne, il y a un
inconvénient dans cette manière de

faire. Dans le cas où vous avez besoin
d'un auteur ou d'un type qui n'existe
pas, vous devez fermer le formulaire
Livres et ouvrir les formulaires Au-
teurs ou Médias. Dans un futur tutoriel,
nous tenterons de remédier à cet in-
convénient.

Dans le prochain tutoriel, nous
créerons une requête et un rapport
pour extraire des informations de
notre base de données.

Le Podcast Ubuntu couvre toutes
les dernières nouvelles et les pro-
blèmes auxquels sont confrontés
les utilisateurs de Linux Ubuntu et
les fans du logiciel libre en général.
La séance s'adresse aussi bien au
nouvel utilisateur qu'au plus ancien
codeur. Nos discussions portent sur
le développement d'Ubuntu, mais
ne sont pas trop techniques. Nous
avons la chance d'avoir quelques super
invités, qui viennent nous parler direc-
tement des derniers développements
passionnants sur lesquels ils tra-
vaillent, de telle façon que nous pou-
vons tous comprendre ! Nous parlons
aussi de la communauté Ubuntu et
de son actualité.

Le podcast est présenté par des
membres de la communauté Ubuntu
Linux du Royaume-Uni. Il est couvert
par le Code de Conduite Ubuntu et
est donc adapté à tous.

L'émission est diffusée en direct un
mardi soir sur deux (heure anglaise)
et est disponible au téléchargement
le jour suivant.

podcast.ubuntu-uk.org

http://podcast.ubuntu-uk.org/
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S i vous suivez cette série sur Libre-
Office Base, vous avez actuelle-

ment un fichier de base de données
avec des tables et des relations. Vous
pouvez entrer des informations dans
votre base de données avec des for-
mulaires, mais comment récupérer des
informations de la base de données ?
Des Requêtes et des Rapports sont
utilisés pour extraire des données d'une
base de données – les Requêtes défi-
nissent les données à extraire et les
Rapports définissent l'apparence des
données extraites. Nous allons créer
une requête et un rapport pour vous
montrer comment générer un rapport
de vos données.

LA CRÉATION D'UNE REQUÊTE

Les requêtes interrogent la base
de données pour des informations
spécifiques qui s'y trouvent. Il y a trois
façons de créer une requête : avec
l'assistant, en mode ébauche ou en
mode SQL. L'assistant ne fonctionne
pas avec le genre de base de données
relationnelle que nous avons créée et
SQL dépasse les propos de ce tutoriel ;
nous allons donc nous servir du mode
ébauche pour créer notre requête.
Nous allons créer une requête con-

tenant tous les champs importants dans
nos tables : titre, année de publication,
auteur(s) et type(s).

Cliquez sur Requêtes dans le volet
Base de données, puis cliquez sur
Créer une requête en mode Ébauche
dans le volet Tâches. Une ébauche de
Requête s'affichera avec un dialogue
pop-up Ajouter des tables ou une re-
quête. Ajoutez toutes les tables pro-
posées à l'Ébauche de Requête et fer-
mez le pop-up. Le résultat final sera
un dessin qui ressemble à celui des
relations qui nous avons créées précé-
demment. Sous les tables, vous verrez
un formulaire contenant les champs à
inclure dans notre requête. À partir
de la table Livres, faites un glisser-

déplacer de Titre et Publié vers le
formulaire. Faites la même chose pour
Nom à partir d'Auteurs et pour Type à
partir de Média. C'est tout ce dont
nous avons besoin pour cette requête.
Sauvegardez-la sous le nom de
TouslesChamps. Fermez le formulaire
d'Ébauche de requête.

Vous avez maintenant une requête

que vous pouvez utiliser pour créer
des rapports multiples pour votre base
de données. Si vous souhaitez en sa-
voir plus sur le SQL utilisé pour créer
votre requête, vous pouvez faire un
clic droit sur la requête nouvellement
créée et sélectionner Modifier en
mode SQL. Le mode SQL s'affiche
alors avec l'argument complet en SQL
pour la requête que vous venez de
créer. Je vous déconseillerai de l'édi-
ter à moins de très bien connaître le
SQL, mais créer de multiples requêtes
en mode ébauche, puis les visionner
en mode SQL, pourrait vous aider
pour commencer à apprendre le SQL.

LA CRÉATION D'UN RAPPORT

Un rapport exécute une requête
et met les résultats de celle-ci en un
format utilisable. Vous pouvez créer
beaucoup de rapports différents avec
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la requête que nous avons créée -
selon votre façon de regrouper les
données trouvées par la requête.
Nous allons créer un rapport pour le
tri des livres par type de média et je
suggérerai comment vous pourrez
créer d'autres rapports à partir de la
même requête.

Il n'y a qu'une seule façon de créer
un rapport : utiliser l'assistant. Sélec-
tionner Rapports dans le volet Base
de données et cliquez sur Utiliser
l'assistant pour créer rapport… Une
fenêtre de modèle de rapport s'affi-
chera avec l'assistant. Vous pouvez
même regarder le modèle se complé-
ter pendant que vous suivez les étapes
de l'assistant, ce qui vous donnera des
idées sur l'apparence du rapport final.

À la première étape, vous choisi-
rez la requête et les champs qui
seront utilisés pour le rapport. Si vous
ne l'avez pas déjà fait, sélectionnez la
requête TouslesChamps que nous

venons de créer. Déplacez tous les
champs de Champs disponibles vers
Champs du rapport en cliquant sur le
bouton >>. Si vous vouliez créer un
rapport qui ne se sert que de quel-

ques-uns des champs, vous ne sélec-
tionneriez que les champs voulus.
Pour notre rapport, nous allons uti-
liser tous les champs. Cliquez sur
Suivant.

Il faut maintenant (étape 2) éti-
queter les champs. C'est ici que nous
précisons comment les champs doivent
être étiquetés dans le rapport. Chan-
gez le nom de Type en Type de média
et le Nom en Auteur(s). Cliquez sur
Suivant.

Lors de l'étape 3, nous créons nos
groupes. Les groupes contrôlent la
façon dont les champs sont conso-
lidés et organisés dans le rapport. La
création de groupes est importante,
parce que nous pouvons les utiliser

pour créer un rapport tout à fait
différent du premier selon le regrou-
pement des champs. Par exemple, si
vous vouliez créer un rapport de

titres par auteur, vous feriez de Nom
votre premier groupe avec Titre comme
sous-groupe. Pour notre rapport, nous
créons un rapport de Titres par Type
de média. Ainsi, l'ordre des groupes
est Type, Titre, Année de publication.
Nous ajoutons cette dernière car, s'il
y a plus d'un auteur, l'année de pu-
blication se répétera dans le modèle

de rapport, un sous-produit indésiré.
Nous exclurons le champ Nom, parce
que, s'il y a plus d'un auteur, nous

voulons qu'ils soient listés ensemble.
Cliquez sur Suivant.

Le tri est fait à l'étape 4, mais ce
ne serait pas très utile ici. Vous
remarquerez que vous ne pouvez
modifier que l'ordre du tri (Croissant
ou Décroissant) des groupes. Dans la
quatrième case, sélectionnez Nom et

laissez sur Croissant. Cliquez sur
Suivant.

C'est à l'étape 5 que nous choi-
sissons une mise en page pour les
données ainsi que pour l'en-tête. Il y
en a plusieurs pour chaque et ils
modifient l'apparence du rapport. J'ai
laissé les miens par défaut, mais vous
êtes libre de jouer avec ces options si
cela vous chante. Sous la case concer-
nant la mise en page de la liste des
données, vous pouvez choisir si le
rapport est en paysage ou en portrait.
Pour ce rapport-ci, je pense que portrait
sera mieux. Cliquez sur Suivant.
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L'étape finale est la création du

rapport. Vous pouvez lui donner un
titre, indiquer comment le rapport
sera utilisé et que faire avec. Appelez
ce rapport-ci Titrepartype ; mainte-
nant, nous devons répondre à deux
questions. Quel type de rapport vou-
lez-vous créer ? Un rapport statique
est un rapport ponctuel. Il ne peut
pas changer. Une fois créé, les don-
nées sont fixes. Si, cependant, vous
voulez un rapport qui soit réutilisable,
vous voulez un rapport dynamique.
Un rapport dynamique n'est qu'un
modèle que vous pouvez réutiliser.
Pour ce rapport-ci, nous voulons un
rapport dynamique que nous pourrons
réutiliser ; sélectionnez donc Dyna-
mique. Comment voulez-vous procé-
der une fois le rapport créé ? Modifier
la mise en page du rapport vous
permettra d'éditer le rapport en tant
que document Writer. Créer un rap-
port maintenant est explicite ; il rem-
plira les données et générera le
rapport. Nous pouvons toujours modi-
fier la mise en page plus tard ; nous
sélectionnerons donc Créer un rap-
portmaintenant. Cliquez sur Terminer.

Base génère notre rapport et l'af-
fiche dans une fenêtre de Writer. Ce
rapport est en lecture seule. Si vous
voulez changer le texte du rapport ou
sa mise en page, fermez-le. Dans le
volet Rapports, faites un clic-droit sur

votre rapport et Èditer. Le modèle du
rapport s'ouvrira alors dans Writer, où
vous pourrez ajouter du texte, des
graphismes, etc., tout comme vous le
feriez dans n'importe quel document
Writer. Il faut simplement faire atten-
tion quand vous changerez quelque
chose dans les cellules contenant des
données.

Dans ce tutoriel, nous avons créé
une requête et un rapport. Jouez un
peu avec les paramètres de groupe et
de tri dans l'assistant et essayez de
créer un maximum de rapports diffé-
rents à partir de la requête que nous
avons créée.

La prochaine fois, nous utiliserons
des macros pour améliorer notre base
de données de sorte qu'elle agisse un
peu plus comme une application.

SSUUDDOOKKUU 11 66xx11 66
Les numéros de 1 à 9 et les lettres A à F sont à pourvoir dans le
réseau 1 6×1 6 de sorte que chaque rangée, chaque colonne et
chaque boîte 4×4 contienne de 1 à 9 et de A à F.

Jeu aimablement fourni par The Puzzle Club, qui en possède les
droits d'auteur - www.thepuzzleclub.com

http://www.thepuzzleclub.com
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D ans les quatre parties précédentes
de cette série, nous avons pris

notre temps pour construire un docu-
ment de base de données avec le mo-
dule Base de LibreOffice. Nous avons
une base de données avec des formu-
laires pour saisir nos données et des
requêtes et des rapports pour les ex-
traire. Nous avons maintenant un docu-
ment que nous pouvons utiliser pour
l'enregistrement de notre bibliothèque.
Toutefois, le design actuel a un défaut
qu'il faut surmonter. Si nous avons be-
soin de saisir le nom d'un nouvel auteur
ou d'un type de média pendant que
nous nous trouvons dans le formulaire
livres, il faut fermer celui-ci et ouvrir
l'un des autres. Si on avait la possibilité
de saisir les nouveaux auteurs et médias
directement à partir du formulaire livres,
notre base se comporterait davantage
comme une application et la saisie des
données deviendrait encore plus facile.
Nous pouvons le faire avec quelques
courtes macros.

Le langage Basic de LibreOffice est
très similaire à d'autres langages Basic,
tels que Visual Basic for Applications.
Afin de manipuler le document Libre-
Office sous-jacent, nous accédons au
cadre UNO qui contrôle le document.
Le cadre UNO est très complexe, mais
je ferai de mon mieux pour expliquer
les propriétés et les objets que nous

utiliserons. Mon objectif n'est pas de
vous apprendre à écrire des macros
dans LibreOffice, mais de vous montrer
comment vous pourrez les utiliser.

MACROS : SÉCURITÉ ETOPTIONS

Alors qu'il est vrai que les macros
nous permettent de faire des trucs sym-
pas dans nos documents, elles peuvent
également être source de problèmes. Il
y a des individus qui se servent de
macros pour compromettre le système
d'autres personnes ; c'est pourquoi il
faut prendre quelques minutes pour
parler de la sécurité des macros. Que
vous exécutiez LibreOffice sous Linux,
Mac ou Windows, du code malicieux au
sein d'une macro peut compromettre

vos données et éventuellement votre
système tout entier.

La sécurité des macros dans Libre-
Office est simple. Outils > Options ouvre
le dialogue Options pour LibreOffice.
Sous LibreOffice, sélectionnez Sécurité.
Cliquez sur le bouton Sécurité des Ma-
cros… pour afficher les options de
sécurité des macros. Il y en a quatre.
N'utilisez jamais le niveau de sécurité
faible, il exécutera des macros sans vous
demander la permission. Je suggère le
niveau de sécurité moyen. Avec ce
niveau, vous devez indiquer votre choix
– exécuter les macros ou pas – quand
vous ouvrez un document qui en
contient. Les niveaux de sécurité élevé
et très élevé nécessitent un certificat
ou un dossier désigné par vos soins
comme étant de confiance. C'est très
bien, mais je crois que rien ne vaut les
instincts de l'utilisateur. D'habitude, vous
savez si vous vous attendez à ce qu'un
document contienne des macros. Dans
le doute, cliquez sur Non. Cliquez sur
OK pour sauvegarder votre choix et sur
OKpour fermer le dialogue des options.

Et maintenant, amusons-nous.

LES MACROS

Nous allons écrire quatre macros

pour notre document de base de don-
nées. Trois traiteront l'ouverture de for-
mulaires et le dernier mettra à jour les
cases de la liste d'auteurs et de types
de média. En général, la raison d'être
des macros est de faire des choses qui
ne sont pas intégrées dans le programme
ou de simplifier les tâches complexes.
En fait, nos macros font les deux, car
nous allons simplifier les tâches du rajout
d'auteurs et de types de média et nous
allons fournir une fonctionnalité qui ne
fait pas partie du programme.

Avant de commencer à écrire les
macros, nous avons besoin d'un conte-
neur où les mettre. Les macros sont
contenues dans un module. Les modules
peuvent vivre dans le programme même
ou au sein du document. Puisque nos
macros sont spécifiques au fichier de
base de données, nous allons les inté-
grer dans le document. Les macros
intégrées à un document ne sont dis-
ponibles que quand le document est
chargé. Les macros contenues dans un
programme sont disponibles tant que
le programme fonctionne.

Outils > Macros > Gérer les macros >
LibreOffice Basic. La boîte de dialogue
Macros LibreOffice Basic s'affiche. Sé-
lectionnez book.odb dans la zone Ma-
cro [Ndlt : à gauche]. Cliquez sur le bou-
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ton Nouveau [Ndlt : à droite]. Une boîte
de dialogue s'affiche vous demandant
de nommer le module. Appelez-le
AppelsForm. Cliquez sur OK. L'éditeur
de macro de LibreOffice s'affiche. La
macro contient déjà une routine Main
par défaut. Nous n'allons pas utiliser
cette routine. Mettez Sub Main et End
Main en surbrillance et appuyez sur la
touche Retour arrière pour les sup-
primer.

Notre première macro est une rou-
tine généralisée pour ouvrir un formu-
laire. Une routine généralisée est écrite
pour être réutilisée. Nous appellerons
cette routine deux fois à partir d'autres
routines que nous allons écrire. Tapez la
routinemontrée ci-dessus dans l'éditeur.

La première ligne de la routine s'ap-
pelle la signature. C'est la signature qui
détermine la façon dont la routine est
appelée. Une signature commence par
le mot clé Sub, qui définit cet appel
comme subroutine (routine). Ensuite, le
nom de la routine. Dans notre cas
OpenAForm (OuvrirUnFormulaire) est
le nom de la routine. Enfin, entre
parenthèses, nous avons les arguments
utilisés quand on appelle cette routine-
ci. Dans notre cas, nous avons une
variable nommée FormName (NomDu-
Formulaire) qui est un type de String
(Chaîne). À la deuxième ligne de la
routine, Dim est un autre mot clé. Dim
initialise une variable en tant que type
et, éventuellement, en tant que valeur.

Nous définissons une variable nommée
GetForm (ObtenirFormulaire) en tant
que type Object (Objet). La troisième
ligne assigne une valeur à la variable
GetForm avec une chaîne de com-
mandes dans le cadre UNO.

ThisDatabaseDocument (CeDocu-
mentBase) fait référence au document
de base de données actuellement ou-
vert. Ici, il s'agit de book.odb (livre.odb).
FormDocuments est un ensemble de
tous les formulaires dans le document.
Enfin, GetByName (ObtenirParNom)
récupère un objet formulaire spécifique
dans l'ensemble. Remarquez que nous
passons le nom de formulaire déjà passé
à la routine. La quatrième ligne appelle
la méthode Open (Ouvrir) du formu-
laire. À la cinquième ligne nous disons à
Basic que c'est la fin de la routine avec
la commande End Sub.

Nous appellerons la routine Open-

AForm deux fois. Une fois pour ouvrir
le formulaire auteurs et une fois pour
ouvrir le formulaire média. Ajoutez les
deux sous-routines ci-dessous dans votre
éditeur.

La signature sur ces deux routines
est un peu différente. Puisque nous les
appellerons à partir d'un contrôle à
l'intérieur d'un formulaire, il faut passer
l'objet appelant en argument, malgré
le fait que nous ne l'utilisions pas.
L'argument oEv se réfère à l'objet qui
fait l'appel. Nous utiliserons ceci à notre
avantage plus tard, dans la dernière
routine, mais nous le faisons ici parce
qu'il le faut. Ces deux routines sont
assez simples. Nous faisons tout sim-
plement un appel vers OpenAForm
avec le nom du formulaire que nous
voulons ouvrir, Auteurs ou Médias.

La routine finale traite notre pro-
blème du rafraîchissement des données

dans les menus déroulants pour les au-
teurs et les médias quand nous ajou-
tons des auteurs ou médias au moyen
des deux routines ci-dessus.

Sub ListRefresh(oEv as
Object)

oEv.source.model.Refresh

End Sub

Encore une fois, puisque nous allons
appeler cette routine (ci-dessus) à partir
d'une commande, nous avons besoin
d'une référence pour cette com-
mande. Cependant, cette fois, nous
allons utiliser effectivement l'objet. Ce
sous-programme effectue un appel de
méthode pour le modèle sous-jacent
de la zone de liste et rafraîchit les
données de la liste, mettant ainsi à jour
notre liste des auteurs ou des types de
médias. Sauvegardez votre module et
fermez l'éditeur de macro en Basic.

CRÉER DES CONNEXIONS

AUX MACROS

À ce stade, nos macros ne font rien
du tout. Il faut les relier aux objets dans

Sub OpenAForm (FormName as String)
Dim GetForm as Object
GetForm = ThisDatabaseDocument.FormDocuments.GetByName(FormName)
GetForm.Open

End Sub

Sub OpenAuthorsForm(oEv As Object)
OpenAForm("Authors")

End Sub

Sub OpenMediaForm(oEv As Object)
OpenAForm("Media")

End Sub
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notre formulaire afin de pouvoir les
activer quand on en a besoin. Nous
allons d'abord connecter les routines
OpenAForm (OuvrirUnFormulaire) à des
boutons dans notre formulaire et
ensuite nous connecterons la ListRe-
fresh (RafraîchirListe) aux menus dé-
roulants.

Dans le volet Base de données, cli-
quez sur Formulaires. Faites un clic
droit sur le formulaire Livres et sélec-
tionnez Éditer. Ajoutez deux boutons-
poussoirs au formulaire, un sous le ta-
bleau Auteurs et l'autre sous le tableau
Média. Faites un clic droit sur le bouton
sous le tableau Auteurs et sélectionnez
Contrôle pour afficher le dialogue des
propriétés du bouton. Sous l'onglet Gé-
néral, remplacez le nom par Ajou-
terAuteurs et l'Étiquette par Ajouter
Auteurs. Sous l'onglet Événements, cli-
quez sur le bouton (…), à l'extrémité
droite de la ligne, Exécutez l'action, et
le dialogue Assigner une action s'affi-
chera. Cliquez sur le bouton Macro…
pour afficher le dialogue Sélecteur de
macro. Dans l'arborescence sous Libra-
ry (Bibliothèque), sélectionnez livre.odb
> Standard > AppelsForm. Sélectionnez
OuvrirFormulaireAuteurs dans la liste
Nom de la macro et cliquez sur OK.
Cliquez sur OK pour fermer le dialogue
Assigner une action. Fermez le dialogue
des propriétés des boutons.

Faites la même chose pour le bou-
ton sous le tableau Média : nommez-le

AjouterMédia, donnez-lui l'étiquette Ajou-
ter Type Média et assignez la macro
OuvrirFormulaireMedia à l'événement
Exécutez l'action.

Enfin, nous devons ajouter la routine
pour rafraîchir nos listes déroulantes.

Faites un clic droit sur la colonne Au-
teurs dans le tableau auteurs et sélec-
tionnez Colonne. Sous l'onglet Évé-
nements, cliquez sur le bouton (…), à
l'extrémité droite de la ligne, À la
réception du focus. Dans le bouton
Assigner une action, utilisez le bouton
Macro… pour assigner la macro Rafraî-
chirListe à l'action. Ainsi, la liste mettra
à jour les données du tableau Auteurs
quand vous cliquerez sur la liste dérou-

lante dans la colonne. Faites la même
chose pour la colonne Média dans le
tableau média. Enregistrez vos modifi-
cations dans le formulaire Livres et
fermez-le.

TESTER LES MODIFICATIONS

Chaque fois que nous changeons
quelque chose dans les formulaires, il
faut les tester pour nous assurer que
tout fonctionne, surtout là où nous
avons utilisé des macros. Une seule faute
de frappe pourrait causer d'énormes
problèmes. Double-cliquez sur le formu-
laire Livres pour l'ouvrir. Ajoutez-y un
nouveau livre dont l'auteur et le type
de média n'existent pas encore. Cliquez
sur le bouton Ajouter Auteurs pour
vérifier qu'il ouvre le formulaire. Ajou-
tez-y quelques auteurs ; fermez le for-
mulaire Auteurs. Cliquez sur le menu
déroulant auteurs et vérifiez que les
auteurs que vous venez d'ajouter y
figurent. Faites le même test avec le
bouton Ajouter Type Média et le menu
déroulant.

QUELQUES RÉFLEXIONS ET

RÉFÉRENCES POUR TERMINER

À nouveau, j'aimerais souligner la
complexité de l'écriture de macros avec
LibreOffice Basic. Il n'y a pas beaucoup
de documentation, mais elle existe. Si
relever le défi vous intéresse, voici
quelques références pour vous aider à
commencer :
LibreOffice Basic Guide :
http://wiki.documentfoundation.org/i
mages/d/dd/BasicGuide_OOo3.2.0.odt
Andrew Pitonyak's OpenOffice Macro
Information :
http://www.pitonyak.org/oo.php
Un livre (payant) en français :
http://www.eyrolles.com/Informatiqu
e/Livre/programmation-openoffice-
org-et-libreoffice-978221 21 32472

Vous trouverez les macros utilisées
dans ce tutoriel sur pastebin.com à
http://pastebin.com/MU2Ztizi

La prochaine fois, nous continue-
rons notre exploration de la suite
bureautique LibreOffice avec le mo-
dule Formule.

http://wiki.documentfoundation.org/images/d/dd/BasicGuide_OOo3.2.0.odt
http://www.pitonyak.org/oo.php
http://pastebin.com/MU2Ztizi
http://www.eyrolles.com/Informatique/Livre/programmation-openoffice-org-et-libreoffice-9782212132472
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T ravaillant dans un traitement de
texte, avez-vous déjà eu le besoin

d'insérer une formule dans votre texte ?
Vous étiez peut-être en train de faire
un devoir de maths ou de sciences
pour vos études universitaires, ou
vous répondiez même à une question
sur les statistiques. Si vous avez besoin
de saisir n'importe quoi au-delà des
maths élémentaires, vous rencontrerez
rapidement des problèmes de formatage.
LibreOffice résout ce problème en vous
fournissant le module Math ou For-
mule. Vous pouvez utiliser le module
seul pour créer des formules, ou l'utiliser
directement dans les autres modules
de LibreOffice. Aujourd'hui, nous appren-
drons comment saisir des formules dans
l'éditeur de Math et, dans des articles
à venir, nous apprendrons comment
utiliser des formules dans Writer.

Ouvrez une nouvelle fenêtre Math
en cliquant sur le bouton Formule
dans le Centre de démarrage de Libre-
Office ou en utilisant les menus avec
Fichier > Nouveau > Formule.

LA FENÊTRE DE FORMULE

La fenêtre de Formule a trois parties :
le volet aperçu, l'éditeur de formule

et la fenêtre des Éléments. Le volet
aperçu, en haut, vous montre votre
formule pendant que vous la créez.
L'éditeur de formule en bas est l'en-
droit où vous saisissez votre formule.
La fenêtre flottante Éléments vous four-
nit des raccourcis vers des éléments
de formule divers. Pensez aux élé-
ments comme des composants de base
pour la création de votre formule.

TROIS FAÇONS POUR SAISIR

DES FORMULES

Il y a trois façons de saisir des for-

mules dans l'éditeur de formules : en
passant par la fenêtre des Éléments,
en passant par un menu contextuel
ou directement.

LA FENÊTRE DES ÉLÉMENTS

La fenêtre des Éléments est divisée
en deux sections. Celle du haut est la
section catégorie et celle du bas con-
tient les éléments dans cette catégo-
rie-là. Si vous sélectionnez une catégo-
rie, puis cliquez sur l'un des éléments
dans cette catégorie, le programme
saisira l'élément dans l'éditeur avec
<?> qui sert de caractère générique

pour les variables de l'élément. Le
premier caractère générique est mis
en brillance. Utilisez la touche F4 pour
aller jusqu'à l'élément suivant. MAJ-
F4 vous fera revenir à l'élément pré-
cédent.

Pour vous aider à vous familiariser
avec la fenêtre Éléments, je vais vous
accompagner pas à pas dans l'écriture
d'une formule en utilisant la fenêtre
Éléments. Dans une nouvelle fenêtre
Formule, sélectionnez la catégorie Re-
lations, puis l'élément Égal. <?> = <?>
s'affiche dans l'éditeur de formule. Le
premier <?> est en surbrillance. Sai-
sissez la lettre « h ». Appuyez sur F4
pour aller à l'autre <?>. Sélectionnez
la catégorie Fonctions, puis l'élément
Racine carrée. Le <?> est remplacé par
sqrt{<?>} et le caractère générique à
l'intérieur des accolades est mis en
surbrillance. Sélectionnez la catégorie
Opérateurs unaires/binaires, puis l'élé-
ment Addition. Le programme insère
<?> + <?> entre les accolades de la
Racine carrée. Sélectionnez la catégorie
Formats, puis l'élément Exposant droit.
Le caractère générique en surbrillance
est remplacé par <?>^{<?>}. Entrez la
lettre « a » et appuyez sur F4 pour aller
au caractère générique suivant. Sai-
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sissez le nombre « 2 ». Appuyez sur F4
pour aller jusqu'au caractère géné-
rique suivant. Sélectionnez l'Exposant
droit dans la catégorie Formats. Sai-
sissez la lettre « b » et appuyez sur F4
pour aller au dernier caractère géné-
rique. Entrez le nombre « 2 ». Le résul-
tat final ressemblera à ceci :

et le texte dans l'éditeur de formules
est :

h = sqrt{a^{2} + b^{2} }

LE MENU CONTEXTUEL

Le menu contextuel (voir ci-dessous
à droite) est très similaire à la fenêtre
des Éléments. Faites un clic droit dans
l'éditeur de formules et un menu com-
posé de toutes les catégories s'affi-
chera. Dans chaque catégorie, il y a un
sous-menu des éléments. Cliquez sur
un élément pour l'insérer dans l'édi-
teur de formules. Suivez l'exemple ci-
dessus à nouveau, mais, cette fois-ci,
utilisez le menu contextuel, obtenu
par un clic droit, pour créer la for-
mule. Vous devriez avoir les mêmes
résultats.

SAISIE DIRECTE

En travaillant avecMath et en appre-
nant les éléments, il vous sera possible
d'entrer les formules directement dans
l'éditeur de formules. C'est la façon la
plus rapide de saisir une formule, et
de loin. Ayant maintenant créé la
formule deux fois, avec la fenêtre des
Éléments et avec le menu contextuel,
essayez de la saisir directement dans
l'éditeur sans utiliser les outils d'élé-
ment. Si vous avez besoin d'aide, il
suffit de regarder le texte dans l'édi-
teur montré à la page précédente.

CARACTÈRES SPÉCIAUX

Vous ne trouverez pas, dans la
fenêtre des Éléments et le menu
contextuel, tout ce dont vous avez
besoin. Beaucoup d'équations utilisent
des caractères grecs et d'autres sym-

boles. LibreOffice Math vous permet
de saisir des caractères spéciaux dans
votre équation. Si vous avez besoin
d'un caractère spécial qui n'est pas
listé parmi les caractères spéciaux,
vous avez même la possibilité d'ajouter
vos propres caractères.

L'AJOUT DE CARACTÈRES GRECS

Avec Outils > Catalogue… vous pou-
vez accéder aux caractères grecs au
moyen des sous-ensembles de ca-
ractères Grec et iGrec. Grec vous
donne les lettres en texte sans for-
matage et iGrec vous donne les
lettres en italique. Il suffit de sélec-
tionner le caractère que vous voulez,
puis de cliquer sur le bouton Insérer.
Quand vous aurez terminé, cliquez
sur le bouton Fermer. Pour une saisie
en direct, tapez « % » suivie du nom
de la lettre grecque. Par exemple,
pour avoir la lettre grecque pi,

saisissez %pi. Pour avoir la lettre
majuscule, tapez son nom en majus-
cules, %PI. Pour que le caractère soit
en italique, mettez un petit « i »
devant le nom de la lettre, %ipi.

D'AUTRESCARACTÈRESSPÉCIAUX

Vous trouverez d'autres carac-
tères spéciaux dans Outils > Cata-
logue > sous-ensemble Spécial. Choisis-
sez le symbole dont vous avez besoin
et cliquez sur le bouton Insérer. Au
fur et à mesure que vous utilisez et
apprenez le nom des symboles, vous
pouvez les saisir directement avec le
% puis le nom du symbole.

NOTA : Le petit « i » pour italique ne
fonctionne qu'avec les lettres grec-
ques. Nous allons parler de l'insertion
d'italiques pour d'autres éléments dans
le prochain tutoriel.

L'AJOUTDE CARACTÈRES
SPÉCIAUX

Si le catalogue ne contient pas le
caractère spécial dont vous avez besoin,
vous pouvez l'y ajouter. Un tel caractère
est le symbole prime. Ajoutons-le à
notre sous-ensemble spécial. Outils >
Catalogue et choisissez l'ensemble
des symboles Spécial. Cliquez sur le
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bouton Éditer. Le dialogue Édition des
symboles s'affichera. Pour la Police
sélectionnez DejaVu Sans et, pour la
Plage sélectionnez Ponctuation générale.
Le symbole que vous voulez est
Ux2023. Pour le nom du symbole,
tapez prime. Cliquez sur les boutons
Ajouter et OK. Le symbole prime
vient d'être ajouté à la liste des
symboles spéciaux. Vous pouvez l'uti-
liser en le sélectionnant dans le
catalogue ou en tapant directement
%prime.

CONCLUSIONS

Math vous permet de créer des
formules que vous pourrez insérer
dans vos documents. Il y a trois mé-
thodes pour entrer des formules dans
l'éditeur de formules : en passant par

la fenêtre Éléments, en passant par le
menu contextuel ou, alors, par saisie
directe. La fenêtre Éléments et le
menu contextuel vous aident à ap-
prendre comment entrer les diffé-
rents éléments d'une formule, mais,
une fois que vous savez comment
faire, la saisie directe est la façon la
plus rapide de créer une formule.

Dans le prochain tutoriel LibreOffice,
nous examinerons comment formater
nos formules pour qu'elles s'affichent
comme on veut.

Elmer Perry a commencé à
travailler et programmer sur Apple IIE,
puis il y a ajouté de l'Amiga, pas mal de
DOS et de Windows, une pincée d'Unix,
et un grand bol de Linux et Ubuntu.
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L orsque vous créerez des formules
plus complexes dans le module

Math, vous découvrirez rapidement que
les choses ne se présentent pas de la
manière dont vous l'auriez souhaitée.
Il existe quelques astuces pour présen-
ter ces formules de la manière voulue,
particulièrement pour les formules
complexes. Aujourd'hui, nous allons
donc aborder nombre de ces astuces
pour présenter correctement nos for-
mules.

GROUPER DES ÉLÉMENTS

AVEC DES ACCOLADES

Les accolades, {}, sont réservées à
des usages bien spécifiques dans les
formules. Elles vous aident à regrou-
per des éléments. Sans elles, vous
pourriez obtenir une formule bien dif-
férente de celle que vous souhaitez.
Suit une série d’exemples pour illus-
trer ce que je veux dire.

Saisissez l'expression suivante
dans l'éditeur de formules :

2 over x + 1

Vous devez obtenir
le résultat suivant :

Mais que faire si vous voulez pla-
cer le x+1 au dénominateur de la frac-
tion ? Vous devez utiliser les accolades
pour regrouper ces deux éléments.

Saisissez la même formule dans
l'éditeur, mais avec des accolades
autour de l'addition :

2 over {x + 1}

Vous obtenez le résul-
tat désiré.

Dès que la formule ne se présente
pas de la manière attendue, vous pou-
vez utiliser les accolades pour regrou-
per des éléments et les faire apparaî-
tre correctement. Vous découvrirez
davantage de possibilités d'utilisation
de ces accolades quand nous travaille-
rons sur d'autres exemples dans ce
tutoriel.

ÉQUATIONS SUR PLUSIEURS

LIGNES

Certaines équations prennent plus
de sens si elles sont écrites sur plu-
sieurs lignes ou si vous avez besoin de
présenter la progression d'une formule
étape par étape, du début à la fin.

Conserver tout cela sur une seule
ligne rendra difficile la lecture de cette
formule. Cependant, appuyer sur la
touche Entrée ne donnera pas le
résultat escompté. Afin d'obtenir une
nouvelle ligne dans la formule, il faut
utiliser l'élément newline.

Un exemple dans l'éditeur de for-
mules :

x over 250 = 5 over 100
newline
100x = 250(5) newline
100x = 1250 newline
100x over 100 = 1250 over
100 newline
x = 12.5

et le résultat :

LIMITES DE SOMME ET

D'INTÉGRALE

Les commandes sum (somme) et
int (intégrale) peuvent accepter des

paramètres optionnels pour préciser
l’intervalle de la somme ou de l'inté-
grale. Les mots clefs « from » (de) et
«  to » (à) génèrent les limites inférieures
et supérieures d'intervalle de ces com-
mandes. Le balisage suivant le montre :

sum from x=0 to x=n f(n) "
or "
int from x to n f(n+1)

Voici le
résultat :

M ISE À L'ÉCHELLE DES

PARENTHÈSES

Il arrive parfois que vous ayez
besoin de parenthèses qui occupent
plus d'une ligne. Un bon exemple serait
une matrice. Si vous utilisez juste le
caractère parenthèse, vous obtenez
une bien vilaine matrice.

Le balisage :

(matrix {x#x+1##y#y+1})

et le résultat :

Pour ajuster la taille de la paren-
thèse à celle de la matrice, nous devons
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utiliser le balisage « left (» (gauche) et
« right) » (droite). Cela permet d'obtenir
une matrice au visuel plus plaisant.

Le balisage :

left(matrix {x#x+1##y#y+1}
right)

et le résultat :

Pour une mise à l'échelle des cro-
chets, l'instruction est « left [ » et
«  right ] ». Pour celle des accolades, l'ins-
truction est alors « left lbrace » et « right
rbrace ». Vous trouverez une liste com-
plète de toutes les parenthèses dispo-
nible dans l'aide de LibreOffice [Ndt :
touche F1 ].

PARENTHÈSES DISSOCIÉES

Il se peut que vous ayez besoin de
temps en temps d'une parenthèse et
non de la paire. Et si vous ouvrez une
parenthèse sans la fermer, vous obte-
nez un point d’interrogation inversé
et l'équation apparaît désordonnée.
Pour surmonter cette difficulté, il faut
utiliser les instructions « left none »
(pas à gauche) ou « right none », selon
ce que vous souhaitez obtenir, pour
préciser que vous n'avez pas de paren-
thèse ouvrante ou fermante.

Un bon exemple est celui de la
définition mathématique de la suite

des Nombres de Lucas.

Le balisage :

L_n = left lbrace
matrix{2 # if n = 0; ##
1 # if n = 1; ##
L_{n-1} + L_{n-2} # if n >
1.}
right none

et le résultat :

Il est à noter que j'ai terminé la
définition avec un « right none » pour
qu'elle s'affiche correctement.

ALIGNERDES ÉLÉMENTS EN

UTILISANTL'INSTRUCTIONMATRIX

Vous aurez remarqué (dans la défi-
nition de la suite de Nombres de Lucas)
que j'ai utilisé une matrice pour tout
aligner correctement. La commande
matrix (matrice) est très utile pour cela,
parce que Math ne possède pas de
commande pour faire un alignement
selon un élément précis. Grâce à la
commande matrix, nous pouvons
utiliser les colonnes et les lignes pour
aligner nos éléments comme nous le

souhaitons. Un bon exemple de cela
est d'aligner des équations selon le
signe égal.

Par exemple, le balisage :

matrix {
3x + 2x # `=` # 45 ##
alignr 6x # `=` # 45
}

et le résultat :

Vous avez remarqué l'accent grave
(` ) de part et d'autre du signe égal.
Cela est nécessaire parce que le signe
égal est un opérateur binaire et qu'il
demande une expression avant et
après. L'accent grave (` ) est le bali-
sage d'une petite espace dans Math.
Vous pouvez obtenir de la même ma-
nière une grande espace avec l'instruc-
tion (~) ou utiliser des accolades vides
({}). Souvenez-vous que dans une ma-
trice tout ce qui est entre deux dièses
(#) est une expression indépendante.

Vous aurez aussi remarqué que,
dans la seconde ligne, j'ai utilisé
l'instruction « alignr » pour aligner le
6x à droite dans sa colonne. Utilisez
«  alignl » pour aligner à gauche et
«  alignc » pour centrer. Les expressions
sont centrées par défaut, sauf dans
les matrices, dans lesquelles, par dé-
faut, l'alignement se fait à gauche.

SAISIR DU TEXTE DANS UNE

FORMULE

Parfois, il se peut que vous ayez
besoin d'ajouter des notes ou du texte
dans votre formule. Vous pouvez le
faire en encapsulant ce texte entre des
guillemets (””).

Par exemple :

c^2 = a^2 + b^2 newline
"The Pythagorean Theorem."

et le résultat :

SAISIRDES FORMULES CHIMIQUES

Math a été conçu pour écrire des
équations mathématiques, mais vous
pouvez aussi l'utiliser pour des for-
mules chimiques. Comme les variables
sont traditionnellement écrites en ita-
lique, vous devrez supprimer la mise
en forme italique pour les variables
(voir plus bas).

Un exemple d'instruction :

matrix {
"molecules" # H_2 SO_4 ##
"Isotopes" # U lsub 92 lsup
238 ##
"Ions" # SO_4^{2-{}}
}
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et le résultat :

Remarquez les instructions « lsub »
et « lsup ». L'instruction « lsub » im-
plique une mise en indice à gauche et
« lsup », en exposant à gauche. [Ajout
du traducteur : utiliser « rsub » pour
une mise en indice à droite et « rsup »,
en exposant à droite.] Vous aurez
également besoin d'ajouter quelques
doubles flèches particulières à votre
catalogue pourvos formules chimiques.

MISE EN COULEUR, EN GRAS,
EN ITALIQUE

Les instructions color (mise en
couleur), bold (gras) et ital (italique)
vous permettent d'amplifier l'impact
de votre formule. Elles ne modifient
que l'élément qui les suit. Pour modi-
fier plusieurs éléments, vous devez
donc les regrouper avec des
accolades.

Un exemple :

bold color blue c^2 = color
red {a^2 + b^2} newline
ital color green "The
Pythagorean Theorem"

et le résultat :

Notez que j'ai regroupé les élé-
ments de la somme pour qu'ils s'ins-
crivent en rouge. Pour le c2, j'ai combiné
les instructions relative à la couleur et
à la mise en gras. Il existe huit couleurs :
black, white, cyan, magenta, red, blue,
green et yellow.

MODIFIER LAPOLICE ET LA

TAILLE DE LAPOLICE

Certaines fois, vous voudrez utiliser
une police de caractères ou une taille
différente de celle définie par défaut.
Format > Police… affiche la fenêtre de
dialogue pour modifier la police des
variables, fonctions, nombres et textes.
Vous pouvez ici configurer l'usage de
certaines polices personnalisées. For-
mat > Taille de police… affiche la fenêtre
de dialogue relative aux tailles. Vous

définissez la taille de base et les tailles
des divers éléments sont adaptés en
tant que pourcentage de cette taille
de base.

MODIFIER L'ALIGNEMENT ET

L'ESPACEMENTDES ÉLÉMENTS

Parfois, il est nécessaire de modifier
l'alignement et l'espacement des élé-
ments de la formule générale. Format
> Espacement… affiche la fenêtre de
dialogue. Par la liste déroulante de
Catégorie (Category) vous sélectionnez
le type d'espacement que vous vou-
lez modifier. Vous définissez les divers
espacements pour les éléments sous
forme de pourcentages de la largeur
ou de la hauteur des éléments, en fonc-
tion du type d'espacement.

Par exemple, si nous voulons chan-
ger l'espacement pour l'alignement
sur le signe égal, comme nous l'avons
fait plus tôt, nous devons sélectionner
matrices dans la catégorie. Si nous
mettions un pourcentage à 0 pour
l'espacement entre les colonnes, les
expressions iront buter contre le
signe égal.

Le résultat :

Format > Alignement… affiche la
fenêtre de dialogue Alignement. Là,
nous pouvons changer l'alignement
par défaut de la formule : à gauche, à
droite et centré.

CONCLUSION

Les nombreuses options de for-
matage de votre formule peuvent vous
décourager, mais vous les maîtriserez
avec la pratique. La première et la plus
importante idée à retenir est l'utilisa-
tion des accolades pour regrouper des
éléments dans une formule. Regardez
dans la boîte de dialogue Éléments
ou le menu contextuel en cas de
doute sur la façon de faire quelque
chose ; en outre, vous voudrez peut-
être garder cet article à portée de
main comme référence.

Le mois prochain, nous discuterons
de l'utilisation de formules dans Libre-
Office Writer.
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Ê tre capable de créer des formules
dans le module Math de LibreOffice

est bien, mais comment faire si vous
devez insérer une formule dans un
document texte ? L'intégration entre
Writer etMath vous permet d'insérer des
formules dans votre texte, de nu-
méroter les équations, de référencer les
équations numérotées et d'insérer des
équations créées dans le module Math.

INSERTION D'UNE FORMULE

DANSWRITER

Une formule s'insère par les menus
Insertion > Objet > Formule. L'éditeur
de formules s'ouvre en bas de la fe-
nêtre de Writer et la fenêtre flottante

Éléments s'ouvre aussi. [Ndt : Elle s'ac-
tive/se désactive par le menu Affichage
> Éléments.] Une bordure de cadre appa-
raît dans le document où la formule
sera affichée. Vous pouvez utiliser l'édi-
teur de formules comme vous le feriez
dans le module Math. Lorsque vous
aurez fini de créer votre formule,
appuyez sur la touche Échappe ou
cliquez n'importe où dans le document,
en dehors du cadre de la formule.

Dans Writer, les formules sont des
objets OLE et, par défaut, sont insérées
en tant que caractères, ce qui signifie
qu'elles restent sur la même ligne que
le texte. Vous pouvez modifier la façon
dont le texte s'adapte autour de la for-
mule en changeant le point d'ancrage.

Faites un clic droit sur la formule, Ancrer
> À la page. La formule étant ancrée à
la page, vous pouvez la déplacer à l'en-
droit où vous voulez dans le document.

TRANSFORMER L'ÉDITEUR DE

FORMULES EN UNE FENÊTRE

FLOTTANTE

Si l'éditeur de formules fixé en bas
de la fenêtre ne vous convient pas,
vous pouvez le détacher comme une
fenêtre flottante en appuyant sur Ctrl
et en double-cliquant sur la bordure.
Vous pouvez également cliquer dessus
et faire glisser la bordure pour détacher
l'éditeur de formules. Une fois qu'il est
détaché, vous pouvez le déplacer à

l'endroit qui vous convient le mieux.
Appuyez sur Ctrl et double-cliquez sur
la bordure pour de nouveau attacher
l'éditeur de formules en bas de l'écran.

NUMÉROTER ET RÉFÉRENCER

DES ÉQUATIONS

Souvent, vous aurez besoin de numé-
roter les équations afin de les référencer
dans votre texte. Writer vous facilite la
gestion de ces références. La numéro-
tation des équations est l'une des
meilleures fonctions cachées de Writer.
Sur une nouvelle ligne dans Writer,
tapez « nf » et appuyez sur F3. Le « nf »
est remplacé par une équation numé-
rotée. Double-cliquez sur l'équation
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pour la modifier et insérer votre propre
équation.

Pour créer une référence à l'équa-
tion numérotée, choisissez dans la barre
de menus Insertion > Renvoi. Dans le
champ Type de champ [Ndt : page pré-
cédente, image de col. 3 et 4, à gauche],
sélectionnez Texte. Dans la liste de
sélection [Ndt : Sélection à droite], sélec-
tionnez l'équation que vous souhaitez
référencer. Dans la zone Insérer une
référence à, sélectionnez Référence ou
Numérotation. Référence comprendra
la parenthèse, mais Numérotation utili-
sera juste un nombre.

MODE TEXTE

Dans la plupart des cas, vous aurez
numéroté et référencé vos grandes for-

mules. Parfois, vous aurez besoin d'uti-
liser une formule plus importante dans
le corps du texte. Lorsque vous le ferez,
utilisez Format > Mode texte lors de
l'édition de la formule. Ce Mode texte
va tenter d'adapter la formule à la hauteur
du texte. Numérateurs et dénominateurs
sont réduits, et les limites pour les som-
mes et intégrales sont « poussées » vers
la droite plutôt que vers le haut et le bas.

MODIFICATION DE L'OBJET

FORMULE

Comme je l'ai mentionné plus tôt,
les formules sont affichées dans des
cadres d'objets OLE dans Writer. Cela
signifie que vous pouvez ajouter des
arrière-plans, des bordures, des retours
à la ligne et des marges à votre for-
mule. Pour changer un cadre d'objet

formule, sélectionnez la formule en cli-
quant une fois, et Format > Cadre/Ob-
jet dans le menu. La boîte de dialogue
de l'objet s'ouvre. Vous pouvez éga-
lement ouvrir la boîte de dialogue
objet par un clic droit sur la formule,
puis cliquer sur Objet.

Si vous avez besoin de définir par
défaut un élément qui s'applique à
tous les objets formule, vous pouvez
modifier le style de cadre de la formule
dans la fenêtre des styles. Vous trou-
verez le style de formule dans la caté-
gorie des cadres de la fenêtre Styles et
formatage. [Ndt : menu Format > Styles
et Formatage ou F1 1 .]

CRÉER UNE BIBLIOTHÈQUE DE

FORMULES

Si vous utilisez souvent des for-
mules dans vos documents, vous
pouvez créer une bibliothèque de
formules. Lorsque vous enregistrez des
formules créées dans le module Math,
elles se sauvegardent sous forme de
fichiers ODF. Vous pouvez enregistrer
des formules à partir de vos documents
à l'aide du clic droit et en sélectionnant
« Enregistrer la copie sous ».

Pour insérer une formule à partir de
votre bibliothèque, sélectionnez Inser-
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tion > Objet > Objet OLE dans la barre
de menus. Sélectionnez « Créer à partir
d'un fichier » et recherchez ou tapez le
chemin d'accès au fichier ODF à insérer.

CONCLUSION

L'utilisation de formules dans Writer
est réellement très facile, elle rend la
création de documents contenant des
formules mathématiques poussées une
tâche assez simple. Vous pouvez numé-
roter les formules et les référencer
dans votre texte. Par l'utilisation du
mode texte, vous pouvez créer des for-
mules dans vos paragraphes qui s'ali-
gnent aussi bien que possible avec le
flux du texte. Vous pouvez changer
l'apparence de votre formule en édi-
tant le cadre de l'objet OLE inséré.
L'export, puis l'import, de formules que
vous créez dans le module Math est
possible dans votre document Writer
par l'insertion d'un objet OLE.

CRITIQUE RAPIDE : UBUNTU 4.1 0
par Anas Alsaidy

Après avoir téléchargé le fichier ISO, je l'ai gravé sur un CD, redémarré mon ordinateur, et j'ai lancé le CD. J'ai eu un
problème avec le CD qui ne voulait pas démarrer, mais restait bloqué au niveau du chargement. Donc, j'ai dû l'essayer
par le biais de VirtualBox. Dans VirtualBox, je n'ai eu aucun problème avec le démarrage et cela a fonctionné
exactement comme prévu.

La première chose que j'ai remarquée, c'est le bon vieil environnement de bureau GNOME que j'ai vraiment aimé. La
deuxième chose était les anciennes versions des applications modernes tels que GIMP, OpenOffice, Gedit, etc.

Inconvénients :
• Je n'aimais point le papier peint, qui était affreux, même pour un OS sorti en 2004.
• Je n'aimais pas le thème brun laid non plus. Heureusement, cependant, il y avait beaucoup de thèmes entre lesquels
je pouvais basculer.
• Un problème est survenu et je ne pouvais pas sauvegarder quoi que ce soit, mais je pense que c'était la faute à mon
ordinateur.

Avantages :
• Il est rapide. Vraiment rapide.
• Je n'ai pas eu de problèmes avec les tâches multiples.
• J'ai vraiment aimé les vieux menus GNOME ainsi que le gestionnaire des paramètres. Mais vraiment pas, pas le
thème !

J'ai déjà dit que ça allait vite ; parce qu'il est vraiment rapide, j'ai lancé beaucoup d'applications et tout s'est bien passé,
sauf pour GIMP. Il ralentissait tout le système et j'ai dû redémarrer la machine, mais ce n'était pas un problème, car
j'utilisais VirtualBox. Et tout le reste était très rapide.

Ubuntu 4.1 0 était certainement un excellent système, mais apparemment il ne
peut pas remplacer les nouvelles versions d'Ubuntu. Mais, sincèrement, j'ai
vraiment aimé ce système d'exploitation ; l'ayant utilisé, j'avais l'impression que ses
versions ultérieures seraient bonnes et elles le sont, vraiment. J'ai lu que le
magazine a besoin de notre aide, alors j'ai décidé d'écrire sur mon expérience avec
cette vieille distrib. Habituellement, les critiques portent sur de nouvelles choses
modernes, mais je voulais faire un peu plus original que les autres.

Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a
ajouté de l'Amiga, pas mal de DOS et de
Windows, une pincée d'Unix, et un
grand bol de Linux et Ubuntu.
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L e module Draw de LibreOffice est
une application de dessin vectoriel

incluse dans la suite LibreOffice. Draw
permet de créer des graphiques que
vous pouvez utiliser dans vos docu-
ments. Bien qu'il existe des programmes
de graphiques vectoriels plus avancés
– tel qu'Inkscape – Draw vous fournit
plus d'outils que la plupart des logi-
ciels de dessin inclus dans d'autres suites
bureautiques.

Les graphiques vectoriels créent
des images en définissant des formes
géométriques telles que des cercles,
des rectangles et des polygones,
plutôt que par des points/pixels sur
l'écran. Pour cette raison, les
graphiques vectoriels changent de
taille sans distorsion.

Comme c'est le cas pour les autres
modules de LibreOffice, Draw s'intègre
bien avec les autres, ce qui en fait un
outil de choix lors de la création
graphique de vos documents.

LA MISE EN PAGES PAR DÉFAUT

La mise en pages par défaut de
Draw est plutôt basique. Vous aurez
probablement envie de la modifier
pour y inclure les barres d'outils que

vous utiliserez le plus souvent. La mise
en page comprend les éléments de
base dont vous avez besoin pour créer
une image graphique. Le centre de
l'écran est la zone où vous allez créer
votre graphique. À gauche, vous avez
le volet « Pages », montrant les dif-
férentes pages du graphique. Les gra-
phiques multi-pages sont utilisés prin-
cipalement pour les présentations et
je les traiterai à un moment ultérieur.

Par défaut, vous avez trois barres
d'outils. La barre d'outils standard est
la barre d'outils supérieure. Il s'agit de
celle que vous voyez dans la plupart
des modules de LibreOffice. Elle pro-
pose les fonctions pour créer un nou-

veau graphique, ouvrir, enregistrer, co-
pier, couper, coller, et d'autres fonc-
tions qui se rapportent à la plupart
des modules. La barre d'outils de ligne
et de remplissage se trouve en des-
sous. Celle-là contrôle l'apparence des
lignes et du remplissage d'un objet.
Au bas de la fenêtre se trouve la barre
d'outils de dessin. À partir de cette
barre d'outils, vous pouvez créer la plu-
part des objets pour votre graphique.
Vous pouvez déplacer les barres d'ou-
tils en saisissant la poignée au début
de la barre d'outils et en la faisant
glisser à l'endroit où vous le souhaitez.

La barre d'état au bas de la fe-
nêtre vous donne beaucoup d'infor-

mations utiles sur l'objet que vous
modifiez. Le type de l'objet, ses di-
mensions, son angle et d'autres infor-
mations utiles apparaîtront ici. Je me
référerai souvent à la barre d'état pen-
dant ces tutoriels sur Draw.

Au sommet et le long du bord
gauche se situent les règles. Les règles
vous indiquent votre emplacement dans
l'image. Si vous souhaitez modifier
l'unité de mesure de ces règles, vous
pouvez faire un clic droit sur la règle
et sélectionner une unité de mesure

différente. Lorsque vous avez sélec-
tionné un objet, la règle affiche des
lignes doubles pour indiquer la position
de l'objet sur le dessin.

TTUUTTOORRIIEELL
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http://wiki.documentfoundation.org/images/d/dd/BasicGuide_OOo3.2.0.odt
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LA BARRE DE COULEURS

La barre de couleurs affiche la pa-
lette de couleurs actuelle sous la
zone de dessin. Vous pouvez l'utiliser
pour sélectionner les couleurs pour
vos objets plutôt que d'avoir à utiliser
la liste déroulante de la barre d'outils
ligne et remplissage. La première case
– la case blanche avec un X – est la
sélection sans couleur (ou invisible).
Pour afficher la barre de couleurs, cli-
quez sur Affichage > Barre d'outils >
Barre de couleurs. Pour utiliser la barre
de couleurs, faites un clic gauche sur
la couleur que vous voulez pour la
couleur de remplissage de l'objet, et
faites un clic droit pour sélectionner
la couleur de la ligne.

LES BARRES D'OUTILS
EXTENSIBLES

La plupart des icônes des barres
d'outils ont un triangle ou une flèche
vers la droite. Cela indique que l'élé-
ment est extensible. Cliquer sur la
flèche vous donne plus de choix. Vous
pouvez détacher ces éléments de la
barre d'outils, pour créer une barre
d'outils flottante. Lorsque vous déve-
loppez l'élément, vous voyez une barre
d'appui en bas. Cliquez et faites glis-
ser la barre d'appui pour créer une
barre d'outils flottante avec ces élé-
ments. Cette fonction est utile lors-
que vous avez besoin d'utiliser les
éléments à plusieurs reprises, et est
plus rapide que d'avoir à développer les
éléments à chaque fois. Lorsque vous
avez terminé, il suffit de fermer la barre
d'outils flottante en cliquant sur le

bouton Fermer dans la barre de titre.

GRILLE, LIGNES D'ACCROCHAGE
ET POINTS DE CAPTURE

Lors de la création d'une image, je
trouve qu'il est utile d'avoir des guides
pour travailler. La grille, les lignes d'ali-
gnement et les points d'accrochage
sont utiles pour de tels guides. Vous
pouvez configurer le programme pour
vous aligner sur ces guides, qui vous
aident à placer précisément vos objets
dans le dessin.

Pour configurer la grille, allez dans
Outils > Options > LibreOffice Draw >
Grille. Si vous voulez que les objets
s'alignent sur la grille par défaut, cochez
la case Capturer à la grille sous le titre

de la zone Grille. Vous avez également
la possibilité de rendre la grille visible
par défaut. La zone Résolution définit
les paramètres verticaux et horizontaux
de la grille. La zone Finesse définit le
nombre de marqueurs entre les points
de grille horizontale et verticale. Plus
la finesse est importante et plus les
changements sont précis lorsque la
capture à la grille est activée. Mais,

TUTORIEL - LIBREOFFICE P. 27
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comme pour la plupart des choses, un
juste milieu est généralement meilleur.
Vous pouvez configurer certaines op-
tions d'accrochage par défaut dans la
zone Capturer, mais je recommande
de laisser tout désactivé par défaut et
d'utiliser la barre d'options lorsque vous
avez besoin de les activer. Utilisez la
plage de capture pour contrôler la dis-
tance en pixels nécessaire avant que
votre objet ne soit positionné sur ce
point.

Contrairement à la grille, les points
d'accrochage et les lignes de capture
sont insérés lorsque vous avez besoin
d'un emplacement plus exact. Les lignes
d'alignement sont parfaites pour ali-
gner les objets verticalement ou hori-
zontalement. Pour créer une ligne ou
un point de capture, Insertion> Insé-
rer un point/une ligne de capture…
La position X contrôle la distance à
partir de la gauche de l'image. La posi-
tion Y contrôle la distance à partir du
haut. Le type détermine si vous insérez
un point de capture, une ligne de cap-
ture verticale, ou une ligne de capture
horizontale. Vous pouvez également

créer des lignes de capture en faisant
un glisser/déposer à partir des règles
horizontale ou verticale. Pour supprimer
une ligne de capture, cliquez dessus
et faites glisser de nouveau à la règle.
Pour supprimer un point de capture,
faites-y un clic droit et sélectionnez
Supprimer le point de capture.

LA BARRE D'OUTILSOPTIONS

La barre d'outils Options contient
toutes les options de capture. Si elle
n'est pas affichée, sélectionnez Affi-
chage > Barres d'outils > Options. Sur
la barre d'outils, vous pouvez basculer
entre l'affichage de vos guides ou pas,
et activer et désactiver les options
d'accrochage. Vous pouvez ancrer cette
barre d'outils en bas ou sur le côté de
la fenêtre étant donné que vous allez
l'utiliser souvent pour basculer entre
ces options.

Il reste un guide sur la barre d'ou-
tils dont nous n'avons pas encore
parlé. Ce sont les lignes d'aide lors du
déplacement. Lorsque vous sélection-
nez ces lignes d'aide lors du dépla-

cement sur la barre d'Options, puis,
lorsque vous déplacez un objet, des
pointillés s'affichent depuis les coins
de votre objet jusqu'aux règles. Ce
jeu de lignes est juste un outil de plus
pour vous aider à placer vos objets
avec précision.

CONCLUSION

LibreOffice Draw est l'application
graphique de la suite LibreOffice. Draw
sauvegarde vos graphiques dans un
format graphique vectoriel pour les uti-
liser dans vos documents créés avec
d'autres applications de la suite. Draw
vous fournit les outils permettant de
combiner des textes et des objets géo-
métriques pour créer vos graphiques.
Des guides, et la possibilité d'un aligne-
ment sur ces guides, vous aident à
placer vos objets avec précision.

Dans le prochain article LibreOf-
fice, nous nous pencherons sur la
création d'objets de base dans Draw.

Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a
ajouté de l'Amiga, pas mal de DOS et de
Windows, une pincée d'Unix, et un
grand bol de Linux et Ubuntu.
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Le Podcast Ubuntu couvre toutes les
dernières nouvelles et les problèmes
auxquels sont confrontés les utilisa-
teurs de Linux Ubuntu et les fans
du logiciel libre en général. La séance
s'adresse aussi bien au nouvel utili-
sateur qu'au plus ancien codeur. Nos
discussions portent sur le développe-
ment d'Ubuntu, mais ne sont pas trop
techniques. Nous avons la chance
d'avoir quelques supers invités, qui
viennent nous parler directement des
derniers développements passion-
nants sur lesquels ils travaillent, de
telle façon que nous pouvons tous
comprendre ! Nous parlons aussi de
la communauté Ubuntu et de son
actualité.

Le podcast est présenté par des
membres de la communauté Ubuntu
Linux du Royaume-Uni. Il est cou-
vert par le Code de Conduite Ubuntu
et est donc adapté à tous.

L'émission est diffusée en direct un
mardi soir sur deux (heure anglaise)
et est disponible au téléchargement
le jour suivant.

podcast.ubuntu-uk.org

http://podcast.ubuntu-uk.org/
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L orsque j'étais enfant, j'aimais jouer
avec des blocs de construction. Je

n'ai pas eu des blocs finement finis et
polis comme vous pouvez acheter pour
les enfants actuellement. Au lieu de cela,
j'ai eu des restes de morceaux de bois
de la menuiserie de mon père. Je me suis
retrouvé avec une collection de diffé-
rentes formes et tailles géométriques.
Ces blocs sont devenus des forts pour
mes soldats de plomb, des routes pour
mes voitures et même un paysage urbain
avec l'aéroport. La seule limite était mon
imagination.

Alors que mes compétences artis-
tiques n'ont jamais progressé bien au-
delà de mes cours d'arts visuels en 3e,
associer des choses me plaît toujours
et j'ai toujours apprécié la géométrie.
Mes blocs m'ont appris que la plupart
des choses peuvent se décomposer en
des formes géométriques de base com-
me des cercles, des rectangles et d'au-
tres formes géométriques 2D. Avec ces
objets, vous pouvez, même si ce n'est
que rudimentaire, tout créer. Au cœur
de LibreOffice Draw se trouvent ces
formes géométriques de base. Elles
vous permettent de dessiner n'importe
quoi et la seule limite est votre imagi-
nation. Vous trouverez tous les objets
de base sur la barre d'outils Dessin.
Commençant par le plus fondamental

de tous les éléments de dessin, la ligne,
nous allons regarder la façon d'utiliser
les objets de base disponibles dans
LibreOffice Draw.

LIGNES ET FLÈCHES

La ligne est le deuxième outil de la
barre d'outils Dessin par défaut, le
premier étant l'outil de sélection. Pour
dessiner une ligne, cliquez dans la zone
de dessin à l'endroit où vous voulez
commencer votre ligne et faites glisser
jusqu'à son extrémité. Si vous regardez
la barre d'état pendant que vous des-
sinez votre ligne, vous remarquerez
qu'il vous en indique la taille et l'angle.
Pour limiter l'angle de votre ligne à des
incréments de 45 degrés (0, 45, 90, 1 35,
1 80, -1 35, -90, -45), maintenez la touche
Maj enfoncée tout en dessinant votre
ligne.

Parfois, vous voudrez dessiner votre
ligne à partir d'un point central plutôt
que d'un point final. Maintenez enfon-
cée la touche Alt tout en dessinant
votre ligne, et celle-ci va croître à partir
de ce point central. Vous pouvez main-
tenir la touche Alt et Maj ensemble
pour tracer une ligne du point central
et limiter l'angle par incréments de 45
degrés.

Il y a aussi une barre d'outils éten-
due pour les lignes sur la barre d'outils
Dessin. Elle vous permet de dessiner
des lignes avec des points de départ
et/ou d'arrivée de formes différentes
dont des flèches. Il y a aussi une ligne
de cote pour visualiser des dimensions.
Vous pouvez utiliser les mêmes mé-
thodes pour tracer une ligne avec des
flèches que vous utilisez pour dessiner
une ligne ordinaire.

Utilisez la barre d'outils de Ligne et
remplissage pour modifier le style de
ligne et son épaisseur, et pour la colo-
rier. Assurez-vous que votre ligne est
sélectionnée lorsque vous effectuez ces
changements. Vous pouvez également
sélectionner différents styles de flèches
pour votre ligne à l'aide de la barre
d'outils Ligne et remplissage.

RECTANGLES ET CARRÉS

Si vous voulez, vous pouvez utiliser
des lignes de capture et la touche Maj
pour dessiner quatre lignes afin de créer
un rectangle ou un carré, mais Draw
vous fournit un moyen plus facile de les
créer. Le rectangle est le quatrième outil
sur la barre d'outils Dessin par défaut.
Avec lui, vous pouvez créer des rec-
tangles et des carrés.

Pour dessiner un rectangle, sélec-
tionnez l'outil Rectangle de la barre
d'outils. Cliquez sur l'endroit où vous
voulez placer le premier sommet et
faites glisser à l'emplacement du som-
met opposé. Vous faites un carré en
maintenant la touche Maj enfoncée tout
en faisant glisser. La touche Maj ga-
rantit que la largeur et la hauteur sont
toujours les mêmes.
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Tout comme pour une ligne, vous

aurez parfois besoin de créer un rectangle
ou un carré à partir de son centre plu-
tôt que d'un des sommets. Encore une
fois, la touche Alt permet au rectangle
de se développer depuis le centre.
Utilisez la combinaison Maj + Alt pour
dessiner un carré à partir de son centre.

Les rectangles et carrés par défaut
sont dessinés avec les couleurs de ligne
et de remplissage sélectionnées. Vous
pouvez les modifier à l'aide de la barre
d'outils Ligne et remplissage. Vous pou-
vez également utiliser la barre de cou-
leurs. Faites un clic droit pour la couleur
de la ligne et un clic gauche pour la
couleur de remplissage. Vous pouvez
également contrôler l'épaisseur et le
style de la bordure à l'aide de la barre
d'outils Ligne et remplissage.

ELLIPSES ET CERCLES

L'outil Ellipse est le cinquième outil
sur la barre d'outils de dessin par défaut.
Les ellipses sont dessinées à peu près
de la même manière que les rectangles
et les carrés. Fondamentalement, vous
dessinez un rectangle qui contiendra
votre ellipse ou votre cercle. Tout com-
me avec le carré, enfoncer la touche
Maj vous permet de dessiner un cercle.
La touche Alt est utilisée pour dessiner
votre ellipse depuis le centre, la combi-
naison Maj + Alt vous permet de dessi-
ner un cercle depuis le centre.

Comme c'est le cas pour le rec-
tangle et le carré, les ellipses et les
cercles sont dessinés avec les couleurs
de ligne et de remplissage sélection-
nées. Vous pouvez les changer à l'aide
de la barre d'outils Ligne et remplis-
sage ou la barre de couleurs. La barre
d'outils Ligne et remplissage vous per-
met également de changer le style de
la bordure et son épaisseur.

FORMES ET SYMBOLES DE

BARRES D'OUTILS ÉTENDUS

Outre la barre d'outils étendue des
lignes, vous avez plusieurs autres barres
d'outils étendues à votre disposition, y
compris les formes de base (objets géo-
métriques 2D), des symboles (émoti-
cône, la lune, un cœur, etc), des flèches,
des symboles d'organigramme, des lé-
gendes et des étoiles. Ces barres d'ou-
tils étendues vous donnent un ensemble
plus large d'objets avec lesquels cons-
truire votre graphique.

Ils sont dessinés à peu près de la
même manière que les rectangles, les

carrés, les ellipses et les cercles. Vous
dessinez un rectangle contenant l'objet.
Les touches Maj et Alt fonctionnent
également sur la plupart des objets de
la même manière que pour les rec-
tangles. Vous pouvez utiliser la barre
d'outils Ligne et remplissage pour modi-
fier l'épaisseur du trait, le style de ligne,
la couleur de la ligne et la couleur de
remplissage de l'objet.

EXEMPLE DE DESSIN :
UNE FUSÉE SIMPLE

Comme je l'ai dit au début, je ne suis
pas vraiment un artiste, mais je sais
associer les formes pour créer un objet ;
nous allons donc créer une image de
fusée très simple, étape par étape. En
cours de route, je vais vous présenter
quelques nouveaux outils et concepts
pour travailler avec des formes de base.

Tout d'abord, nous allons mettre en
place une grille pour notre dessin,

Outils > Options > LibreOffice Draw >
Grille. Réglez la résolution verticale et
horizontale à 1 centimètre et les deux
subdivisions à 1 0. Cela créera un beau
quadrillage sur notre surface de dessin.
Cochez Capturer à la grille. Cela nous
aidera pour ajuster nos objets à la bonne
taille.

Commençons avec le nez. Sélection-
nez le triangle isocèle dans la barre
d'outils des formes étendues [Ndt :
neuvième bouton, celui en forme de
losange]. Dessinez, en haut de l'image,
le triangle en lui donnant une base de 2
cases de la grille et une hauteur de 2
cases également. Attribuez la couleur
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Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a
ajouté de l'Amiga, pas mal de DOS et de
Windows, une pincée d'Unix, et un
grand bol de Linux et Ubuntu.
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noire à la ligne et définissez la couleur
de remplissage à gris 30 %. Pour le
corps de la fusée, utilisez un rectangle,
2 cases de la grille en largeur et 6 cases
de la grille en hauteur, couleur de ligne
noire, couleur de remplissage gris 30 %.

Ajoutons quelques ailettes de
stabilisation à notre fusée. Choisissez le
triangle rectangle dans les Formes de
base étendues de la barre d'outils. Des-
sinez le triangle rectangle en bas à
droite du corps de la fusée, 2 cases de
hauteur et 1 case de largeur. Réglez la
couleur de la ligne à noir, la couleur de
remplissage à gris 40 %. Sélectionnez
l'ailette nouvellement créée et faites
Édition > Copier, puis Édition > Coller.
La copie se superposera sur la première
ailette. Faites glisser et déposez la copie
sur le côté gauche du corps de fusée.
Faites un clic droit sur la copie et Re-
fléter > Horizontalement. Déplacez-la
ensuite vers le bas le long du côté
gauche du corps de fusée. Avec la copie
toujours sélectionnée, appuyez à trois
reprises sur la flèche vers le bas pour la
déplacer juste en dessous du corps de
fusée. Faites de même avec l'ailette
droite.

Nous terminerons notre dessin avec
la tuyère du moteur. Créez un triangle
isocèle en bas au centre du corps de
fusée. Définissez sa taille au mieux. Le
point haut du triangle doit recouvrir la
partie inférieure du corps de la fusée.
Attribuez la couleur noire à la ligne et la

couleur gris 60 % au remplissage.
Assurez-vous que la tuyère est centrée
par rapport à la partie inférieure du
corps. Faites un clic droit sur le triangle,
puis Organiser > Envoyer à l'arrière.
Cela déplace le triangle derrière les
autres objets de sorte que nous ne
pouvons en voir que la partie infé-
rieure. Voilà ! Vous avez un dessin très
simple.

CONCLUSION

Les formes de base sont les blocs
de construction des images dans Draw.
Avec elles, vous pouvez créer un dessin
aussi simple ou aussi compliqué que
nécessaire pour vos documents. Vous
pouvez organiser les objets dans l'image
pour qu'ils se chevauchent et les re-
tourner pour changer l'orientation hori-
zontale ou verticale.

Dans le prochain tutoriel, je vous
montrerai comment créer des arcs, des
courbes et des polygones dans vos
images.

UBUNTU TACTILE SDK BETA

Aujourd'hui, nous [Canonical] annonçons le SDK Beta Ubuntu. Le
SDK fournit un ensemble d'API qui comprend la boîte à outils de

l'interface utilisateur, permettant aux développeurs de créer des
applications sensibles et interactives avec une interface portable Ubuntu
native. Qt Creator est un IDE avec une interface visuelle pour écrire,
tester et déployer des applications ; la documentation de l'API et un site
de développement plein de ressources et de tutoriels, facilitent la
production d'applications de qualité.

Avec une communauté dynamique et sans cesse croissante de
développeurs d'applications, Ubuntu et le SDK offrent le meilleur
écosystème pour permettre à vos applications de prospérer.

SOYEZ PRÊT À DÉMARRER, LE GUIDE POUR

L'INSTALLATION DU SDK

Pour commencer avec le SDK Ubuntu, y compris les instructions
pour une installation facile, des tutoriels et une documentation
détaillée de l'API, rendez-vous à developer.ubuntu.com/get-started

Pour vous aider à concevoir et à construire de belles applications, les
guides de conception d'application comprennent tout ce que vous
devez savoir sur UX et les meilleures pratiques de conception visuelle.
Vous les trouverez à design.ubuntu.com/apps

Vous pouvez garder votre téléphone de développement à jour avec
la dernière version en suivant les instructions à :
wiki.ubuntu.com/TouchInstallProcess

ANNONCE DE CANONICAL

http://developer.ubuntu.com/get-started
http://design.ubuntu.com/apps
http://wiki.ubuntu.com/TouchInstallProcess


82full circle magazine Retour au Som m aireLibreOffice

TTUUTTOORRIIEELL
Écrit par Elmer Perry LLiibbrreeOOffffiiccee PP.. 2299 :: ppoollyyggoonneess,, aarrccss eett ccoouurrbbeess

C omme j'ai dit la dernière fois, le
jeu de cubes que j'avais dans mon

enfance avait été fabriqué par mon
père qui travaillait le bois. Ils n'étaient
pas tous parfaitement proportionnés
dans des formes géométriques claires.
Parfois, ils étaient bizarres ou, comme
souvent avec le bois, ils étaient créés
en fendant le bois selon son fil au lieu
d'être découpés avec une scie. Cer-
tains avaient une forme courbée quand
leurs contre-parties avait été utilisées
pour faire une chaise ou une armoire.
Je n'ai pas mis ces formes irrégulières
au rebut, car elles me plaisaient beau-
coup. Tout dans notre monde réel
n'est pas créé à partir de lignes droites,
d'ellipses et des cercles.

Dans cette perspective, nous conti-
nuerons notre examen de LibreOffice
Draw et apprendrons à créer des poly-
gones, des arcs et des courbes. Un
polygone est un objet plan avec au
moins trois lignes droites et trois
angles. En termes géométriques, les
carrés, les rectangles et les triangles
sont tous des types de polygones.
Pour ce qui nous concerne, nous par-
lerons de polygones avec plus de
quatre côtés. Un arc, dans Draw, est
une partie d'un cercle ou d'un ovale.

Vous pouvez les faire pleins ou vides.
Une courbe est une ligne recourbée.
Nous verrons deux méthodes pour
créer des courbes, l'outil courbe lui-
même et la méthode Bezier.

DESSINER DES POLYGONES

Comme indiqué déjà, un polygone
est un objet avec de multiples côtés.
Dans Draw, il y a quatre outils pour les
polygones. Deux sont fermés et rem-
plis et deux sont ouverts et vides. Les
outils polygones vides sont utiles pour
la création d'une série de lignes. Pour
les deux types, vous avez une version
à main levée et une version restreinte
aux angles qui sont des multiples de
45 degrés. Pour créer un polygone,

choisissez l'un des outils polygone dans
la barre d'outils étendus de lignes.
Cliquez et glissez pour créer le point
de départ de la première ligne. Quand
vous lâchez le bouton de la souris, le

point final de la première ligne est
créé. Mettez la souris à l'emplace-
ment où vous voulez le point final de
la ligne suivante et cliquez. Continuez
jusqu'à ce que toutes les lignes de
votre polygone soient créées. Double-
cliquez sur le dernier point pour
terminer le polygone. Si vous utilisez
l'un des outils de polygone rempli, le
point final de la dernière ligne se
connectera automatiquement au point
de départ de la première ligne et fer-
mera le polygone.

Si vous vous servez d'un des outils
de polygone rempli, Draw remplit le
polygone avec la couleur de remplis-

sage actuelle et règle la couleur des
lignes à la couleur de ligne actuelle-
ment sélectionnée. Vous pouvez les
changer avec la barre d'outils Ligne et
remplissage ou la barre des couleurs.

AJOUTER LA BARRE D'OUTILS
DES CERCLES ET DES OVALES

Pour un accès rapide aux outils
arcs et segments, il faut ajouter la
barre d'outils Cercles et ovales à la
barre d'outils Dessin. Faites un clic-
droit sur la barre d'outils Dessin et
choisissez Personnaliser la barre d'ou-
tils… Cela ouvrira le dialogue Person-
naliser. Cliquez sur le bouton Ajouter.
Dans la liste Catégorie, sélectionnez
Dessin. Dans la liste Commandes, trou-
vez les outils Ellipse – il y en a deux.
Vous voulez celui avec la description
«  En personnalisant la barre d'outils,

vous pouvez ajouter une icône Ellipse

qui ouvre la barre d'outils Cercles et

ovales». Cliquez sur le bouton Ajouter.
Cliquez sur Fermer pour fermer le dia-
logue de sélection.

Vous pouvez bouger la nouvelle
icône là où vous la voulez sur la barre
d'outils avec les flèches haut et bas.
J'ai placé la mienne au-dessous de
l'outil Ellipse. En fait, nous n'avons
plus besoin de l'outil Ellipse, car c'est
inclus dans la barre d'outils Cercles et
ovales. Décochez l'outil Ellipse. Cliquez
sur le bouton OK et vous devez main-
tenant voir la barre d'outils sur votre
barre d'outils Dessin.
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DESSINER DES ARCS OU DES

SEGMENTS

Pour dessiner un
arc ou un segment,
choisissez l'un des
outils de la barre
d'outils des Cercles
et ovales que vous

venez d'ajouter. Cliquez et faites glis-
ser pour créer un cercle ou un ovale
fermé. Relâchez le bouton de la souris.
Cliquez dans le cercle ou l'ovale à
l'endroit où vous voulez que l'arc ou
le segment commence. Bougez la sou-
ris autour du cercle ou de l'ovale pour

créer l'arc ou le segment. Cliquez une
deuxième fois pour créer le point fi-
nal pour l'arc ou le segment. La barre
d'état affichera l'angle à partir du
centre des points, pendant que vous
bougez autour du cercle ou de l'ovale.
Cela peut vous aider à créer des arcs
et segments précis et justes.

DESSINER DES COURBES

Une courbe est une ligne courbée
et non pas un segment d'un cercle ou
d'un ovale. Pour dessiner une courbe,
sélectionnez l'outil courbe dans la
barre d'outil ligne. Cliquez sur le point
de départ et déplacez votre souris
pour dessiner une ligne. Relâchez le
bouton au point le plus haut de votre
courbe. Bougez la souris pour faire
courber la ligne jusqu'au point où vous
voulez que la courbe se termine. Dou-
ble-cliquez pour compléter la courbe.

LES COURBES DE BEZIER

Une courbe de Bezier est une
courbe graduelle avec un point de dé-

part, un point final et deux points de
contrôle. Les mathématiques derrière
la courbe de Bézier dépassent la por-
tée de cet article, mais vous n'avez
pas besoin de les comprendre pour
en dessiner une. Pour dessiner une
courbe de Bézier, sélectionnez l'outil
courbe dans la barre d'outils des
lignes. Cliquez sur le point de départ,
glissez jusqu'au point final et double-
cliquez. Cliquez sur l'outil Points sur la
barre d'outils Dessin (F8 sur le clavier)
et la barre d'outils Éditer les points
s'affichera. Sélectionnez soit le point
de départ, soit le point final (le point
de départ est le plus grand carré).
Sélectionnez l'outil Jonction lisse ou
Jonction symétrique dans la barre
d'outils Éditer les points. Une ligne en
pointillés et un cercle apparaîtront,
indiquant le point de contrôle pour ce
point-là. Bougez le point de contrôle
afin de créer la courbe pour ce point-
là. Répétez pour l'autre point.

CONCLUSION

Puisque tout n'est pas créé à
partir de lignes droites, d'ellipses et
de cercles, les créateurs de Draw nous

proposent plus d'outils pour créer des
objets. Un polygone peut créer un
objet ayant plus de quatre côtés. Arcs
et segments nous donnent des par-
ties et des segments d'un cercle ou
une ellipse. Courbes nous donne la
capacité de courber une ligne pour
créer des formes différentes. Avec
ces outils supplémentaires, Draw vous
permet de créer des images plus
complexes pour vos documents.

Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a
ajouté de l'Amiga, pas mal de DOS et de
Windows, une pincée d'Unix, et un
grand bol de Linux et Ubuntu.
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Lorsque vous travaillez avec des blocs
de bois, vous devez parfois modifier

la forme d'un bloc, le personnalisant
pour un usage spécifique. Vous pouvez
utiliser un rabot ou du papier de verre
pour faire un côté incliné ou un bord
arrondi. Vous pouvez utiliser une scie
pour virer un coin. Tout cela pour créer
un bloc spécial personnalisé différent
des autres blocs que vous avez.

Parfois, nous devons faire la même
chose avec nos blocs numériques. Les
outils d'édition intégrés à LibreOffice
Draw deviennent les rabot, papier de
verre et scie numériques. En fait, vous
pouvez faire des trucs que je n'ai jamais
rêvé de faire à mes blocs lorsque j'étais
enfant.

LAFENÊTRE DE DIALOGUELIGNE
(LINE)

La fenêtre de dialogue Ligne vous
permet de modifier l'apparence des
lignes de votre objet. Pour accéder à la
fenêtre de dialogue Ligne, faites un clic
droit sur votre objet, puis sélectionnez
Ligne. De là, vous pouvez modifier le
style de la ligne (continue, en pointillé,
tiret-point, etc.), la couleur, la largeur et
la transparence. Vous pouvez également
ajouter des styles de flèches pour le

début et la fin de votre ligne. N'oubliez
pas que, pour les objets fermés (trian-
gles, carrés, cercles, etc.), les flèches ne
sont pas dessinées sur les lignes. En
dessous des styles de flèches, vous pou-
vez en ajuster la largeur. « Centre »
(Center) place le centre de la pointe de
flèche sur le point final de la ligne
sélectionnée. « Synchroniser les extré-
mités » (Synchronize ends) change auto-
matiquement les deux pointes de flè-
ches lorsque vous modifiez le style, la
largeur ou le centre d'une des extré-
mités. « Style d'angle » (Corner style)
contrôle la façon dont l'angle de votre
objet est dessiné. « Style de fin » (Cap
style) contrôle à quoi ressembleront les

points de terminaison des lignes sans
flèches.

Si vous travaillez avec un objet ouvert,
il y a un onglet « Ombre » (Shadow).
Cela vous permet de créer une ombre
pour la ligne en définissant la position,
la distance, la couleur et la transpa-
rence de l'ombre.

Les onglets « Styles de lignes » (Line
Styles) et « Styles de flèches » (Arrow
Styles) vous permettent d'ajouter, de
modifier, de supprimer, puis d'enregistrer
différents styles de lignes et de flèches.
Vous pouvez jouer avec ceux-ci, mais
généralement vous trouverez ce dont
vous avez besoin dans les styles prédé-

finis. Si ce n'est pas le cas, n'hésitez pas
à créer les vôtres.

LAFENÊTRE DE DIALOGUE DE

REMPLISSAGE (AREA)
La fenêtre de dialogue de remplis-

sage s'applique aux objets qui sont fer-
més et s'applique à l'espace à l'intérieur
de l'objet. Vous pouvez changer la
couleur de remplissage ainsi que la
manière dont l'objet est rempli. Pour
accéder à la fenêtre de dialogue de
remplissage, cliquez droit sur l'objet et
sélectionnez Remplissage (Area).

L'onglet Remplissage contrôle ce
qui remplit l'objet. Vous pouvez choisir
la couleur, le dégradé (gradient), les
hachures (hatching), et l'image de rem-
plissage dans la liste déroulante « Rem-
plir » (Fill). Une fois que vous avez sélec-
tionné le type de remplissage, vous
pouvez sélectionner un remplissage dans
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la liste. La zone d'aperçu vous montre
le résultat de vos sélections.

L'onglet « Ombre » (Shadow) vous
permet d'ajouter une ombre sous votre
objet. Cochez « Appliquer l'ombre » (Use
Shadow) pour créer une ombre. La po-
sition détermine l'emplacement de l'om-
bre et la distance détermine l'éloigne-
ment par rapport à l'objet. « Couleur »
détermine la couleur de l'ombre et
«  Transparence » définit l'opacité de
l'ombre.

Sur l'onglet Transparence, nous déter-
minons l'opacité du remplissage de
l'objet. Nous avons trois options pour la
transparence du remplissage. « Aucune
transparence » signifie que le remplissage
est complètement opaque. Avec la Trans-
parence, vous pouvez définir un pourcen-
tage pour l'ensemble de la zone. « Dé-
gradé » (Gradient) est l'option avec le
plus de paramètres et la possibilité de
créer les effets les plus intéressants.
Vous avez six choix pour les types de
dégradés : linéaire, axial, radial, ellip-
soïde, quadratique et carré. Pour tous

sauf le linéaire et l'axial, vous pouvez
contrôler le centre XY du dégradé. Le
centre XY est le point où l'objet est le
plus clair ou plus transparent. Sauf pour
le radial, vous pouvez également défi-
nir un angle pour la zone de dégradé.
Les paramètres de bordure (Border) ré-
duisent la taille de la zone transparente.
Plus le pourcentage est élevé, moins
grande est la surface transparente. Uti-
lisez les valeurs initiale et finale pour
modifier les niveaux d'opacité du début
et de la fin. Par exemple, si vous ne voulez
pas d'endroit totalement clair sur votre
objet, vous pouvez commencer avec
une valeur de 1 0 ou 1 5 %.

Les onglets de couleurs, dégradés,
hachures et bitmaps vous permettent
de créer de nouveaux styles de rem-

plissage en définissant des bitmaps, des
dégradés, des hachures et de nouvelles
couleurs.

LAFENÊTRE DE DIALOGUE

POSITION ET TAILLE (SIZE AND
POSITION)

En plus de contrôler la position et la
taille d'un objet, la boîte de dialogue
Position et taille permet aussi de con-
trôler la rotation, l'inclinaison et le rayon
d'angle d'un objet. Pour accéder à la
fenêtre de dialogue Position et taille,
faites un clic droit sur votre objet, puis
sélectionnez « Position et taille ».

L'onglet Position et taille fait ce à
quoi vous vous attendez. Vous pouvez
contrôler la position XY sur la grille de
l'objet et sa largeur et hauteur. Le point
de base pour chacune des options dé-
termine le point parmi neuf sur l'objet
à partir duquel la position ou la taille
est calculée. Il y a une case à cocher
«  Proportionnel » sous la taille pour aider
à maintenir le ratio d'aspect de l'objet
(n'importe quel changement de hauteur
créera un changement de largeur et vice
versa). Vous avez également la possi-
bilité de protéger la position ou la taille
afin d'éviter de les modifier par inadver-
tance. L'option « adapter » concerne seu-
lement les blocs de texte et vous per-
met d'adapter la largeur et/ou la hauteur
pourfaire correspondre le texte.

Avec l'onglet Rotation, vous pouvez
contrôler la rotation de l'objet. C'est
généralement beaucoup plus précis
que l'utilisation de l'outil rotation. Vous
pouvez sélectionner le point de rota-
tion au moyen des zones de saisie, ou
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en sélectionnant un point de rotation
dans la zone de Paramétrages par dé-
faut. Sélectionnez votre angle dans la
zone de saisie ou en sélectionnant un
point sur la boussole de Paramétrages
par défaut des angles.

Enfin, l'onglet « Inclinaison et rayon
d'angle » (Slant & Corner radius) vous
permet de contrôler le rayon d'angle et
l'inclinaison (pensez au texte en ita-
lique). Pensez au rayon d'angle comme
à un papier de verre pour arrondir un
angle. Plus vous frottez, plus le coin
devient rond. Plus le nombre est grand,
plus rond sera le coin. Si vous définissez
un rayon d'angle assez élevé sur un
rectangle, il deviendra un ovale. L'incli-

naison (Basculer), donnée comme un
angle, bascule l'objet vers la droite pour
un angle positif et vers la gauche pour
un angle négatif. En utilisant le rayon
d'angle et l'inclinaison, vous pouvez obte-
nir des formes intéressantes. Le rayon
d'angle est bloqué pour certains objets.

ORGANISER, ALIGNEMENT,
REFLÉTER, CONVERTIR

Parfois, il devient nécessaire d'empiler
les objets, de les aligner, de les refléter
ou juste de les convertir en quelque
chose que vous pouvez modifier d'une
manière différente. Toutes les com-
mandes suivantes se trouvent en cli-
quant droit sur l'objet. Elles sont éga-
lementdisponiblesdans lemenuModifier.

Les options d'organisation vous per-
mettent de contrôler la position dans la
pile d'objets. Lorsque vous avez plusieurs

objets qui se chevauchent, vous devrez
peut-être modifier l'ordre dans lequel
ils sont empilés. Par défaut, ils se rangent
dans l'ordre dans lequel ils sont créés,
le dernier sur le dessus. En utilisant les
options d'organisation, vous pouvez pous-
ser des objets vers l'avant ou vers
l'arrière dans la pile jusqu'à ce que vous
obteniez les résultats souhaités.

« Alignement » vous permet d'aligner
les objets entre eux ou par rapport à la
page. Si vous avez sélectionné un seul
objet, l'objet s'aligne à la page actuelle.
Si plus d'un objet est sélectionné, ils
s'aligneront les uns par rapport aux autres.
Le plus grand des objets contrôle habi-
tuellement l'emplacement final, et les
autres objets sont déplacés pour s'aligner
sur la position sélectionnée de cet
objet-là. Les options d'alignement sont
gauche, droite, centrage horizontal, cen-
trage vertical, haut et bas. Draw a une
barre d'outils d'alignement en plus du
menu contextuel et du menu Modifier.

Les options de Refléter (Flip) sont
simples. Vous pouvez refléter un objet
verticalement (de haut en bas) ou
horizontalement (de gauche à droite).

Il y a beaucoup d'options sous le
menu contextuel > Convertir, mais il y
en a une en particulier sur laquelle je
veux attirer votre attention, Convertir >
En courbe ( Convert > To Curve ). En
convertissant n'importe quel objet en
une courbe, vous pouvez modifier les

points à l'intérieur de cet objet, ce qui
vous permet de réaliser des formes
tout à fait originales. Une fois qu'un
objet est une courbe, vous pouvez
ajouter des points, supprimer des points
et utiliser les outils de translation de
point sur les points de l'objet. Trans-
formez un rectangle en une courbe,
puis commencez à ajouter, déplacer et
manipuler les points pour voir ce que
vous pouvez créer.

CONCLUSION

Les options de Draw vous permet-
tant de modifier un objet sont nom-
breuses. En utilisant les bons outils sur
un objet, vous pouvez créer presque
n'importe quelle forme imaginable (peut-
être quelques-unes que vous n'auriez
jamais imaginées). Je vous encourage à
jouer avec ces outils et voir ce que vous
pouvez faire avec. On ne sait jamais,
vous pourriez découvrir ce petit bout
d'artiste ou de créateur qui est en vous.

http://eeperry.wordpress.com
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S i vous travaillez beaucoup avec
LibreOffice, vous verrez que vous

utilisez presque toujours la même mise
en forme. Que vous l'utilisiez pour
écrire des lettres ou pour créer le
prochain best-seller, vous passez beau-
coup de temps à mettre en place les
mêmes styles maintes et maintes fois.
Les modèles sont la réponse à ce pro-
blème. Un modèle est une maquette
de document utilisée pour créer d'au-
tres documents. Toutes les applica-
tions LibreOffice peuvent utiliser des
modèles. En fait, chaque fois que vous
créez un nouveau document, Libre-
Office utilise un modèle par défaut.

Les Styles sont essentiels pour la
création de modèles. Les styles sont
une façon prédéfinie d'afficher des
informations. J'ai parlé de l'importance
de l'utilisation des styles pour la pre-
mière fois il y a longtemps, dans la
partie 3 de cette série, en vous mon-
trant comment les styles aident à créer
un aspect uniforme dans votre docu-
ment tout en vous faisant gagner du
temps. Dans l'esprit de vous faire éco-
nomiser du temps, nous pouvons ajou-
ter une utilisation de plus aux styles,
la création de modèles.

METTRE EN PLACE UN MODÈLE

D'une lettre commerciale à un ar-
ticle de recherche scientifique, tout
requiert une mise en page et un for-
mat. Disons que nous écrivons un
document qui nécessite un format de
plan numéroté avec des sous-niveaux.
Une autre exigence est que le titre et
l'auteur s'affichent en haut de chaque
page et le numéro de page en bas
avec le format « Page # de # ».

Abordons tout d'abord le style de
numérotation. Dans un nouveau docu-
ment Writer, ouvrez la fenêtre « Styles
et formatage ». Cliquez sur l'icône de
Styles de liste (la dernière sur la barre
d'outils de Styles). Choisissez « Numé-
rotation 1 ». Faites un clic droit sur
«  Numérotation 1 », puis cliquez sur
Modifier. Dans l'onglet plan, prendre
le style qui porte la mention « Numé-
rique avec tous les sous-niveaux » lors-
que vous passez la souris dessus. Cliquez
sur les boutonsAppliqueretOK.

Maintenant, occupons-nous de l'en-
tête et du pied de page. Ouvrez la
fenêtre Styles et formatage et cliquez
sur l'icône de Styles de Page (avant-
dernier de la barre d'outils de Styles).

Faites un clic droit sur le style de page
Standard, puis sélectionnez Modifier.
Dans l'onglet en-tête, cochez Activer
l'en-tête, puis allez dans l'onglet pied
de page et cochez Activer le pied de
page. Cliquez sur OK pour enregistrer
les modifications. Cliquez dans la zone
d'en-tête de la première page, puis
Insertion > Champs > Titre. Tapez une
espace et « par », puis Insertion >
Champs > Auteur. Déplacez votre souris
vers le pied de page au bas de la page.
Tapez « Page », une espace, puis Inser-

tion > Champs > Numéro de Page. Tapez
espace, « de », espace, puis Insertion >
Champs > Nombre de pages.

ENREGISTRER LE MODÈLE

Nous sommes maintenant prêts à
enregistrer notre modèle. Fichier >
Enregistrer comme modèle ouvre le
gestionnaire de modèles. Choisissez le
dossier de modèles où vous souhaitez
stocker votre modèle. Cliquez sur En-
registrer. Une boîte de dialogue vous
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invite à nommer le modèle. Entrez le
nom que vous souhaitez donner au
modèle et cliquez sur accepter. Fer-
mez le gestionnaire de modèles.

UTILISER LE MODÈLE

Nous allons maintenant utiliser le
modèle nouvellement créé. Fichier >
Nouveau > Modèles et documents.
Ouvrez le dossier où vous avez enre-
gistré votre modèle, puis double-cli-
quez dessus. Le titre est celui que vous
avez donné au modèle. Modifions-le.
Fichier > Propriétés. Sélectionnez

l'onglet Description et modifiez le
titre. Cliquez sur OK. Le titre dans
l'en-tête prendra la nouvelle valeur.

Essayons le système de numé-
rotation de plan. Ouvrez les Styles et
formatage, cliquez sur l'icône de
styles de liste et double-cliquez sur
Numérotation 1 . Ce que vous allez
entrer va prendre le style de liste que
nous avons défini pour Numérotation
1 lors de la création du modèle. Ajou-
tez du texte et n'oubliez pas d'ajouter
plusieurs niveaux pour vous assurer
que ça marche. Maintenant, vous pou-
vez enregistrer votre document comme

vous le feriez normalement. Cela ne
l'enregistre pas comme modèle, mais
comme un nouveau fichier sur votre
ordinateur.

DÉFINIR UN NOUVEAU

MODÈLE PAR DÉFAUT

Si vous avez besoin d'utiliser votre
nouveau modèle la plupart du temps,

pourquoi ne pas en faire votre modèle
par défaut ? Cela se fait facilement
dans LibreOffice. Fichier > Nouveau >
Modèles et documents. Naviguez jus-
qu'au dossier qui contient votre modèle
et sélectionnez-le. Cliquez sur le bou-
ton « Définir comme modèle par dé-
faut ». Maintenant, chaque fois que
vous démarrez un nouveau document
de ce type, LibreOffice utilisera votre
modèle plutôt que le modèle par dé-
faut fourni avec LibreOffice.

DIFFÉRENTES SOURCES POUR

LES MODÈLES

Créer vos propres modèles est
super, mais vous n'aurez pas toujours
besoin de faire tout ce travail. Le dé-
pôt officiel de modèles http://tem-
plates.libreoffice.org a des centaines
de modèles que vous pouvez essayer
et utiliser. Pour utiliser un modèle
particulier, importez-le dans le Ges-
tionnaire de modèles.

http://templates.libreoffice.org
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Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a
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grand bol de Linux et Ubuntu. Son blog
est à http://eeperry.wordpress.com
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Certains modèles sont des collec-
tions. Elles ont une extension .OXT.
Pour importer ces modèles, utilisez le
gestionnaire d'extensions, Outils > Ges-
tionnaire des extensions. Cliquez sur
Ajouter et recherchez le fichier OXT
téléchargé. Sélectionnez le fichier et
cliquez sur Ouvrir. Le gestionnaire d'ex-
tensions traitera le fichier et ajoutera
la collection à votre Gestionnaire de
modèles.

CONCLUSION

Les modèles sont un moyen de
répéter la mise en forme d'un docu-
ment à un autre. La création et l'enre-
gistrement des modèles s'appuie prin-
cipalement sur l'utilisation des styles.
Même si j'ai démontré la création d'un
modèle dans Writer, vous pouvez
aussi créer des modèles dans les au-
tres modules de LibreOffice. Vous
pouvez même définir votre modèle par
défaut pour cet autre type de docu-
ment. Les modèles sont un outil de
plus pour gagner du temps au sein de
la suite LibreOffice.

ÉDITIONS SPÉCIALES PYTHON :
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S i vous avez déjà animé une pré-
sentation, vous savez que revenir

vers l'ordinateur pour faire avancer
vos diapositives est pénible, surtout
si, comme moi, vous vous déplacez
beaucoup et faites activement parti-
ciper votre auditoire. J'ai récemment
présenté une session de formation au
travail et je n'ai cessé de vouloir une
télécommande. La Document Founda-
tion a fourni une solution avec l'ap-
plication Android, Impress Remote (té-
lécommande Impress). Impress Remote
vous permet de contrôler votre pré-
sentation Impress à partir de votre
téléphone ou tablette Android. Impress
Remote nécessite LibreOffice en ver-
sion 4.0.1 ou supérieure et un télé-
phone ou une tablette sous Android
2.3 ou supérieur. Si vous possédez un
téléphone ou une tablette récente et
que votre distribution Linux est à jour,
l'utilisation de ce programme devrait
être assez facile.

INSTALLATION

Nous aurons besoin de faire des
changements à notre configuration
LibreOffice Impress pour exécuter le
programme à distance. Commencez
par ouvrir une présentation (nouvelle

ou existante). Puis Outils > Options >
LibreOffice Impress > Général. Cochez
la case « Activer le contrôle à distance ».
Cliquez sur OK. Outils > Options >
LibreOffice > Avancé. Cochez la case
«  Activer les fonctions expérimentales ».
Cliquez sur OK. Redémarrez LibreOf-
fice et ouvrez votre présentation.

Lorsque nous installerons l'applica-
tion de télécommande, nous aurons
besoin de l'adresse IP de l'ordinateur
qui exécute LibreOffice. Dans un ter-
minal Linux, la commande suivante
devrait fonctionner pour la plupart des
utilisateurs : ifconfig eth0 Les infor-
mations dont vous avez besoin sont
sur la ligne qui commence par « inet
addr: xxx.xxx.xxx.xxx », où xxx.xxx.xxx.xxx
est l'adresse IP de votre ordinateur.
Notez cette adresse et conservez-la
pour plus tard. Vous en aurez besoin
lorsque vous configurerez l'application
de télécommande.

Maintenant, nous installons l'appli
Impress Remote. Dans la boutique
Google Play, recherchez Impress Re-
mote et installez l'application sur votre
téléphone ou votre tablette. La pre-
mière fois que vous ouvrez l'appli, vous
voyez un écran presque vide. Sélec-

tionnez « Ajoutermanuellement un ordi-
nateur en WiFi ». Entrez un nom pour
l'ordinateur et son adresse IP. Sélec-
tionnez « Ajouter ». Sélectionnez l'ordi-
nateur dans la liste et laissez-le se
connecter. De retour dans Impress, Dia-
porama > Contrôle à distance Impress
(Impress Remote). Sélectionnez votre
appareil à distance. Entrez le code qui
vous a été donné par l'application.
Cliquez sur Sélectionner. Dans l'appli
à distance, cliquez sur « Démarrer la
présentation » pour démarrer la présen-
tation.

Si votre ordinateur dispose du Blue-
tooth, vous pouvez également vous
connecter par l'appairage de votre télé-
phone avec votre ordinateur. Lorsque
vous ouvrez l'appli, il va rechercher

votre appareil via Bluetooth, et il vous
suffit de sélectionner votre appareil
dans la liste. Vous avez toujours besoin
d'activer les options de communi-
cation à distance et expérimentales
dans LibreOffice.

REMARQUE : Si vous utilisez un pare-
feu sur votre ordinateur, vous devez
ouvrir le port TCP 1 599 pour les
communications parWiFi.

UTILISER L'APPLI IMPRESS

REMOTE

L'appli est assez basique, mais il faut
se rendre compte que moins c'est com-
pliqué mieux c'est quand vous don-
nez une présentation. La barre d'outils
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dans la partie supérieure affiche l'heure
actuelle, ce qui est pratique lorsque
votre présentation doit commencer
ou se terminer à des heures définies.
À gauche de l'horloge est le
commutateur de vues et à droite de
l'heure est le menu de l'appli.

Quand vous commencez une pré-
sentation, vous obtenez la vue de
défilement des diapositives de votre
présentation. Cette vue est la plus
utile parce que, quand vous êtes en
mode de défilement, vous pouvez
également voir toutes les notes que
vous avez faites pour la diapositive.
Bien que vous puissiez utiliser votre

doigt pour naviguer dans le diapo-
rama, ce n'est pas la meilleure mé-
thode, sauf si vous avez juste besoin
d'avancer ou de reculer de plusieurs
diapositives à la fois. La meilleure
façon de – ou celle qui a été conçue
pour – naviguer dans votre présen-

tation est d'utiliser les boutons volume
haut et bas. Le bouton haut vous
avance dans la présentation et le bou-
ton bas fait revenir en arrière.

Parfois, vous avez besoin de faire
une pause et déplacer l'attention de
votre auditoire de l'écran vers autre
chose. Impress Remote vous donne la
capacité de vider l'écran. Dans le menu
de l'appli, sélectionnez « Blank Screen ».
Votre écran de présentation se vide.
Lorsque vous êtes prêt à retourner à
la présentation, cliquez simplement sur
« Retour à la diapo ». La présentation
reprendra là où vous l'avez laissée.

Vous pouvez afficher vos diaposi-
tives de deux manières différentes :
celle que nous avons déjà vue, le mode
défilement, et le mode liste. Vous
pouvez basculer entre les deux modes
en cliquant sur le bouton sélecteur de

vue. Dans le mode défilement, vous
vous déplacez rapidement jusqu'à
une diapositive en faisant glisser avec
votre doigt. Pour sélectionner une
diapositive en mode liste, il suffit de
sélectionner la diapositive. Ce n'est pra-
tique que pour les diapositives figées.
Toute diapositive ayant des animations
nécessitera l'utilisation des boutons
volume haut et bas.

Si vous cliquez sur l'horloge, vous
avez la possibilité de laisser l'heure
actuelle ou de démarrer un chrono-
mètre. Choisissez le chronomètre pour
l'utiliser. Vous obtiendrez des options
Start et Reset. Appuyez sur Start pour
lancer le chronomètre. Le chrono com-
mencera à compter et les options
changeront en Pause et Restart. Choi-
sissez Pause pour interrompre le chrono
et Restart pour recommencer à partir
de 0.00. Ceci est pratique pour chrono-
métrer une activité ou travailler sur le
débit de votre présentation.

Dans le menu de l'appli, il y a un
choix pour les Options. La première
option est d'utiliser les boutons de
volume haut et bas pour contrôler la
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présentation. Il me semble qu'il n'y ait
pas de raison valable de décocher celle-
ci, mais je pense qu'elle est là parce
que quelqu'un avait une bonne raison.
La deuxième option est d'activer une
connexion sans fil entre le téléphone
et l'ordinateur. Cela permet à l'appli
de rechercher automatiquement les
périphériques du réseau sans fil qui
ont LibreOffice Impress ouvert avec
la fonction de connexion à distance
activée. Enfin, l'option de changer d'ordi-
nateur vous permet de basculer sur
un autre ordinateur.

CONCLUSION

Quand on anime une présentation,
il est agréable de pouvoir bouger.
L'appli Android Impress Remote vous
donne cette possibilité en vous per-
mettant de contrôler votre présenta-
tion Impress à partir de votre télé-
phone ou tablette Android. L'appli est
facile à configurer via Bluetooth ou
WiFi. L'interface est dépouillée, ce qui
facilite son utilisation et son contrôle.
Comme l'appli a été développée par
les mêmes personnes qui développent
LibreOffice, la compatibilité future est
pratiquement assurée.

TUTORIEL - LIBREOFFICE P. 32

Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a
ajouté de l'Amiga, pas mal de DOS et de
Windows, une pincée d'Unix, et un
grand bol de Linux et Ubuntu. Voici son
blog : http://eeperry.wordpress.com
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U tiliser HSQLDB, le système de
gestion de base de données (SGBD,

Database Management System, DMS, en
anglais) par défaut dans LibreOffice Base
est très bien pour la création de nou-
velles bases de données, mais parfois vous
avez besoin de vous connecter à une
base de données existante sur un autre
SGBD comme MySQL, dBase, JDBC, Oracle,
PostgreSQL, et d'autres. Je vous ai mon-
tré comment vous connecter à une base
de données faite à partir d'une simple
feuille de calcul dans le numéro 52. Au-
jourd'hui, je vais vous montrer comment
vous connecter à une base de données
créée avec MySQL.

MySQL est un SGBD utilisé sur de
nombreux sites Web. Wordpress et d'au-
tres systèmes de gestion de contenu
utilisent MySQL pour leurs bases de don-
nées. Il se peut que vous ayez de nom-
breuses raisons d'accéder à une base de
données créée dans MySQL. MySQL est
Open Source et vous pouvez l'installer à
partir de votre gestionnaire de logiciels.

INSTALLER MYSQL
Installer MySQL à partir de votre ges-

tionnaire de logiciel nécessite l'installa-
tion de deux paquets. Le premier paquet
est « mysql-client », le programme client
pour MySQL. Il vous permet d'interagir
avec MySQL.

Si vous installez MySQL sur votre
machine actuelle, vous devrez aussi ins-
taller le paquet serveur de MySQL : « mysql-
server ». Lorsque vous installez le paquet
serveur, il vous demande un mot de passe
« root » et demande une confirmation.
Ceci est votre mot de passe maître pour
MySQL. Notez-le quelque part. Vous en
aurez besoin plus tard. Si vous vous con-
nectez à une base de données sur un
autre ordinateur, vous n'avez pas besoin
de ce paquet.

Le dernier paquet que vous devez ins-
taller est « libreoffice-mysql-connector ».
Ce paquet va vous permettre de vous
connecter à MySQL sans utiliser de
surcouche ODBC ou JDBC.

CRÉER UNE BASE DE

DONNÉES MYSQL DE TEST

Si c'est la première fois que vous vous
connectez à une base de données
externe à l'aide de LibreOffice Base, je
vous recommande de créer une base de
données de test en MySQL où vous

pourrez faire des erreurs et en tirer des
leçons. Vous pouvez installer un pro-
gramme comme PHP MyAdmin ou
EMMA, mais je pense qu'il est plus facile
d'utiliser simplement le client MySQL en
ligne de commande.

Pour vous connecter à MySQL sur votre
machine locale, utilisez la commande :

mysql -h localhost -u root -p

MySQL vous demandera le mot de
passe « root ». Saisissez-le et vous êtes
accueilli par un message de bienvenue et
l'invite de commande « mysql> ». Pour
vous connecter à un serveur MySQL sur
un autre ordinateur, remplacez « local-
host » par le nom du serveur ou l'adresse
IP. Gardez à l'esprit que vous aurez
besoin de paramétrer MySQL pour qu'il
accepte les connexions à distance. Pour
plus de détails sur la configuration de
MySQL pour accepter les connexions à
distance, lire ce tutoriel : http://www.cy-
berciti.biz/tips/how-do-i-enable-remote-
access-to-mysql-database-server.html

Pour créer une base de données, uti-
lisez la commande suivante à l'invite de
MySQL :

CREATE DATABASE <dbname>;

où <dbname> est le nom que vous
souhaitez donner à la base de données.
Pour créer le nom de base de données
«  myTestDB » entrez :

CREATE DATABASE myTestDB;

MySQL répond avec un message indi-
quant que la requête a été exécutée.
Entrez :

SHOW DATABASES;

pour générer une liste de toutes les
bases de données. Vous devriez voir votre
nouvelle base de données parmi celles
énumérées. Une base de données vide
est suffisante pour se connecter à
MySQL à partir de Base, mais vous pou-
vez également vous connecter à une
base de données entièrement fonction-
nelle. Cependant, comme je l'ai dit, il est
préférable de s'entraîner sur une base de
données de test en premier. Tapez « quit »
et appuyez sur Entrée pour quitter votre
session MySQL.

LLiibbrreeOOffffiiccee PP..3333 :: CCoonnnneecctteerr BBaassee àà MMyySSQQLL
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CONNECTEZ BASE À UNE

BASE DE DONNÉES MYSQL
Nous allons maintenant faire ce pour

quoi nous avons fait tout ce travail : une
vraie connexion de Base à la base de
données MySQL. Commencez par créer
un nouveau document de base de
données dans LibreOffice, Fichier > Nou-
veau > Base de données. Nous allons
utiliser ce document pour nous connec-
ter à la base de données que nous avons
créée auparavant. En utilisant l'assistant
de base de données (recommandé), c'est
un processus en cinq étapes.

Étape 1 : Nous voulons nous connec-
ter à une base de données existante. Ne
pas confondre avec la connexion à un
fichier de base de données existant. Vous
voulez la dernière sélection. Dans la liste
déroulante sélectionnez MySQL. Cliquez
sur Suivant.

Étape 2 : Puisque nous avons installé
le « libreoffice-mysql-connector », nous
n'avons pas besoin des connexions ODBC

ou JDBC. Sélectionnez « Connexion di-
recte ». Cliquez sur Suivant.

Étape 3 : La base de données est le
nom de la base de données que nous
venons de créer dans MySQL. Notre base
de données exemple est « myTestDB ».
Le serveur est « localhost » pour l'ordinateur
local ou le nom du serveur ou l'adresse IP
d'un autre ordinateur. Laissez le port par
défaut, sauf si vous l'avez modifié dans
vos paramètres MySQL ou que votre
service informatique vous a dit de le
faire. Cliquez sur Suivant.

Étape 4 : Le nom d'utilisateur dont
vous avez besoin pour vous connecter à
MySQL à partir de votre ordinateur.
Utilisez « root » si vous vous connectez à
MySQL sur votre ordinateur local. Cochez
la case « Mot de passe requis ». Cliquez

sur « Tester la connexion ». Vous êtes
invité à donner votre mot de passe.
Entrez votre mot de passe et cliquez sur
OK. Si vous avez tout fait correctement,
vous recevrez un message disant que
Base s'est correctement connecté à la
base de données. Cliquez sur OK, puis
cliquez sur Suivant.

Étape 5 : Sélectionnez Enregistrer ou
Ne Pas Enregistrer selon vos besoins
pour la base de données. Une base de
données enregistrée est disponible dans
d'autres modules de LibreOffice. Cochez
la case « Ouvrir la base de données pour
l'édition ». Cliquez sur Terminer. Base
vous demandera un nom de fichier.
Entrez un nom et cliquez sur Enregistrer.

Vous pouvez maintenant interagir
avec la base de données MySQL de la
même manière que vous le feriez avec
une base de données HSQLDB. Vous
pouvez créer des tables, des requêtes,
des rapports et des formulaires comme
vous le feriez avec les SGBD par défaut.
Vous devrez faire attention aux types de
données, car ils sont légèrement diffé-
rents dans MySQL. Pour un aperçu des
types de données HSQLDB voir mon
article http://wp.me/pvwht-8Q. Pour une
liste des types de données MySQL, allez à
http://dev.mysql.com/doc/refman/5.0/e
n/data-type-overview.html.

Bien qu'utiliser le SGBD par défaut
pour Base soit une bonne méthode pour
les nouvelles bases de données, il de-
vient parfois nécessaire de se connecter
à des bases de données existantes. Dans
cet article, nous avons montré comment
on fait pour se connecter à une base de
données externe que nous avons créée
avec MySQL. Nous avons installé MySQL
et créé une base de données vide. En
utilisant l'assistant de base de données
dans Base, nous sommes connectés à
cette base de données où nous pouvons
créer des tables, formulaires, requêtes et
rapports pour interagir avec la base de
données. Base peut également se con-
necter à d'autres types de bases de don-
nées comme dBase, JDBC, Oracle,
PostgreSQL, etc.

http://wp.me/pvwht-8Q
http://dev.mysql.com/doc/refman/5.0/en/data-type-overview.html
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D e nouvelles fonctionnalités et
améliorations sont apparues dans

la dernière version de LibreOffice 4.
L'une des plus intéressantes parmi elles
est le panneau latéral expérimental. Ce
dernier rassemble un grand nombre
de fonctions et d'outils en un endroit
facilement accessible, éliminant la néces-
sité d'avoir une barre d'outils de for-
matage pourun grand nombre d'objets.

Aujourd'hui, nous allons donc nous
intéresser à ce panneau latéral et
nous verrons comment il s'adapte au
document sur lequel vous êtes en train
de travailler. Souvenez-vous que ce
panneau latéral est expérimental, ce
qui signifie qu'il peut faire planter le
programme sans préavis. Lorsque vous
l'utilisez je vous recommande d'enre-
gistrer votre document très souvent.

CONFIGURATION

Étant donné que le panneau latéral
est expérimental, il nous faudra l'ac-
tiver. Depuis n'importe quel écran de
LibreOffice, allez dans Outils > Op-
tions > LibreOffice > Avancé. Cochez
la case « Activer les fonctions expéri-
mentales » et cliquez sur OK. Il faut
ensuite redémarrer LibreOffice pour
que le changement prenne effet.

PRÉSENTATION
Le panneau latéral de LibreOffice

ressemble à celui de Calligra ou au
ruban de Microsoft Office. Même s'il
ne peut pas tout remplacer, vous
aurez tendance à l'utiliser plutôt que
les barres d'outils de formatage et
autres boîtes de dialogue. Le panneau
latéral propose en fait plus de fonc-
tionnalités que la barre d'outils de
formatage par défaut.

Par défaut, la barre latérale est
placée sur le côté droit de la fenêtre
principale. Vous pouvez l'afficher ou
la masquer en utilisant le bouton affi-
cher/cacher sur le bord, ou via le menu
Affichage > Volet latéral. Le menu du
panneau latéral vous permet de l'at-
tacher/détacher. Il est également pos-
sible de la personnaliser en suppri-
mant les panneaux que vous n'uti-
liserez pas.

La barre latérale est une collection
de panneaux. Les panneaux disponibles
dépendent du programme que vous
utilisez. Vous pouvez accéder à cha-
cun d'entre eux en sélectionnant leurs
icônes sur la droite ou par le biais du
menu du panneau latéral. Chaque
panneau sert de raccourci à différents
outils dans le programme. Personnel-
lement, j'utilise le plus souvent les
panneaux Propriétés et Styles et for-
matage. Jetons un œil à chacun d'en-
tre eux.

PROPRIÉTÉS
Le panneau Propriétés présente les

propriétés d'un élément du document.
Vous pouvez y ajuster les différentes
propriétés en utilisant les icônes du
panneau. Modifier des propriétés par

le biais de ces icônes revient à effec-
tuer manuellement les changements
à travers les boîtes de dialogue et
barres d'outils, ce qui signifie que cela
n'a aucun effet sur le style sous-jacent
assigné à l'élément − uniquement sur
l'élément actuel. Si vous ne trouvez
pas la propriété, cliquez sur le bouton
« Plus d'options » présent dans le coin
de chaque propriété pour faire appa-
raître la boîte de dialogue correspon-
dante avec ses onglets. Il est possible
d'étendre et de réduire chacun des
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blocs grâce au bouton Étendre/Ré-
duire à côté de chaque titre de bloc.

Par exemple, tandis que vous tapez
dans un document Writer, vous verrez
trois blocs dans le panneau Proprié-
tés : Caractère, Paragraphe et Page.
Le bloc Caractère permet de contrô-
ler les différents paramètres liés au
texte − police de caractères, gras, ita-
lique, couleur, etc. Le bloc Para-
graphe vous donne la possibilité de
contrôler l'alignement du paragraphe,
l'espacement, les marges, etc. Le bloc
Page propose des options pour chan-
ger la taille de la page, son orien-
tation, ses marges et ses colonnes.

STYLES ET FORMATAGE

La barre latérale reprend les options

proposées dans la fenêtre « Style et
formatage ». Elle permet un accès
direct aux différents styles du docu-
ment. Bien qu'il soit toujours possible
d'utiliser le bouton dans la barre d'ou-
tils, la nouvelle barre latérale introduit
un emplacement central pour cet
outil et bien d'autres. La fenêtre pro-
pose toujours les styles divisés par
type (caractères, paragraphes, cadres,
pages et listes), aussi bien que le
menu de sous-catégories.

GALERIE

La Galerie est une collection
d'images utilisables dans vos docu-
ments. Le panneau Gallery présente
une liste de catégories, appelées thè-
mes, en haut, et une liste d'images
en-dessous. Cette bibliothèque peut

être utilisée pour insérer des ClipArt
et un arrière-plan, dans vos documents,
mais aussi des sons dans vos pré-
sentations. Vous pouvez également
ajouter et créer de nouveaux thèmes
dans votre Galerie. Un tutoriel complet
sur la bibliothèque de la Galerie sera
proposé dans un prochain article.

NAVIGATEUR

Le Navigateur est un catalogue des
titres, tableaux, sections, images, etc.,
de votre document. Il vous permet de
vous déplacer rapidement d'un point
de votre document à un autre grâce à
la référence à un objet. Cela devient
pratique dans les gros documents, et
c'est un bon argument pour donner à
vos objets OLE et à vos images un
nom lisible.

PAGES MAÎTRESSES

(UNIQUEMENT DANS IMPRESS)

Le panneau Pages maîtresses est
utilisé pour sélectionner et créer des
pages maîtresses dans Impress. J'ai ex-
pliqué les pages maîtresses dans la partie
1 6 de cette série, dans le FCM n° 63 :
http://www.fullcirclemag.fr/?downlo
ad/254. Ce panneau est simplement
une traduction de la section Pages
maîtresses du volet Tâches d'Impress.

ANIMATIONS PERSONNALISÉES

(UNIQUEMENT DANS IMPRESS)

Le panneau Animations personna-
lisées permet d'animer des objets sur
une diapositive Impress. J'ai parlé des
animations dans la partie 1 8 de cette
série, dans le Full Circle Magazine n° 65 :
http://www.fullcirclemag.fr/?downlo
ad/260. C'est également une transition
du volet Tâches d'Impress, sous un
nouveau format.

TRANSITIONS (UNIQUEMENT

DANS IMPRESS)

Les transitions contrôlent la façon
dont une présentation passe d'une
diapositive à une autre. Pour plus de
détails, voyez la partie 1 8 de cette série,

http://www.fullcirclemag.fr/?download/254
http://www.fullcirclemag.fr/?download/260
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dans le Full Circle Magazine n° 65 :
http://www.fullcirclemag.fr/?downlo
ad/260. Ce panneau est, là encore,
une copie de l'ancien volet Tâches
d'Impress.

FONCTIONS (UNIQUEMENT

DANS CALC)

Le panneau Fonctions vous donne

accès à toutes les fonctions de Calc.
Une liste divise les fonctions en ca-
tégories, incluant les catégories « Les
dernières utilisées » et « Toutes ». En-
dessous, se trouve une liste de toutes
les fonctions de la catégorie choisie.
Vous pouvez insérer les fonctions dans
la cellule courante en double-cliquant
sur le nom de la fonction ou en cli-

quant sur le bouton fx à gauche de la
liste des catégories. Cela donne un
accès rapide aux fonctions et est plus
facile (à mon avis) à utiliser que l'As-
sistant Fonction.

La barre latérale expérimentale est
un outil qui permet un accès plus
rapide, et plus facile, aux outils cou-
rants. LibreOffice a accompli cela via
l'expansion du panneau et les com-
binaisons de barres d'outils courantes,
et en traduisant d'autres panneaux et
assistants dans un nouveau format.
Vous pouvez la comparer à la barre
latérale de Calligra ou au Ruban de
Microsoft Office. Je l'ai trouvée facile
d'utilisation, mais gardez à l'esprit
que cette fonction est expérimentale
et peut parfois faire planter Libre-
Office.

ÉDITIONS SPÉCIALES PYTHON :

http://www.fullcirclemag.fr/?
download/224

http://www.fullcirclemag.fr?
download/230

http://www.fullcirclemag.fr/?
download/231

http://www.fullcirclemag.fr/?
download/370

http://www.fullcirclemag.fr/?
download/371

http://www.fullcirclemag.fr/?
download/372

http://www.fullcirclemag.fr/?
download/240

http://www.fullcirclemag.fr/?
download/268

http://www.fullcirclemag.fr/?
download/272

http://eeperry.wordpress.com
http://www.fullcirclemag.fr/?download/260
http://www.fullcirclemag.fr/?download/224
http://www.fullcirclemag.fr/?download/230
http://www.fullcirclemag.fr/?download/272
http://www.fullcirclemag.fr?download/370
http://www.fullcirclemag.fr/?download/371
http://www.fullcirclemag.fr/?download/372
http://www.fullcirclemag.fr/?download/231
http://www.fullcirclemag.fr/?download/240
http://www.fullcirclemag.fr/?download/268
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R assembler des Cliparts afin de les
utiliser dans un bulletin, un tableau,

une présentation ou autre peut rapide-
ment devenir une tâche chronophage,
surtout quand il s'agit d'organiser – afin
de les retrouver plus tard – les images
que vous souhaitez utiliser. LibreOffice
fournit une « Galerie » (appelée Gallery)
intégrée pour la collecte et l'organisa-
tion de ces images, mais aussi des sons
et des vidéos. La « Galerie » comporte
des dossiers, organisés par thème. Vous
pouvez ajouter des fichiers à partir de
la Galerie directement dans votre do-
cument et vous pouvez créer des thèmes
supplémentaires pour ajouter vos pro-
pres fichiers à la collection.

LA GALERIE

Vous pouvez accéder à la Galerie de
trois manières différentes, via le menu
(Outils > Gallery), par un bouton sur la
barre d'outils standard et en utilisant

un panneau dans la barre latérale
expérimentale. Par défaut, la Galerie
est ancrée sous la barre d'outils de mise
en forme. Vous pouvez détacher et
ancrer la Galerie avec la combinaison
suivante : CTRL + double-cliquez sur la
bordure de la Galerie. Utilisez le bouton
afficher/cacher sur le bord inférieur afin
d'afficher ou de masquer la galerie
lorsqu'elle est ancrée. Si vous survolez
le bord inférieur, le curseur de la souris
se transforme en double flèche et vous
pouvez alors redimensionner la hauteur
de la Galerie.

Sur le côté gauche de la Galerie se
trouve la liste des thèmes. Le fait de
sélectionner un thème modifie les fichiers
qui s'affichent dans le panneau princi-
pal. Le panneau principal affiche les
fichiers disponibles pour le thème sélec-
tionné. Au-dessus de la zone principale
se trouvent deux boutons pour afficher
les fichiers – sous forme de miniatures

ou en vue détaillée. À côté des bou-
tons, s'affichent également le nom du
thème, le nom du fichier et son empla-
cement.

UTILISATION DE LA GALERIE

La Galerie vous permet d'insérer un
fichier en tant que copie, en tant que
lien, ou comme fond. Lorsque vous
insérez le fichier en tant que copie, il
est incorporé dans le document courant
et ne dépend pas d'un autre fichier. Si
vous insérez le fichier comme un lien,
une référence au fichier source est créée
dans le document. Si vous avez ouvert
un document avec des fichiers liés, les
fichiers ne s'affichent que s'ils sont
présents dans l'emplacement référencé
dans le document (lien vers le fichier
source). Si votre document est destiné
à être utilisé sur plusieurs ordinateurs,
insérez plutôt une copie. Si le document
ne doit résider que sur un seul ordina-
teur, vous pouvez alors n'insérer qu'un
lien.

Pour insérer la copie d'un fichier dans
le document à partir de votre Galerie,
sélectionnez le thème contenant le
fichier et sélectionnez le fichier à insérer.
Vous pouvez ensuite faire glisser et dé-
poser le fichier dans votre document,
ou faites un clic droit sur le fichier puis
Insérer > Copier.

Pour insérer un lien vers un fichier à
partir de votre galerie dans un docu-
ment, sélectionnez le thème et le fichier.
Maintenez MAJ + CTRL enfoncés tout
en faisant glisser le fichier dans le
document, ou faites un clic droit puis
Insertion > Lien.

Lorsque vous souhaitez utiliser une
image comme arrière-plan d'une page
ou d'un paragraphe, sélectionnez le
thème et l'image puis faites un clic
droit sur l'image et Ajouter > Arrière-
plan > Page. Pour définir l'image comme
fond pour le paragraphe en cours, faites
un clic droit sur l'image et Ajouter >
Arrière-plan > Paragraphe.

GESTION DE LA GALERIE

Une fonctionnalité intéressante de
la Galerie consiste en la possibilité d'ajou-
ter vos propres fichiers à la collection.
Cependant, vous ne pouvez pas ajouter
à, enlever de, ou supprimer les thèmes
par défaut. Pour ajouter vos propres
fichiers dans la Galerie, vous devez créer
vos propres thèmes. Vous pouvez ajou-
ter votre propre thème en cliquant sur
le bouton « Nouveau Thème », qui ouvre
la boîte de dialogue éponyme. Dans
l'onglet « Général », entrez le nom de
votre nouveau thème. Vous pouvez de
suite ajouter des fichiers à votre thème
dans l'onglet « Fichiers » ou cliquez sur
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« OK » pour enregistrer le thème.

Il est facile d'ajouter des fichiers au
thème que vous venez de créer. Vous
pouvez ajouter des fichiers un par un
en les faisant glisser dans le panneau
principal où vous aurez sélectionné
votre thème. Une boîte de dialogue
vous permet d'ajouter des fichiers en
les sélectionnant, voire ajouter un dos-
sier en entier : faites un clic droit sur le
titre du thème et sélectionnez « Pro-
priétés ». La boîte de dialogue « Pro-
priétés » s'affiche. Il s'agit de la même
boîte de dialogue que vous obtenez
lors de l'ajout d'un thème et vous pou-
vez donc utiliser cette méthode pour
ajouter des fichiers lorsque vous créez
un nouveau thème. Sélectionnez l'onglet
« Fichiers », puis cliquez sur « Recher-
cher des fichiers ». Utilisez la boîte de
dialogue de fichiers pour accéder au
dossier contenant le(s) fichier(s) que
vous voulez ajouter et cliquez sur « Sé-
lectionnez ». Une liste de fichiers s'af-
fiche alors dans la boîte de dialogue.

Utilisez le menu déroulant au-dessus de
la liste pour filtrer les fichiers, si néces-
saire, en fonction de leurs extensions.
Prenez le temps de parcourir la liste de
filtres pour avoir une idée des nom-
breux formats de fichiers que la Galerie
prend en charge. Pour les fichiers d'ima-
ges, vous pouvez obtenir un aperçu en
cochant la case « Aperçu ». Une fois que
vous trouvez le fichier que vous voulez,
vous pouvez le sélectionner et cliquer
sur « Ajouter » pour l'ajouter au thème,
ou cliquez sur « Ajouter tout » pour
ajouter tous les fichiers contenus dans
la liste.

Vous ne souhaitez peut-être pas
conserver tous les fichiers que vous
avez insérés dans la Galerie, mais juste
les utiliser pour un document ou un
projet en particulier. Une fois que le
projet est terminé et que vous n'avez
plus besoin de ces fichiers, vous pouvez
les supprimer en toute sécurité. Pour
supprimer un fichier d'un thème, faites
un clic droit sur le fichier et sélec-

tionnez « Supprimer ». Vous pouvez éga-
lement supprimer un thème avec tous
ses fichiers par un clic droit sur le titre
du thème et en sélectionnant « Sup-
primer ». Gardez à l'esprit qu'il n'y a pas
d'annulation pour ces actions et que la
suppression d'un fichier de la Galerie ne
le supprime pas de l'ordinateur, mais
uniquement de la liste des thèmes de
la Galerie.

En conclusion, LibreOffice fournit
une bibliothèque de médias appelé la
Galerie. La galerie est divisée en collec-
tions appelées thèmes. Vous pouvez
ajouter vos propres thèmes et vos
propres fichiers dans la Galerie. Si un
fichier ou un thème n'est ajouté que
pour un projet spécifique, vous pouvez
ensuite le supprimer lorsque le projet

est terminé. La galerie est disponible
dans tous les modules de la suite Libre-
Office et vous aide à maintenir une
certaine cohérence dans vos bulletins,
feuilles de calcul, présentations, bases
de données et rapports.

Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a
ajouté de l'Amiga, pas mal de DOS et de
Windows, une pincée d'Unix, et un
grand bol de Linux et Ubuntu. Son blog
est à http://eeperry.wordpress.com

http://eeperry.wordpress.com
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S i vous travaillez avec Base pendant
quelque temps, vous rencontrerez

une situation où vous aurez besoin
d'une table dont la structure est un
peu différente, où vous aurez besoin
des résultats d'une requête sous
forme d'une table que vous pourrez
utiliser. La solution à ces problèmes
est « Vues ». Une vue est une requête
sous forme d'une table qui pourra
servir dans d'autres requêtes, des for-
mulaires ou des contrôles. Aujour-
d'hui, je vous montrerai comment cela
peut vous être utile dans la création
de formulaires.

NOS TABLES

Nous allons créer une base de
données simple avec deux tables. La
base de données suivra des projets
pour une société et nous permettra
d'assigner un membre de l'équipe à
chaque projet. La structure des tables
à créer se trouve ci-dessous.
Project Table
Field|Type|Properties
ID|Integer|Primary Key, Auto
Increment
Title|varchar(50)|Not Null
Description|varchar(250)
Due|Date
MemberID|Integer|foreign key

TeamMember Table
Field|Type|Properties

ID|Integer|Primary Key, Auto
Increment
FirstName|Varchar(25)|Not
Null
LastName|Varchar(25)|Not Null

Vous verrez à droite le SQL pour
créer les tables. Créez une nouvelle
base de données, puis allez à Outils >
SQL et tapez les commandes à la main
ou faites un copier/coller.

Les commandes SQL ci-dessus sont
également disponibles sur pastebin.com
à http://pastebin.com/Wyb3R5Fz.

La clé de cette tâche est la clé
externe « MemberID » dans la table
«  Project », qui est reliée au champ ID
de la table « TeamMember ». Quand
nous créons notre formulaire, nous
créons un menu déroulant permet-
tant de sélectionner le responsable du
projet parmi les membres de l'équipe.
Remarquez que la table « TeamMem-
ber » contient des champs pour le
prénom et le nom. Le contrôle de liste
nous permet d'utiliser un seul champ
dans la liste. On pourrait n'afficher que
le nom dans la liste déroulante, mais
que faire si deux membres de l'équipe
ont le même nom ? Nous allons ré-
soudre ce problème en créant une vue
qui rassemblera le prénom et le nom
dans un seul champ appelé « Name ».

Nous utiliserons notre vue pour éta-
blir la nouvelle liste déroulante.

Si les tables ne s'affichent pas dans
votre liste de tables, après avoir exé-
cuté les commandes, Affichage >
Actualiser les tables (Review > Re-
fresh Table) établira la liste.

CRÉER UNE REQUÊTE/VUE
Nous utiliserons un processus en

deux étapes pour créer notre vue.
D'abord, nous créons une requête et,
ensuite, nous convertissons la re-
quête en vue. Dans notre requête,
nous créons un seul champ en com-

binant les champs prénom et nom.
Nous obtiendrons aussi le champ « ID »,
puisque nous en aurons besoin pour
nous lier à la table « Project ».

Pour créer la requête, nous sélec-
tionnons l'option « Requêtes » dans le
volet « Base de données ». Dans le
volet « Tâches », sélectionnez « Créer
une requête en mode SQL… » La com-
mande SQL suivante créera notre
requête :

SELECT "FirstName" || ' ' | |
"LastName" AS "Name",

"ID" FROM "TeamMember";

drop table "Project" if exists;
drop table "TeamMember" if exists;

create table "TeamMember" (
"ID" integer generated by default as identity

(start with 1) not null primary key,
"FirstName" varchar(25) not null,
"LastName" varchar(25) not null

);

create table "Project" (
"ID" integer generated by default as identity

(start with 1) not null primary key,
"Title" varchar(50) not null,
"Description" varchar(250),
"Due" date,
"Member" integer,
constraint FK_MEM foreign key ("Member")

references "TeamMember" ("ID")
);

http://pastebin.com/Wyb3R5Fz
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Si vous connaissez le SQL, cela

ressemble à une requête standard sauf
pour ce qui concerne les doubles sym-
boles trait vertical « || ». On les utilise
pour concaténer les chaînes. Dans la
commande, nous sélectionnons chaque
« FirstName » et l'adjoignons à une
espace, puis nous prenons le résultat
et l'adjoignons à « LastName ». Enfin,
nous nommons cette chaîne « Name ».
Nous obtenons aussi le « ID » puisqu'il
identifie chaque enregistrement. Vous
pouvez tester la requête pour vous
assurer qu'elle fonctionne, mais, à ce
stade, les résultats sont vides, néan-
moins la requête devrait s'exécuter
sans erreur. Enregistrez la requête
sous le nom de « QueryTeam ».

Transformer la requête en vue est
aussi simple que faire un clic droit sur
le nom de la requête et sélectionner
«  Créer une vue ». Appelez la vue « Team-
View ». Si vous sélectionnez « Tables »
dans le volet « Base de données », vous
verrez que « TeamView » figure dans
la liste des tables.

CRÉER LES FORMULAIRES

Nous allons créer un formulaire
pour les membres de l'équipe et un
formulaire du projet, pour les données.
Le formulaire « membres de l'équipe »
étant le plus facile, nous allons le
créer en premier. Cliquez sur l'icône
«  Formulaires » dans le volet « Base

de données » et choisissez « Utiliser
l'assistant de création de formulaire… ».
L'Assistant Formulaire s'affichera.

Sur le premier écran, choisissez
«  Table : TeamMember » dans le menu
déroulant. Déplacez les champs « First-
Name » (prénom) et « LastName » (nom)
dans le menu déroulant appelé « Champs
du formulaire ». Cliquez sur le bouton
« Suivant > ». Il n'y a pas de sous-formu-
laire alors cliquez sur « Suivant > » à
nouveau. À l'étape 5, vous pouvez
utiliser n'importe laquelle des options
de contrôle exceptée l'option « Comme
feuilles de données ». À l'étape 6,
acceptez les défauts. À l'étape 7 vous
devez choisir un style qui vous plaît.
Quand vous arrivez à l'étape 8,
appelez le formulaire « TeamMember-
Form » et laissez sur « Utiliser le for-
mulaire ». Lorsque vous cliquez sur
«  Créer », le formulaire s'affichera pour
l'entrée de données. Ajoutez-y quel-
ques noms pour tester le formulaire
projet quand nous l'aurons terminé.

Pour le formulaire projet nous
avons besoin d'à peu près la même
chose, sauf qu'il faut utiliser « Table:
Project » à partir du menu déroulant à
l'étape 1 et qu'il faut sélectionner tous
les champs sauf « ID » comme champs
du formulaire. Appelez-le « ProjectForm »
et, à l'étape 8, choisissez « Modifier le
formulaire ». Cette fois-ci, au lieu de
s'afficher pour que vous puissiez y

entrer des données, il s'affiche pour
que vous puissiez l'éditer.

Quand vous créez des formulaires
avec l'assistant de création de formu-
laire, l'assistant groupe une zone texte
pour la plupart des types de données
avec une étiquette pour chaque champ.
Pour changer le contrôle d'un champ
de données, il faut dissocier la zone
texte de l'étiquette. Ici, nous voulons
modifier le champ « Member ». Pour ce
faire, faites un clic-croit sur l'étiquette
et la zone texte de «Member » et sélec-
tionnez Groupe > Dissocier. Cliquez
sur le fond du formulaire pour désé-
lectionner les deux. Faites un clic droit
sur la zone de texte et choisissez « Sup-
primer ». Sélectionnez « Zone de liste »
sur la barre d'outils « Contrôles de
formulaire ». Si cette barre n'est pas
affichée, alors, pour l'afficher, faites
Affichage > Barres d'outil > Contrôles
de formulaire. Une fois Zone de liste
sélectionnée, le curseur prendra la
forme d'une croix, +. Cliquez et déplacez
pour créer le menu déroulant. Quand
vous lâcherez le bouton de la souris,
l'Assistant Zone de liste s'affichera.

Comme table, sélectionnez « Team-
View » et cliquez sur « Suivant > ». Le
champ que nous voulons dans la Zone
de liste est « Name » ; sélectionnez
donc«Name »etcliquez sur« Suivant> ».
Enfin, il faut « Sélectionner les champs
dont le contenu doit coïncider ». Pour

la « Value Table », choisissez « Mem-
ber ». Il faut sélectionner ID comme
champ pour « List Table », car c'est la
clé primaire qui s'accorde avec le
champ de clé externe « Member » dans
la table « Project ».

Enregistrez les modifications et
fermez la fenêtre d'édition.

Maintenant, si vous avez mis des
noms dans le formulaire « TeamMem-
berForm », vous pouvez ouvrir « Pro-
jectForm » et ces noms-là s'afficheront
dans le menu déroulant que nous
venons de créer. Vous voudrez sans
doute créer plusieurs projets et leur
assigner des membres pour tester le
fonctionnement de vos formulaires.

Dans cet article, nous avons parlé
de l'utilisation d'une vue de Libre-
Office Base pour créer une nouvelle
table à partir d'une table existante.
Nous avons utilisé cette vue pour cons-
truire un formulaire automatisant la
récupération et la sélection d'enregis-
trements à partir de cette vue.

Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a
ajouté de l'Amiga, pas mal de DOS et de
Windows, une pincée d'Unix, et un grand
bol de Linux et Ubuntu. Son blog est à :
http://eeperry.wordpress.com

http://eeperry.wordpress.com
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D ans mon article du numéro 83 du
FCM, je vous ai montré comment

créer un formulaire qui utilise une
vue, mais j'ai laissé des choses en plan
dans les formulaires : je n'ai rien fait
concernant les contrôles qui assurent
l'intégrité des données. Si vous ne
l'avez pas encore fait, lisez l'article dans
le FCM n° 83 et suivez-le pour créer les
tables et les formulaires. Nous allons
travailler avec le projet « ProjectForm »
et voir comment nous pouvons amé-
liorer l'intégrité des données. Je vais
attendre si vous avez besoin de réa-
liser le tutoriel du numéro 83.

CONTRÔLES DE DATE ETD'HEURE

Maintenant reprenons le travail.
Dans le volet « Formulaires » de la
base de données que vous avez créée,
faites un clic droit sur « ProjectForm »
et sélectionnez Éditer. Comme je l'ai
déjà dit, l'assistant associe habituel-
lement une étiquette avec une zone
de saisie, mais, dans le cas des champs
de date et d'heure, il les associe en
fait à des contrôles de date et d'heure.
Sans aucun formatage, elles ressem-
blent aux zones de saisie de texte,
mais croyez-moi, ce sont des con-
trôles de date et d'heure. Nous de-

vons dissocier le contrôle de son
étiquette avant de modifier le con-
trôle de date. Faites un clic droit sur
l'étiquette « Due », ou sur le contrôle
de date, et sélectionnez Groupe >
Dissocier.

Double-cliquez sur le contrôle de
date pour afficher la boîte de dialo-
gue des propriétés. Dans l'onglet
«  Général », vous trouverez tous les
ajustements disponibles. Nous nous
intéressons à ceux qui ajustent la saisie
de date.

Date Min/Date Max - Ces deux
options vous permettent de contrôler
les valeurs de dates mini et maxi auto-
risées dans les champs. Les valeurs
par défaut sont le 01 /01 /1 980 pour le
minimum et le 1 2/31 /2200 pour le
maximum. Dans les applications habi-
tuelles, ces valeurs par défaut devraient
fonctionner, mais si vous avez des
besoins différents, libre à vous de les
adapter. Par exemple, dans une base
de données de gestion de stock où il
est nécessaire qu'aucune facture ne
soit datée d'avant la date de création
de la société. Vous devriez mettre la
date mini à la date d'ouverture.

Format de Date - Il y a 1 2 formats
différents de date. Cette option dé-
termine le format d'affichage de la
date par le contrôle. Parcourez la liste
d'options et voyez celle qui convient
le mieux à votre application.

Date par défaut - Il y a une date
par défaut pour ce champ. S'il y a une
date que les utilisateurs choisiront la
plupart du temps, alors utilisez cette
date. Ça accélérera la saisie. Ça peut
être aussi une façon de montrer le
format de saisie des dates à l'utili-
sateur. Malheureusement, pour l'ins-
tant, vous ne pouvez pas choisir la

date (courante) de saisie de l’enregis-
trement comme valeur par défaut.

Compteur - Mettre cette option à
Oui ajoute un bouton « Monte-Baisse »
au contrôle. L'utilisateur peut utiliser
ce bouton pour ajuster le jour, le mois
et l'année. L'utilisateur clique sur la
partie de date à modifier et ajuste la
valeur en cliquant sur ces boutons.
Très pratique pour la saisie des dates.

Répéter - L'option Répéter est liée
à l'option Compteur. Elle vérifie si
l'action est répétée quand vous tenez
le bouton de souris appuyé sur le
bouton « Monte-Baisse ». Elle est à
votre disposition. Parfois, c'est logique
de l'utiliser. D'autres fois, non.

Délai - L'option de Délai contrôle
la vitesse de l'option de répétition. Un
délai plus long signifie que vous devez
tenir le bouton de souris plus long-
temps avant que ça ne se répète. La
valeur par défaut est « 50 ms »
millisecondes).

Déroulante - l'option « Dérou-

AAmméélliioorraattiioonn ddeess ffoorrmmuullaa ii rreess
ddaannss BBaassee



1 03full circle magazine Retour au Som m aireLibreOffice

TUTORIEL - LIBREOFFICE P. 37

lante » ajoute une flèche de type liste
déroulante au contrôle. En cliquant
dessus, un calendrier s'affiche pour
pouvoir sélectionner la date voulue.

NOTE : Vous pouvez utiliser les op-
tions Compteur et Déroulante ensem-
ble pour créer un contrôle flexible.

Après avoir fait les ajustements au
contrôle, sauvez le formulaire et fer-
mez-le. Ouvrez le formulaire et testez
votre contrôle de date nouvellement
ajusté. N'hésitez pas à essayer les
différentes options pour avoir une
meilleure idée de leur usage. Les
options pour le contrôle de l'heure
sont les mêmes que pour le contrôle
de date sauf l'option Déroulante qui
n'est pas disponible.

RENDRE LE TITRE
OBLIGATOIRE

Maintenant que nous avons réglé
le contrôle de date, attaquons-nous à
quelques possibles difficultés avec la
zone de saisie du champ « Title ».
Quand nous avons créé ce champ,
nous en avons limité la longueur à 50
caractères. Cependant, les dimensions
actuelles de la zone de texte nous
permettent de saisir plus de 50 ca-
ractères. Si nous essayons de sauve-
garder l’enregistrement avec plus de
50 caractères dans « Title », une erreur
SQL va se produire. De plus, quand
nous avons créé la table, nous avons
déclaré qu'une entrée était obligatoire.
Le statut « NON NULL » évite que la
zone de saisie soit laissée vide, mais il
est toujours possible de saisir une
espace pour que le formulaire accepte
la saisie comme valide. Aussi, nous
avons quelques points à régler dans

notre formulaire.

Ouvrez « ProjectForm » en édition.
Faites un clic droit sur l'étiquette ou
la zone de saisie « Title », Groupe >
Dissocier. Maintenant, double-cliquez
sur la zone de saisie « Title » pour affi-
cher la boîte de dialogue des pro-
priétés. Dans l'onglet « Général », met-
tez la valeur de « Longueur de texte
max » à 50. Ceci empêche l'utilisateur
de saisir plus de 50 caractères. Dans
l'onglet « Données », assurez-vous
que « Espace vide égale NULL » et
«  Saisie requise » sont tous les deux à
« Oui ». Ces 2 réglages assurent un
contrôle redondant vérifiant que le
champ saisi contient une valeur valide.

Cependant, nous avons toujours
un problème avec le fait que l'utili-
sateur peut simplement créer un titre
avec des espaces. Pour résoudre ce
point, nous avons besoin d'utiliser un
bout de SQL. J'avais regardé comment

obtenir le même résultat avec une
interface graphique, mais, parfois quand
on travaille avec des bases de don-
nées, SQL est le meilleur, si ce n'est le
seul choix. Nous allons ajouter une
contrainte CHECK à la table « Project ».
Cliquez sur Outils > SQL. Utilisez la
commande SQL suivante pour ajouter
la contrainte à la table :

ALTER TABLE “Project”

ADD CONSTRAINT NOSPACES_CK

CHECK(TRIM(BOTH FROM “Title”)
<> '');

La commande ALTER TABLE signifie
que nous apportons des changements
à la table, en l’occurrence la table
«  Project ». Pour indiquer le changement
à faire, nous utilisons la commande
ADD CONSTRAINT. NOSPACES_CK est
le nom de la contrainte à ajouter. Il
n'est pas nécessaire de mettre les noms
de contrainte tout en majuscules. Je
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fais cela juste comme une conven-
tion. La dernière ligne est la con-
trainte CHECK. En utilisant la fonction
intégrée TRIM, cela enlève toutes les
espaces aux deux bouts de la chaîne
de caractères et ça la vérifie pour être
sûr qu'il ne reste pas de chaîne vide.
Maintenant, si quelqu'un essaie de pla-
cer une chaîne d'espaces dans «  Title »,
cela générera une erreur de contrainte
SQL.

Vous pouvez faire la même chose
pour les champs « FirstName » et
«  LastName » dans la table « TeamMem-
ber ». La « Longueur de texte max »
pour les noms de champs est 25. Je
suggère les commandes SQL suivantes
pour ajouter les contraintes :

ALTER TABLE “TeamMember”

ADD CONSTRAINT
RNAME_NOSPACES_CK

CHECK(TRIM(BOTH FROM
“FirstName”) <> '');

ALTER TABLE “TeamMember”

ADD CONSTRAINT
LNAME_NOSPACES_CK

CHECK(TRIM(BOTH FROM
“LastName”) <> '');

AMÉLIORER LAREQUÊTE DEVUE

La vue que nous avons créée pour

mettre les noms sous forme de liste
déroulante dans « ProjectForm » est
en bon et légal SQL, mais il y a deux
problèmes. D'abord, bien que nous
ayons pris les dispositions pour em-
pêcher qu'un nom ne soit fait que
d'espaces, les utilisateurs peuvent en-
core ajouter des noms corrects avec
des espaces au début ou à la fin. De
ce fait, les noms ne sont plus or-
donnés.

Heureusement, nous pouvons édi-
ter notre vue et faire quelques com-
pléments pour résoudre ces difficul-
tés. Choisissez « Tables » dans le
panneau « Base de données ». Faites
un clic droit sur « TeamView » et
sélectionnez « Editer en mode SQL… ».
Ceci affiche le code SQL utilisé pour
créer la vue. Modifiez le code SQL
affiché par la déclaration suivante :

SELECT TRIM(BOTH FROM
“FirstName”) || ' '
|| TRIM(BOTH FROM “LastName”)
AS “Name”, “ID”
from “TeamMember” ORDER BY
“LastName”, “FirstName”;

Nous avons déjà vu TRIM quand
nous avons créé les contraintes CHECK.
Il enlève les espaces au début et à la
fin de « FirstName »etde « LastName ».

A la fin, nous ajoutons la com-
mande ORDERBYpour classer les noms

par « LastName », puis par « First-
Name ». Cela signifie que les noms
seront d'abord triés par « LastName »,
puis, s'il y a plus d'un même « Last-
Name », un tri se fera par « FirstName »
Avec les réglages des contrôles et un
peu de SQL, nous avons été capables
d'apporter plusieurs améliorations à
nos formulaires, rendant la saisie des
données non seulement plus simple,
mais aussi plus fiable.

Si vous voulez mieux comprendre
le code SQL utilisé dans ce tutoriel,
j'ai deux ressources pour vous. Sur
mon blog «What the tech am I doing ? »
(Ndt : Quelle technique j'utilise ?), les
billets sur LibreOffice Base,
http://eeperry.wordpress.com/categ
ory/libreoffice/libreoffice-base/

W3Schools SQL Tutorial (Ndt : Tuto-
riel SQL des écoles W3)
http://www.w3schools.com/sql/defa
ult.asp

Le Podcast Ubuntu couvre toutes
les dernières nouvelles et les pro-
blèmes auxquels sont confrontés les
utilisateurs de Linux Ubuntu et les
fans du logiciel libre en général. La
séance s'adresse aussi bien au nou-
vel utilisateur qu'au plus ancien
codeur. Nos discussions portent sur
le développement d'Ubuntu, mais ne
sont pas trop techniques. Nous avons
la chance d'avoir quelques supers
invités, qui viennent nous parler direc-
tement des derniers développements
passionnants sur lesquels ils tra-
vaillent, de telle façon que nous
pouvons tous comprendre ! Nous par-
lons aussi de la communauté Ubuntu
et de son actualité.

Le podcast est présenté par des
membres de la communauté Ubuntu
Linux du Royaume-Uni. Il est couvert
par le Code de Conduite Ubuntu et
est donc adapté à tous.

L'émission est diffusée en direct un
mardi soir sur deux (heure anglaise)
et est disponible au télécharge-
ment le jour suivant.

podcast.ubuntu-uk.org

http://eeperry.wordpress.com
http://eeperry.wordpress.com/category/libreoffice/libreoffice-base/
http://www.w3schools.com/sql/default.asp
http://podcast.ubuntu-uk.org/
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I maginez un scientifique, disons qu'ils'appelle Docteur Brown, qui vient
d'écrire le manuscrit d'un livre décrivant
une nouvelle théorie sur le voyage
dans le temps. Le manuscrit est long
de quelques centaines de pages. Il l'a
réparti en chapitres et en sections,
mais il avait besoin d'une table des
matières et d'un index pour que les
autres scientifiques, qui loueront et
adoreront son travail, puissent naviguer
facilement dans son ouvrage. Heureu-
sement, il connaissait LibreOffice et
savait comment utiliser les outils d'index
et de tables de Writer pour créer une
table des matières et un index. Voyons
comment il s'y est pris.

PRÉPARER LES STYLES

Dans beaucoup de mes articles,
j'insiste sur l'importance d'utiliser les
styles, mais, juste au cas où vous n'au-
riez pas encore compris, « l'utilisation
des styles est la meilleure façon de

gagner du temps et d'uniformiser la

présentation de vos documents ». Heu-
reusement, Dr Brown sait qu'il est
important d'utiliser les styles, et il les
a utilisé pour simplifier la création de
sa table des matières. Ce sont les styles
de titres « Titre 1 […1 0] ». Il pouvait

éditer les styles pourobtenir l'apparence
qu'il souhaitait, mais nous voulons sa-
voir comment il les a utilisé dans la
structure générale du document.

Pour préparer la structure générale
de ce document, Dr Brown a ouvert la
boîte de dialogue « Numérotation du
plan », Outils > Numérotation des
chapitres… En sélectionnant chacun
des niveaux différents, il a noté que
chacun d'eux est déjà relié à un style
de titre et que les styles sont ordon-
nés de 1 à 1 0.

Gardant ces valeurs par défaut pour
travailler, il choisit le niveau 1 associé
au style de paragraphe « Titre 1 ».
Pour le paramètre Numéro, il choisit
«  1 , 2, 3, … ». Pour « Avant », il a entré
« Chapitre » (remarquez l'espace), et
pour « Après », il a saisi les caractères
« : » (espace, 2 points, espace). De cette
façon, chaque « Titre 1 » inséré dans
le document prendrait le format de
«  Chapitre N : Titre », où N est le nu-
méro du chapitre.

Dr Brown décida aussi que les

deuxième et troisième niveaux auraient
un format de numérotation « 1 .1 »
pour le deuxième niveau et « 1 .1 .1 »
pour le troisième. Pour le second niveau,
il choisit « 1 , 2, 3, … » pour « Numé-
ro  », mit « Montrer les sous-niveaux »
à 2 et saisit un point et une espace
pour « Après ». Pour le troisième niveau,
il choisit « 1 , 2, 3, … » pour « Numéro »,
mit « Montrer les sous-niveaux » à 3
et saisit un point et une espace pour
«  Après ».

Tous ces styles ayant été paramé-
trés, Dr Brown se mit à son document.
Il utilisa « Titre 1 » pour tous les en-
têtes de chapitre et Titre 2, et Titre 3
pour les sous-titres dans les chapitres.
Parce qu'il a pris le temps de préparer
ses styles, il pourra facilement créer
sa table des matières une fois son
document terminé.

CRÉER UNE TABLE DES

MATIÈRES

Une fois tout le travail d'écriture
fait, Dr Brown était prêt pour créer sa
table des matières. En positionnant
son curseur à la dernière ligne de la
page de titre, il décida que la table
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des matières commencerait sur une
nouvelle page. Insertion > Saut ma-
nuel…, ouvrit la fenêtre de dialogue
«  Insérer un saut ». Il sélectionna
«  Saut de page » et cliqua sur OK. Le
curseur se trouvait ainsi au début
d'une nouvelle page.

Il pouvais désormais créer une
table des matières. Insertion > Index
et tables > Index et tables… La boîte
de dialogue « Insérer un index/une
table » s'ouvrit. Il modifia « Titre » en
« Traité de mathématiques pour le
voyage dans le temps ». Pour le « Type »,
il vérifia que « Table des matières »
était sélectionnée.

Pour le paramètre « Créer un in-

dex/table pour » il avait deux options :
« Document entier » ou « Chapitre ».
S'il l'avait voulu, il aurait pu placer une
table des matières au début de cha-
que chapitre, avec insertion de la table
des matières après l'entête du chapi-
tre, en faisant le choix de « Chapitre »
dans « Créer un index/table pour ».
Mais il a choisi de créer la table des
matières pour tout l'ouvrage, en sélec-
tionnant « Document entier ».

Enfin, il y a l'option « Evaluer jus-
qu'au niveau ». Ici, il a sélectionné la
profondeur de sa table des matières.
S'il l'avait mise à 1 , seul le titre du
chapitre aurait été visible. En ensuite
il aurait créé une table des matières
par chapitre pour afficher les sous-

titres. Finalement, il décida de mon-
trer trois niveaux dans la table des
matières et mit l'option à 3.

Dr Brown cliqua sur OK et la table
des matières fut créée. Sans aucune
rédaction, les numéros de pages des
trois premiers niveaux s'ajoutèrent à
la table des matières. Par un léger
retrait, chaque nouveau niveau montrait
qu'il était de plus bas niveau. Chaque
titre de la table des matières était un
lien vers l'entête dans le document.
Ceci s'est avéré pratique quand il a
converti le document en PDF et en
ebook. Il aurait pu laisser la table des
matières dans cet état et il aurait fait
du bon travail, mais il décida qu'elle
avait besoin de quelques petites tou-
ches supplémentaires.

EDITER LES STYLES DE LA

TABLE DES MATIÈRES

Pour modifier l'apparence des diffé-
rents niveaux de la table des matières

elle-même, Dr Brown aurait eu besoin
d'éditer les styles « Table des matières
1 […1 0] ». Il y avait aussi le style « Titre
de table des matières » utilisé pour
personnaliser le titre de la table des
matières.

Dr Brown voulait un titre centré,
plus grand et en gras. Il ouvrit la boîte
de dialogue « Styles et formatage » à
partir de la nouvelle barre latérale
(qui n'est plus expérimentale depuis
la version 4.2). Il aurait pu aussi ouvrir
la boîte de dialogue « Styles et for-
matage » en cliquant sur le bouton
dans la barre d'outils « Format » ou en
utilisant le menu Format > Styles et
formatage. Il fit un clic droit sur « Ti-
tre de la table des matières » et sélec-
tionna « Modifier ». Dans l'onglet « Po-
lice », il choisit « Gras » et mit la taille
à 20. Il passa dans l'onglet « Aligne-
ment » et choisit « Centré ». Il cliqua
sur OK pour sauvegarder ses chan-
gements.

Comme Dr Brown n'avait inclus
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que les trois premiers niveaux, il
n'avait à changer que les styles de
paragraphes « Table des matières 1 »,
« Table des matières 2 » et « Table
des matières 3 ». Il modifia le style
«  Table des matières 1 » en choisis-
sant Gras et une taille de 1 6 points
dans l'onglet « Police ». Pour distin-
guer le second niveau du troisième, il
plaça le second en gras, mais laissa la
taille par défaut. Pour le troisième, il
changea la police en italique avec la
taille par défaut.

Dr Brown sauvegarda son document
avec sa table des matières nouvelle-
ment formatée. Il avait fait un pas de
plus vers la publication de son livre et
la célébrité. Il sourit en imaginant les
comptes rendus élogieux de ses pairs,
mais attendez… Et l'index alphabétique ?

CRÉER LES ENTRÉES DE

L'INDEX

Dans un ouvrage d'une telle impor-
tance scientifique, un index en fin de
livre pourrait aider les chercheurs à
trouver la référence à une connais-
sance scientifique particulière conte-
nue dans le livre. Une fois la rédaction
terminée, Dr Brown commença à par-
courir son manuscrit pour déterminer
quels mots il devrait inclure dans
l'index.

Avant de créer l'index même, il a
eu besoin de créer les entrées de
l'index pour les mots qu'il avait décidé
d'y inclure. Pour commencer, il choisit
le premier mot qu'il voulait indexer,
puis, à partir du menu, il sélectionna
Insérer > Index et tables > Entrée…
La boîte de dialogue « Insertion d'une
entrée d'index » s'afficha.

Il laissa le champ « Index » à sa
valeur par défaut, « Index lexical ». S'il
avait eu l'intention de créer un index
personnalisé, il en aurait créé un en
utilisant le bouton à côté de la liste
déroulante.

« Entrée » est le terme ou la phrase
dans l'index et il ne doit pas néces-
sairement apparaître comme dans le
manuscrit. Par exemple, il transforma
le terme « nouvel angle » en « Angle,
nouveau » dans l'index. Même si l'ordre
des mots a changé, il continue à faire

référence au même endroit dans le
manuscrit.

Writer autorise deux niveaux de
«  Clés » ou catégories de regroupe-
ment des index. Par exemple, Dr
Brown décida que tous les index con-
cernant les angles devraient apparaî-
tre ensemble dans l'index, idem pour
les différents opérateurs utilisés. Pour
les entrées des angles, il entra « angle »
dans « Clé 1 » et pour les entrées des
opérateurs, il entra « opérateurs » dans
« Clé 1 ». Alors qu'il n'avait créé qu'un
seul niveau de clé dans chaque cas, il
aurait pu en créer deux en entrant
une deuxième valeur dans « Clé 2 ».

S'il avait été sur la page où appa-
raît le texte principal sur le sujet, il
aurait coché « Entrée principale ». Ceci
entraîne que le numéro de page appa-
raît en gras pour cette entrée par
défaut. (Vous pouvez changer l'appa-
rence du numéro de page de l'entrée
principale en éditant le style de carac-
tère « Entrée principale d'index ».)

Dr Brown cocha l'entrée « Appliquer
à tous les textes similaires » de façon
à créer une entrée à chaque appa-
rition du mot ou de la phrase dans le
manuscrit. Il laissa « Respecter la casse »
décoché, ainsi le mot peut apparaître
avec ou sans majuscule. Il cocha
«  Uniquement les mots entiers » parce

qu'il ne voulait pas de variations du
mot ou de la phrase indexée.

Une fois fini pour un mot, Dr Brown
cliqua « Insérer ». Laissant la boîte de
dialogue ouverte, il sélectionna le mot
ou phrase suivant dans le document.
Quand il cliqua sur la boîte de dia-
logue, le nouveau mot ou la nouvelle
phrase apparut dans le champ « En-
trée ». Il fit les changements néces-
saires pour cette entrée et cliqua sur
« Insérer ». Cette possibilité de passer
de la boîte de dialogue au texte rend
la création des entrées d'index plus
rapide que s'il avait fallu ouvrir la
boîte de dialogue à chaque fois.

CRÉER L'INDEX

Une fois que Dr Brown eut fini la
création de ses entrées d'index, il fut
prêt à créer l'index réel. Il se plaça à la
dernière page du manuscrit et, déci-
dant que l'index devait commencer à
la page suivante, il inséra un saut de
page (Insertion > Saut manuel…, puis
sélectionnez « Saut de page » et
cliquez sur OK).

Insertion > Index et tables > Index
et tables… fit ouvrir la boîte de
dialogue « Insérer un index/une ta-
ble ». Dans l'onglet « Index/table », il
sélectionna « Index lexical » pour le
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«  Type », modifia le « Titre » en « In-
dex » et laissa décochées toutes les
entrées sauf « Regrouper les entrées
identiques ». Ceci empêche l'index de
créer des entrées différentes pour les
mots avec minuscules ou majuscules.

Dr Brown décida que l'index devait
comporter deux colonnes pour pré-
server un peu d'espace. Dans l'onglet

« Colonnes », il choisit 2 pour le nom-
bre de colonnes. Pour créer un peu
d'espace entre les deux colonnes, il
modifia l'espacement à 0,50 cm (0,20”).

Satisfait d'avoir paramétré l'index
comme il le souhaitait, il cliqua sur
OK. L'index apparut sur la page avec
l'aspect voulu.

Maintenant, le manuscrit du Dr
Brown est prêt à être publié. Il com-
mence à rêver qu'il va recevoir des
comptes rendus élogieux de ses con-
frères. Grâce à LibreOffice, il a pu
ajouter une table des matières et un
index assez rapidement.

Le Podcast Ubuntu couvre toutes
les dernières nouvelles et les pro-
blèmes auxquels sont confrontés
les utilisateurs de Linux Ubuntu et
les fans du logiciel libre en général.
La séance s'adresse aussi bien au
nouvel utilisateur qu'au plus ancien
codeur. Nos discussions portent sur
le développement d'Ubuntu, mais
ne sont pas trop techniques. Nous
avons la chance d'avoir quelques
supers invités, qui viennent nous
parler directement des derniers dé-
veloppements passionnants sur les-
quels ils travaillent, de telle façon
que nous pouvons tous compren-
dre ! Nous parlons aussi de la com-
munauté Ubuntu et de son actualité.

Le podcast est présenté par des
membres de la communauté Ubuntu
Linux du Royaume-Uni. Il est couvert
par le Code de Conduite Ubuntu et
est donc adapté à tous.

L'émission est diffusée en direct un
mardi soir sur deux (heure anglaise)
et est disponible au télécharge-
ment le jour suivant.

podcast.ubuntu-uk.org

http://eeperry.wordpress.com
http://podcast.ubuntu-uk.org/
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Q uand j’étais à l’école, j’étais très
concentré sur l’écriture et je ne

voyais pas l’intérêt de beaucoup d'au-
tres matières, notamment les mathé-
matiques. En mûrissant, j’ai commencé
à aimer jouer avec les mathématiques.
Depuis pas mal d'années maintenant,
j'étudie les mathématiques par moi-
même. Pendant ce temps, j’ai créé de
nombreux documents contenant mes
notes sur les mathématiques. J’ai dé-
cidé qu’il était temps de les mettre tous
dans un même document avec des
chapitres, une table des matières et
un index. Mais comment faire pour
fondre une liasse de documents en
un seul ?

Je suppose que j’aurais pu tout
simplement copier le texte de chaque
document dans un autre gros docu-
ment, mais cela pouvait devenir un
gros fouillis, particulièrement parce
que je n’étais pas sûr du classement le
plus judicieux de ces documents. Je
voulais utiliser une méthode que je
puisse appliquer à des documents indi-
viduels avant de les combiner en un
seul et je voulais avoir la possibilité de
ré-arranger l'ordre des documents.
Dans LibreOffice, vous pouvez le faire
avec les « documents maîtres ». Pensez

à un document maître comme à un
conteneur qui réunit des documents
textes séparés. Exactement la fonction-
nalité que je cherchais. Aussi j'ai
décidé d’utiliser un document maître.

PRÉPARER LES DOCUMENTS

Parce que les documents avaient
été faits petit à petit au fil des années,
ils furent créés avec des versions
différentes d'OpenOffice et de Libre-
Office. Ni style ni modèle en commun.
J'ai décidé de créer un modèle pour
homogénéiser tous les documents et
le document maître.

Pour créer mon modèle, j'ai com-
mencé par un nouveau document vierge.
Tout en créant mon modèle, j'ai gardé
quelques points à l'esprit. Je savais
que je voulais créer une table des
matières, si bien qu'il me fallait éditer
la « Numérotation des chapitres ». Je
voulais aussi que chaque chapitre com-
mence par une nouvelle page. Pour

finir, je ne voulais qu'un seul style de
page de titre.

Pour éditer la « Numérotation des
chapitres », je suis allé dans Outils >
Numérotation des chapitres… J'ai édité
le niveau le plus haut pour mettre
«  Chapitre » et le numéro du chapitre
avant le titre principal, comme on en
a parlé dans la partie 38 de cette série
(voir le FCM n° 85). J'ai décidé de
laisser les autres niveaux vides, bien
que certains d'entre eux soient sans
doute inclus dans la table des ma-
tières.

Pour que chaque chapitre commence
par une nouvelle page, j'ai édité le
style de chapitre de niveau le plus
haut, « Titre 1 ». J'ai ouvert l'onglet
«  Styles et formats » de la barre laté-
rale, fait un clic droit sur « Titre 1 » des
styles de paragraphes et sélectionné
« Modifier… ». Dans l'onglet « Enchaî-
nements », rubrique « Sauts », j'ai
coché « Insérer ». J'ai choisi le type

«  Page » et la position « Avant ». Puis OK
pour sauvegarder les changements.

Nota : Vous pouvez aussi ouvrir la fe-
nêtre « Styles et Formatage » depuis
son bouton dans la barre d'outils
Formatage, par le menu (Format >
Styles et Formatage) ou en appuyant
sur F1 1 .

J'ai créé un style de page appelé
«  Page de titre » basé sur le style « Pre-
mière page ». Je n'ai fait qu'un seul
vrai changement en positionnant le
haut à mi-hauteur de la page pour cen-
trer le titre verticalement sur la page.
J'ai modifié le style de paragraphe
«  Titre » pour une police et une taille à
mon goût. J'ai aussi créé un style de
paragraphe « Signature » basé sur le
style « Sous-titre ». Peu de change-
ments ici, j'ai juste choisi une police
assortie à celle du titre.

Pour la sauvegarde, Fichier > Mo-
dèles > Enregistrer comme Modèle a
ouvert le Gestionnaire de Modèles.
J'ai cliqué sur Enregistrer et le pro-
gramme m'a demandé un nom pour
le modèle. Je l'ai nommé « Référence
Maths ». J'ai validé et j'ai eu ainsi un
nouveau modèle.
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Quand vous créez un modèle,

vous pouvez souhaiter faire d'autres
changements. C'était cela qui me sem-
blait un bon point de départ pour
moi. Vous pouvez aller aussi loin que
vous voulez avec un modèle. Au final,
vous avez la main. Si vous décidez,
pendant que vous travaillez sur les
sous-documents, que vous avez besoin
de faire plus de modifications sur les

styles, faites les changements dans le
modèle plutôt que sur un document
individuel.

Pourmodifiermon modèle «Maths »,
Fichier > Nouveau > Modèles. J'ai
sélectionné le modèle et cliqué sur
Éditer. Ceci ouvre le modèle au lieu
d'un nouveau document utilisant le
modèle. J'ai fait les changements, puis
je l'ai enregistré comme si c'était un
document normal (en cliquant sur le
bouton Enregistrer de la barre d'outil,
Fichier > Enregistrer ou CTRL-S).
Quand j'ai ouvert un des documents
qui utilise ce modèle, LibreOffice m'a

informé que le modèle avait changé
et m'a demandé si le document de-
vait être actualisé avec la nouvelle ver-
sion du modèle. J'ai cliqué sur « Actua-
liser les styles » et les styles dans le
document ont été mis à jour.

Puis, j'ai eu besoin d'appliquer mon
nouveau modèle à mes documents
existants. J'ai ouvert chacun des docu-
ments et Édition > Tout sélectionner.
Ensuite, j'ai créé un nouveau document
en utilisant mon modèle, Fichiers >
Nouveau > Modèles. J'ai sélectionné
mon modèle et cliqué sur Ouvrir.
Édition > Coller et le texte et les
objets du fichier original ont été re-
produits dans le nouveau fichier. J'ai
fermé l'ancien document parce que je
voulais enregistrer le nouveau sous le
même nom. J'ai sauvegardé le nou-
veau document et j'avais le contenu
de l'ancien fichier avec le nouveau
modèle. J'ai répété cette procédure
pour tous les documents existants.

CRÉER LE DOCUMENT MAÎTRE

Pour créer le document maître, j'ai
ouvert un nouveau document en utili-
sant mon modèle « Référence Maths ».
En sélectionnant le style « Titre prin-
cipal », j'ai saisi mon titre. Ensuite j'ai
créé le sous-titre et la signature. Une
fois que mon document contenait quel-

que chose, je l'ai enregistré comme
un document maître, Fichier > En-
voyer > Créer un document maître. Je
lui ai donné un nom et j'ai cliqué sur
Enregistrer. Puis je suis allé dans les
styles de page du panneau latéral
Styles et Formatage et j'ai changé le
style de page en « Page de titre ».

INSÉRER DES DOCUMENTS

Une fois le document maître exis-
tant, j'ai pu commencer à lui ajouter
des fichiers. Quand j'avais enregistré
le document maître, une fenêtre flot-
tante s'était ouverte automatiquement,
le Navigateur. J'aurais pu travailler
dans cette fenêtre flottante, mais je
l'ai fermée et j'ai utilisé le panneau
latéral Navigateur. Les deux sont iden-
tiques ; c'est donc vous qui choisissez
comment vous voulez travailler. La fe-
nêtre Navigateur s'ouvre en appuyant
sur la touche F5 ou par le menu
Affichage > Navigateur.

Le Navigateur pour les documents
maîtres est différent de celui des
autres documents. Par défaut, il est
en mode liste de documents. Le pre-
mier bouton à ma disposition dans la
barre d'outils est un inverseur entre
la liste de documents et un panneau
standard Navigateur. Pendant que je
travaillais dans le document maître, je

ne voyais aucune raison pour basculer
dans le mode normal, mais il se pour-
rait que vous ayez une raison pour
naviguer vers un objet ou un sous-
titre dans un des sous-documents.

J'ai remarqué qu'un document était
déjà dans la liste des fichiers. C'était
le texte du document maître lui-même,
à ce stade, la page de titre. Quand
j'en aurai besoin, j'ajouterai d'autres
blocs de texte dans le document
maître en utilisant le bouton Insérer.
Pour ajouter mes documents au docu-
ment maître, j'ai cliqué et maintenu le
bouton Insérer. J'ai glissé jusqu'à la
ligne Fichier avant de relâcher le bou-
ton de la souris. Une boîte de dia-
logue de sélection de fichier m'invi-
tait à choisir le fichier à insérer. J'ai
cliqué sur Ouvrir et le fichier a été
ajouté au document maître. Lors de
l'ajout d'un fichier au document maître,
Writer l'ajoute toujours au-dessus du
fichier sélectionné dans la liste exis-
tante. J'ai utilisé les boutons « Mon-
ter » et « Descendre » pour mettre les
documents dans l'ordre que je vou-
lais. Toutes les références et les
numéros de chapitres étaient mis à
jour automatiquement en relation avec
les montées ou descentes des docu-
ments dans ma liste.
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Le Podcast Ubuntu couvre toutes
les dernières nouvelles et les pro-
blèmes auxquels sont confrontés
les utilisateurs de Linux Ubuntu et
les fans du logiciel libre en général.
La séance s'adresse aussi bien au
nouvel utilisateur qu'au plus ancien
codeur. Nos discussions portent sur
le développement d'Ubuntu, mais
ne sont pas trop techniques. Nous
avons la chance d'avoir quelques
supers invités, qui viennent nous
parler directement des derniers dé-
veloppements passionnants sur les-
quels ils travaillent, de telle façon
que nous pouvons tous compren-
dre ! Nous parlons aussi de la com-
munauté Ubuntu et de son actualité.

Le podcast est présenté par des
membres de la communauté Ubuntu
Linux du Royaume-Uni. Il est cou-
vert par le Code de Conduite Ubuntu
et est donc adapté à tous.

L'émission est diffusée en direct un
mardi soir sur deux (heure anglaise)
et est disponible au télécharge-
ment le jour suivant.

podcast.ubuntu-uk.org

Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a
ajouté de l'Amiga, pas mal de DOS et de
Windows, une pincée d'Unix, et un grand
bol de Linux et Ubuntu. Son blog est à
http://eeperry.wordpress.com.
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EDITER DEPUIS LE

DOCUMENT MAÎTRE

Tous les documents reliés au do-
cument maître sont en lecture seule
dans le document maître. Pour éditer
un document à partir du document
maître, j'ai sélectionné le document
dans la liste du Navigateur et cliqué
sur le bouton Éditer. Une nouvelle fe-
nêtre s'est ouverte contenant le do-
cument que je voulais éditer. J'ai
modifié le document, je l'ai enregistré
et fermé. Dans le document maître,
j'ai cliqué et maintenu le bouton Actua-
liser. Après glissement, je l'ai relâché
sur Liens. Une fenêtre de message
apparut pour me demander si je vou-
lais mettre à jour tous les liens dans le
document. J'ai cliqué sur Oui et le
document que je venais d'éditer a été
mis à jour dans le document maître.
J'aurais pu aussi ouvrir le document
par la méthode habituelle et l'éditer
ainsi. Les changements se font seule-
ment quand j'ai actualisé les liens du
document maître.

J'ai inséré une table des matières,
avec l'insertion d'un saut de page
après ma page de titre, en utilisant les
mêmesméthodes que celles présentées
dans le partie 38 de cette série (voir
FCM n° 85). J'ai fait la même chose
pour l'index, mais j'ai dû ajouter un
bloc de texte à la fin du document
maître, par le bouton d'insertion. Le
bloc de texte était nécessaire pour
créer un bloc qui puisse être modifié
à la fin du document maître.

Les documents maîtres sont une
excellente solution pour créer des gros
documents. Dans mon cas, je voulais
de la flexibilité pour travailler sur les
documents individuels et la possibi-
lité de changer l'ordre des documents.
Un document maître fonctionne le
mieux avec un modèle partagé par
tous les documents. Tout comme un
document ordinaire de Writer, vous
pouvez ajouter une table des matières
et un index. Même si le document
maître n'est pas toujours le meilleur
choix, il vous donne la possibilité de

déplacer les différentes parties ou
d'avoir des auteurs différents pour les
différentes parties. Ceci n'était qu'un
exemple d'utilisation d'un document
maître. Si vous organisez bien votre
travail, vous pouvez commencer dès
le tout début avant même d'avoir
écrit le premier document.

http://podcast.ubuntu-uk.org/
http://eeperry.wordpress.com
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Ç a ne devrait sans doute pas vous
étonner d'apprendre que j'utilise

LibreOffice pour écrire ces articles. Pen-
dant longtemps, j'ai imprimé chaque
brouillon d'un article, je le marquais au
crayon rouge, puis je transférais mes
modifications dans l'ordinateur. Cette
méthode « vieille école » de révision de
documents dura de ma période estudian-
tine jusque dans ma vie professionnelle.
Quand j'ai commencé à écrire de ma-
nière régulière, j'ai accumulé une pile
toujours croissante de papier à recy-
cler de mes écrits. J'ai essayé d'utiliser les
2 faces de la feuille et même de la par-
tager en quatre pour l'utiliser comme
bloc-note. Il n'a pas fallu longtemps pour
consommer beaucoup de papier et
d'encre.

À un moment, j'ai décidé que j'avais
besoin d'une solution informatique.
Je savais déjà que Writer fournissait
des outils d'annotation, mais je ne les
avais jamais essayés pour la relecture
de mes documents. Avec quelque hési-
tation, j'ai commencé à l'utiliser. La
difficulté bien connue de « On n'ap-
prend pas à un vieux singe à faire la
grimace ». Après deux mois, j'ai fini
par me demander pourquoi je ne
l'avais pas utilisé avant. Directement

dans Writer, je peux suivre mes modi-
fications, ajouter des notes (des com-
mentaires) et accepter ou rejeter ces
changements. À bien des égards, c'est
plus rapide et même plus efficace que
la solution des impressions papier.

PRÉPARER L'ENREGISTREMENT

DESMODIFICATIONS

Une fois que le premier jet de mon
article est terminé, je l'enregistre comme
une version et enclenche le suivi des
modifications (je reviendrai sur les ver-
sions plus tard). « Édition > Modifications
> Enregistrer » prépare Writer pour l'enre-
gistrement des modifications. « Édition
> Modifications > Afficher » indique à
Writer de me montrer les modifica-
tions effectuées. Je me suis posé la
question de l'intérêt de voir mes modi-
fications pendant que je relis le texte.
D'un côté, je vois les modifications en
les faisant. De l'autre, voir les modifi-
cations pendant que je les fais com-
plique la lecture. J'ai essayé les deux
solutions et je trouve plus logique de
ne pas afficher les modifications
pendant la révision, mais d'attendre le
moment du rejet ou de l'acceptation
de ces modifications pour les voir. Au
final, faites votre propre choix.

NOTE : Si vous transmettez votre
document à quelqu'un pour qu'il le
révise, vous pourriez vouloir prendre
quelques précautions. Fichier > Pro-
priétés ; sélectionnez l'onglet Sécurité.
Cochez « Enregistrer les modifications »
et cliquez sur « Protéger... ». Entrez et
confirmez un mot de passe. Ceci em-
pêchera l'autre personne de faire des
modifications en activant le mécanisme
d'acceptation/rejet. Quand vous récu-
pérez le document avec les modifica-
tions, Fichier > Propriétés, cliquez sur
« Annuler la protection … » et entrez
votre mot de passe. Vous pouvez main-
tenant accepter ou rejeter les modifi-
cations.

ENREGISTRERLESMODIFICATIONS

Si je paramètre Writer pour affi-
cher les modifications et que j'ajoute
du texte, il est surligné et devient la

couleur paramétrée. Quand j'enlève
du texte, il est seulement barré comme
je le faisais sur mon exemplaire pa-
pier. Le texte barré est présenté dans
une couleur différente de celle du
texte ajouté. Les couleurs utilisées
pour les textes ajoutés ou supprimés
sont contrôlées par des réglages dans
Outils > Options… > LibreOffice Writer >
Modifications.

Si je passe la souris sur une mo-
dification, je peux lire dans une info-
bulle l'auteur, la date et l'heure du
changement. Si j'ai coché « Infobal-
lons » dans Outils > Options… >
LibreOffice > Général, l'infobulle pré-
sentera l'auteur, la date et l'heure et
aussi tout commentaire lié à la modi-
fication. Le nom de l'auteur est con-
trôlé par l'information saisie dans Outils >
Options… > LibreOffice > Données
d'identité.
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Pour ajouter un commentaire à la
modification, je place mon curseur
n'importe où dans la modification.
Édition > Modifications > Commen-
taires ouvre le dialogue des com-
mentaires. Je peux ensuite saisir un

commentaire concernant la modifi-
cation. C'est parfois utile pour me
rappeler pourquoi j'ai fait une mo-
dification précise. Quand j'ai fini, je
clique sur OK et les commentaires
sont ajoutés à la modification.

ACCEPTER/REJETER LES

MODIFICATIONS

Après la correction du brouillon, je
suis prêt à revoir mes modifications.
Si elles ne sont pas visibles, Édition >
Modifications > Afficher. Le chemin
Édition > Modifications > Accepter ou
rejeter… ouvre une boîte de dialogue
« Accepter ou rejeter les modifi-
cations », qui affiche toutes mes mo-
difications. Chaque enregistrement
présente le type de modification, l'au-
teur, la date, l'heure et tout commen-
taire. En sélectionnant l'une des lignes
de la liste, la modification concernée
est mise en évidence dans le texte. Si
je veux conserver la modification, je
clique sur Accepter, sinon, je clique
sur Rejeter. Si je suis sûr de vouloir
garder toutes mes modifications, je
clique sur Tout accepter ; en revanche,
si je décide de laisser tomber tous les
changements, je clique surTout rejeter.

Dans l'onglet Filtrer, je peux réduire
la liste des modifications affichée. Je
peux choisir entre quatre types de
filtres : Date, Auteur, Action, Com-

mentaire.

Le filtre Date me permet de ne
voir que les modifications créées
avant, depuis, égal à ou différent d'une
certaine date. Je peux aussi sélec-
tionner les changements réalisés entre
deux dates. À droite de chaque
champ de saisie de date, un bouton
avec une horloge me permet d'un clic
de positionner l'horodatage à l'instant
actuel. Le dernier choix de filtrage
des dates permet de ne voir que les
modifications effectuées depuis le
dernier enregistrement.

Je n'ai jamais beaucoup utilisé le
filtre Auteur car, je suis habituelle-
ment seul à faire des modifications.
Cependant, si quelqu'un d'autre révise
pour moi, je peux faire la différence
entre mes modifications et celles de
cet autre correcteur.

Le filtre Action me permet d'affi-
cher juste un des cas de modification.
Les quatre types sont insertion, sup-
pression, formats et modification de
tableau.

Si je ressens le besoin d'ajouter de
nombreux commentaires à mes modi-
fications, je peux utiliser le filtre
Commentaire pour filtrer les modifi-
cations d'après le texte qui a été saisi
en commentaire. Je n'ai qu'à cocher
le filtre Commentaire et à entrer le
texte que je veux rechercher.

NOTES DEMARGE ET

COMMENTAIRES

Parfois, j'ai besoin de me rappeler
quelque chose. Quand j'utilisais un
exemplaire papier, je mettais la note
tout simplement dans la marge. Les
notes ne représentent en général pas
une modification réelle, mais une
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idée ou une action à faire plus tard.
Par exemple, j'ai besoin de m'étendre
sur un sujet ou je veux sauvegarder
une idée pour un prochain article. Les
notes de marges se créent par Com-
mentaire. Ne les confondez pas avec
les commentaires des modifications.

Pour créer un commentaire, je
surligne l'information à laquelle je
l'applique. Insertion > Commentaire.
Une plage dans la couleur attribuée à
l'auteur par LibreOffice apparaît dans
la marge de droite. Le nom qui appa-
raît en bas du commentaire est contrôlé
par la donnée saisie dans Outils >
Options… > LibreOffice > Données
d'identité. Je place mon curseur dans
la plage et je tape mon commentaire.
Je peux même formater le texte de
cette plage de commentaire en utili-

sant les outils de formatage de la
barre de formatage ou du panneau
latéral. Je fais un clic droit ou je clique
sur la flèche en bas à droite de la
plage de commentaire pour ouvrir un
menu me permettant d'effacer les com-
mentaires dont je n'ai plus besoin.

SAUVEGARDERDES VERSIONS

Après chaque cycle de modifica-
tions et d'acceptation/rejet, j'aime sau-
vegarder une version du document
dans son état actuel. Fichiers > Ver-
sions… ouvre la boîte de dialogue
Versions. Je clique sur Sauvegarder
une nouvelle version et je lui donne
un nom comme « Brouillon brut »,
puis, au besoin, je peux faire des com-
mentaires comme « les marqueurs
d'image sont en place ». Je clique sur

OK pour sauver la version. Si jamais
j'ai besoin de voir une version à
nouveau, je peux ouvrir la boîte de
dialogue Versions, sélectionner la ver-
sion souhaitée et cliquer sur Ouvrir.
Pour plus d'information sur le con-
trôle des versions, voir mon billet de
blog sur : http://wp.me/pvwht-9k.

NOTE : Le contrôle de version de
LibreOffice est bien pour des docu-
ments de tailles petites ou moyennes,
mais il n'est que passable pour de très
grands documents.

Les outils d'édition disponibles dans
Writer sont utiles pour l'édition par
une personne seule ou par plusieurs
personnes. Je peux avoir la trace de
mes modifications, ce qui me permet
ensuite de les accepter ou de les re-
jeter. Je peux ajouter des commentaires
aux modifications pour m'aider à me
rappeler pourquoi ce changement a
eu lieu. Je peux aussi ajouter des notes
dans la marge du document avec
l'outil Commentaire. Après chaque
édition, je peux sauvegarder une version
du document au cas ou je déciderais
de revenir à une version précédente.

Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a
ajouté de l'Amiga, pas mal de DOS et de
Windows, une pincée d'Unix, et un
grand bol de Linux et Ubuntu.
Il blogue à http://eeperry.wordpress.com

Le Podcast Ubuntu couvre les tou-
tes dernières nouvelles et les pro-
blèmes auxquels sont confrontés
les utilisateurs de Linux Ubuntu et
les fans du logiciel libre en général.
La séance s'adresse aussi bien au
nouvel utilisateur qu'au plus ancien
codeur. Nos discussions portent sur
le développement d'Ubuntu, mais
ne sont pas trop techniques. Nous
avons la chance d'avoir quelques
supers invités, qui viennent nous
parler directement des derniers
développements passionnants sur
lesquels ils travaillent, de telle façon
que nous pouvons tous compren-
dre ! Nous parlons aussi de la com-
munauté Ubuntu et de son actualité.

Le podcast est présenté par des
membres de la communauté Ubuntu
Linux du Royaume-Uni. Il est couvert
par le Code de Conduite Ubuntu et
est donc adapté à tous.

L'émission est diffusée en direct un
mardi soir sur deux (heure anglaise)
et est disponible au téléchargement
le jour suivant.

podcast.ubuntu-uk.org

http://wp.me/pvwht-9k
http://eeperry.wordpress.com
http://podcast.ubuntu-uk.org/
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R etour en arrière sur les parties 8
à 1 2 (FCM nos 53, 55-58) : je vous ai

amené d'une feuille de tableau blanc
à un tableau de budget pleinement
opérationnel. J'utilise quelque chose
de similaire deux fois par mois pour
mon budget familial. Je garde une
année complète de feuilles de bud-
get dans un document, ce qui signifie
que deux fois par mois je copie la
feuille, je la renomme et je m'assure
que tous les réglages sont bons pour
mettre une copie de la feuille cou-
rante à la fin des onglets. Croyez-moi,
des erreurs ont été commises. Des
jurons ont été crachés. Des ordina-
teurs innocents ont été menacés.

En temps voulu et puisque je suis
un être humain faillible et imparfait,
j'ai décidé que je devais réduire le
nombre d'étapes nécessaires à la réa-
lisation de cette tâche, de façon à
réduire les risques d'erreur. Le résul-
tat fut une macro où tout ce que j'ai à
faire est de donner un nouveau nom
à la feuille. La macro gère tout le
reste, s'assurant de la copie et du
positionnement à la fin de la liste des
onglets. La tâche colle parfaitement à
l'idée des macro : un processus répé-
titif que l'automatisation peut accé-

lérer tout en évitant les erreurs. Au-
jourd'hui, je vous les présente.

LA MÉTHODE MANUELLE

Pour pouvoir apprécier une ma-
cro, vous devez bien comprendre ce
qu'elle va faire pour vous et quelles
erreurs sont possibles. Par consé-
quent, je commencerai par la des-
cription du déroulement manuel que

la macro simplifie. Il y a réellement
plus d'une façon de copier une feuille
dans Calc, mais je vous montrerai la
méthode interactive avec toutes les
options.

Faites un clic droit sur l'onglet de
la feuille que vous voulez copier et
sélectionnez Déplacer/Copier la feuil-
le… La boîte de dialogue Déplacer/
Copier la feuille apparaît. Ensuite, sé-
lectionnez Copier. Une des erreurs que
j'ai commises a justement été d'ou-
blier ceci. À la fin, j'avais seulement
renommé ma feuille. Dans « Insérer
avant », choisissez la dernière option
« placer en dernière position ». Si j'ou-
blie celui-ci, la feuille est insérée avant
la feuille active au lieu d'être placée
en dernière position, comme je le sou-
haite. Enfin, je dois renommer la
feuille. Il y a eu des fois où je faisais
tellement attention de bien faire les
autres réglages que j'oubliais de chan-
ger le nom. Dans ce cas, le nom de la
feuille copiée prend un « _2 » à la fin.
Cliquez sur OK pour appliquer les
réglages.

Je sais ; vous allez dire que ce n'est
pas si dur, mais après vous être trom-
pé plusieurs fois, votre nature brute

ressort et vous voulez tout balancer.
D'accord, ce n'est peut-être que moi.
La mise en équilibre du budget fami-
lial est suffisamment pénible sans
ajouter en prime des erreurs lors de la
copie des tableaux.

LA MACRO COPYSHEET

La macro n'est pas très longue
(page suivante, en haut à droite) et
vous pouvez aisément la saisir. Vous
pouvez aussi la copier sur :
http://pastebin.com/s3iTGjN6.

La macro commence par la dé-
claration de 3 variables utilisées dans
le corps de la macro. «  Sheet1   » et
«  Sheet2  » sont des chaînes de carac-
tères qui contiendront les noms de la
feuille courante (Sheet1 ) et de la
nouvelle feuille (Sheet2). La variable
«  Doc  » contiendra une référence au
document en cours. Elle est déclarée
comme un type Object parce que la
référence est celle d'un objet API
LibreOffice.

Doc = ThisComponent

ThisComponent est le document
courant actif dans LibreOffice. Dans

http://pastebin.com/s3iTGjN6
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ce cas, la macro cherchera un tableur
Calc.

If NOT
Doc.supportsService("com.sun.s
tar.sheet.SpreadsheetDocument"
) then

MsgBox "This Macro Only
Works with Calc Spreadsheets"

Exit Sub
End If

L'argument « If » s'assure que le
document courant est bien un tableur
Calc. Il vérifie si le document supporte
le service SpeadsheetDocument, l'iden-
tifiant comme un tableur Calc et non
comme un autre type de document.
Si ce n'est pas un tableur, la macro
ouvre une fenêtre de message pour
prévenir l'utilisateur que la macro ne
fonctionne que pour un tableur. En-
suite, la macro exécute un « Exit Sub »
qui termine la macro sans exécuter
d'autre code.

Sheet1 =
Doc.CurrentController.ActiveSh
eet.Name

La macro utilise l'objet Doc pour
extraire le nom de la feuille courante.
La notation avec une ribambelle de
points marque une progression vers
plus de détail. CurrentController fait
référence au service qui contrôle le
document. ActiveSheet se réfère à la
feuille active du document. Enfin, Na-

me récupère le nom de la feuille actu-
elle et celui-ci est affecté à la variable
Sheet1 .

Sheet2 = InputBox("Enter Name
for Copied Sheet:", "Copy
Sheet", Sheet1)

Pour récupérer le nom de la nouvelle
feuille, la macro utilise la fonction In-
putBox. InputBox contient 3 argu-
ments :
•••Une invite destinée à l'utilisateur
(«  Enter Name for Copied Sheet: »)
[Entrez le nom de la feuille copiée : ]
•••Le titre de la fenêtre InputBox
(« CopySheet »).
•••Le texte par défaut (le nom de la
feuille courante [Sheet1 ] est le texte

par défaut).

Si l'utilisateur clique sur OK, la
fonction InputBox retourne la chaîne
de caractères entrée dans la zone de
texte ou le texte par défaut s'il n'a pas
été modifié. Si l'utilisateur clique sur
Annuler, une chaîne vide est retour-
née.

If Sheet2 = "" Then Exit Sub

Do While
Doc.Sheets.hasByName(Sheet2)

Sheet2 = InputBox(Sheet2 +
_

" already exists, select
a different name:", "Copy
Sheet", Sheet2 + "2")

If Sheet2 = "" Then Exit
Sub
Loop

Maintenant, la macro doit utiliser
un raisonnement logique pour déter-
miner comment procéder. Le «  If  »
teste si la chaîne de caractères est
vide. Si c'est le cas, ça signifie que le
bouton Annuler a été cliqué, donc la
commande Exit Sub est exécutée.
Exit Sub termine la macro sans
exécution de code supplémentaire.

La boucle Do While… vérifie si
une autre feuille du document Calc a
le même nom. La méthode hasBy-
Name compare le nom aux noms des
autres feuilles du classeur. Si une cor-

Sub CopySheet
dim Sheet1 as String
dim Sheet2 as String
dim Doc as Object
Doc = ThisComponent

If NOT Doc.supportsService("com.sun.star.sheet.SpreadsheetDocument") then
MsgBox "This Macro Only Works with Calc Spreadsheets"
Exit Sub

End If
Sheet1 = Doc.CurrentController.ActiveSheet.Name
Sheet2 = InputBox("Enter Name for Copied Sheet:", "Copy Sheet", Sheet1)
If Sheet2 = "" Then Exit Sub
Do While Doc.Sheets.hasByName(Sheet2)

Sheet2 = InputBox(Sheet2 + _
" already exists, select a different name:", "Copy Sheet", Sheet2 + "2")
If Sheet2 = "" Then Exit Sub

Loop
Doc.Sheets.CopyByName(Sheet1, Sheet2, Doc.Sheets.Count)

End Sub
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respondance est détectée, la macro
utilise une fonction InputBox pour
demander un nouveau nom différent
à l'utilisateur. La boucle Do While…
tournera jusqu'à ce que le nom dans
Sheet2 soit différent des autres noms
de feuilles. Le test « If » dans la boucle
provoque une sortie de la macro si
vous cliquez sur Annuler. Si, dès le dé-
part, le nom est sans correspondan-
ce, la boucle ne se lance pas. Ceci évite
que deux feuilles puissent avoir le
même nom.

NOTE : Le trait de soulignement (_) dans
la déclaration InputBox est utilisé pour
couper une longue ligne de texte en mor-
ceaux plus courts. Le Basic de LibreOffice
exige que le trait de soulignement soit le
dernier caractère de la ligne. Rien, pas
même une espace, ne peut le suivre.
Quand des lignes sont reliées par ce
biais, LibreOffice les considère comme
une seule ligne.

Doc.Sheets.CopyByName(Sheet1,
Sheet2, Doc.Sheets.Count)

La dernière ligne de la macro
regroupe tout le travail préparatoire
pour enfin exécuter la copie. Sheets
est un appel à l'ensemble des feuilles
du classeur. CopyByName est la mé-
thode qui exécute la copie de feuille
et qui la place à la fin des onglets. La
fonction CopyByName a 3 paramè-
tres :
••Le nom de la feuille à copier (Sheet1 ) ;
••Le nom de la feuille copiée (Sheet2) ;
••La position de la nouvelle feuille
(Doc.Sheets.Count).

Count est le nombre total de
feuilles du classeur (Sheets). Comme
les feuilles sont comptées à partir de
0, l'utilisation faite ici de Count met la
nouvelle feuille à la fin.

CRÉER LE MODULE DE MACRO

CALC

Quand j'ai développé et écrit la
macro CopySheet, j'ai créé un module
de macro dans Calc. Ici je pouvais
sauvegarder la macro ainsi que toute
autre macro que je développerai pour
le programme Calc. C'est une bonne
pratique de regrouper les macros
ainsi.

Pour créer le module Outils >
Macros > Gérer les macros > Libre-
Office Basic… La boîte de dialogue
Macros LibreOffice Basic s'ouvre. Cli-
quez sur Gérer… pour ouvrir la boîte
de dialogue Gestion des macros de
LibreOffice Basic. Sous Mes macros >

Standard, il y a un module par défaut
appelé Module 1 . Sélectionnez-le et
supprimez-le. Sélectionnez Standard
et cliquez sur Nouveau… Appelez
«  Calc » ce nouveau module et cliquez
sur OK. Puis cliquez sur Fermer.

De retour dans la boîte de dialo-
gue LibreOffice Basic, sélectionnez le
module « Calc » que vous venez de
créer et cliquez sur Éditer, ce qui ou-
vre l'éditeur de LibreOffice Basic. Ef-
facez les lignes « Sub Main » et « End
Sub » créées automatiquement. Saisis-
sez ou copiez/collez la macro Copy-
Sheet dans l'éditeur. Sauvegardez le
module et fermez l'éditeur.
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TESTER LAMACRO

Après avoir saisi et sauvé la macro,
vous voulez la tester pour être sûr
que toute la saisie est correcte. D'a-
bord, ouvrez le document Calc ou créez-
en un nouveau. Vous pouvez mainte-
nant faire le test en allant à Outils >
Macros > Exécuter la macro… Dans Bi-
bliothèque, sélectionnez Mes macros >
Standard > Calc. Sous Nom de la macro,
sélectionnez CopySheet et cliquez sur
Exécuter. Entrez un nouveau nom
pour la feuille comme «  New Sheet ».
Cliquez sur OK. Si tout va bien, une
nouvelle feuille est créée avec le nom
que vous avez saisi. Vous devez
répéter le test sans changer le nom
pour voir si la macro vous demande
un nom différent. Faites également un
test pour vérifier que la macro s'arrête
quand vous cliquez sur Annuler plutôt
que sur OK. Pour le dernier essai, ou-
vrez un document texte et lancez la
macro. Vous devriez avoir un message
vous disant que la macro ne fonc-
tionne que pour les tableurs.

NOTE : Dans l'article du n° 64 du FCM
(LibreOffice Partie 1 7 : Macros), je vous
avais montré comment créer un raccour-
ci du menu vers une macro. Vous avez ici
un bon candidat pour un tel raccourci.
Créez le menu et le raccourci dans Calc.

Les macros comme CopySheet peu-
vent accélérer vos processus et vous
éviter de faire des erreurs, ce qui est
toute l'idée derrière les macros. Ce
n'est qu'un exemple de ce que vous
pouvez faire avec les macros, mais
vous pouvez écrire vos propres ma-
cros qui vont étendre l'utilisation ou
les capacités de n'importe quel pro-
gramme de LibreOffice, ou tout simple-
ment raccourcir une tâche que vous
faites souvent. Une recherche dans
Google sur « LibreOffice Basic » est
un bon endroit pour commencer à en
apprendre plus.

EXTRA ! EXTRA !
LISEZ TOUT !

Actuellement, nos glorieux repor-
ters de la rubrique Actus mettent
des mises à jours régulières des
actus sur le site principal du Full
Circle. Cliquez sur le lien NEWS,
dans le menu du site en haut de
la page et vous verrez les titres
des actus. Par ailleurs, si vous re-
gardez le côté droit de n'importe
quelle page du site, vous verrez
les cinq derniers messages.
N'hésitez pas à nous écrire au
sujet des messages des actus.
Peut-être que c'est quelque
chose qui pourrait passer du site
au magazine.
Amusez-vous bien !

Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a
ajouté de l'Amiga, pas mal de DOS et
deWindows, une pincée d'Unix, et un
grand bol de Linux et Ubuntu. Son blog
est à http://eeperry.wordpress.com.

Le Podcast Ubuntu couvre toutes
les dernières nouvelles et les pro-
blèmes auxquels sont confrontés
les utilisateurs de Linux Ubuntu et
les fans du logiciel libre en général.
La séance s'adresse aussi bien au
nouvel utilisateur qu'au plus ancien
codeur. Nos discussions portent sur
le développement d'Ubuntu, mais
ne sont pas trop techniques. Nous
avons la chance d'avoir quelques
supers invités, qui viennent nous
parler directement des derniers dé-
veloppements passionnants sur les-
quels ils travaillent, de telle façon
que nous pouvons tous compren-
dre ! Nous parlons aussi de la com-
munauté Ubuntu et de son actualité.

Le podcast est présenté par des
membres de la communauté Ubuntu
Linux du Royaume-Uni. Il est cou-
vert par le Code de Conduite Ubuntu
et est donc adapté à tous.

L'émission est diffusée en direct un
mardi soir sur deux (heure anglaise)
et est disponible au télécharge-
ment le jour suivant.

podcast.ubuntu-uk.org

http://eeperry.wordpress.com
http://podcast.ubuntu-uk.org/
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J e n'ai pas eu à travailler très long-
temps dans Calc avant d'avoir

besoin d'utiliser des noms de cellules
pour référencer des valeurs dans d'au-
tres cellules. Ce besoin a été suivi
d'échecs : je n'arrivais pas à obtenir ce
que je voulais de ces noms de réfé-
rence. Bien qu'il n'y ait pas de diffi-
culté à référencer des cellules, une
petite réflexion sur ce qu'on en attend
est parfois bienvenue.

Essentiellement, il y a deux types
de références : relative ou absolue. Les
références relatives font référence à
un ensemble d'écarts à partir de la
cellule courante. Les références abso-
lues se rapportent à la cellule, colonne
ou rangée exacte (ou fixée). Avec ces
deux types, nous pouvons voir des
références de quatre manières. Les
références de cellules peuvent même
être inter-onglets.

Quelquefois, vous souhaitez faire
référence à plus grand qu'une cellule.
C'est fait avec les plages de cellules.
Une plage de cellules peut être en
référence relative ou absolue tout
comme les références de cellule. Vous
pouvez même donner un nom à une
plage de cellules.

RÉFÉRENCES RELATIVES

Une référence relative de cellule
est un ensemble d'écarts à partir de la
cellule courante. Si vous faites réfé-
rence à la cellule C4 dans la cellule D6,
cela fait référence à la cellule située à
une colonne à gauche et deux lignes
plus haut. Si vous copiez cette for-
mule dans une autre cellule, mettons
D7, la référence sera C5, qui est à une
colonne à gauche et 2 lignes plus haut
que D7.

Créons un exemple pour lever
toute ambiguïté. Créons une nouvelle
feuille de calcul. Dans les cellules B3
et B4, plaçons les valeurs 1 5 et 46.
Dans les cellules C3 et C4 plaçons 1 1
et 1 4. Sélectionnez la cellule B5 et
entrez la formule suivante (oui, le
signe [=] est nécessaire) :

=B3+B4

Quand vous appuyez sur entrée,
vous voyez un total de 61 , somme des
2 valeurs en B3 et B4. Maintenant, sur
B5, faites un clic droit et copiez.
Sélectionnez C5, et par un clic droit,
collez. Dans C5, vous obtenez un total
de 25, la somme des deux valeurs en
C3 et C4. Vous voyez comment la
référence s'est déplacée ? Parce qu'il

n'y a pas eu de changement de ligne,
les références restent sur la même
ligne. Cependant, si nous l'avions fait,
la référence relative à une cellule se
serait décalée pour refléter le chan-
gement.

Ainsi, dans une référence relative,
les références bougent en cas de
copie sur une autre position, pour
conserver les mêmes écarts.

LES RÉFÉRENCES ABSOLUES

Une référence absolue est figée.
Si C1 est une référence absolue, quel
que soit l'endroit où cette référence
est copiée, la référence se fera tou-
jours sur C1 . Les références absolues
sont créées en ajoutant le signe dollar
($) devant la colonne ou la ligne qui
doit rester absolue. Par exemple, $C$1
est une référence absolue à la cellule
C1 .

Prenons un autre exemple pour
illustrer les références absolues. Ima-
ginez que nous voulons multiplier un
ensemble de nombres par un facteur.
Dans la cellule D1 , plaçons 0,75. C'est
notre facteur. En D2, D3 et D4, nous
mettons 1 0, 20 et 30. Dans la colonne
E, nous mettrons nos calculs. Saisis-

sons la formule en E2 :

=D2*D1

La réponse est 7,5, qui est juste.
Cependant, si nous copions la formule
de E2 en E3 et E4, nous obtenons 200
et 600, ce qui est faux. Si nous re-
gardons les formules copiées, les réfé-
rences ont bougé, à cause de la
référence relative. Nous voulons que
le premier facteur change, mais D1
doit rester la référence fixe. En édi-
tant la formule en E2, changeons-la
ainsi :

=D2*$D$1

Nous avons encore la bonne ré-
ponse en E2. Maintenant, copiez la
formule de E2 en E3 et E4. Nous
obtenons 1 5 et 22,5, qui sont les bons
résultats. Si vous regardez les formules
copiées en E3 et E4, vous verrez que
la référence à D1 reste fixe.

QUATRE FAÇONS DE FAIRE

RÉFÉRENCE À UNE CELLULE

Avec ce qui précède en tête, nous
avons 4 manières différentes de faire
référence à une cellule. La référence
peut être relative, absolue ou partiel-
lement absolue (de deux façons dif-
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férentes).
••D1 - Relative, depuis E3, c'est à une
colonne à gauche et deux lignes au-
dessus.
••$D$1 - Absolue, D1 est la référence
depuis n'importe quelle cellule.
••$D1 - Partiellement absolue, la co-
lonne D est fixée, mais la ligne est
relative.
••D$1 - Partiellement absolue, la co-
lonneestrelativemais la ligne 1 estfixée.

RÉFÉRENCE À UNE CELLULE

D'UNE AUTRE FEUILLE

Pour faire référence à une cellule
d'une autre feuille, nous utilisons une
notation avec un point pour ajouter le
nom de la feuille à la référence. Par
exemple, Feuille1 .A1 . C'est pratique
si nous devons déplacer un calcul ou
un chiffre d'une feuille à l'autre. Pour
l'illustrer, nous allons renommer notre
feuille courante, ajouter une nouvelle
feuille et créer une référence d'une
feuille à l'autre.

Par un clic droit sur l'onglet de la
feuille active, choisissez « Renommer
la feuille… ». À l'invite, appelez-la My-
Data et cliquez sur OK. Pour créer une
nouvelle feuille, cliquez sur le « + » à
droite du dernier onglet. Sélection-
nez la cellule A1 de la nouvelle feuille
et saisissez :

=MyData.E2

ce qui dupliquera la valeur 7,5 pré-
sente en E2 de la feuille MyData.

NOTE : Si le nom de la feuille contient
des espaces, le placer entre des guille-
mets simples, comme 'My Sheet'.C3.

Comme les autres références, la
référence à la feuille peut être ab-
solue ou relative suivant qu'on place
ou non le signe « $ » devant.

LES PLAGES DE CELLULES

Parfois, nous avons besoin de faire
référence à un groupe de cellules plu-
tôt qu'à une seule. Dans ce cas, nous
utilisons les plages de cellules. Une
plage de cellules est créée en sépa-
rant deux références de cellules par
le signe [:]. La référence de gauche
représente le coin en haut à gauche
de la plage, celle de droite, le coin en
bas à droite de la plage. Par exemple,
A1 :C2 représente un ensemble de 6

cellules : A1 , A2, B1 , B2, C1 et C2. Ce-
pendant, une plage peut ne repré-
senter qu'une colonne ou qu'une
ligne, comme dans C2:C1 00 ou B3:H3.

Les mêmes règles de référence
relative ou absolue s'appliquent aux
plages de cellules. Vous pouvez créer
une référence absolue complète ou
partielle. Vous pouvez même la créer
sur plusieurs feuilles. Par exemple,
nous avons besoin d'une référence à
toutes les cellules A1 de toutes les
feuilles de Sheet1 à Sheet1 0. Nous
utiliserons la plage de cellules
Sheet1 .A1 :Sheet1 0.A1 .

Pour le confort, nous pouvons
nommer une plage. Pour nommer une
plage, sélectionner la plage de cel-
lules sur la feuille. Insérer > Noms >
Définir ouvre la boîte de dialogue Dé-
finir un nom. Donnez le nom. Retenez
que le nom ne peut contenir que des

lettres, des chiffres et le signe [_].
Notez l'utilisation d'une référence ab-
solue dans le champ Plage. Vous pou-
vez ajuster la plage manuellement ou
en cliquant sur le bouton de plage et
en choisissant la plage avec la souris
ou le curseur. Le champ Étendue per-
met de définir si la plage nommée
s'applique à tout le document ou seu-
lement à une feuille. Cliquez sur OK
pour sauver le nouveau nom de la
plage.

Les références aux cellules et les
plages sont fondamentales quand vous
commencez à travailler avec des mises
en pages de feuilles, des fonctions et
des formules complexes dans des do-
cuments Calc. La bonne compréhen-
sion des références absolues et rela-
tives fait gagner du temps et évite les
erreurs dans la copie des formules et
des références. Bien que simple, la
mauvaise utilisation des références
peut conduire à des résultats erronés.

Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a
ajouté de l'Amiga, pas mal de DOS et de
Windows, une pincée d'Unix, et un
grand bol de Linux et Ubuntu.
Il blogue à :
http://eeperry.wordpress.com

http://eeperry.wordpress.com
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L es tableurs sont parfaits pour collec-
ter des données comme les tempé-

ratures, les cours des actions et les don-
nées sportives. Toutefois, les données
en elles-mêmes sont de peu d'intérêt.
Nous devons trouver des moyens pour
les analyser. LibreOffice Calc fournit
des fonctions intégrées pour cela. Dans

cet article, nous allons examiner
quelques-unes des fonctions statisti-
ques simples intégrées dans Calc. Nous
n'allons pas faire un examen approfon-
di de toutes les fonctions, mais plutôt
s'exercer pour que vous soyez plus à
l'aise pour les utiliser.

IMPORTER LES DONNÉES

Pour nos données, j'ai rassemblé la
valeur du prix d'achat d'actions sur le
fonds mutualisé FFACX sur quelques
mois. Vous pouvez trouver les données
sur : http://pastebin.com/AeLcyM1 t.

Les données sont sous forme de
texte délimité par des virgules. Copiez
les données depuis Pastebin. Assurez-
vous que vous copiez à partir de la zone
de texte des « données brutes  » (ou
«  Raw Paste Data »). Créez un nouveau
document Calc. Cliquez avec le bouton
droit sur la cellule A1 et sélectionnez
Coller. La boîte de dialogue d'impor-
tation de texte va apparaître. Sous
Options de séparateur, sélectionnez
«  Séparé par  » et cochez «  Virgule  ».
Cliquez sur OK. Vous avez maintenant
deux colonnes de données, la date et le
prix. Enregistrez la feuille. [Ndt : Si Calc
est configuré en langue française, il faut

remplacer tous les «  . » par des « , » dans
la colonne B pour que les données soient
reconnues comme des nombres.]

CRÉER UNE PLAGE NOMMÉE DE

CELLULES

Tout au long de cet article, nous
allons utiliser ces prix comme plage de
données. Puisque nous allons utiliser
cette plage à plusieurs reprises, nous
allons la nommer pour rendre les réfé-
rences plus simples. Sélectionnez tous
les prix (les cellules B2:B82). La meil-
leure façon de sélectionner toutes les
cellules est de taper la plage B2:B82
dans la « Zone de nom  » de la barre de
formule et d'appuyer sur Entrée sur le
clavier. Insertion > Noms > Définir, et la
boite de dialogue «  Définir un nom  »
s'affiche. Nommez la zone «  Prix  ». Re-
marquez la référence absolue dans la
zone de texte de la plage ($Feuille1 .
$B$2:$B$82). Les noms s'appliquent à
un groupe spécifique de cellules et la ré-
férence est donc absolue. Dans le champ
«  Étendue  », nous allons restreindre
l'utilisation de ce nom à Feuille1 seu-
lement. Cliquez sur Ajouter pour créer
le nom de plage.

Maintenant, dans une formule ou
une fonction où nous utiliserons le nom

http://pastebin.com/AeLcyM1t
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«  Prix  », ce sera la même chose que
d'utiliser la plage de cellules $Feuille1 .
$B$2:$B$82.

MAX ETMIN

Les deux premières fonctions sta-
tistiques que nous examinerons sont
MAX et MIN. Les deux fonctions accep-
tent une liste de valeurs ou plage(s).
MAX retourne le maximum (la plus
grande valeur) dans la liste. MIN fait
exactement le contraire, retournant le
minimum (la plus petite valeur) dans la
liste.

Déplacez votre curseur sur D4. Sai-
sissez « maximum ». Dans la cellule E4,
tapez la formule :

=MAX(Prix)

Vous devriez obtenir le résultat
1 4,1 6. Si vous regardez la liste des prix,
vous découvrirez que c'est le plus
grand nombre dans la liste.

En D5 saisissez « minimum ». La for-
mule de E5 est :

=MIN(Prix)

Le résultat est 1 3,57, le plus petit
nombre dans la liste.

Il est également possible d'utiliser
ceci, ou n'importe quelle fonction Calc,
comme opérande dans une formule.

Par exemple, si nous voulions savoir la
différence entre le prix le plus élevé et
le plus bas, nous pourrions utiliser la
formule :

=MAX(Prix) – MIN(Prix)

dans la cellule E6. Dans la formule, les
résultats de ces fonctions sont cal-
culées en premier. MAX(Prix) devient
1 4,1 6 et MIN(Prix) devient 1 3,57. En-
suite, le résultat 1 4,1 6-1 3,57 est placé
dans la cellule E6. Indiquez le texte
«  différence  » dans la cellule D6 comme
étiquette.

MOYENNE, MÉDIANE ETMODE

Dans les statistiques, il y a de nom-
breuses façons de déterminer quelle
est la valeur représentative pour un
ensemble de nombres. Parmi celles-ci
se trouvent la moyenne arithmétique,
la médiane et le mode. La moyenne
arithmétique, connue de la plupart des
gens sous le nom de moyenne, est la
somme d'une série de nombres, divisée
par le nombre d'éléments de la série.
Dans Calc, nous utilisons la fonction
MOYENNE pour obtenir la moyenne
arithmétique.

La médiane classe les nombres du
plus petit au plus grand. Si on a un
nombre impair de données dans la
série, elle prend celui du milieu. Sinon,
la médiane est la moyenne arithméti-

que des deux nombres du milieu. Calc
utilise la fonction MEDIANE pour cal-
culer la médiane.

Le mode est le nombre qui se répè-
te le plus souvent. S'il y a égalité, on
prend le plus petit nombre. Calc utilise
la fonction MODE pour obtenir le
mode.

Nous pouvons voir les résultats de
ces trois fonctions en plaçant les for-
mules suivantes dans les cellules E7, E8
et E9.

=MOYENNE(Prix)

=MEDIANE(Prix)

=MODE(Prix)

Vous remarquerez que les résultats
sont à quelques centièmes les uns des
autres. Ce n'est pas vrai dans tous les
cas. Des valeurs qui sont beaucoup plus
grandes ou beaucoup plus petites que
les autres peuvent affecter la moyenne.
Dans ces cas-là, le mode ou la médiane
pourraient mieux répondre à vos be-
soins pour une valeur représentative.

Les fonctions statistiques de Calc
nous aident à analyser les données
dans une feuille de calcul. Nous n'avons
abordé que quelques-unes des fonctions
statistiques. Calc a plus de 70 fonctions
statistiques. C'est juste l'une des nom-
breuses catégories de fonctions dispo-
nibles dans Calc. Vous pouvez obtenir

une liste de toutes les fonctions Calc
dans la documentation de l'aide.

FORMATAGE CONDITIONNEL

Dans notre ensemble de données,
le haut et le bas sont assez rapprochés,
de sorte que la moyenne fonctionne
bien comme valeur représentative
pour cet ensemble de données. Nous
pouvons utiliser le formatage condi-
tionnel pour marquer chacun des prix
qui est soit au-dessus soit en dessous
de la moyenne.

Commencez par sélectionner tous
les prix dans la colonne B (B2:B82).
Depuis que nous avons nommé la plage
B2:B82, un moyen rapide pour sélec-
tionner tous les prix est d'utiliser la flè-
che déroulante de la Zone de nom de la
barre de formule et de sélectionner le
nom « Prix(Feuille1 ) ».

Format > Formatage conditionnel >
Condition fera apparaître la boîte de dia-
logue Formatage conditionnel. Sélec-
tionnez « La valeur de cellule est  » dans
la liste déroulante de gauche. Dans la
liste déroulante du centre, sélection-
nez « inférieur à ». Entrez $E$7 dans la
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boîte de texte à droite. Si vous sou-
haitez utiliser la médiane ou le mode
pour la comparaison, vous pouvez utili-
ser $E$8 ou $E$9. Nous utilisons une
référence absolue ici parce que nous
voulons faire référence à la même cel-
lule indépendamment de la ligne que
nous formatons.

Pour « Appliquer le style », sélec-
tionnez « Nouveau style » dans la liste
déroulante. La boîte de dialogue Style
de cellule s'ouvre. Dans l'onglet Ges-
tionnaire, nommez le style « sous la
moyenne ». Basculez vers l'onglet Ar-
rière-plan et sélectionnez la couleur
rouge. Cliquez sur OK pour fermer la
boîte de dialogue et enregistrer le nou-
veau style. Vous verrez que «  sous la
moyenne  » est maintenant sélectionné
en face d'Appliquer le style.

Cliquez sur Ajouter pour ajouter une
deuxième condition. Cette fois-ci, sélec-
tionnez «  supérieur à  » au lieu de «  in-
férieur à  ». Utilisez la même référence
absolue, $E$7, $E$8 ou $E$9, que vous
avez utilisée dans la condition «  infé-

rieur à  ». À nouveau sélectionnez «  Nou-
veau style  » pour Appliquer le style. Don-
nez au nouveau style le nom «  au-des-
sus de la moyenne  », et rendez le fond
vert au lieu de rouge. OK pour enre-
gistrer le nouveau style.

OK dans la boîte de dialogue For-
matage conditionnel enregistrera les
paramètres. Les prix qui sont supé-
rieurs à la moyenne seront mis en
évidence en vert, et les prix inférieurs à
la moyenne apparaîtront en rouge.

REMARQUE : Vous pouvez créer
votre style pour le formatage condi-
tionnel avant de créer la condition.
Dans ce cas, il vous suffit de sélec-
tionner le style à utiliser.

J'espère que cet article vous a aidé
à comprendre l'utilisation des fonctions
statistiques que nous avons vues et des
fonctions en général. Nous avons vu
comment utiliser les plages nommées
pour identifier des plages de cellules
utilisées de façon répétée. Nous avons
utilisé les fonctions seules ainsi que

comme opérandes dans une formule.
En utilisant le formatage conditionnel,
nous avons mis en évidence certaines
cellules pour montrer visuellement
l'état de la valeur de la cellule. Ceci
évite de revenir au début de la feuille
pour vérifier la valeur moyenne. Pour le
mois prochain, recherchez certaines fonc-
tions dans l'aide et utilisez-les. Jouez
aussi avec certaines des caractéristiques
du formatage conditionnel pour voir
quels autres visuels vous pouvez créer.

La prochaine fois, je vous montrerai
comment valider les valeurs des cel-
lules.

Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a
ajouté de l'Amiga, pas mal de DOS et de
Windows, une pincée d'Unix, et un
grand bol de Linux et Ubuntu.
Il blogue à http://eeperry.wordpress.com

http://eeperry.wordpress.com
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L orsque vous commencez à créer
des formules dans Calc, vous réa-

lisez vite qu'un mauvais type de don-
nées dans une cellule référencée par
votre formule peut invalider les résul-
tats. Calc fait de son mieux pour inter-
préter les données saisies selon le style
de mise en forme de la cellule. Si vous
formatez la cellule comme une date,
Calc fait de son mieux pour traduire le
contenu de cette cellule en date. Par-
fois, il réussit, parfois non. Heureuse-
ment, Calc est livré avec des options de
validité intégrées pour vous aider à con-
cevoir votre feuille de calcul de manière
à donner aux utilisateurs de l'aide à la
saisie, ou même les forcer à saisir le type
de données nécessaire pour la cellule.
Dans cet article, nous allons examiner les
options de validité et leurs capacités.

CONFIGURATION DE LAFEUILLE

Avant de passer aux options de vali-
dité de Calc, nous avons besoin de met-
tre en place une feuille de calcul où
nous allons utiliser ces options. La feuille de
calcul est une feuille de temps pour mon-
trer les heures travaillées au cours d'une
semaine. Cette feuille fonctionne bien
pour notre exemple, car pour un jour
donné, l'entrée de temps suivante doit
avoir une valeur supérieure à l'entrée
précédente.

Nous allons commencer par créer le
titre et les en-têtes de colonne. Dans la
cellule A1 , indiquez « Feuille de temps ».
Sur la ligne 2, remplissez les colonnes A
à F avec les titres suivants : JOUR, DÉBUT,
FIN, DÉBUT, FIN, TOTAL. Maintenant, les
en-têtes de ligne. Dans la cellule A3,
indiquez «  lundi ». Sélectionnez la cel-
lule A3 et cliquez sur le petit carré dans
le coin inférieur droit de la cellule en
surbrillance. Le curseur devient une croix.
Faites glisser vers le bas jusqu'à A9.
Lorsque vous relâchez le bouton de la
souris, les autres noms de jours sont
remplis. Cela fonctionne car les jours de
la semaine sont l'une des listes de tri

par défaut. Vous pouvez voir toutes les
listes et ajouter les vôtres dans Outils >
Options > LibreOffice Calc > Listes de tri.

Maintenant, formatons les cellules.
Sélectionnez B3:E9, faites un clic droit
et sélectionnez Formater les cellules.
Cliquez sur l'onglet Nombres. Dans la
liste Catégorie, sélectionnez Heure. Si
vous utilisez habituellement une horloge
sur 12 heures, sélectionnez l'option « 01 :37
PM » comme format. Pour une horloge
sur 24 heures, sélectionnez « 1 3:37 ». Cli-
quez sur OK pour enregistrer les options.
La colonne F contient les totaux. Nous
aurons besoin de choisir un format d'heure,

au moins pour la dernière, qui peut
aller au-delà de 24 heures. Sélectionnez
les cellules F3:F1 0, faites un clic droit,
sélectionnez Formater les cellules. À nou-
veau, sur l'onglet Nombres, sélectionnez
la catégorie Heure, mais pour le for-
mat, sélectionnez « 87661 3:37 ». Cela
permettra d'avoir des totaux dépassant
24 heures. Cliquez sur OK pour enre-
gistrer les paramètres.

Si vous ne l'avez pas encore fait,
vous pouvez enregistrer votre feuille
de calcul.

VALIDATION DE LA
CONFIGURATION

Nous aurons besoin de vérifier la
validité des saisies d'heures. Nous les
voulons dans un format acceptable pour
Calc. C'est la seule exigence pour des
données valides dans la colonne B. Pour
les autres colonnes (C à E), nous aurons
également besoin de vérifier que la saisie
est supérieure à la saisie précédente.

Sélectionnez la cellule B3, puis Don-
nées > Validité. La boîte de dialogue de
validité apparaît.

L'onglet Critères (en haut à gauche,
page suivante) est l'endroit où nous
contrôlons ce qui constitue des données
valides. La liste déroulante Autoriser
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définit le type de données qui est accep-
table. La valeur par défaut est « Toutes
les valeurs ». Les autres types sont
Nombres entiers, Décimal, Date, Heure,
Plage de cellules, Liste et Longueur du
texte. Les choix pour les différents types
sont fondamentalement les mêmes, sauf
pour Plage de cellules et Liste. Pour
Plage de cellules, vous définissez une
plage de cellules et la cellule doit
contenir une valeur qui est dans une de
ces cellules. La plage définie doit être
composée d'une seule colonne ou une
ligne. Avec l'option Liste, vous définis-
sez une liste de valeurs acceptables.
Avec les options Liste et Plage de
cellules, vous obtenez une zone de liste
déroulante avec les valeurs acceptables.
Pour nos besoins, nous devons régler
Autoriser sur Heure.

Cochez la case « Autoriser les
cellules vides » pour permettre aux
cellules de rester vides. Cela nous per-
mettra de commencer avec une feuille
de temps vide.

La liste déroulante Données vous
permet de sélectionner l'opérateur de
comparaison à utiliser pour cette
validation. Les choix sont égal à,
inférieur à, supérieur à, inférieur ou
égal à, supérieur ou égal à, différent,
plage correcte et plage incorrecte.
Chacun demande un minimum, un
maximum, ou une valeur à comparer, à
l'exception des deux choix de plages.
Les choix de plages nécessitent un
minimum et un maximum. Pour nos
fins, il nous faut l'opérateur supérieur
à. Dans la zone de texte minimum,
saisissez 1 2:00 AM ou 00:00.

Cliquez sur l'onglet Aide à la saisie

(ci-dessous). Les paramètres de cet on-
glet sont facultatifs. L'idée est de four-
nir à l'utilisateur des informations sur
ce qu'il faut saisir dans la cellule sous
forme de bulle qui apparaît lorsque la
cellule est sélectionnée. Pour l'activer,
cliquez sur la case à cocher « Afficher
l'aide à la saisie lors de la sélection d'une
cellule ». Créez un titre pour la bulle
d'aide en le plaçant dans la zone de texte
Titre. Dans notre cas, nous pourrions
utiliser le titre « Heure de début ». Dans
la boîte de texte Aide à la saisie, vous
mettez l'aide proprement dite, comme

« Saisissez l'heure de début : ex. 1 :00 PM
or 1 3:00 ».

Passez à l'onglet Message d'erreur
(ci-dessus). Ici, nous pouvons définir la
validation pour afficher un message lors-
que des données incorrectes sont sai-
sies. Pour activer la fonction, cochez la
case « Afficher un message d'erreur en
cas de saisie de valeurs incorrectes ». Il
y a quatre choix pour la liste déroulante
Action : Arrêter, Information, Avertisse-
ment et Macro. Arrêter, celle que nous
allons utiliser, affiche une boîte de dia-
logue et rejette l'entrée lorsque des
données incorrectes sont saisies. Pour
Information et Avertissement, une boîte
de dialogue est affichée avec les boutons
OK et Annuler lorsque des données
incorrectes sont saisies. Si l'utilisateur
clique sur OK, la saisie est conservée. Si
l'utilisateur clique sur Annuler, la saisie
est rejetée. Macro vous permet de sélec-
tionner une macro à exécuter lorsque
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des données incorrectes sont saisies.
Titre et Message d'erreur sont le titre
et le message de la boîte de dialogue.
Nous pourrions les régler à « Heure in-
correcte » et « Saisissez avec le format
d'heure : 1 3:00 or 1 :00 PM ».

Une fois que vous avez tout rempli,
cliquez sur OK pour enregistrer les para-
mètres du dialogue de validité.

Nous allons recopier la cellule B3
dans les cellules B4:B9. Un clic droit sur
la cellule B3 et sélectionnez Copier.
Sélectionnez les cellules B4:B9, faites
un clic droit et sélectionnez Coller. Cela
va copier les paramètres de validité
dans les cellules. La colonne entière aura
les mêmes exigences pour la saisie.

Pour les colonnes C, D et E, nous
allons faire presque la même chose.
Nous allons dérouler les étapes pour C,
et vous pourrez les répéter pour D et E.
Sélectionnez la cellule C3, Données >
Validité. Dans l'onglet Critères de la
boîte de dialogue de validité, sélection-
nez Heure dans la liste déroulante
Autoriser. Cochez pour autoriser les
cellules vides. Réglez Données sur « supé-
rieur à », et définissez la valeur minimale
à B3. Remarquez que nous utilisons ici
une référence de cellule relative. Cela
nous permettra de la copier sur les autres
cellules et la référence sera translatée.
Ces critères indiquent à Calc que la
cellule nécessite une valeur supérieure
à la valeur dans la cellule B3. Faites ce

que vous voulez avec les onglets Aide
et Erreur. Je recommande vraiment d'uti-
liser au moins des messages d'infor-
mation ou d'avertissement pour les don-
nées incorrectes. Les messages pourraient
mentionner qu'on a besoin d'une valeur
plus grande (ou postérieure). Faites un
clic droit sur la cellule C3 et copiez la
cellule, puis collez-la dans les cellules
C4:C9. Vous pouvez répéter pour les
colonnes D et E. Vous pouvez aussi
recopier C3 sur D3:D9 et E3:E9, mais
vous aurez besoin d'ajuster le texte
dans les boîtes de dialogue d'aide et
d'erreur.

FORMULES POUR LES
TOTAUX

Maintenant que notre validation est
en place, nous devons créer les for-
mules pour obtenir les totaux. Nous
allons commencer avec les totaux quo-
tidiens. Sélectionnez la cellule F3. Sai-
sissez la formule :

=(C3-B3)+(E3-D3)

ce qui nous donnera le total des
heures du lundi. Faites un clic droit sur
F3 et Copier. Sélectionnez les cellules
F4:F9, clic droit, et Coller. Pour le total
hebdomadaire en F1 0, nous allons
simplement additionner les totaux quo-
tidiens. Voici la formule :

=SOMME(F3:F9)

PROTECTION DES CELLULES

Une fois que vous avez mis en place
une feuille comme vous le souhaitez,
vous pouvez protéger les parties de la
feuille que vous voulez rendre non modi-
fiables, comme les étiquettes et les
formules. Tout d'abord, vous devez dire
à Calc si la cellule est protégée ou non.
Ensuite, vous ajoutez la protection de
la feuille ou du document une fois que
tout est terminé. Dans le cas de notre
feuille de temps, nous devons protéger
tout, sauf pour les cellules où l'utili-
sateur entre ses heures, B3:E9.

Par défaut, l'option Protéger est ac-
tivée pour toutes les cellules. Pour chan-
ger le réglage de protection pour les
cellules de saisie, sélectionnez B3:B9,
Format > Cellules, et le dialogue de
formatage des cellules apparaît. Cliquez
sur l'onglet Protection de cellule et
décochez Protégé.

À ce stade, vous pouvez toujours
modifier n'importe quelle cellule, car la
feuille et le document ne sont pas
protégés. Pour activer la protection de
la feuille ou du document, Outils >
Protéger le document > Feuille (ou Do-
cument). Le dialogue Protéger la feuille
ou Protéger le document apparaîtra en
fonction de l'option sélectionnée. Sai-
sissez et confirmez le mot de passe
dans la boîte de dialogue. Les options
vous permettront de vérifier si l'utilisa-
teur peut sélectionner des cellules
protégées ou non protégées. Si vous ne
saisissez pas de mot de passe, aucun
mot de passe n'est nécessaire pour
supprimer la protection de la feuille ou
du document.

Pour supprimer la protection d'une
feuille ou d'un document, Outils > Pro-
téger le document > Feuille (ou Docu-
ment). Si un mot de passe a été utilisé
lorsque la protection a été mise, sai-
sissez le mot de passe utilisé pour pro-
téger la feuille ou le document.

MARQUER LES DONNÉES
INCORRECTES AVEC AUDIT

Si vous avez sélectionné Avertis-
sement ou Information dans la liste
déroulante d'action dans le dialogue de
validité, un utilisateur peut entrer des
données incorrectes et cliquer sur OK
pour conserver la saisie incorrecte. Cela
peut générer des résultats étranges
dans vos totaux ou une erreur. Outils >
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Audit > Marquer les données incor-
rectes marquera les données incor-
rectes. Une fois que l'utilisateur corrige
les données, Outils > Audit > Marquer
les données incorrectes devrait effacer
les marques, à moins que les données
soient toujours incorrectes. Remarquez
sur mon exemple que des données non
valides peuvent entraîner que d'autres
cellules soient marquées comme incor-
rectes.

Les options de validité de Calc sont
un excellent moyen de mettre en place
des feuilles pour une utilisation par
d'autres personnes, ou pour vous em-
pêcher d'entrer des données incor-
rectes sur une feuille compliquée. Vous
pouvez les configurer pour rejeter les
données invalides purement et simple-
ment, ou pour que l'utilisateur puisse

faire le choix de garder la saisie. Une
fois que vous avez préparé la feuille
comme vous le souhaitez, vous pouvez
protéger la feuille contre les modi-
fications indésirables. C'est une bonne
façon de protéger les formules et les
étiquettes. Enfin, l'outil Audit permet à
l'utilisateur de marquer des données
incorrectes qui ont été saisies.

Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a
ajouté de l'Amiga, pas mal de DOS et de
Windows, une pincée d'Unix, et un
grand bol de Linux et Ubuntu.
Il blogue à http://eeperry.wordpress.com

http://eeperry.wordpress.com
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D ans mon dernier article, je vous ai
montré comment utiliser l'outil

«  Marquer les données incorrectes  » dans
les outils d'Audit de Calc. Cette fois-ci,
je vais présenter le reste des outils dans
le menu Audit qui nous aident à suivre
les cellules utilisées dans les formules.
Grâce à ces outils, nous pouvons voir quel-
les cellules affectent le résultat d'une for-
mule, quelles formules sont affectées
par une cellule, et quelles cellules sont
impliquées dans une formule qui se tra-
duit par une erreur. La feuille que nous
allons utiliser est petite pour vous aider
à comprendre comment ça fonctionne,
mais ces outils sont des plus utiles dans
les grandes feuilles avec des formules
compliquées.

CONFIGURATION DE LA FEUILLE

Créez une nouvelle feuille, vide. Dans
la cellule A1 , entrez la valeur 1 3. Sélec-
tionnez les cellules A1 :A6. Edition > Rem-

plir > Série… pour faire apparaître la boîte
de dialogue de Remplir la série. Pour la
Direction, sélectionnez En bas, et pour le
Type de séries, sélectionnez Remplis-
sage automatique. Cliquez sur OK, et les
cellules se remplissent de numéros sé-
quentiels. Sélectionnez les cellules A1 :D6.
Edition > Remplir > Série… Cette fois-ci,
choisissez À droite pour la Direction, mais
prendre à nouveau Remplissage auto-
matique pour le type de séries. Cliquez
sur OK et les cellules à droite sont rem-
plies avec des numéros séquentiels.

Créez des totaux pour les lignes et
les colonnes en sélectionnant la cellule
vide à la fin de la ligne ou colonne. Cli-
quez sur le bouton SOMME sur la Barre
de formule. Les cellules vers la gauche
pour les lignes et au-dessus pour les
colonnes, sont sélectionnées automati-
quement. Appuyez sur la touche Entrée/
Retour sur le clavier pour accepter les
résultats. Répéter l'opération pour cha-

cune des rangées et des colonnes.

La cellule E7 va additionner les to-
taux à la fois des lignes et des colonnes.
La formule est :

=SOMME(A7:D7;E1:E6)

REPÉRER LES ANTÉCÉDENTS

La fonction Repérer les antécédents
(en bas à droite) montre les cellules uti-
lisées par la formule dans la cellule ac-
tuelle. Les traces sont affichées sur la
feuille avec des flèches bleues et des
cadres bleus autour des plages de cellu-
les. Cela est vrai pour toutes les fonc-
tions de suivi.

Sélectionnez la cellule E7. Outils >
Audit > Repérer les antécédents. Les flè-
ches bleues indiquent les cadres et les
cellules utilisés par la formule. Si vous
avez entré correctement la formule, elle

inclut tous les totaux pour les lignes et
les colonnes. Pour effacer les marques
de repérage de la feuille, sélectionnez
Outils > Audit > Supprimer le repérage
des antécédents.

REPÉRER LES DÉPENDANTS

Repérer les dépendants (page sui-
vante, en haut à gauche) dessine des flè-
ches vers les cellules contenant des for-
mules qui s'appuient sur la cellule active.
Si vous sélectionnez C4, puis Outils > Au-
dit > Repérer les dépendants, vous obte-
nez des flèches pointant vers C7 et E4.
Deux de ces cellules contiennent des for-
mules qui font référence à C4 dans leur
champ d'application. Tout comme avec
repérage des antécédents, les champs
d'application des deux formules sont en-
tourés d'une boîte bleue. Pour effacer
les marqueurs de repérage, Outils  > Au-
dit  > Supprimer le repérage des dépen-
dants.
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ERREURS CALC COMMUNES

Avant de parler de repérer des er-
reurs, nous allons jeter un coup d'œil à
certaines erreurs courantes que vous
verrez dans Calc.

#DIV0! - La formule tente de diviser un
nombre par zéro. Comme nous l'avons
appris il y a longtemps en cours de ma-
thématiques élémentaires, vous ne pou-
vez pas diviser un nombre par rien. Cer-
taines fonctions, comme VARP et STDEV
(ECART TYPE), donneront cette erreur
lorsque vous ne parviendrez pas à utili-
ser les arguments minimaux requis.

#REF - La cellule ou la plage de réfé-
rence n'est pas valide. Cela arrive sur-
tout lorsque vous faites une erreur de
référence ou que vous référencez une
cellule ou une plage qui n'existe plus.
Par exemple, vous faites référence à
une feuille qui a été supprimée.

#VALEUR - L'entrée était d'un type au-

tre que celui attendu. C'est souvent cau-
sé par une référence à une cellule avec
du texte dans une fonction mathémati-
que ou une formule.

Err:510 - Une variable est absente de la
formule. Cela peut se produire lorsque
vous tapez deux opérateurs ensemble,
comme =1 +*3.

REPÉRER LES ERREURS

Repérer les erreurs dessine des flè-
ches vers toutes les cellules antécéden-
tes qui ont causé une erreur dans la for-
mule de la cellule actuellement sélection-
née. Pour démontrer cela, nous aurons
besoin de générer une erreur. #DIV0

est probablement le plus facile à géné-
rer. Entrez la formule =C3-D2 dans la
cellule E8. Le résultat est zéro. Dans la
cellule E9 entrez la formule =E7/E8. Ce-
la va générer une erreur #DIV0.

Pour repérer l'erreur, cliquez sur la
cellule E9. Outils > Audit > Repérer les
erreurs. Une flèche de repérage est des-
sinée à travers les cellules impliquées
dans la formule. Dans notre cas, il ne
s'agit que de deux cellules. Vous pouvez
remplacer le moins par un plus, la flè-
che s'effacera et l'erreur s'en ira, mais,
pour l'instant, laissons les choses comme
elle sont. Il y a encore une chose que je
veux vous montrer. La seule façon d'ef-
facer une trace d'erreur sans corriger
l'erreur est Outils > Audit > Supprimer
tous les repères.

COMBINER LES REPÉRAGES

Traquer un problème ou une erreur
n'est pas toujours aussi simple que d'uti-
liser l'un des outils de repérage. Vous
pourriez avoir besoin de les combiner
pour trouver le vrai problème. Prenons,
par exemple, notre erreur. Nous pou-
vons choisir la cellule E9, lancer le repé-
rage des erreurs, et voir que la formule
utilise les deux cellules au-dessus. Mais
une fois que vous réalisez que les deux
cellules contiennent aussi des formules,
vous pouvez repérer les antécédents sur
la cellule E8 pour voir si vous pouvez trou-

ver le problème. On se rend compte
alors que les deux cellules utilisées dans
la formule ont la même valeur. Alors,
vous vous apercevez que vous vouliez
utiliser C6 et pas C3. Changer C3 en C6
dans la formule de E8, et l'erreur et la
flèche de repérage de l'erreur disparais-
sent. Notez également que les repéra-
ges des antécédents se déplacent quand
la formule est modifiée.

Avec les outils de repérage de l'audit
dans Calc, vous pouvez voir les cellules
utilisées dans une formule et découvrir
pourquoi vous n'avez pas obtenu les ré-
sultats que vous attendiez. Repérer les
antécédents vous montre les cellules uti-
lisées par la formule dans la cellule ac-
tuelle. Utilisez Repérer les dépendants
pour montrer les cellules contenant des
formules qui utilisent la cellule actuel-
lement sélectionnée. Si vous essayez de
découvrir pourquoi une formule génère
une erreur dans la cellule actuelle, vous
utilisez l'outil Repérer les erreurs. En-
fin, vous pouvez combiner les diffé-
rents outils de repérage pour obtenir
une vue plus large de ce qui se passe,
ou ne se passe pas, dans votre feuille.
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D ans le passé, j'ai présenté et uti-
lisé des fonctions pour illustrer

d'autres fonctionnalités de Calc, mais
aujourd'hui, je vais vous montrer trois
façons différentes de saisir des fonc-
tions. Je vous montrerai la structure
d'une fonction ; nous créerons des
données pour une feuille de calcul ;
puis j'appliquerai chacune des méthodes
de saisie : l'assistant Fonctions, la liste
de fonctions et l'entrée manuelle.

STRUCTURE D'UNE FONCTION

Comprendre la structure des fonc-
tions aide si vous prévoyez de vous en
servir. Je vais utiliser la fonction sui-
vante pour présenter la structure des
fonctions :

=PRODUIT(B5; A1:A6; 0,25)

Les fonctions font toujours partie
d'une formule. Quand vous utilisez
n'importe quelle formule ou fonction,
elle doit toujours commencer par un
signe « = ». Si vous utilisez plusieurs
fonctions, le signe « = » n'est néces-
saire qu'au début.

Le début de la fonction est le nom
de la fonction. Traditionnellement,
les noms de fonctions sont saisis en

majuscules, mais Calc reconnaît aussi
les minuscules ou un mélange des
deux. Conservant la tradition, je saisis
habituellement mes noms de fonction
en majuscules. Le nom de notre fonc-
tion exemple est PRODUIT. PRODUIT
est à la multiplication ce que SOMME
est à l'addition ; le résultat final est la
multiplication de tous ses arguments.

La liste des arguments, séparés par
des points-virgules et encadrés par
des parenthèses, suit le nom de la
fonction. C'est la partie (B5; A1 :A6;
0,25) de la fonction exemple. La forme
des arguments peut différer et la
fonction s'attendra habituellement à
un certain type d'argument dans cha-
cune des positions. Les arguments
peuvent prendre la forme d'un nombre
(9), d'un « texte entre guillemets »,
d'une référence de cellule (B5), d'un
groupe de cellules (A1 :A6), d'une
comparaison (C3>C1 ) ou d'une autre
fonction. Notez qu'un nombre entre
guillemets, "9", est un argument de
type texte, pas un nombre.

PRÉPARER LA FEUILLE

Je travaille avec des installateurs
de systèmes de contrôle d'accès. Lors

du paramétrage d'un nouveau sys-
tème, il est nécessaire de calculer com-
bien d'alimentations seront nécessaires
pour fournir la puissance à l'équipe-
ment sur le site. Nous utilisons une
formule pour calculer la chute de ten-
sion pour chaque appareil. Le calcul
comprend la tension d'entrée, le cou-
rant consommé par l'appareil plus
celui consommé par les appareils sui-
vants, multiplié par la résistance de la
longueur du câble allant jusqu'à l'ap-
pareil. La formule de base est :

Vout = Vin - I(DR)

Où Vin est la tension d'entrée, I, le
courant consommé par l'appareil et
les appareils suivants, D est la longueur
de câble (en m) et R, la résistance du
câble par mètre. Préparons une feuille
de calcul pour calculer la tension Vout
disponible pour chaque appareil.

Commencez avec un titre « Tension
initiale » dans la cellule A1 . Dans les

cellules A2:E2, placez les titres de
colonne suivants : Appareil, Courant,
Distance, Résistance/mètre, et Ten-
sion disponible. Dans la cellule B1 ,
entrons 1 3,2 comme tension initiale,
en A3:A5, mettons 1 , 2, 3 pour les
appareils. B3:B5 contient les courants
consommés par chaque appareil. Pre-
nons 0,3, 0,25 et 0,5. Les trois lon-
gueurs de câbles sont 25, 30 et 40.
Pour la résistance par mètre, utilisez
0,01 1 5 pour les trois. C'est la résis-
tance par mètre approximative d'un
câble d'une section de 1 ,5 mm2. Lais-
sez la colonne Tension disponible vide.
C'est là que nous entrerons nos for-
mules.

L'ASSISTANT FONCTION

L'assistant Fonction est la mé-
thode la plus complète pour entrer des
formules avec des fonctions. C'est
aussi la plus lente du fait du nombre
d'options. L'assistant est une bonne
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façon de construire une formule com-
pliquée, en vous permettant de trai-
ter individuellement les morceaux
d'information, chacun à son tour. Nous
utiliserons l'assistant pour créer la for-
mule de la tension du premier ap-
pareil.

Il y a trois façons d'ac-
céder à l'assistant Fonc-
tion. Sélectionnez la cel-
lule E3 et faites une des actions
suivantes :
• Cliquez sur le bouton Assistant Fonc-
tion de la barre de formule.
• Insertion > Fonction…
• CTRL + F2

L'assistant Fonction affiche une zone
de liste des fonctions sur la gauche.
La liste déroulante Catégorie vous per-
met de réduire la liste des fonctions à
la catégorie choisie. Il y a aussi une
catégorie « Les dernières utilisées »
pour n'afficher que celles récemment
utilisées. Un simple clic sur un nom de
fonction affiche sur la droite une courte
explication de la fonction. Si vous
double-cliquez sur un nom de fonc-
tion, la fonction est insérée dans la
zone de texte des formules, en bas à
droite. Notez que l'assistant a déjà
ajouté le signe égal à votre place. Au
centre à droite, des zones de texte
sont affichées pour entrer les argu-
ments de la fonction. Au-dessus des

zones des arguments, une courte des-
cription de la fonction est affichée,
avec une liste des arguments et leurs
types. En haut à droite, le résultat de
la formule en cours est présenté,
alors que le résultat global de la
formule est présenté au-dessus de la
zone d'édition de la formule.

Notre formule commence par la
tension initiale. Pour le premier appa-
reil, elle est de 1 3,2 en cellule B1 ;
aussi, cliquez en bas dans la zone de
texte des formules et saisissez « B1 - ».
Dans la liste déroulante des catégo-
ries, choisissez Mathématique. Descen-
dez la liste et double-cliquez sur
PRODUIT. La fonction PRODUIT est
ajoutée à la formule.

Cliquez dans la zone de texte Nom-
bre 1 . Le premier argument est la
somme de tous les courants pour tous
les appareils. Cliquez sur la bouton
assistant Fonction à gauche de la zone
de texte Nombre 1 . Ceci vous ouvre
une fenêtre d'assistant Fonction vierge.
Notez que vous avez des boutons
Précédent et Suivant en bas. Sélec-
tionnez Mathématique dans la liste
des catégories, mais cette fois, dou-
ble-cliquez sur la fonction SOMME.
Cliquez sur la zone de texte Nombre
1 . Utilisez votre souris pour sélec-
tionner les cellules B3:B5. Le choix est
ajouté à la zone de texte Nombre 1
de SOMME.

Cliquez deux fois sur Précédent
pour revenir à la fonction PRODUIT
que nous avons commencé. Notez que
la fonction SOMME est maintenant
dans la zone de texte Nombre 1 .
Sélectionnez la zone de texte Nom-
bre 2. À nouveau, double-cliquez sur
PRODUIT. Dans la zone de texte
Nombre 1 de cette deuxième fonc-
tion PRODUIT, entrez ou sélectionnez
le groupe C3:D3.

Nous avons maintenant fini notre
formule. La formule finale devrait
ressembler à :

=B1-
PRODUIT(SOMME(B3:B5);PRODUIT(
C3:D3))

Cliquez sur OK pour fermer l'assis-
tant.

NOTE : J'aurais pu utiliser l'opéra-
teur de multiplication (*) dans la fonc-
tion PRODUIT pour obtenir le même
résultat, mais j'ai utilisé la fonction
pour illustrer la possibilité d'utiliser
des fonctions comme arguments d'au-
tres fonctions.

LISTE DE FONCTIONS

La liste de fonctions est l'assistant
sans tout le bastringue. En fait, c'est
juste la partie liste de fonctions de
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l'assistant. L'idée derrière cela, c'est
de vous aider à ajouter directement
des fonctions dans les cellules. Vous
pouvez afficher la liste des fonctions
par le menu Insertion > Liste des
fonctions ou en cliquant sur l’icône
Fonctions du volet latéral. Quand vous
sélectionnez un nom de fonction dans
la liste, une courte description appa-
raît en bas de la liste. La liste de

fonctions a aussi une catégorie appe-
lée Les dernières utilisées, qui contient
la liste des fonctions que vous avez
utilisées récemment.

Utilisons-la pour créer la formule
du second appareil. Sélectionnez la
cellule E4. Sélectionnez la zone de
saisie de texte dans la barre de for-
mule. C'est le meilleur endroit pour
entrer une fonction en utilisant la

liste de fonctions. Pour cet appareil,
nous avons besoin de la tension dis-
ponible à l'entrée du premier appareil ;
aussi, commencez la formule avec
«  =E3- ». Nous devrions voir la fonc-
tion PRODUIT dans la liste des der-
nières utilisées. Double-cliquez sur
PRODUIT pour l'ajouter à la formule.
Le curseur étant placé entre les pa-
renthèses, double-cliquez sur SOMME,
qui est aussi affiché dans Les der-
nières utilisées. Sélectionnez la tranche
B4:B5. Cliquez dans la formule et
utilisez les touches fléchées pour dé-
placer le curseur hors des paren-
thèses de SOMME. Tapez un point-
virgule et double-cliquez à nouveau
sur PRODUIT. Saisissez ou sélection-
nez la rangée C4:D4. Appuyez sur
Entrée.

Le résultat final devrait être :

=E3-
PRODUIT(SOMME(B4:B5);PRODUIT(
C4:D4))

ENTRÉE MANUELLE

L'entrée manuelle consiste simple-
ment à taper de mémoire la formule

directement dans la zone de saisie de
texte. La formule pour le dernier ap-
pareil est la plus facile car il n'y a plus
de somme des courants des appareils
à faire, puisque c'est le dernier. Sélec-
tionnez la cellule E5 et saisissez :

=E4-PRODUIT(B5;
PRODUIT(C5:D5))

et appuyez sur Entrée. Pendant que
vous tapez la fonction, Calc vous
affiche une info-bulle de la fonction
et de ses arguments.

Calc vous offre trois méthodes
pour entrer des fonctions dans une
cellule. Utilisez l'assistant Fonction
quand vous avez besoin d'être guidé
précisément ou quand vous entrez
une formule compliquée pour la pre-
mière fois. La liste de fonctions vous
donne une liste, avec une courte
explication, pour vous aider à utiliser
les bons arguments et fonctions dans
votre formule. La méthode manuelle
est bien pour entrer des formules
courtes, pour utiliser des fonctions
qui vous sont familières ou pour
répéter une formule que vous avez
déjà utilisée.

Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a
ajouté de l'Amiga, pas mal de DOS et de
Windows, une pincée d'Unix, et un
grand bol de Linux et Ubuntu.
Il blogue à : http://eeperry.wordpress.com

http://eeperry.wordpress.com
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L es feuilles de calcul sont un bon
endroit pour collecter des don-

nées. Le Web est une source géniale
de données et beaucoup d'entre elles
sont dynamiques. Vous pouvez même
envisager de les collecter dans une
feuille et lui faire refléter la nature
dynamique des données du Web. Calc
vous permet les liaisons avec des sour-
ces de données externes, y compris
des pages Web, avec une facilité qui
vous surprendra.

Beaucoup de gens commercent
en bourse. Ce commerce nécessite de
suivre les valeurs assidûment. Dans le
passé, j'ai montré ceci, fait à la main,
mais maintenant, je vais vous montrer
comment utiliser une feuille Calc
pour suivre les actions du top 1 00
telles que regroupées par le site web
barchart.com.

Comme tant de choses, il y a plus
d'une façon de le faire. Je vais vous
montrer la façon qui, à mon sens, est
la plus facile pour découvrir et obte-

nir exactement l'information que vous
voulez. Vous allez importer la page
Web en utilisant le filtre Requête de
page Web. Une fois importée, vous
pouvez analyser les éléments de la pa-
ge pour trouver les données que vous
voulez extraire. Ensuite, vous créerez
votre feuille des 1 00 actions par co-
pier/coller depuis le fichier source im-
porté.

CONFIGURER LA FEUILLE

SOURCE

Quand vous importez la source en
utilisant le filtre Requête de page Web,
vous n'êtes pas vraiment en train de
travailler sur une page locale, mais sur
un lien vers la page sur Internet. Vous
ne sauverez pas cette importation
(mais vous le pourriez). À la place,
nous allons l'utiliser comme référence
vers la vraie page sur le site Web,
barchart.com.

Dans le menu, Fichier > Ouvrir. En

bas de la boîte de dialogue Ouvrir,
vous trouverez une liste déroulante
des types de fichiers. Tous les diffé-
rents types de fichiers reconnus par
Calc sont listés là. Parcourez la liste et
trouvez le filtre appelé «  Requête de
page Web (Calc)  ». Ceci vous aidera à
créer le lien vers la page Web. Dans le
champ « Nom du fichier », entrez (ou
copiez-collez) l'URL suivante :
http://www.barchart.com/stocks/sign
als/top1 00.

Cliquez sur le bouton Ouvrir. Calc
prendra quelques secondes avant
d'ouvrir la boîte de dialogue des
Options d'import. L'option Automati-
que importera la page Web «  telle
quelle  ». Personnalisé vous permet de
sélectionner une autre langue pour
l'importation. Je vous recommande
d'utiliser Automatique qui vous offrira

les meilleures chances d'une interpré-
tation correcte. La case à cocher «  Dé-
tecter les nombres spéciaux (tels que
les dates)  » fait ce que vous pensez
qu'elle doit faire. Quand elle est co-
chée, les dates, heures…, sont détec-
tées et mises au format approprié
dans la feuille. Nous n'avons pas à nous
préoccuper de nombres spéciaux ; donc,
nous n'en avons pas besoin. Cliquez
OK pour accepter les options. Suivant
la connexion à Internet, la vitesse et
la mémoire du PC, il faudra quelques
secondes à Calc pour importer la feuil-
le. Notez qu'il importe la page Web
entière, sans les images.

NOTE : En fait, c'est un lien vers la
page Web. Jusqu'ici, rien n'a été
sauvé en local sur le PC.

http://www.barchart.com/stocks/signals/top100
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LE NAVIGATEUR

Nous utiliserons le Navigateur pour
analyser la page importée et relier les
données à notre nouveau document.
Le Navigateur vous montre les élé-
ments et la structure du document et
est adapté au type du document que
vous avez ouvert. Il convient bien, non
seulement pour nos besoins ici, mais
aussi pour naviguer et manipuler un
document, surtout s'il est gros. Ac-
tuellement, il y a quatre façons d'ou-
vrir le Navigateur :
••Appuyer sur la touche F5.
••Afficher > Navigateur.
••L'onglet Navigateur dans la barre la-
térale.
••Le bouton Navigateur dans la barre
standard.

ANALYSER LA SOURCE

Quand une page Web est impor-
tée, plusieurs noms de plages sont
créés, de même que les noms des ta-
bles importées de la page Web. Le
préfixe HTML_ est ajouté à tous les
noms importés depuis la page. Le
filtre crée deux plages spéciales,
HTML_all et HTML_tables. HTML_all
permet de sélectionner tout le docu-
ment. HTML_tables permet de sélec-
tionner toutes les tables. Le problè-
me auquel vous serez confronté, c'est
que le créateur de la page n'a pas for-
cément pensé à l'importation de sa
page dans Calc. Les noms des tables
importées sont les références du créa-
teur, pas les vôtres.

Si, dans notre document source,
vous ouvrez le Navigateur par une des
méthodes indiquées plus haut, vous
découvrirez dans le Navigateur une
liste de noms sous la rubrique «  Noms
de plage  ». Double-cliquez sur un nom
de plage pour la surligner dans le do-
cument. En parcourant la liste, vous
comprendrez rapidement que les noms
HTML_4 et HTML_dt1 concernent
tous les deux la table des valeurs des
actions. Nous utiliserons l'un des deux
pour créer notre document de va-
leurs.

IMPORTER UNE TABLE DANS

UNE NOUVELLE FEUILLE

Maintenant que nous savons quel
nom de plage utiliser pour importer les
données des valeurs, c'est le moment
de créer la feuille que vous voulez
sauver et conserver. Nous ferons un
import du document source dans ce
nouveau document. Souvenez-vous que
votre document source n'est qu'un
lien vers la vraie page Web ; rien n'a
encore été sauvegardé en local sur
votre ordinateur.

À partir du menu, Fichier > Nou-
veau > Classeur. Utilisez l'une des qua-
tre méthodes présentées plus haut
pour ouvrir le Navigateur. À partir de
la liste des documents au bas de la
fenêtre (du panneau), sélectionnez le
document source, top1 00. Cliquez sur
l'icône «  Mode Glisser  » dans la barre
d'outils du Navigateur et changez le
choix pour «  Insérer comme lien  ».
Ouvrez la liste sous «  Noms de plage  ».
Sélectionnez HTML_4 ou HTML_dt1 ,
tirez-le sur la cellule A1 du nouveau
document et relâchez. Après quelques
secondes, en fonction des vitesses
d'Internet et de votre ordinateur, les
données des valeurs seront affichées
dans la nouvelle feuille. Enregistrez le
nouveau document. Vous pouvez main-
tenant fermer le document source. Il
n'y a pas besoin de le sauvegarder. Le
nouveau document est relié directe-
ment à la page sur le site Web et non
au document source.
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Vous pouvez fermer votre nou-

veau document et, en le rouvrant, il
vous sera demandé si les liens exter-
nes doivent être actualisés. Si vous
répondez Oui, Calc va recharger une
version récente de la page Web et
mettre à jour les données de la feuil-
le. Vous pouvez configurer le fichier
pour une mise à jour régulière quand
il est ouvert. Dans les menus, Édition
> Liens… ouvre la boîte de dialogue
Éditer les liens. Quand le lien est sé-
lectionné, cliquez sur le bouton Modi-
fier… pour ouvrir la boîte de dialogue
Données externes. Cochez «  Actuali-
ser toutes les…  » et saisissez le nombre
de secondes entre deux mises à jour.
Par exemple, toutes les cinq minutes
correspond à 300 secondes, dix minu-
tes à 600 secondes et une heure à
3  600 secondes. Cliquez sur OK pour
enregistrer vos modifications et Fer-
mer pour fermer la boîte de dialogue
Éditer les liens.

Importer des données dynami-
ques d'une page Web dans Calc est
assez simple. Le filtre Requête de
page Web est utilisé pour relier la
page Web à une feuille. Avec le Navi-
gateur, vous pouvez analyser la page
pour déterminer le nom de plage qui
contient les données recherchées. Une
fois que vous savez quel nom de pla-
ge sélectionner, vous utilisez le Naviga-
teur pour tirer-coller le nom de plage

dans le nouveau document, que vous
sauvegardez ensuite. Vous pouvez dé-
cider d'une mise à jour des données
externes lors de chaque ouverture du
nouveau document, ou périodique-
ment, pour peu que vous ayez défini
l'intervalle de temps.

Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a
ajouté de l'Amiga, pas mal de DOS et de
Windows, une pincée d'Unix, et un
grand bol de Linux et Ubuntu.
Il blogue à http://eeperry.wordpress.com

ÉDITIONS SPÉCIALES PYTHON :

http://www.fullcirclemag.fr/?
download/224

http://www.fullcirclemag.fr?
download/230

http://www.fullcirclemag.fr/?
download/231

http://www.fullcirclemag.fr/?
download/370

http://www.fullcirclemag.fr/?
download/371

http://www.fullcirclemag.fr/?
download/372

http://www.fullcirclemag.fr/?
download/240

http://www.fullcirclemag.fr/?
download/268

http://www.fullcirclemag.fr/?
download/272

http://eeperry.wordpress.com
http://www.fullcirclemag.fr/?download/224
http://www.fullcirclemag.fr/?download/230
http://www.fullcirclemag.fr/?download/272
http://www.fullcirclemag.fr?download/370
http://www.fullcirclemag.fr/?download/371
http://www.fullcirclemag.fr/?download/372
http://www.fullcirclemag.fr/?download/231
http://www.fullcirclemag.fr/?download/240
http://www.fullcirclemag.fr/?download/268
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S e relier à des données du Web est
souvent utile, mais, parfois, vous

avez juste besoin de passer des don-
nées d'une feuille de calcul à un autre
fichier Calc. Vous pouvez simplement
importer ou lier toute la feuille à un
autre fichier. Vous le faites par la boîte
de dialogue Insertion Feuille… Un autre
choix existe, avec un peu plus de pos-
sibilités, en créant des plages de don-
nées nommées à relier à la nouvelle
feuille. Vous pouvez le faire par le Navi-
gateur comme vous l'avez fait pour les
données du Web, mais il y a une autre
méthode d'insertion par la boîte de
dialogue Données Externes.

DIFFÉRENCE ENTRE INSÉRER

ET LIER

Parce que notre sujet principal
concerne les liaisons de données avec
d'autres feuilles, vous devez savoir la
différence entre insérer une feuille et
lier une feuille. Quand une feuille est
insérée, vous pouvez changer les don-
nées dans les cellules des deux feuilles
et les changements dans l'une ne
changent rien dans l'autre. À l'inverse,
quand vous créez dans la feuille 2 un
lien à la feuille 1 , les changements dans
les cellules de la feuille 1 remplacent

les changements de la feuille 2 quand
la feuille 2 est mise à jour. Les chan-
gements dans la feuille 2 n'ont aucun
effet sur la feuille 1 .

LIER/INSÉRER UNE FEUILLE

ENTIÈRE

Parfois, vous avez seulement be-
soin de toute la feuille de calcul d'un
tableur dans le fichier d'un autre ta-

bleur. Si vous voulez faire des modi-
fications dans la feuille et que ces
changements persistent, vous devez
importer la feuille. Cependant, si vous
avez besoin que tous les change-
ments dans la feuille originale soient
appliqués aussi à la nouvelle feuille,
vous avez besoin de créer un lien. À
partir du menu Insertion > Feuille…,
vous ouvrez la boîte de dialogue Insé-
rer une feuille.

Vous avez deux choix pour posi-
tionner la nouvelle feuille dans le
tableur. Vous pouvez la placer avant
ou après la feuille actuellement sélec-
tionnée. Les options Position vous
permettent de sélectionner où vous
voulez placer la nouvelle feuille impor-
tée/liée.

Vous avez le choix entre créer une
nouvelle feuille vierge ou sélection-
ner une feuille existante d'un autre
fichier. Les choix sous « Nouvelle
feuille » vous permettent de créer
une ou plusieurs feuilles vierges. Les
réglages sous « À partir d'un fichier »
vous donnent le choix d'importer, et
éventuellement de lier, une feuille
d'un autre fichier.

Dans les options de « Nouvelle
feuille », vous pouvez définir le nom-
bre de feuilles vierges à ajouter et, si
vous n'en voulez qu'une, le nom de la
feuille. Si vous créez plus d'une feuille,
l'option Nom est grisée. Les feuilles
sont créées avec un préfixe par dé-
faut, suivi d'un chiffre itératif. Le pré-
fixe par défaut peut être défini dans
Outils > Options > LibreOffice Calc >
Par défaut.
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Pour les options de « À partir d'un

fichier », vous utilisez le bouton « Par-
courir… » pour définir le fichier conte-
nant la feuille (ou les feuilles) à im-
porter dans votre nouveau fichier de
tableur. Une fois que le fichier choisi
est ouvert, la liste des feuilles appa-
raît dans la fenêtre déroulante. Sélec-
tionnez la/les feuille(s) que vous vou-
lez dans votre nouveau fichier. Pour
sélectionner plusieurs feuilles succes-
sives, cliquez sur la première, puis main-
tenez la touche MAJ appuyée pour
cliquer sur la dernière. Si vous voulez
sélectionner des feuilles dispersées,
cliquez sur la première, maintenez la
touche CTRL appuyée et cliquez sur
chaque feuille à sélectionner. Une fois
les feuilles sélectionnées, vous pouvez
cocher la case Lier pour relier les feuilles
plutôt que d'en importer une copie.
Souvenez-vous cependant que la mise
à jour de chaque feuille se fera à par-
tir de celle d'origine.

Cliquez sur OK pour importer/créer
les feuilles, suivant les options choi-
sies.

LIER UNE PARTIE DE FEUILLE

Pour vous montrer comment se
relier à des données du Web, j'ai
utilisé le Navigateur pour lier les don-
nées. Aujourd'hui, je vais vous montrer

une autre méthode de liaison de don-
nées ; cette fois-ci, je vais relier les
données à partir d'une autre feuille et
non du Web.

Pour lier seulement une section
d'une feuille, vous devez définir la
portion de votre feuille que vous vou-
lez lier. C'est fait en créant une plage
nommée. Nous avons parlé des plages
nommées dans la partie 42 (n° 90 du
Full Circle Magazine). Nous créerons
une plage nommée afin de pouvoir
créer une liaison à cette portion de la
feuille.

Par exemple, disons que vous vou-
lez lier juste les 1 0 premières lignes
de vos 1 00 valeurs boursières, tirées
du Web la dernière fois. Ouvrez le
fichier des 1 00 valeurs boursières liées
aux données du Web. Sélectionnez la
plage A1 :H1 2. Insertion > Noms >
Définir…. La boîte de dialogue Définir
un nom s'ouvre. Donnez un nom à la
plage comme « Top1 0 ». Souvenez-
vous que le nom ne doit pas contenir
d'espace. Le champ Plage doit corres-
pondre à la zone sélectionnée. Con-
server « Document (global) » dans le
champ Étendue. Cliquez sur Ajouter
et sauvegardez la feuille.

Créer un nouveau fichier de ta-
bleur, Fichier > Nouveau > Classeur.
Cette fois, nous allons utiliser la boîte
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de dialogue Données externes à la
place du Navigateur. Insertion > Lien
vers des données externes… ouvre la
boîte de dialogue. La liste déroulante
présente un ensemble de documents
récents. Sélectionner le fichier des
1 00 valeurs boursières. Si le docu-
ment voulu n'apparaît pas dans la
liste déroulante, vous pouvez cliquer
sur le bouton aux 3 points (…) pour
naviguer et sélectionner le fichier.
Une fois le fichier sélectionné, les
plages nommées apparaissent dans la
liste. Sélectionnez la plage nommée
Top1 0 du fichier des valeurs bour-
sières pour créer un lien avec les 1 0
premières valeurs. Vous pouvez défi-
nir la fréquence d'actualisation quand
le fichier est ouvert, en réglant le
champ « Actualiser tous les : ». Gardez
en tête que cette valeur est en
secondes.

Cliquez sur OK et vous avez main-
tenant un lien vers les 1 0 premières
valeurs boursières. Les données seront
rafraîchies à partir de la feuille d'ori-
gine chaque fois que vous ouvrez la
feuille ou régulièrement à l'intervalle
de temps spécifié.

Vous pouvez aussi relier une page
Web en utilisant la boîte de dialogue
Données externes. Tapez simplement
l'URL ou collez-la dans la liste dérou-
lante et appuyez sur Entrée. Vous

obtiendrez la boîte de dialogue pré-
sentée dans le précédent article. Vous
obtiendrez une liste de noms de liens.
Contrairement à la méthode par le
Navigateur, il n'y a pas de possibilité
de prévisualiser quel est l'élément
recherché. C'est une question de tâton-
nements (avec beaucoup d'erreurs).
C'est pourquoi je recommande la mé-
thode du Navigateur qui me semble
la meilleure pour lier des données du
Web.

Vous pouvez utiliser aussi la mé-
thode du Navigateur pour lier des
plages nommées à d'autres docu-
ments. Il suffit de tirer la plage nom-
mée dans le nouveau document.

Nous pouvons non seulement lier
des données sur le Web, mais nous
pouvons aussi relier des données
d'autres fichiers Calc. Nous pouvons
importer ou lier des feuilles entières
en utilisant la boîte de dialogue
Insérer une feuille. Si nous voulons
seulement une partie de la feuille,
nous pouvons créer une plage nom-
mée dans la feuille d'origine. Dans la
nouvelle feuille, nous pouvons créer
un lien vers la plage nommée de la
feuille d'origine par la boîte de dia-
logue Données externes. Gardez tou-
jours en mémoire la différence entre
importer et lier. Les données impor-
tées ne sont pas affectées par des

modifications dans l'original, alors
que les données liées sont affectées
par ces modifications.

Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a
ajouté de l'Amiga, pas mal de DOS et de
Windows, une pincée d'Unix, et un
grand bol de Linux et Ubuntu. Il blogue
à http://eeperry.wordpress.com

FCM N°1 00

ENQUÊTE

La question est :

Quelles sont vos saveurs et
versions préférées/détestées ?

Répondez à ce sondage rapide et
nous publierons les résultats

dans le FCM n° 1 00

http://goo.gl/DPt2q0

http://eeperry.wordpress.com
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D ans l'article du mois prochain, je
présenterai l'utilisation de ma-

cros comme fonctions, mais, avant de
le faire, je dois impérativement pré-
senter la sécurité dans les macros. Bien
que les macros soient un outil puis-
sant quand elles sont bien utilisées,
elles peuvent contenir du code dange-
reux pour les données de votre ordi-
nateur. Depuis des années, de nom-
breux virus d'ordinateur sont transmis
par le biais de documents avec ma-
cros. Avec un peu d'attention et quel-
ques réglages, vous pouvez minimiser
les risques que votre ordinateur attra-
pe un virus à partir des macros des
documents.

N IVEAUX DE SÉCURITÉ

Ouvrez les réglages de sécurité
des macros dans le menu  : Outils  >
Options > LibreOffice > Sécurité  >
Sécurité des macros... (bouton). Libre-
Office a quatre niveaux différents de
sécurité des macros, d'aucune limita-
tion à très restrictif. Chaque niveau a
ses avantages. Regardons chacun en
détail.

Faible : c'est le niveau « Sans sécu-
rité ». Toutes les macros sont exécu-

tées sans vous poser de question.
Elles peuvent tourner sans que vous
le sachiez, elles peuvent endomma-
ger vos fichiers et vos réglages. C'est
comme marcher pieds nus sur un nid
de serpents : vous serez mordus. Le
seul cas où ce niveau aurait un sens,
c'est sur un ordinateur qui est com-
plètement isolé d'Internet et sur le-
quel on n'ouvre jamais de fichier qui
n'ait pas été créé sur cet ordinateur.

Pas très réaliste.

Moyen : c'est le niveau « Êtes-vous
sûr ? ». Avec le niveau moyen de pro-
tection, le document lancera une ma-
cro si elle vient d'une source sûre - on
en parlera plus bas - sans vous poser
de question. Si le document ne vient
pas d'une des sources sûres, Libre-
Office vous demandera si les macros
du document peuvent être lancées.

Vous avez le choix : Oui ou Non. Je
vous donnerai plus loin des recomman-
dations pour prendre votre décision.

Élevé : C'est le niveau de « Non-in-
tervention ». Seules les macros signées
provenant d'une source sûre, ou des
macros venant d'emplacements de
fichiers de confiance, sont autorisées
à tourner. Les macros de tous les au-
tres fichiers seront désactivées. Vous
n'avez pas le choix ; vous n'êtes jamais
sollicité. C'est un niveau où vous ne
voulez pas que les utilisateurs finaux
prennent les décisions ; vous voulez
que LibreOffice prenne la décision à
leur place.

Très élevé : C'est le niveau «  Para-
noïaque ». Seuls les fichiers provenant
de sources sûres peuvent lancer des
macros. À nouveau, vous n'êtes pas
invité à choisir. Si le fichier ne vient pas
d'une source sûre, les macros sont
désactivées. C'est le plus verrouillé ;
c'est le niveau « ne faites confiance à
personne ». Si vous pensez que le mon-
de entier cherche à vous voler votre
identité et à connaître tous vos se-
crets, vous aurez sans doute raison,
ce niveau est fait pour vous.
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SOURCES SÛRES :

L'onglet Sources de confiance
vous permet d'identifier les sources
sûres pour vos documents.

Certificats de confiance : Les
certificats de confiance sont utilisés
pour signer numériquement les fi-
chiers. Ces certificats viennent d'une
autorité de certification. Ils sont en
général utilisés sur les sites Web pour
authentifier la source. L'installation
des certificats est hors sujet pour cet
article, mais pour signer numérique-
ment une macro, allez à Outils  >
Macros > Signature numérique...

Emplacements de fichiers de
confiance : Quel que soit le niveau
utilisé - sauf Faible -, je vous recomman-
de de définir au moins un emplace-
ment de fichiers de confiance. Vous
avez besoin d'au moins un emplace-
ment d'où vous pouvez lancer des
fichiers sûrs avec des macros sans
répondre OK à l'invite. N'utilisez pas
un emplacement où vous téléchargez
habituellement des fichiers de mails
ou d'Internet. Utilisez un emplacement
où vous rassemblez pour les sauve-
garder les fichiers que vous voulez
conserver. Parfois, il est utile d'avoir
deux ou trois emplacements. De plus,
assurez-vous que l'emplacement n'est

pas trop général, comme votre dos-
sier home.

RECOMMANDATIONS

N'utilisez JAMAIS Faible. J'ai bien
dit JAMAIS. N'essayez pas de racon-
ter que vous savez ce que vous faites,
et que vous avez un pare-feu, un anti-
virus et une protection contre les ma-
liciels. Ne le faites pas ! Non. Non, pas
de réglage à Faible. Ouvrez tout de
suite votre copie de LibreOffice et

changez pour un autre niveau.

Là. Vous vous sentez plus en
sécurité maintenant, non ? Alors, nous
pouvons présenter calmement les
avantages des autres niveaux.

Moyen est mon réglage préféré.
Tout en vous protégeant bien, vous
avez la possibilité de faire vous-même
des choix. Je recommande ce niveau
pour les ordinateurs dans votre ré-
seau domestique. Les réglages vous
apportent la protection, mais ne vous

enlèvent pas le droit de choisir. Si
certains ordinateurs sont utilisés par
des étudiants, vous aurez à cœur de
leur apprendre à bien décider pour
les documents provenant des mails et
d'Internet. Plus tard, je vous propose-
rai une méthode que je trouve utile.

Élevé et Très élevé sont les mieux
adaptés pour les réseaux profession-
nels et pour les jeunes scolaires.
Utilisez-les quand vous bloquez un
ordinateur où vous voulez limiter les
droits de l'utilisateur final. Je vois ça
tout le temps dans mon activité
professionnelle. La société a limité les
ordinateurs des utilisateurs à ce qu'ils
peuvent faire pour préserver l'inves-
tissement de l'entreprise en informa-
tique et en données. Parfois, c'est
réglé selon l'expérience et les besoins
des utilisateurs. Si vous êtes adminis-
trateur de réseau, vous devrez pren-
dre cette décision pour chaque utili-
sateur.

Comme je l'ai dit plus haut, quel
que soit le niveau que vous choisissez,
je recommande au moins un empla-
cement de fichiers de confiance. En
fait pour Très élevé, vous n'avez pas
le choix. En outre, avec des empla-
cements de fichiers, vous pouvez évi-
ter de signer les macros dans chaque
fichier avec un certificat de sécurité.
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VOUS ÊTES VOTREMEILLEUR

OUTIL

La plus importante protection de
toutes contre les virus : la matière grise
et molle entre vos oreilles. Si vous ne
vous attendiez pas à recevoir un do-
cument avec des macros, alors, peut-
être, vous n'autoriseriez pas le lance-
ment des macros. Suivez votre ins-
tinct, cela s'est développé chez l'être
humain comme mesure de protec-
tion. Soyez sceptique ! Si vous avez
l'impression que quelque chose ne
tourne pas rond, peut-être que quel-
que chose ne tourne pas rond.

Prenez ces mesures quand vous
recevez un nouveau fichier. Ouvrez le
fichier à partir d'un emplacement de
fichier non sûr, mais n'autorisez pas le
lancement des macros. Examinez les
macros dans le document. Si vous
avez la moindre question sur ces ma-
cros, posez-la à celui qui vous a en-
voyé le document. Si vous n'obtenez
pas une réponse satisfaisante sur la
présence des macros, éliminez le do-
cument. Il se peut qu'il ne soit pas
votre ami et qu'il n'ait pas votre meil-
leur intérêt à l'esprit (ou que son ordi-
nateur soit infecté par un virus). Oui,
tout cela peut paraître un peu para-
noïaque, mais il vaut mieux un peu
trop de sécurité que de perdre son

temps et ses données. Si le document
est propre (sans macro) ou que l'expé-
diteur vous fournit une réponse satis-
faisante pour ces macros, déplacez le
fichier dans un emplacement de fi-
chiers sûrs.

Bien que les macros soient utiles,
des gens les utilisent aussi pour des
raisons de malveillance. LibreOffice
vous fournit quatre niveaux diffé-
rents de protection contre les macros
malveillantes. Vous ne devriez jamais
utiliser le niveau Faible, mais le niveau
Moyen est bon pour les ordinateurs
et les réseaux domestiques. Élevé et
Très élevé sont bien pour des envi-
ronnements de bureau où vous devez
contrôler les interactions entre utili-
sateurs finaux. Prenez toujours des
précautions quand vous utilisez des
fichiers venant d'autres personnes.
Parfois, les gens transfèrent sans le
savoir des documents comportant
des macros malveillantes.

Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a
ajouté de l'Amiga, pas mal de DOS et de
Windows, une pincée d'Unix, et un
grand bol de Linux et Ubuntu.
Il blogue à http://eeperry.wordpress.com

ENQUETE
POUR LE FCM N° 1 00

La question est :

Quelles sont vos saveurs et
versions préférées/détestées ?

Remplissez ce sondage rapide et
nous publierons les résultats

dans le FCM n° 1 00.

http://goo.gl/DPt2q0

http://eeperry.wordpress.com
http://goo.gl/DPt2q0
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L ibreOffice Calc intègre des centaines
de fonctions. Elles couvrent les

mathématiques, dont la géométrie, la
trigonométrie et le calcul, des fonc-
tions de logique, des fonctions sur les
cellules et des fonctions sur les textes.
Après des années d'utilisation de Calc,
je n'ai jamais eu un besoin que je n'ai
pas résolu ou une formule que je ne
pouvais pas recréer en utilisant les fonc-
tions de Calc.

Cependant, je sais que le jour peut
arriver où j'aurai besoin d'une fonction
hautement spécialisée, une fonction qui
fait ce que les fonctions intégrées ne
peuvent pas faire ou qui calcule une
formule extrêmement compliquée. Heu-
reusement, Calc vous permet d'utiliser
des macros comme fonctions. Vous
pouvez créer vos propres fonctions et
les appeler dans la formule d'une cel-
lule. Vous pouvez même passer les
valeurs des cellules et même une plage
de cellules dans vos fonctions.

CRÉER DES FONCTIONS

PROPRES À L'UTILISATEUR

Pour créer des fonctions propres à
l'utilisateur, vous avez besoin d'abord
d'un module pour ranger vos macros.

Créez un nouveau fichier Calc et sau-
vez-le sous le nom Macrofunctions.ods.
Ouvrez la boîte de dialogue du Basic
LibreOffice des macros : Outils > Ma-
cros > Gérer les Macros > LibreOffice
Basic. Dans le cadre de navigation « Ma-
cros de », sélectionnez le nom de votre
fichier Macrofunctions.ods. Cliquez sur
Nouveau. Dans la fenêtre Nouveau
module, saisissez le nom UserFunctions
et cliquez sur OK. LibreOffice va ouvrir
un nouveau module dans l'IDE (Inte-
grated Development Environment - Envi-
ronnement intégré de développement)
du Basic LibreOffice. Le module définit
automatiquement une sous-routine
principale vierge. Vous pouvez la laisser
ou l'effacer ; à vous de choisir. Vous ne
l'utiliserez pas dans cet exemple. L'IDE
est un mini-éditeur de programmation.
En tant qu'éditeur de macro intégré
dans la suite bureautique, il est plutôt
bon. Il y a des outils pour tester et
pister les macros, mais tout ceci est

hors de propos aujourd'hui. Dans l'IDE,
vous allez écrire votre première fonc-
tion. C'est très simple. La fonction re-
tourne simplement le nombre cinq.

Function NumberFive()

NumberFive = 5

End Function

La première ligne est la définition de
la fonction. Elle commence par le mot
"Fonction" la montrant comme une
fonction plutôt qu'un sous-programme
(Sub). La principale différence entre une
fonction et un sous-programme est
qu'une fonction renvoie une valeur. Vient
ensuite le nom de la fonction, Num-
berfive, suivi par des parenthèses. Les
parenthèses sont nécessaires, même si
elles sont vides. La deuxième ligne de
cette fonction est le corps de la fonc-
tion. Le corps d'une fonction peut conte-
nir un nombre quelconque de lignes.

Cette fonction renvoie simplement le
nombre 5. Nous retournons une valeur
d'une fonction en définissant le nom de
la fonction (sans les parenthèses) égale
à la valeur que nous voulons retourner.
Enfin, nous avons la ligne "End Function"
qui désigne la fin de la fonction. Une fois
que vous avez tapé la nouvelle fonction,
cliquez sur le bouton Enregistrer.

Pour utiliser la macro dans notre
tableur, sélectionnerune cellule et taper :

=NumberFive()

Quand vous appuyez sur Entrée, le
nombre 5 apparaît dans la cellule où
vous avez tapé la formule qui utilise le
nom de la fonction. Vous pouvez même
utiliser la fonction dans une plus
grande formule comme :

=2 + NumberFive() - 3

dont le résultat est 4.

PASSER DES ARGUMENTS

C'est bien d'avoir créé la macro et
de l'utiliser dans une formule. Pour que
cette fonction soit vraiment utile, vous
avez besoin de pouvoir envoyer des
données à la fonction. Vous envoyez



1 43full circle magazine Retour au Som m aireLibreOffice

TUTORIEL - LIBREOFFICE
des données par le biais d'arguments.
Comme arguments, vous pouvez utili-
ser du texte, des nombres, des réfé-
rences de cellules et des plages de
cellules. D'abord, vous allez créer une
fonction qui passe un seul argument,
que ce soit une référence de cellule ou
une valeur.

Function SqrIt(x)
If IsNumeric(x) Then

SqrIt = x * x
Else

SqrIt = 0.0
End If

End Function

La déclaration de la nouvelle fonction
est presque identique à la première, à
l'exception de la variable x entre pa-
renthèses. Ce x représente la valeur
que vous passez à la fonction. Dans le
corps de la fonction, x est vérifié pour
être sûr que c'est un nombre. Si c'est
un nombre, la fonction le multiplie par
lui-même et retourne le résultat. Si x
n'est pas un nombre, elle retourne 0.0.

Vous pouvez donner des valeurs
numériques à x quand vous utilisez la
fonction :

=SqrIt(3)
=SqrIt(2.4)

ou faire référence à des cellules pour x :

=SqrIt(A1)
=SqrIt(B4)

ou utiliser la fonction dans une formule
plus grande :

=NumberFive() + SqrIt(C4)

Par défaut dans LibreOffice Basic,
les arguments sont passés par valeur.
Quand vous passez la référence d'une
cellule à une fonction, la fonction ne
reçoit pas une référence de la vraie
cellule. À la place, la fonction reçoit la
valeur de la cellule ou le résultat de la
formule qu'elle contient. Si la cellule A1
contient le chiffre 3, ou une formule
dont le résultat est 3, la fonction SqrIt
reçoit la valeur 3 et pas une référence à
A1 .

PASSERDES VALEURSMULTIPLES

Si passer une valeur à une fonction
est utile, parfois vous avez besoin de
passer plusieurs valeurs. Par exemple,
vous créez une fonction qui calcule le
volume d'un parallélépipède. Une ver-
sion simpliste de cette fonction est
représentée par la fonction Vol (voir ci-
dessous).

Dans Vol, vous passez les trois va-
leurs nécessaires pour calculer le volume
d'un parallélépipède. Les parenthèses
contiennent trois variables séparées
par des virgules. Dans la déclaration If,
la fonction vérifie si chacune des va-
riables est un nombre, et si c'est vrai,
elle retourne le résultat du produit des
valeurs. Sinon, elle retourne 0.0.

Nous pouvons utiliser cette fonc-
tion comme nous l'avons fait pour les
autres :

=Vol(2, 3, 4)
=Vol(A1, A2, A3)
=Vol(SqrIt(A1), A2, A3)
=SqrIt(Vol(A1, A2, A3))

PASSER DES PLAGES DE

CELLULES

Jusqu'ici, vous avez passé des réfé-
rences à une cellule dans vos fonctions,
mais vous pouvez passer une plage de
cellules plutôt qu'une référence unique.
En Basic, une plage de cellules est pas-
sée à une fonction comme une matrice.

Une matrice est un ensemble de va-
leurs. Les plages de cellules sont trans-
mises comme des matrices multi-dimen-
sionnelles, par exemple x(ligne, colonne).
Vous pouvez utiliser une fonction
appelée IsArray pour déterminer si la
valeur passée est une matrice. La fonc-
tion SumIt démontre l'utilisation de la
référence à une plage de cellules. SumIt
acceptera une valeur simple ou une
plage de cellules. Si l'argument est une
simple valeur, il retourne la valeur. Si
l'argument est une plage de cellules, il
additionne les valeurs de toutes les
cellules de la plage. Le code pour cette
fonction est présenté à la page sui-
vante, à droite.

Le corps de la fonction définit trois
variables, TheSum, iRow, et iCol. iRow
et iCol sont définis comme entiers,
c'est-à-dire des nombres entiers comme
1 , 2, 3… Ces deux variables sont les index
de ligne et de colonne. TheSum est
défini comme Double, c'est-à-dire un
nombre réel, en virgule flottante, par
exemple, 2,34 ; il contiendra le résultat
courant. TheSum est initialisé à 0.0.

Function Vol(a, b, c)
If IsNumeric(a) AND IsNumeric(b) AND IsNumeric(c) Then

Vol = a * b * c
Else

Vol = 0.0
End If

End Function
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Il n'y a qu'un seul argument dans la

définition de la fonction, x. L'utilisateur
peut envoyer, soit une simple valeur,
soit la référence d'une cellule, soit une
plage de cellules. La fonction fait un
test en utilisant la déclaration If. Elle
utilise la fonction IsArray pour déter-
miner si x est une matrice. Si c'est le
cas, SumIt parcourt deux boucles. La
boucle extérieure parcourt les valeurs
de ligne en ordre croissant. La boucle
intérieure parcourt les valeurs crois-
santes des colonnes. Les limites basses
sont trouvées avec la fonction Lbound
et les bornes hautes avec la fonction
Ubound. Ces deux fonctions prennent
en référence la matrice x et la dimen-
sion de la matrice, 1 ou 2. Souvenez-
vous que les valeurs sont référencées
par l'intermédiaire de x(ligne, colonne).
La ligne est la première valeur, la
colonne la deuxième. Au cœur des
deux boucles, SumIt prend la valeur de
somme courante, TheSum, et lui ajoute
la valeur de la cellule courante de la
matrice, x(ligne, colonne). Quand la
première ligne est finie et que iCol a
atteint sa limite Ubound, l'index iRow
s'incrémente d'un et la boucle inté-
rieure est relancée. Ce processus con-
tinue jusqu'à ce que iRow et iCol
atteignent leurs limites Ubound. Les
deux déclarations Next terminent les
boucles quand elles atteignent leurs
limites respectives Ubound. La décla-
ration Else traite le cas où x n'est pas
une matrice mais une valeur simple.

TheSum prend la valeur de l'argument
unique.

Enfin, la fonction retourne la valeur
de TheSum.

Cette fonction vous permet d'uti-
liser une plage de cellules comme
argument. Vous pouvez aussi utiliser
une simple valeur ou une cellule
comme argument. Vous pouvez même
utiliser la fonction dans une fonction
plus conséquente.

=SumIt(A3:C6)
=SumIt(A1)
=SqrIt(SumIt(A1:A5))

Bien que Calc vous fournisse des
centaines de fonctions pour manipuler

des données dans vos feuilles de calcul,
vous pouvez avoir besoin occasionnel-
lement d'une fonction spécialisée qu'il
n'est pas facile de construire en uti-
lisant les fonctions intégrées de Calc.
Une fois que vous avez créé une
fonction en Basic, vous pouvez l'ap-
peler dans une cellule avec une for-
mule. Vous pouvez définir vos fonc-
tions pour qu'elles acceptent de
simples valeurs, une référence à une
cellule ou à une plage de cellules. Ceci
vous donne la possibilité de créer des
fonctions très variées.

Function SumIt(x)
Dim TheSum as Double
Dim iRow as Integer
Dim iCol as Integer

TheSum = 0.0

If IsArray(x) Then
For iRow = LBound(x, 1) To UBound(x, 1)

For iCol = LBound(x, 2) To UBound(x, 2)
TheSum = TheSum + x(iRow, iCol)

Next
Next

Else
TheSum = x

End If

SumIt = TheSum
End Function

Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a
ajouté de l'Amiga, pas mal de DOS et de
Windows, une pincée d'Unix, et un grand
bol de Linux et Ubuntu. Son blog est à :
http://eeperry.wordpress.com

http://eeperry.wordpress.com
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DDésastre du DDisque DDur

Dans le numéro 80 du magazine, Ronnie

écrivait :

NUMÉRO CORRECT DU FULL CIRCLE !

J e dois commencer ce mois-ci
par des excuses quant à l'état du

numéro précédent (le FCM n° 79).
Pour faire court, j'ai lancé la com-
mande dd sans vérifier correcte-
ment la lettre des disques et j'ai
complètement annihilé mes parti-
tions sur le disque de 1 To, perdant
ainsi toutes mes données. Celles-ci
comprenaient, bien sûr, le fichier Scri-
bus du FCM n° 79. Inutile de dire
que j'ai écrit un article sur comment
sauvegarder vos données et un
court article sur la récupération de
données. Croyez-moi, ne restez pas
là en pensant (comme je l'ai fait)
que cela ne vous arrivera jamais. Ça
peut vous arriver !

Dans cette compilation, j'ai utilisé
les images des pages telles que
publiées dans le numéro 79. Voici
le texte brut et les images de cet
article pour ceux qui souhaiteraient
les utiliser.

Appendice 1 Contenu de la partie 32 (numéro 79)
LibreOffice Partie 32 :
Impress Remote par Elmer Perry

Si vous avez déjà animé une pré-
sentation, vous savez que revenir vers
l'ordinateur pour faire avancer vos
diapositives est pénible, surtout si,
comme moi, vous vous déplacez
beaucoup et faites activement parti-
ciper votre auditoire. J'ai récemment
présenté une session de formation au
travail et je n'ai cessé de vouloir une
télécommande. La Document Foun-
dation a fourni une solution avec l'appli-
cation Android, Impress Remote (télé-
commande Impress). Impress Remote
vous permet de contrôler votre pré-
sentation Impress à partir de votre
téléphone ou tablette Android.

Impress Remote nécessite LibreOf-
fice en version 4.0.1 ou supérieure et
un téléphone ou une tablette sous
Android 2.3 ou supérieur. Si vous pos-
sédez un téléphone ou une tablette
récent et que votre distribution Linux
est à jour, l'utilisation de ce pro-
gramme devrait être assez facile.

Installation

Nous aurons besoin de faire des
changements à notre configuration
LibreOffice Impress pour exécuter le

programme à distance. Commencez
par ouvrir une présentation (nouvelle
ou existante). Puis Outils > Options >
LibreOffice Impress > Général. Cochez
la case «  Activer le contrôle à distance  ».
Cliquez sur OK. Outils > Options >
LibreOffice > Avancé. Cochez la case
«  Activer les fonctions expérimentales  ».
Cliquez sur OK. Redémarrez Libre-
Office et ouvrez votre présentation.

Lorsque nous installerons l'applica-
tion de télécommande, nous aurons
besoin de l'adresse IP de l'ordinateur
qui exécute LibreOffice. Dans un
terminal Linux, la commande suivante
devrait fonctionner pour la plupart
des utilisateurs :

ifconfig eth0

Les informations dont vous avez be-
soin sont sur la ligne qui commence
par «  inet addr:xxx.xxx.xxx. xxx  », où
xxx.xxx.xxx.xxx est l'adresse IP de
votre ordinateur. Notez cette adresse
et conservez-la pour plus tard. Vous
en aurez besoin lorsque vous configu-
rerez l'application de télécommande.

Maintenant, nous installons l'appli
Impress Remote. Dans la boutique
Google Play, recherchez Impress Re-
mote et installez l'application sur votre

téléphone ou votre tablette. La pre-
mière fois que vous ouvrez l'appli, vous
voyez un écran presque vide. Sélec-
tionnez «  Ajouter manuellement un
ordinateur en WiFi  ». Entrez un nom
pour l'ordinateur et son adresse IP.
Sélectionnez «  Ajouter  ». Sélection-
nez l'ordinateur dans la liste et lais-
sez-le se connecter. De retour dans
Impress, Diaporama > Contrôle à dis-
tance Impress (Impress Remote).
Sélectionnez votre appareil à dis-
tance. Entrez le code qui vous a été
donné par l'application. Cliquez sur
Sélectionner. Dans l'appli à distance,
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cliquez sur «  Démarrer la présentation  »
pour démarrer celle-ci.

Si votre ordinateur dispose du Blue-
tooth, vous pouvez également vous
connecter par l'appairage de votre
téléphone avec votre ordinateur. Lors-
que vous ouvrez l'appli, il va recher-
cher votre appareil via Bluetooth, et il
vous suffit de sélectionner votre
appareil dans la liste. Vous avez
toujours besoin d'activer les options
de communication à distance et
expérimentales dans LibreOffice.

REMARQUE : Si vous utilisez un pare-
feu sur votre ordinateur, vous devez
ouvrir le port TCP 1 599 pour les com-
munications parWiFi.

Utiliser l'appli Impress Remote

L'appli est assez basique, mais il faut
se rendre compte que, moins c'est
compliqué, mieux c'est quand vous
donnez une présentation. La barre
d'outils dans la partie supérieure
affiche l'heure actuelle, ce qui est
pratique lorsque votre présentation

doit commencer ou se terminer à des
heures définies. À gauche de l'hor-
loge est le commutateur de vues et à
droite de l'heure est le menu de
l'appli.

Quand vous commencez une pré-
sentation, vous obtenez la vue de
défilement des diapositives de votre
présentation. Cette vue est la plus
utile parce que, quand vous êtes en
mode de défilement, vous pouvez éga-
lement voir toutes les notes que vous
avez faites pour la diapositive. Bien
que vous puissiez utiliser votre doigt
pour naviguer dans le diaporama, ce
n'est pas la meilleure méthode, sauf
si vous avez juste besoin d'avancer ou
de reculer de plusieurs diapositives à

l

a fois. La meilleure façon de – ou celle
qui a été conçue pour – naviguer dans
votre présentation est d'utiliser les

boutons volume haut et bas. Le
bouton haut vous avance dans la pré-
sentation et le bouton bas fait reve-
nir en arrière.

Parfois, vous avez besoin de faire une
pause et déplacer l'attention de votre
auditoire de l'écran vers autre chose.
Impress Remote vous donne la capa-
cité de vider l'écran. Dans le menu de
l'appli, sélectionnez «  Blank Screen  ».
Votre écran de présentation se vide.
Lorsque vous êtes prêt à retourner à

la présentation, cliquez simplement
sur «  Retour à la diapo  ». La présen-
tation reprendra là où vous l'avez
laissée.

Vous pouvez afficher vos diaposi-
tives de deux manières différentes  :
celle que nous avons déjà vue, le
mode défilement, et le mode liste.
Vous pouvez basculer entre les deux

modes en cliquant sur le bouton
sélecteur de vue. Dans le mode défi-
lement, vous vous déplacez rapi-
dement jusqu'à une diapositive en
faisant glisser avec votre doigt. Pour

Contenu de la partie 32 (numéro 79)



1 47full circle magazine Retour au Som m aireLibreOffice

sélectionner une diapositive en mode
liste, il suffit de sélectionner la dia-
positive. Ce n'est pratique que pour
les diapositives figées. Toute diapo-
sitive ayant des animations nécessi-
tera l'utilisation des boutons volume
haut et bas.

Si vous cliquez sur l'horloge, vous
avez la possibilité de laisser l'heure
actuelle ou de démarrer un chro-
nomètre. Choisissez le chronomètre
pour l'utiliser. Vous obtiendrez des
options Start et Reset. Appuyez sur
Start pour lancer le chronomètre. Le
chrono commencera à compter et les

options changeront en Pause et
Restart. Choisissez Pause pour inter-
rompre le chrono et Restart pour
recommencer à partir de 0.00. Ceci
est pratique pour chronométrer une
activité ou travailler sur le débit de
votre présentation.

Dans le menu de l'appli, il y a un choix
pour les Options. La première option
est d'utiliser les boutons de volume
haut et bas pour contrôler la pré-
sentation. Il me semble qu'il n'y ait

pas de raison valable de décocher
celle-ci, mais je pense qu'elle est là
parce que quelqu'un avait une bonne
raison. La deuxième option est
d'activer une connexion sans fil entre
le téléphone et l'ordinateur. Cela

permet à l'appli de rechercher auto-
matiquement les périphériques du
réseau sans fil qui ont LibreOffice
Impress ouvert avec la fonction de
connexion à distance activée. Enfin,
l'option de changer d'ordinateur vous
permet de basculer sur un autre
ordinateur.

Conclusion

Quand on anime une présentation, il
est agréable de pouvoir bouger.
L'appli Android Impress Remote vous
donne cette possibilité en vous per-
mettant de contrôler votre présen-
tation Impress à partir de votre télé-
phone ou tablette Android. L'appli
est facile à configurer via Bluetooth

ou WiFi. L'interface est dépouillée, ce
qui facilite son utilisation et son con-
trôle. Comme l'appli a été dévelop-
pée par les mêmes personnes qui
développent LibreOffice, la compatibi-
lité future est pratiquement assurée.

Elmer Perry a commencé à travailler et
programmer sur Apple IIE, puis il y a ajouté
de l'Amiga, pas mal de DOS et de Windows,
une pincée d'Unix, et un grand bol de Linux et
Ubuntu. Voici son blog :
http://eeperry.wordpress.com

http://www.fullcirclemag.fr/?downl
oad/305

http://www.fullcirclemag.fr/?downl
oad/435
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